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1. Introduction to MCUXpresso IDE

1.1

MCUXpresso IDE User Guide -

MCUXpresso IDE version 10.2.0 is a low-cost microcontroller (MCU) development platform
ecosystem from NXP. It provides an end-to-end solution enabling engineers to develop
embedded applications from initial evaluation to final production.

The MCUXpresso platform ecosystem includes:

. - a software development environment for creating applications for
NXP’s ARM Cortex-M based MCUs including “LPC”, “Kinetis” and iMX RT" ranges.

. (introduced in MCUXpresso IDE version 10.1), comprising
of Pins, Clocks and Peripherals Tools that are designed to work with SDK projects and are
fully integrated and installed by defaul

. | each offering a package of device support and example software
extending the capability and part knowledge of MCUXpresso IDE.

¢ The range of LPCXpresso development boards, each of which includes a built-in “LPC-Link”,
“LPC-Link2", or CMSIS-DAP debug probe. These boards are developed in collaboration with
Embedded Artists.

¢ The range of Tower and Freedom development boards, most of which include an OpenSDA
debug circuit supporting a range of firmware options.

¢ Therange of IMX RT Series EVK development board which include an OpenSDA debug circuit
supporting a range of firmware options.

¢ The standalone “LPC-Link2” debug probe.

This guide is intended as an introduction to using MCUXpresso IDE. It assumes that you have
some knowledge of MCUs and software development for embedded systems.

Note: MCUXpresso IDE incorporates technology and design from LPCXpresso IDE. This means
that users familiar with LPCXpresso IDE will find MCUXpresso IDE looks relatively familiar.

MCUXpresso IDE Overview of Features

MCUXpresso IDE is a fully featured software development environment for NXP’s ARM-
based MCUs, and includes all the tools necessary to develop high-quality embedded software
applications in a timely and cost effective fashion.

MCUXpresso IDE is based on the Eclipse IDE and includes the industry standard ARM GNU
toolchain. It brings developers an easy-to-use and unlimited code size development environment
for NXP MCUs based on Cortex-M cores (LPC, Kinetis and iMX RT). The IDE combines the best
of the widely popular LPCXpresso and Kinetis Design Studio IDEs, providing a common platform
for all NXP Cortex-M microcontrollers.

MCUXpresso IDE is a free toolchain providing developers with no restrictions on code or
debug sizes. It provides an intuitive and powerful interface with profiling, power measurement
on supported boards, GNU tool integration and library, multicore capable debugger, trace
functionality and more. MCUXpresso IDE debug connections support Freedom, Tower, EVK,
LPCXpresso and custom development boards with industry leading open-source and commercial
debug probes including LPC-Link2, P&E and SEGGER.

The fully featured debugger supports both SWD and JTAG debugging, and features direct
download to on-chip and external flash memory.

For the latest details on new features and functionality, please visit:
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Summary of Features

Complete C/C++ integrated development environment

» Eclipse-based IDE with many ease-of-use enhancements
 Built on Eclipse Oxygen 3 and CDT 9.4
« The IDE installs with Eclipse Plugins offering
» Git, FreeRTOS and support for P&E Micro debug probes
e The IDE can be further enhanced with many other Eclipse plugins
* Command-line tools are included for integration into build, test, and manufacturing systems

Industry standard GNU toolchain v7 2017g4-major including:

¢ C and C++ compilers, assembler, and linker
e Converters for SREC, HEX, and binary

Advanced project wizards

« Simple creation of pre-configured applications for
» Extendable with

» Device-specific support for NXP’s ARM-based MCUs (including LPC, Kinetis and iMX RT)

. of linker scripts for correct placement of code and data into Flash
and RAM
» Extended support for flexible placement of

¢ Automatic generation of MCU-specific startup and device initialization code

¢ Note: No assembler required with Cortex-M MCUs

Advanced multicore support

 Provision for for each core in multicore MCUs
¢ Debugging of within a single IDE instance, with the ability to link
various debug views to specific cores

Fully featured native debugger supporting SWD and JTAG connection via LinkServer

¢ Built-in optimized for internal and SPI Flash
¢ High-level and instruction-level

. and

¢ Views of CPU and on-chip

e Support for multiple devices on the JTAG scan-chain

Full install and integration of 3rd party debug solutions from:

Library support

¢ Redlib: a small-footprint embedded C library
« RedLib-nf: a smaller footprint library offering reduced fprintf support
* RedLib-mb: a library variant offering enhanced semihosting performance
* Newlib: a complete C and C++ library
¢ NewlibNano: a new small-footprint C and C++ library, based on Newlib
¢ LPCOpen MCU software libraries
« Cortex Microcontroller Software Interface Standard (CMSIS) libraries and source code
« Extendable support per device via MCUXpresso SDKs

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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1.1.2

MCUXpresso IDE User Guide -

LinkServer Trace functionality

« Instruction trace via Embedded Trace Buffer (ETB) on certain Cortex-M3/M4/M7 based MCUs
or via Micro Trace Buffer (MTB) on Cortex-M0O+ based MCUs

« Providing a snapshot of application execution with linkage back to source, disassembly and
profile
¢ SWO Trace on Cortex-M3/M4 based MCUs when debugging via LPC-Link2, providing
functionality including:

« Profile tracing

* Interrupt tracing
» Datawatch tracing
e Printf over ITM

LinkServer Power Measurement

¢ On LPCXpresso boards, sample power usage at adjustable rates of up to 200 ksps; average
power usage display option

e Explore detailed plots of collected data in the IDE

« Export data for analysis with other tools

MCUXpresso Configuration Tools

¢ Introduced in MCUXpresso IDE version 10.1.0, | designed
to work with SDK projects are fully integrated and installed by default, comprising:

* Pins Tool
» Clocks Tool
» Peripherals Tool
* Note: Now updated to version 4.1

Supported Debug Probes

MCUXpresso IDE installs with built in support for 3 debug solutions:

* Native LinkServer (including CMSIS-DAP) as also used in LPCXpresso IDE

« this supports a variety of debug probes including OpenSDA programmed with CMSIS-DAP
firmware, LPC-Link2 etc.

* https://community.nxp.com/message/630896
* P&E Micro

 this supports a variety of debug probes including OpenSDA programmed with P&E
compatible firmware and MultiLink and Cyclone probes

* http://www.pemicro.com/
¢ SEGGER J-Link

« this supports a variety of debug probes including OpenSDA programmed with J-Link
compatible firmware and J-Link debug probes

* https://lwww.segger.com/
This support includes the installation of all necessary drivers and supporting software.
Please see for more details.

Note: Kinetis Freedom and Tower boards typically provide an on-board OpenSDA debug circuit.
This can be programmed with a range of debug firmware including:

« mBed CMSIS-DAP - supported by LinkServer connections

¢ DAP-Link — supported by LinkServer connections (DAP-Link is preferred to mBed CMSIS-DAP
when available)

e J-Link — supported by SEGGER J-Link connections

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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¢ P&E — supported by P&E connections

The default firmware can be changed if required, for details of the procedure and range of
supported firmware options please information visit: http://www.nxp.com/opensda

Tip

@ Under Windows 10, OpenSDA Bootloaders might experience problems and the
OpenSDA LED will blink an error code. The following article discusses the problem
and how it can be fixed: https://mcuoneclipse.com/2018/04/10/recovering-opensda-
boards-with-windows-10

1.1.3 Development Boards

NXP have a large range of development boards that work seamlessly with MCUXpresso IDE
including:

LPCXpresso Boards for LPC

These boards provide practical and easy-to-use development hardware to use as a starting point
for your LPC Cortex-M MCU based projects.

s v g o v
TARTERN BREEETRENTR

Figure 1.2. LPCXpresso Development Board (LPCXpresso54608)

For more information, visit: http://www.nxp.com/lpcxpresso-boards
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Freedom and Tower Boards for Kinetis

Similarly, for Kinetis MCUs there are many development boards available including the popular
Freedom and Tower ranges of boards.

Figure 1.3. Tower (TWR-KV58F220M)

For more information, visit: http://www.nxp.com/pages/: TOWER_HOME

Figure 1.4, Freedom (FRDM-K64F)

For more information, visit: http://www.nxp.com/pages/:FREDEVPLA
iMX RT Crossover Processor Boards

iMX RT based boards bring the convergence of low power applications processors with high-
performance microcontrollers.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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Figure 1.5. i.MX RT Series (MIMXRT1050-EVK)

For more information, visit: https://www.nxp.com/pages/:IMX-RT-SERIES
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2. New Features in MCUXpresso IDE 10.2.0

MCUXpresso IDE User Guide -

The MCUXpresso IDE team are pleased to bring a host of new features to this release continuing
our strategy of both customer focused and general product improvements, including:

Product

¢ All previous Pro Edition features have been incorporated into the standard Free edition
and the Pro edition has been discontinued

 Built upon latest Eclipse Oxygen and offering significantly faster project builds
* includes a new

IDE

* Redesigned
« with links for for all supported Debug Solutions
¢ Support for new MCUs both via internal part support and also new version 2.4 SDKs

Debug

* Increased integration of our supported debug solutions including:

. is re-architected to provide support for LinkServer, P&E and
SEGGER debug solutions

« offering binary flash programming and erase capability for all supported debug solutions

» with a feature set integrated into the QuickStart panel, project Launch Configurations and
from the IDE as before

« Instruction trace is seamlessly supported by LinkServer, P&E and SEGGER debug solutions

. including printf are further optimised to deliver
approximately double the performance of the previous release
. via new library variant Redlib MB and

LinkServer which can deliver both a further increase in performance and no disruption to code
executing with time critical interrupts

e LinkServer
 Live global variable values can now be traced both in graphical and tabular forms

. to simplify complex peripheral views

Flash Programming

e LinkServer via self configuring flash
drivers using JEDEC SFDP (Serial Flash Discovery Protocol) for LPC18/43, LPC546xx,
LPC540xx (iMX RT to be made available post release)

Projects

« Many enhancements for improved includng:
» Drag and Drop of projects for import and export
« Options for project local inclusion of: SDK part support, flash drivers, and LinkServer connect
and reset scripts

. introduced to enable easy visibility and editing of project
configurations

. for all debug solutions delivered via project launch
configurations

Linker

« Enhanced managed linker support including:
. support for sophisticated boot strategies
. across multiple RAM regions
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SDK

* SDK Manifest Analyser to provide visibility of SDK XML description
* Easy access to
¢ Extension of SDK Component Management to allow

* improved SDK Component Management

General Improvements in SDK Handling including:

» SDK version string now present and reported in SDK view (SDK version 2.4 only)
« user selection of versioned internal XML descriptions (enabled via preference)
 better automatic support for SDKs with overlapping capabilities

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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3. IDE Overview

The following chapter provides a high level overview of the features offered by the IDE itself.

3.1

MCUXpresso IDE User Guide -

Documentation and Help

MCUXpresso IDE is based on the Eclipse IDE framework, and many of the core features
are described well in generic Eclipse documentation and in the help files to be found on the
MCUXpresso IDE’s Help -> Help Contents menu. It also provides access to the MCUXpresso
IDE User Guide (this document), as well as the documentation for the compiler, linker, and other
underlying tools.

MCUXpresso IDE documentation comprises a suite of documents including:

* MCUXpresso IDE Installation Guide

« MCUXpresso IDE User Guide (this document)

e MCUXpresso IDE LinkServer SWO Trace Guide

« MCUXpresso IDE LinkServer Instruction Trace Guide

¢ MCUXpresso IDE LinkServer Power Measurement Guide
* MCUXpresso IDE FreeRTOS Debug Guide

e MCUXpresso (IDE) Config Tools User’s Guide

To obtain assistance on using MCUXpresso IDE, visit: http://www.nxp.com/mcuxpresso/ide

Related web links can be found at Help -> Additional resources as shown below:

Search |

(@ Help Contents

MCUXpresso IDE User Guide
%’ Search

Show Contextual Help

Show Active Keybindings... { 3L
Tips and Tricks...
Cheat Sheets...

@ Eclipse User Storage >
%4 Check for Updates

g Install New Software...

& Eclipse Marketplace...

EF Additional resources

3 Product Information
ﬂ MCUXpresso IDE support forum

# Show welcome page

B MCUXpresso IDE website
B MCUXpresso SDK website
B MCUXpresso SDK Builder
» LPCOpen Resources
Code Bundles for LPCB00 Family devices

» OpenSDA probe firmware
LPCScrypt - LPC-Link2 probe firmware
» LPC11U35 CMSIS-DAP probe firmware

SEGGER J-Link website

53 PEMicro website

MBED Serial Port Driver website
& 'MCU on Eclipse’ blogs

When MCUXpresso IDE is launched, a Welcome page is displayed (usually within the Editor
view). This page contains product information including a link to the User Guide. If this page

All information provided in this document is subject to legal disclaimers
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is not required on startup, it can be disabled via unticking the preference at Preferences ->
MCUXpresso IDE -> General -> Show welcome view.

3.2 Workspaces

When you first launch MCUXpresso IDE, you will be asked to select a Workspace, as shown
in Figure 3.1.

[ NN ] Eclipse Launcher

Select a directory as workspace

MCUXpresso IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | /Users/nxp/Documents/MCUXpressolDE_10.0.0/workspace [~ Browse...

Use this as the default and do not ask again

} Recent Workspaces

Cancel [ OK

Figure 3.1. Workspace selection

A Workspace is simply a directory used to store projects. MCUXpresso IDE can only access a
single Workspace at a time, although it is possible to run multiple instances in parallel — with
each instance accessing a different Workspace.

If you tick the Use this as the default and do not ask again option, then MCUXpresso IDE
will always start up with the chosen Workspace opened; otherwise, you will always be prompted
to choose a Workspace.

You may change the Workspace that MCUXpresso IDE is using, via the File -> Switch
Workspace option.

3.3 Perspectives and Views

The overall layout of the main MCUXpresso IDE window is known as a Perspective. Within
each Perspective are many sub-windows, called Views. A View displays a set of data in the IDE
environment. For example, this data might be source code, hex dumps, disassembly, or memory
contents. Views can be opened, moved, docked, and closed, and the layout of the currently
displayed Views can be saved and restored.

Typically, MCUXpresso IDE operates using the single Develop Perspective, under which both
code development and debug sessions operate as shown in Figure 3.3. This single perspective
simplifies the Eclipse environment, but at the cost of slightly reducing the amount of information
displayed on screen.

Alternatively, MCUXpresso IDE can operate in a “dual Perspective” mode such that the C/
C++ Perspective is used for developing and navigating around your code and the Debug
Perspective is used when debugging your application.

You can manually switch between Perspectives using the Perspective icons in the top right of
the MCUXpresso IDE window, as shown in Figure 3.2.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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Figure 3.2. Perspective selection

All Views in a Perspective can also be rearranged to match your specific requirements by
dragging and dropping. If a View is accidentally closed, it can be restored by selecting it from the
Window -> Show View dialog. The default layout for a perspective can be restored at any time

via Window -> Perspective -> Reset Perspective.

3.4 Major Components of the Develop Perspective

(wi] B33 BUBMRRIRIG S AU O QOO F [ I E @ Y-
= B 45 Debug R
=% ®- B evkbimat1050 igpio_led_output LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application]
v i evkbimxrt1050_igpio_led_output.axf [MIMXRT1052xxxxx (cortex-m7)]
v 4 Thread #1 1 (Suspended : Breakpoint)
= main() at gpio_led_output.c:80 0x60002fee
+4 arm-none-eabi-gdb (8.0.50.20171128)

@
4

[ Project Ex 52

¥ 5 evkbimxrt1080_igpio_led_output
v @ Project Settings
» =i Associated SDK
» =i Libraries (and semihosting)
» @ MCU
» il Memory
» [ Options
>4 Binaries
» il Includes.
> ESCMsIS
» (S board
» B drivers 3
¥ (@ source ¥
» £ gpio_led_output.c

[4) gpio_led_output.c

volatile uint32_t i = 0;
for (i = 0; i < EXAMPLE_DELAY_COUNT; ++i)

i /% delay */

» [& semihost_hardfault.c
> @startup
> (Butilities

B evkbimxrt1050_igpio_led_output LinkServer Debug.launch
[l evkbimxrt1050_igpio_led_output LinkServer Release.launch

k, debug console inik */

nsQ;
BOARD_BootClockRUNQ) ;
BOARD_Ini tDebugConsole();

note to terminal. *
GPIO Driver example\r\n");
The LED is blinking.\r\n");

O Quickst ¢+ Glo Variable Brea tine = O

- MCUXpresso IDE - Quickstart Panel s PRINTF("
o) Project: evkbimxrt1050_igpio_led_output (Debug)

/7 Inik output LED GPIO. */
. GPIO_PinIni t(EXAMPLE_LED_GPTO, EXAMPLE_LED_GPTO_PIN, &led_config);
~ Create or import a project

8 New project while )

jelayO;
® Import project(s) from file system. GPI0_PortToggle(EXAMPLE_LED_GPTO, 1u << EXAMPLE_LED_GPIO_PIN);

~ Build your project

& suild @ Installed SDKs %X [ Properties & Console (2] Problems [ Memor ol struction Trace & ™
o Clean J Installed SDKs
- Debug your project - EA-  Toinstallan SOK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKS' view.
Name SOKVerson  Manifest Version _ Location
) ¥ Debug £ SDK_2.x EVK-MIMXRT1020 2.40 320 /SDK_2.0_EVK-MIMXRT1020
# Terminate, Build and Debug £ SDK_2.x_EVKB-IMXRT1050 234 320 5 <Default Location>/Wed_Apr_4_17_01_51_2018-windows-mcu
4 SDK_2.x_FROM-KB4F 220 320 -] /SDK_2.0_FRDM-K64F
iscellaneous @ # SDK_2.x_LPCXpresso54018 230 3.20 '} /SDK_2.3.0_LPCXpresso54018.zip
® Edit project settings # SDK_2.x_LPCXpresso54628 230 /SDK_2.0_LPCXpresso54628

uick Settings>>

& Build all projects [Debug]

¥

Writable Smartinsert | 80:1

=
0 Trace Conf o8 me=no
SDK Details m
Selected SDK content.
[ 8oards
» EVKB-IMXRT1050 1.00
» EVKB-IMXRT1050-AGMO1 1.00
» EVKB-IMXRT1050-OM13588 1.00
v B Devices
v B MIMXRT1052 1.00
» © Packages
» B Cores
O NXP MIMXRT1052:0000¢" (evkbimx...output)

Figure 3.3. Develop Perspective (whilst debugging)

1. Project Explorer / Peripherals / Registers Views

« The Project Explorer gives you a view of all the projects in your current
« many editing and configuration features are available from this view including new

options and

« When debugging, the Peripherals view allows you to display a list of the
and project memory regions. Selecting a peripheral or memory region
will spawn a new window to display the detailed content. Note: depending on your MCUs
configuration, some peripherals may not be powered/clocked and hence their content will

not display.

* When debugging, the Registers view allows you to display the registers and their content

within the CPU of your MCU.
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Not visible here is the Symbol Viewer; this view displays symbolic information from a
referenced .axf file.

2. Editor

Centrally located is the Editor, which allows modification and saving of source code. When
debugging, this is where you can see the code you are executing and can step from line to
line. By pressing the 'i-> icon at the top of the Debug view, you can switch to stepping by
assembly instruction. Clicking in the left margin will set and delete breakpoints.

3. Console / Installed SDKs / Problems / Trace Views / Power Measurement

On the lower right are the Console, Installed SDK and Problems Views etc. The Console

View displays status information on compiling and debugging, as well as semihosted

program output.

The view enabled the management of installed SDKs. New SDKs can

be added using drag and drop. Other SDK management features are also provided from

this view including unzip, explore and delete.

* New — SDK Documentation can now be browsed and extracted

The Problems View (available by changing tabs) shows all compiler errors and warnings

and will allow easy navigation to the error location in the Editor View.

Sitting in parallel with the Console View are the various Views that make up the Trace

functionality of MCUXpresso IDE. For more information on Trace functionality, please see

the MCUXpresso IDE SWO Trace Guide and/or the MCUXpresso IDE Instruction Trace

Guide.

« The SWO trace Views allow you to gather and display runtime information using the SWO/
SWV technology that is part of Cortex-M3/M4 based parts.

« On some MCUSs, you can also view instruction trace data downloaded from the MCU’s
Embedded Trace Buffer (ETB) or Micro Trace Buffer (MTB).

Sitting in parallel with the Console View is the Power Measurement View, a dedicated trace

View capable of displaying real-time target power usage. For more information please see

the MCUXpresso IDE Power Measurement Guide.

4. Quickstart / Variables / Breakpoints / Outline Views

On the lower left of the window, the Quickstart Panel View has fast links to commonly used
features. From here you can launch various wizards including New Project, Import from
SDK and Import from File System plus options such as Build, Debug, and Import. The large
icon in each section will perform the first option in the group i.e. New project, Build, Debug.
Also, the Debug group contains debug solution specific
* Note: This Panel is essential to the operation of MCUXpresso IDE and so cannot be

removed from the perspective.
Sitting in parallel to the Quickstart Panel, the Global Variables View allows you to see and
edit the values of Global variables.
e Variables can be monitored while the target is running using the LinkServer

and features.

Sitting in parallel to the Quickstart Panel, the Variables View allows you to see and edit
the values of local variables.
Sitting in parallel to the Quickstart Panel, the Breakpoints View allows you to see and
modify currently set breakpoints.
Sitting in parallel to the Quickstart Panel, the Outline View allows you to quickly find
components of the source file with input focus within the editor.

5. Debug View

The Debug View appears when you are debugging your application. This shows you the
stack trace. In the “stopped/paused” state, you can click on any function and inspect its local
variables in the Variables tab (which is located parallel to the Quickstart Panel View).

6. Quick Access

Enables quick access to features such as views, perspectives etc. for example enter ‘Error’
to view and open the IDE’s Error Log, or ‘Trace’ to view and open the various LinkServer
Trace views.

7. Perspective Selection

MCUXpresso IDE User Guide -
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3.4.1

« From here you can select and switch between the various perspectives, initially only the
perspective selector and the Develop perspective will be shown.
8. Quick Links
¢ Various useful shortcuts, for example to open a project’s workspace.

Project Settings

New in MCUXpresso IDE version 10.2.0 are Project Virtual Nodes contained within a Project
Settings virtual folder. These are automatically generated for any project and provide a quick
way to view many key project settings. In addition, a right click on these nodes provides direct
options to edit the associated settings that otherwise require many more mouse clicks to reach.

Figure 3.4. Project Settings

{3 Project Explorer 82 7, Peripherals+ i} Registers .1 Symbol Viewer

v =5 frdmk64f _led_blinky
¥ & Project Settings

¥ =i Associated SDK - = Edit Libraries >
o name = 'SDK_2.x_FRDM-KG64F* _
o version = '2.4.0' / | |
¥ =i Libraries (and semihosting) © Edit MCU
o LibraW B
v €& MCU r

o chip = 'MKG64FN1MOxxx12'
o package = 'MKG64FNTMOVLL
© processor = 'corf
v if5i Memory
o Flash name='PROGRAM_FLASH' typgs-*dsh' address="0x0" size="0x100000"' FTFE_4K.cfx
o RAM name="SRAM_UPPER' AM' address="0x20000000" size='0x30000"
o RAM2 name='SRAM R' type='RAM' address="0x1fff0000" size="0x10000"
o RAM3 namesz- RAM' type="RAM' address="'0x14000000" size="0x1000"
v [T Options
o Defined symbols (-D) (C) = '[_REDLIB__, CPU_MKB64FN1MOVLL12_cm4, CPU_MKB4FNTMOVLL 2,
» ¥ Binaries
» ik Includes
» (2 CMSIS
» (£ board
» (2 drivers
» (% source
» (2 startup
b (2 utilities
» = Debug
» (= doc
.frdmkﬁdf_led_blinky LinkServer Debug.launch
.frdmkﬁdf_led_blinky LinkServer Release.launch

it Edit memory

12

[ Edit options

3.5 Help us improve MCUXpresso IDE
MCUXpresso IDE can send anonymous information to NXP on how you use the IDE, including
the built-in Config Tools, and with which MCUs. This information can help us to improve the
functionality of the tools as well as to resolve problems. You can turn this information collection
off at any time by unticking the workspace option:
Preferences -> MCUXpresso IDE -> General -> Help us improve the tool
MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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4. Debug Solutions Overview

MCUXpresso IDE installs with built-in support for 3 debug solutions; comprising the
as used in LPCXpresso IDE. Plus support for both
and . This support includes the installation of all
necessary drivers and supporting software.

The rest of this chapter discusses these different Debug solutions. For general information on
debugging please see the chapter

Note: Within MCUXpresso IDE, the debug solution used has no impact on project setting or build
configuration. Debug operations for basic debug are also identical.

4.1 Starting a Debug Session

To start a debug session:

1. select a project within the MCUXpresso IDE Project View
2. click Debug from within the MCUXpresso IDE QuickStart View

L]
L) Quickst Globa Variable Breakp Outine = B

MCUXpresso IDE - Quickstart Panel
(_1E [ Project: evkbimxrt1050_igpio_led_output [Debug]]

~ Create or import a project

. New project...

b
Import SDK example(s)...

2 Import project(s) from file system...

~ Build your project

%, Build

& Clean

~ Debug your project .' EE' m'

4 Debug
#‘ Terminate, Build and Debug

~ Miscellaneous

B Edit project settings

& Quick Settings>>

,@ Export project(s) to archive (zip)

[P Export project(s) and references to archive (zip)
o Build all projects [Debug]

* A debug probe discovery operation is automatically performed to display the available
debug connections (i.e. the detected debug probes), including LinkServer, P&E and J-Link
compatible probes.

3. select the required debug probe and click OK

4. Note: a forced discovery of particular debug solution can made by clicking the matching icon
(LinkServer, P&E, SEGGER)

« A project launch configuration is automatically created containing debug specific
configurations

. are stored within a project and are different for each of the
supported debug solutions

Tip

@ When a project has been debugged, debug details will be stored within the project
in a - if the debug probe used is unchanged,
subsequent debug operations to the project will skip the debug probe discovery step.
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From this point onwards, the low level debug operations are controlled by one of the above debug
solutions.

However, from the users point of view most common debug operations within the IDE will appear
the same (or broadly similar), for example:

< Automatic inheritance of part knowledge
¢ Automatic downloading of generated image to target Flash memory

e Setting and
. (single, step in step out etc.)
* Viewing and editing local variables, registers, , memory

* Viewing and editing
* live global variables is a LinkServer only feature
* Viewing disassembly
* Semihosted 10
¢ New in MCUXpresso IDE version 10.2.0:
 Instruction Trace is supported for all debug solutions
. is supported for all debug solutions

Note: In addition MCUXpresso IDE will dynamically manage each debug solutions connection
requirements allowing multiple sessions to be started without conflict. For debug of Multicore
MCUs please refer to the section

However, it is important to note that advanced operations such as the handling of launch
configuration features may be very different for each debug solution. Furthermore, advanced
debug features and capabilities may vary between solutions and even similar features may
appear quite different within the IDE.

MCUXpresso IDE documentation will only describe the advanced features provided by native
LinkServer debug connection. These include:

¢ Flash programming
* please see the chapter
* Instruction Trace
* please see LinkServer Instruction Trace Guide
¢ Live Global Variable display (including Graphing)
« described later in this chapter
* Power Measurement
» please see LinkServer Power Measurement Guide
¢ FreeRTOS Debug
« please see FreeRTOS Debug Guide
¢ SWO Trace (Profiling, Interrupts, Data Watch) - LPC-Link2 Only
» please see LinkServer SWO Trace Guide

P&E Micro and SEGGER debug solutions also provide a number of advanced features, details
can be found at their respective web sites.

An Introduction to Launch Configuration Files

The debug properties of a project in MCUXpresso IDE are held locally within each project in
Jaunch files (known as launch configuration files).

Launch configuration files are different for each debug solution (LinkServer, P&E, SEGGER) and
contain the properties of the debug connection (SWD/JTAG, and various other configurations
etc.) and can also include a debug probe identifier for automatic debug probe matching.

If a project has not yet been debugged, for example a newly imported or created project, then
the project will not have a launch configuration associated with it.

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide

Rev. 10.2.0 — 14 May, 2018 15


http://www.pemicro.com/
https://www.segger.com/

NXP Semiconductors MCUXpresso IDE User Guide

When the user first tries to debug a project, MCUXpresso IDE will perform a Debug Probe
Discovery operation and present the user with a list of debug probes found. Note: The Debug
Solutions searched can be filtered from this dialogue as highlighted, removing options that are
not required will speed up this process.

o e Probes discovered
Connect to target: MK64FN 1MOxxx12

1 probe found. Select the probe to use:

Available attached probes

Name Serial number/ID Type Manufactui IDE Debug Mode

| [LPC-LINK2 CMSIS-DAP V5.183 [IQCOAXGY |LinkServel NXP Sem{Non-Stop |

Supported Probes (tick/untick to enable/disable}

MCUXpresso IDE LinkServer {inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again

Remember my selection (for this Launch configuration)

Figure 4.1. Debug Probe Discovery

Once the debug probe is selected and the user clicks ‘OK’, the IDE will automatically create a
default launch configuration file for that debug probe (LinkServer launch configuration shown
below).

{5 Project Ex 32 | 7. Peripheral 17} Registers £ SymbolVi = 8
B S X- -
¥ =5 frdmk64f_bubble
» € Project Settings
» 3 Binaries
» il Includes
> 2 CMSIS
» (Zaccel
> (2 board
» (S drivers
¥ (2 source
» [€ bubble.c
» | semihost_hardfault.c
» (2 startup
» (2 utilities
» (= Debug

T=rior
B8 frdmk64f_bubble LinkServer Debug.launch
.1rdmk64|_bubble LinkServer Release.launch

Figure 4.2. Launch Configuration Files

Note: a launch configuration will be created for each project build configuration.
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For most debug operations, these files will not require any attention and can essentially be
ignored. However, if changes are required, these files should not be edited manually, rather their
properties should be explored within the IDE.

The simplest way to do this is to click to expand the Project within the ‘Project Explorer’ pane,
then simply double click a launch configuration file to automatically open the launch configuration
Edit Configuration dialogue.

Note: This dialogue has a number of internal tabs, the Debugger tab (as shown below) contains
the debug main settings. See also the new in MCUXpresso IDE version 10.2.0

[ NN | Edit Configuration

Modify configuration and continue. ’ﬁ\(
Name: MKE4FN1MOxxx12_Project Li
(2 Main % Source [ € GUI Flash T40I %> Debugger . fcommon

B mMcuxpresso IDE LinkServer Debugger

Stop on startup at:  main Request hardware breakpoint

Debugger Options

M{n Target configuration

Debug options for NXP MKE4FN1MOxxx12 (cortex-md)

Debug Connection SWD | ™

Cenfiguration Option ~ Value

ah[: Additional options

i-| Attach only False

st Connect Script kinetisconnect.scp
abf: Debug Level 2

:-| Debugger memaory cache Disable

i-| Disconnect behavior cont

i Flash Driver Reset Handling

i|Load image True

Miscellaneous
Emulator selection  LinkServer o

Edit scripts...

Debug options template

Debug Configuration (*) A Show all
Revert Apply

Figure 4.3. Launch Configuration

Some debug solutions support advanced operations (such as the recovering of badly
programmed parts) from this view.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide Rev. 10.2.0 — 14 May, 2018 17




NXP Semiconductors MCUXpresso IDE User Guide

4.3

4.4
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Note: Once a launch configuration file has been created, it will be used for the projects future
debug operations. If you wish to use the project with a different debug probe, then simply delete
the existing launch configuration and allow a new one to be automatically used on the next debug
operation.

Enhancement: Introduced in MCUXpresso IDE version 10.1.0 — to simplify this operation, a
probe discovery can be forced by holding the SHIFT key while launching a debug session
from the Quickstart panel. If the new debug connection is completed, a new project launch
configuration will be created replacing any existing launch configurations. Alternatively and new
in MCUXpresso IDE version 10.2.0, are available to force the use of a
particular debug solution.

Tip

@ When exporting a project to share with others, launch configurations should usually
be deleted before export (along with other IDE generated folders such as build
configuration folders (Debug/Release if present)).

For further information please see the section

LinkServer Debug Connections

MCUXpresso IDE’s native debug connection (known as LinkServer) supports debug operation
through the following debug probes:

¢ LPC-Link2 with CMSIS-DAP firmware
¢ LPCXpresso V2/V3 Boards incorporating LPC-Link2 with CMSIS-DAP firmware
¢ CMSIS-DAP firmware installed onto on-board debug probe hardware (as shipped by default
on LPCXpresso MAX and CD boards)
« For more information on LPCXpresso boards see: http://www.nxp.com/lpcxpresso-boards
« Additional driver may be required:
 https://developer.mbed.org/handbook/Windows-serial-configuration
¢ CMSIS-DAP firmware installed onto on-board OpenSDA debug probe hardware (as shipped
by default on certain Kinetis FRDM and TWR boards)
« Known as DAP-Link and mBed CMSIS-DAP: http://www.nxp.com/opensda
» Additional driver may be required:
« https://developer.mbed.org/handbook/Windows-serial-configuration
e Other CMSIS-DAP probes such as Keil uLINK with CMSIS-DAP firmware: http:/
www?2.keil.com/mdk5/ulink
¢ Legacy RedProbe+ and LPC-Link
* RDB1768 development board built-in debug connector (RDB-Link)
* RDB4078 development board built-in debug connector

Note: MCUXpresso IDE will automatically try to softload the latest CMSIS-DAP firmware onto
LPC-Link2 or LPCXpresso V2/V3 boards. For this to occur, the DFU link on these boards must
be set correctly. Please refer to the boards documentation for details.

LinkServer Debug Operation

When the user first tries to debug a project, MCUXpresso IDE will perform a Debug Probe
Discovery operation and present the user with a list of debug probes found.

Note: To perform a debug operation within MCUXpresso IDE, select the project to debug within
the ‘Project Explorer’ view and then click Debug from the QuickStart View.

If more than one debug probe is presented, select the required probe. For LinkServer compatible
debug probes, you can select from Non-Stop (the default) or All-Stop IDE debug mode.
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Non-Stop uses GDB’s “non-stop mode” and allows data to be read from the target while an
application is running. Currently this mechanism is used to support the Live Variables feature
within the Global Variables view.

Connect to target: MK64FN1MOxxx12
1 probe found. Select the probe to use:

Available attached probes

Name Serial number/ID Type Manutaftur IDE Debug Mode
. LPC-LINK2 CMSIS-DAP V5.18{IQCOAXGV LinkServe NXP Sgmi Non-Stop

Supported Probes (tick/untick to enable/disable)

MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again
Remember my selection (for this Launch configuration)

¢)] Cancel OK

Ry

Figure 4.4. Debug Probe Discovery Non-Stop

Click ‘OK’ to start the debug session. At this point, the projects launch configuration files will be
created. LinkServer Launch configuration files will contain the string ‘LinkServer'.

Note: If “Remember my selection” is left ticked, then the probe details will be stored within the
launch configuration file, and this probe will be automatically selected on subsequent debug
operations for this project.

For a description of some common debugging operations using supported debug probes see

45 LinkServer Global and Live Global Variables

MCUXpresso IDE provides a new Global Variables view for displaying the values of global
variables. This replaces the use of the “Expressions” view for displaying such variables, as used
in LPCXpresso IDE (and KDS). This view defaults to be located within the QuickStart panel.

This view can be populated from a selection of a projects global variables. Simply click the “Add
global” button to launch a dialogue:
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Quickstar 9= Global Va 22 Variables Breakpo Outline = O
K t C

ue

G -

Variabl T * =3
ariable i Add global variables

Figure 4.5. LinkServer Add Global Variables

This will then display a list of the global variables available in the image being debugged. Select
the ones of interest via their checkboxes and click OK :

[ JoN ] Select symbols.
Name ~ Agoress Siza ]

_Ciob 0x2000007c 180

__end_of_heap 0x20000130 4

__heaps 0x20000134 4

__num_Ciob_streams 0x00006670 4

_Vectors 0x00000000 408

errno 0x20000138 4

Flash_Config 0x00000400 16

g_accel_address 0x00005974 4

g_MasterHandle 0x20000014 40

g_pfnvectors 0x00000000 408

g xAngle 0x2000003¢ 2

g_xDuty 0x20000040 2

g_xtalOFreg 0x20000044 4

g_xtal32Freq 0x20000048 4

g_yAngle 0x2000003e 2

g_yDuty 0x20000042 2

Select All Deselect All
®@ cancel | (TN

Figure 4.6. LinkServer Global Variable Selector

MCUXpresso IDE User Guide -

Note: to simplify the selection of a variable, this dialogue supports the option to filter (highlighted)
and sorts on each column.

Once selected, the chosen variables will be remembered for that occurrence of the dialogue.

For “All-Stop” debug connections, the Global Variables view will be updated whenever the target
is paused.

For “Non-Stop” debug connections, variables can be selected to be updated while the target is
running. These are known as " Live Variables".

For variables to be “Live™:

« the target must be running
« the enable/disable (run) button clicked (as shown highlighted below)

Once done, the display will update at the frequency selected (selectable from 500 ms to 10 s).
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) Quickstart Panel (4= Global Variables 52 |(x)= Variables ®s Breakpoints E= Outline

X & @ 1000 4B I hd
Value Address

Variable Type

v (#®array uint32_t [4] 0x20000018 <array> 0%20000018
09:=array[0] uint32_t 1 0x20000018
oo=array[1] uint32_t 85 0x2000001¢c
co=array[2] uint32_t 10 0x20000020
J-array(3) uint32_t 7 0%20000024

- g_xAngle volatile int16_t a5 0%20000120
¢9:g_yAngle volatile int16_t 1 0x20000122

5 Add new expression

Figure 4.7. LinkServer Global Variable Display

New in MCUXpresso IDE version 10.2.0 is the ability to enter an expression (using standard C
notation) or symbol. The expression will be evaluated and the address displayed in the Adresss
column.

Quickstart Panel (- Global Variables 53 Variables ®g Breakpoints 0= Outline = |m]
R & Q1000 I % B 3 =
variable Type value Address
» (=array uint32_t [4) 0x20000018 <array> 0x20000018

09=g_xAngle volatile int16_t 86 0x20000120
(-9 gle volatile int16_t 3 0x20000122
uint32_t 103 0x20000018

Figure 4.8. LinkServer Global Variable Display Expression

Live Variables like normal Globals can also be edited in place. Simply click on the variable value
and edit the contents. During the edit operation, the display will not update. This mechanism
provides a powerful way of interacting with a running target without impacting on any other aspect
of system performance.

Note: If you wish to have some global variables ‘Live’ and others not, then this can be achieved
by spawning a second Globals display via the ‘New View' button and populating this without
enabling the ‘run’ feature for that view.

The usefulness of Live Variables reduces as the number of Globals monitored increases, and
ultimately there will be a limit as to how many variables can be updated at the selected frequency.
However, complex list of variables can be monitored if required. For example:
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U Quickstart Pa ()= Global Variabl 83

poigts OF Outline = B

tB e~
Variable Type
©)=_random_j <data variable, no debug info> 25
©9=_random_k <data variable, no debug info> 2
_Bool frue
float 62.9931755
double -0.88162727834732613
void * 0x20000130 <bi_a>
volatile int 5
int 3
int 3
double [5] 0x20000108 <uni_a>
double 0.64644408768343009
double 0.52534067329267975
double 0
double 0
double -0.69493926395426475
¥ float [3][3] 0x20000130 <bi_a>
¥ (= bi_a[0] float [3] 0%20000130 <bi_a>
e9-bi_a[0][0] float 77.4734955
©9=bi_a[0][1] float 92.8300503
©4-bi_a[0][2] float 46.7962074
v (#bi_a[1] float [3] 0x2000013c <bi_a+12>
©4-bi_a[1][0] float 63.3472824
6a-bi_a[1][1] float 95.4246202
©9-bi_a[1)[2] float 30.6657524
> (= bi_a[2) float [3] 0x20000148 <bi_a+24>
> (=5 _example char [15] 0%20000154 <s_example>
v (&5 ex1 struct Struct_example {.}
» (#name char [5] 0x20000168 <s_ex1>
=5 | int 3

Figure 4.9. LinkServer Global Variable Display Complex

MCUXpresso IDE defaults to the selection of “Non-Stop” mode when a LinkServer probe
discovery operation is performed. This can be disabled from an MCUXpresso IDE Preference via:

Preferences -> Debug Options (Misc)

Debug Options (Miscellaneous) =1 .-
::‘fge‘a' com.crt.debugcommen v10.2.0.2018047112303
++
»Help Debugger executable arm-none-eabi-gdb
¥ Install/Update Debugger timeout 10
» Java
SWV Packet Timeout 4]

MCUXpresso Config Tools
¥MCUXpresso IDE

Extended debug trace (DEBUG_TRACE)

g S Jl
Debug Options (Miscellaneous)

Default Tool settings
General
J-Link Options
LinkServer Options
LPC-Link Options
LPC-Link2 SWO Trace
MCU settings
Paths and Directories
PEMlicro Options
Quickstart Panel
SDK Options
User Interface Enablement
Utilities

> Mylyn

» Run/Debug

» Team

» Terminal

Validation
XML

@

Figure 4.10. LinkServer Non Stop Preference

Stream all stub messages to Console
Show stub warnings as notes
Show debug log when written to
Display asynchronous error messages
Disable Auto-select device on multicore target
Always show JTAG selection dialog
Show progress messages in log
LM chouy
Enable Non-Stop Mode ]

ded debug

SWV Server Port o

Restore Defaults Apply

Apply and Close

Cancel

For a given project, the Non-Stop mode option is stored within the project’s launch configuration.
For projects that already have launch configurations, these will need to be deleted before

proceeding.
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LinkServer Live Global Variable Graphing

New in MCUXpresso IDE version 10.2.0 is the capturing of live variable values over time. This
data can be displayed as raw values (which can be exported) or plotted as graphs directly within
the IDE.

To select a plot type, right click within the Globals view and choose one of the options:

View Memory

Number Format >

Find... ®F

Show Details As >

Launch Configuraﬁo'l 1 Trace global variables
Smart update v 2 Plot global variables

Utilities 3 Number Formats Viewer

; ¥
@, Cast To Type...

=[] Display As Array...
Restore Original Type
%Y Watch

* Trace Global Variables will sample values of the selected variables at the variable update
frequency. These values can be viewed within the panel or exported as tsv data.

« Plot Global Variables will sample and plot values of the selected variables at the variable
update frequency. These graphs can be viewed within the panel or saved as png.

* Number Format Viewer will display the selected variable values in various bases

Variables can only be sampled if they have first been added to the Global Variable panel as
discussed in the previous section. The selection of variables to plot is simply made by clicking
to highlight the variable of interest.

Tip
@ multiple variables can be selected by normal host multiple selection scheme e.g.
ctrl/cmd click

Note: Once a variable has been selected, the timebase (uptime) will begin and variables values
will be sampled and displayed. If additional variables are selected, their values will join the
display at the current uptime. If a variable is unselected its values will no longer be sampled and
displayed. If however, it is selected again within the same debug session, it will be displayed
along with any previously captured values. During any period it was not selected its values will
show as zero.

Tip

@ if the display is paused, data will still be captured but the new values will not be
displayed, this can help detailed viewing of the data. Once un-paused, the captured
data will be added to the display.

Note: If the target is paused, time (x-axis) will continue to advance although the display will not
update until the target is resumed.

LinkServer Live Global Variable Graphing details

In the example below, two variables have been added to the Global variable view and both have
been selected.
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() Quickstart Panel (4= Global Variables £2 (%)= Variables g Breakpoints o= Outline = 0
X & Q1000 T BB e~
Variable Type Value Address
(9=yvar volatile int32_t -263 0x2000000¢
td=loop uint32_t 227 0x20000010
5 Add new expression O
Details E C
/' e by

Plot of "yvar* from project 'frdmk84f_led_blinky'

/v;tf'
/\\\/ \/Qy/\\/\ooT

DOOU{] 00200 00&00 01:00.0 01200 DTdDU 02000 0220{] DZ&C]O 03000

Uptime [mm:ss.5]

yvar

Plot of 'loop' from project “frdmk64f_led_blinky"

00:00.0 00:20.0 ©0:40.0 01:00.0 01:20.0 01:40.0 02:00.0 02:20.0 02:40.0 03:00.0
Uptime [mm:ss.5]

Figure 4.11. LinkServer Global Variable Graphing major features

The highlighted features are discussed below:

1.

Selected variables for graphing. Click to select, ctrl/cmd click to add additional variables. The
selected values will be remembered between debug sessions

¢ Once selected the variable will exist in the internal database of values and will remain until
the debug session is terminated (even if it is later unselected)

. Save: Click to save the display as a png. The size of the png will be proportional to the size of

the global view. Therefore, for more detail, increase the size of the global view before saving

« Other graphic formats are also supported. Note: in addition a tsv file containing the captured
data will also be saved

. Pause: Click to pause the graph display updated. Variables values will still be captured but

the screen will not update
¢ This may be useful if a portion of the display needs to be viewed in detail

. Multiple/Single Graphs: Click toggle the display between separate graphs for each variable

and all variables plotted on a single graph

. Show Data Statistics: Click to add display of min, max, average information for each plotted

variable.

. Clear all Data Statistics: Click to clear existing data from the Data Statistics values

7. Click onto the graph to view the actual variable value at that point

« it may help to pause the update to explore variable values

Below, is a view of two variables on a single graph with data statistics enabled.
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Details & 00
Plot of selected variables from project “frdmk6&4f_lad_blinky"
1 1 \ 0 I|
300 f-\ A {1 [
200 f---| - . {1
I

100+ R [/ It/ |

¥ axis
[=]
L

-100 41| -
-200 - b - | L1

3004 | b/ L4 \ t

= Variable min
yvar

loop 0.0

00:30.0 01:00.0 01:30.0 02:00.0
Uptime [mm:ss.S]

— yvar — kop

Figure 4.12. LinkServer Multiple Global Variable Graph

02:30.0 03:00.0

-360.0 359.0

max avg
368.0

360.0 1796

Within a graph view there are a range of features that can be explored. Right click within the

graph to display the menu as below:

Plot settings ('loop')

Details | = B
Plot of salected variables from project "frdmk64f_led_blinky"
f A I i [
L1 Mgk Al I | ,'
300+ /1| ,-"l AR A *l F A *. ."II| rlll ; / ' A ’
IV i -f“|-f -'“ ' 'H'l'f"
200 £ A/ IHE VY AEVATY |I ALY |' _' i || Y
l | ,f | { ) | Admst M|s Range > | | ;
: mray '
00 |.| | /| f ,.'II| Zoom In > f | i
N | - | VI i Zoom Qut > / AF'Q
. | | | | | Save As... | | |
I |
-1001 || T Properties... | ! ||
2004 [ | | X Axis unit 3 | [ | |
|| [ 1 Time Window » ]
| | | Reset I
-300 - VR | et
Y ! 'u' Plot settings (‘yvar') » v )

L

00000 01: 000 DZODO 03000 04000 05000 vowwwwerueewowwewed0.0  10:00.0

Uptime [mm:ss.5]

— yar — kg

Figure 4.13. LinkServer Multiple Global Variable Options

Most options are self explanatory, however the Time Window option is discussed below:

Time Window offers 3 options; Small, Medium (default) and Wide. This setting controls the
number of samples that can be captured and displayed - where Smallis 100, Medium is 1000, and
Wide is 10000. If these samples were expressed as an amount of time, 1000 samples captured
at a frequency of 1 sample per second (default) would ultimately display a window spanning
1000 seconds.
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Once the selected number of samples have been captured, the oldest samples will be discarded
as new samples are taken, and the display will scroll horizontally.

Also consider, due to the physical limitations of a monitor, 1000 samples will require roughly 1/2
the horizontal pixels available on a 1080p display to render without loss, so the Wide option will

only be of benefit if used in conjunction with zoom or a large screen.
Note: the Trace option will always capture up to 10000 samples per variable.

Finally, if you wish to explore the graph in more detail, you can simply drag within the display
to zoom into the view as below:

Details E(D =8
Plot of salected variables from project "frdmkE41_led_blinky'
[ |/ | |/ | \/
| | /
150/ f}f f ){ 1 7
| A | Ial ral
| /| | a |I g
| | / /o
| | /
..'/ | | ..n"f | II _.f |
100 - / | | | | / |
| / | / |
/ ‘I | / \I | _;"l |
w / | / / |
E / | ‘ | / | |! ff |
/ | | / | |
50 1 / | [/ | ;’f
/ |/ | / |
_f | / | / |
, | / I
. | / | ¥ |
] | | | | |
| | | |
| | |
| | | |

|
02:50.0 03:00.0 03:10.0 03:20.0 03:30.0 03400 03500 04000 04:10.0 04:20.0

Uptime [mm:ss.5]

—_— e = lap

Figure 4.14. LinkServer Multiple Global Variable Zoom

4.7

4.7.1

MCUXpresso IDE User Guide -

User Guide

It is recommended that the display is paused for detailed exploration of this sort.
LinkServer Troubleshooting

Debug Log

On occasion, it can be useful to explore the operations of a debug session in more detail. The
steps are logged into a console known as the Debug log. This log will be displayed when a Debug
operation begins, but by default, will be replaced by another view when execution starts. The

debug log is a standard log within the IDE’s Console view. To display this log, select the Console
and then click to view the various options (as below):

[Se b 50 CH| 3*
# 1 FreeRTOS Task Aware Debugger Console version 1.0.3 (201804111610)

2 frdmk64f_bubble LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application] gdb traces
&l 3 CDT Global Build Console

&l 4 CDT Build Console [frdmk64f_bubble]
5 RedlinkServear

+ B 6 frdmk64f_bubble Debug messages ]

7 frdmk64f_bubble LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application] frdmk64f_bubble.axf
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The debug log displays a large amount of information which can be useful in tracking down
issues.

In the example debug log below, you can see that an initial Connect Script file has been run.
Connect scripts are required for debugging certain parts and are automatically added to launch
configuration files by the IDE if required. Next, the hardware features of the MCU are captured
and displayed, this includes the number of breakpoints and watchpoints available along with
details of various hardware components indicating what debug features might be available, for
example Instruction Trace.

Further down in this log you will see the selection of a Flash driver (FTFE_4K), the identification of
the part being debugged (in this case a K64), and the speed of the Flash programming operation
(in this case 81.35 KB/sec).

Tip

@ a line similar to flash variant ‘K 64 FTFE Generic 4K’ detected (1MB = 256*4K at
0x0) will be displayed for LinkServer Flash programming operations. The size of the
detected flash (in this example itis 1MB) and sector size (4KB) will be displayed here.
The sector size may be important since multiples of this size represent valid base
addresses for flash programming operations. For example, if the programming of
more than one image is required, the second image must begin on a 4KB boundary
beyond the end of any previously programmed image.

MCUXpresso | DE RedlinkMilti Driver v10.2 (Apr 12 2018 00:28:54 - crt_emu_cmredlink build 482)
Reconnected to existing link server

Connecting to probe 1 core 0:0 (using server started externally) gave 'K

============= SCRI PT: ki neti sconnect.scp =============

Ki neti s Connect Scri pt

Dpl D = 2BA01477

Assert NRESET

Reset pin state: 00

Power up Debug

MDM AP API D:  0x001C0000

MDM AP Syst em Reset/ Hol d Reset/ Debug Request

MDM AP Control : 0x0000001C

MDM AP St atus (Fl ash Ready) : 0x00000032

Part is not secured

MDM AP Control : 0x00000014

Rel ease NRESET

Reset pin state: 01

MDM AP Control (Debug Request): 0x00000004

MDM- AP St at us: 0x0001003A

MDM AP Core Halted
============= END SCRI PT
Probe Firnware: LPC-LINK2 CVSI S-DAP V5. 183 (NXP Semi conduct or s)

Serial Nunber: | QCOAXGV

VID:PID: 1FC9: 0090

USB Pat h: USB_1f c9_0090_330000_f f 00

Using nenory fromcore 0:0 after searching for a good core

debug interface type = Cortex-M3/4 (DAP DP | D 2BA01477) over SWD TAP 0
Cortex- M4 (CPU | D 00000C24) on DAP AP 0

nunber of h/w breakpoints = 6

processor type

nunber of flash patches =2

nunber of h/w wat chpoints 4

Probe(0): Connected&Reset. Dpl D: 2BA01477. Cpul D 00000C24. |nfo: <None>
Debug protocol: SWD. RTCK: Disabl ed. Vector catch: Disabled.

Content of CoreSight Debug ROMs):
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RBASE EOOFF000: Cl D B105100D PI D 04000BB4C4 ROM dev (type 0x1)

ROM 1 EOOOEO000: CI D B105EQ00D PI D 04000BBOOC Chi pl P dev SCS (type 0x0)

ROM 1 E0001000: CI D B105EQ00D PI D 04003BB002 Chi pl P dev DWI (type 0x0)

ROM 1 E0002000: Cl D B105EQO0D PI D 04002BB003 Chi pl P dev FPB (type 0x0)

ROM 1 E0000000: CI D B105EQO0OD PI D 04003BB001 Chi pl P dev I TM (type 0x0)

ROM 1 E0040000: CI D B105900D PI D 04000BB9A1 CoreSi ght dev TPIU type 0x11 Trace Sink - TPIU
ROM 1 E0041000: Cl D B105900D PI D 04000BB925 CoreSi ght dev ETM type 0x13 Trace Source - core
ROM 1 E0042000: CI D B105900D PI D 04003BB907 CoreSi ght dev ETB type 0x21 Trace Sink - ETB
ROM 1 E0043000: CI D B105900D PI D 04001BB908 Cor eSi ght dev CSTF type 0x12 Trace Link - Trace /
funnel /router

Inspected v.2 On chip Kinetis Flash nenory nodul e FTFE_4K. cf x

I mage 'Kinetis Sem Generic Feb 17 2017 17:24:02'

Openi ng flash driver FTFE 4K cf x

Sendi ng VECTRESET to run flash driver

flash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0xO0)

Cl osing flash driver FTFE 4K cfx

NXP:  MK64FN1MDxxx12

Connected: was_reset=true. was_stopped=true

Awai ting telnet connection to port 3331 ...

GDB nonst op node enabl ed

Opening flash driver FTFE 4K cfx (already resident)

Sendi ng VECTRESET to run flash driver

Witing 26324 bytes to address 0x00000000 in Fl ash

Erased/ Wote page 0-6 with 26324 bytes in 316nsec

Cl osing flash driver FTFE 4K cfx

Fl ash Wite Done

Fl ash Program Sunmary: 26324 bytes in 0.32 seconds (81.35 KB/ sec)

Starting execution using systemreset and halt target

St opped: Breakpoint #1

4.7.2 Flash Programming

MCUXpresso IDE User Guide -

Most debug sessions begin with the programming of Flash, if this should fail then the debug
operation will be aborted.

Below is a brief discussion of the most common low level flash operations:

1.

Sector Erase: internally Flash devices are divided into a number of sectors (or blocks), where
a sector is the smallest size of Flash that can be erased in a single operation. A sector will be
larger than a page (see below). Sectors are usually the same size for the whole Flash device,
however this is not always the case. A sector base address will be aligned on a boundary that
is a multiple of its size. A sector erase is usually the first step in a programming sequence.

. Page Program: internally Flash devices are divided into a number of pages, where a page is

the smallest size that can be programmed in a single operation. A page will be smaller than a
sector. A page base addresses will be aligned on a boundary that is a multiple of its size.

. Mass Erase: a mass erase will reset all the bytes in Flash (usually to Oxff). Such an

operation may clear any internal low level structuring such as protection of Flash areas (from
programming).

The programming of an image (or data) comprises repeated operations of sector erase followed
by a set of program page operations; until the sector is fully programmed or there is no more
data to program.

One of the common problems when programming Kinetis parts relates to their use of Flash
configuration block at offset 0x400. For more information please see:

. Flash sector sizes on Kinetis MCUs range from 1KB to 8KB,

therefore the first Sector Erase performed may clear the value of this block to all OxFFs, if this is
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4.9
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not followed by a successful program operation and the part is reset, then it will likely report as
‘Secured’ and subsequent debugging will not be possible until the part is recovered.

Such an event can occur if a debug operation is accidently performed to the ‘wrong board’ and
a wrong Flash programmer is invoked.

Note: LinkServer mass erase operations will restore this Flash configuration block automatically
for Kinetis parts. However, if a Kinetis device is mass erased by sector, this mechanism will be
bypassed, therefore this operation should not be performed!

Should you need to recover a ‘locked’ part please see the section

LinkServer executables

LinkServer debug operations rely on 3 main debug executables.

e arm-none-eabi-gdb — this is a version of GDB built to target ARM based MCUs

e crt_emu_cm_redlink — this executable (known as the debug stub) communicates with GDB
and passes low level commands to the LinkServer executable (also known as Redlink server)

e redlinkserv — this is the LinkServer executable and takes stub operations and communicates
directly with the ARM Cortex debug hardware via the debug probe.

If a debug operation fails, or a crash occurs, it is possible that one or more of these processes
will fail to shut down. Therefore, if the IDE has no active debug connection but is experiencing
problems making a new debug connection, ensure that none of these executables is running.

New in MCUXpresso IDE version 10.2.0 is an IDE button " to kill all low level debug executables.

P&E Debug Connections

P&E Micro software and drivers are automatically installed when MCUXpresso IDE installs. There
is no need to perform any additional setup to use P&E Micro debug connections.

Currently we have tested using:

e Multilink Universal (FX)

¢ Cyclone Universal (FX) (USB and Ethernet)

« P&E firmware installed into on-board OpenSDA debug probe hardware (as shipped by default
on certain Kinetis FRDM and TWR boards)

Note: Some Kinetis boards ship with OpenSDA supporting P&E VCOM but with no debug
support. To update this firmware visit the OpenSDA Firmware Update pages linked at: Help ->
Additional Resources -> OpenSDA Firmware Updates

P&E Debug Operation

The process to debug via a P&E compatible debug probe is exactly the same as for a native
LinkServer (CMSIS-DAP) compatible debug probe. Simply select the project via the ‘Project
Explorer’ view then click Debug from the QuickStart panel and select the P&E debug probe from
the Probe Discovery Dialogue.

If more than one debug probe is presented, select the required probe and then click ‘OK’ to start
the debug session. At this point, the projects launch configuration files will be created. Note: P&E
Launch configuration files will contain the string ‘PE’.

MCUXpresso IDE stores the probe information, along with its serial number in the projects launch
configuration. This mechanism is used to match any attached probe when an existing launcher
configuration already exits.
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To simplify debug operations, MCUXpresso IDE will automatically start P&E’s GDB Server and
select and dynamically assign the various ports needed as required. This means that multiple
P&E debug connections can be started, terminated, restarted etc. all without the need for any
user connection configuration. These options can be controlled if required by editing the P&E
launch configuration file.

For more information see

Note: If the project already had a P&E launch configuration, this will be selected and used. If
they are no longer appropriate for the intended connection, simply delete the files and allow new
launch configuration files to be created.

Important Note: Low level debug operations via P&E debug probes are supported by P&E
software. This includes, Part Support handling, Flash Programming, and many other features.
If problems are encountered, P&E Micro maintain a range of support forums at http:/
www.pemicro.com/forums/

4.9.1 P&E Differences from LinkServer Debug
MCUXpresso IDE core technology is intended to provide a seamless environment for code
development and debug.
When used with P&E debug probes, the debug environment is provided by the P&E debug server.
This debug server does not 100% match the features provided by native LinkServer connections.
However basic debug operations will be very similar to LinkServer debug.
For a description of some common debugging operations using supported debug probes see
Note: LinkServer advanced features such as SWO Trace, Power Measurement, Live Global
Variables etc. will not be available via a P&E debug connection.
4.9.2 P&E Micro Software Updates
P&E Micro support within MCUXpresso IDE is via an Eclipse Plugin. The P&E update site is
automatically added to the list of Available Software Update sites.
To check whether an update is available, please select:
Help -> Check for Updates
Any available updates from P&E will then be listed for selection and installation.
Note: P&E Micro may provide news and additional information on their website, for details see
https://www.pemicro.com
4.10 SEGGER Debug Connections
SEGGER J-Link software and documentation pack is installed automatically with the
MCUXpresso IDE Installation for each host platform. No user setup is required to use the
SEGGER debug solution within MCUXpresso IDE.
Currently we have tested using:
¢ J-Link debug probes (USB and Ethernet)
¢ J-Link firmware installed into on-board OpenSDA debug probe hardware (as shipped by default
on certain Kinetis FRDM and TWR boards)
¢ J-Link firmware installed onto LPC-Link2 debug hardware and LPCXpresso V2/V3 boards
« for details see https://www.segger.com/Ipc-link-2.html
* also for firmware programming see http://www.nxp.com/LPCSCRYPT
MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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4.10.1

SEGGER software installation

Unlike other debug solutions supplied with MCUXpresso IDE, the SEGGER software installation
is not integrated into the IDE installation, rather it is a separate SEGGER J-Link installation on
your host.

The installation location will be similar to:

On Wndows: C:./Program Files (x86)/SEGGER JLi nk_V630
On Mac: /Applications/ SEGGER/ JLi nk_V630
On Linux: /opt/SEGGER/ JLi nk

MCUXpressolDE automatically locates the required executable and it is remembered as a
Workspace preference. This can be viewed or edited within the MCUXpresso IDE preferences
as below.

Figure 4.15. Segger Preferences

e Preferences
J-Link Options =p . v

> General

BCiC++

*Help J-Link Server executable [Applications/SEGGER/JLink V630k/JLinkGDBServerCLExe Browse...

¥ Install/Update

» Java Enable discovering of SEGGER J-Link IP probes

MCUXpresso Config T Enable SEGGER J-Link user actions

¥MCUXpresso IDE
Debug Options (Ad'
Debug Optians (Mic J-Link Server SWO: initial auto discover port | 2332
Debug Probe Disco
Default Tool setting

SEGGER J-Link probe preferences

J-Link Server: initial auto discover port 2331

J-Link Server Telnet: initial auto discover port 2333

General J-Link port auto discover retries attempts 100
Enable Instruction Trace service

LinkServer Options

LPC-Link Options

LPC-LinkZ SWO Trz

MCU settings

Paths and Directori:
PEMicro Options
Quickstart Panel
SDK Options

User Interface Enat
Utilities

Restore Defaults Apply

Q) Cancel

MCUXpresso IDE User Guide -

Note: this preference also provides the option to enable scanning for SEGGER IP probes (when
a probe discovery operation is performed). By default, this option is disabled.

From time to time, SEGGER may release later versions of their software, which the user could
choose to manually install. For details see https://www.segger.com/downloads/jlink

MCUXpresso IDE will continue to use the SEGGER installation path as referenced in a projects
workspace unless the required executable cannot be found (for example, the referenced
installation has been deleted). If this occurs:

1. The IDE will automatically search for the latest installation it can find. If this is successful, the
Workspace preference will automatically be updated

2. If a SEGGER installation cannot be found, the user will be prompted to located an installation

To force a particular workspace to update to use a newer installation location simply click the
Restore Default button.

To permanently select a particular SEGGER installation version, the location of the SEGGER
GDB Server can be stored in an environment variable.

For example, under Windows you could set:
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MCUX_SEGGER_SERVER="C: / Program Fi | es (x86)/ SEGGER/ JLi nk_V630k/ j Li nkGDBSer ver CL. exe"

This location will then be used, overriding any workspace preference that maybe set.
SEGGER software un-installation

If MCUXpresso IDE is uninstalled, it will not remove the SEGGER J-Link installation. If this is
required, then the user must manually uninstall the SEGGER J-Link tools.

Note: If for any reason MCUXpresso IDE cannot locate the SEGGER J-Link software, then the
IDE will prompt the user to either manually locate an installation or disable the further use of the
SEGGER debug solution.

SEGGER Debug Operation

The process to debug via a J-Link compatible debug probe is exactly the same as for a native
LinkServer (CMSIS-DAP) compatible debug probe. Simply select the project via the ‘Project
Explorer’ view then click Debug from the QuickStart Panel and select the SEGGER Probe from
the Probe Discovery Dialogue.

If more than one debug probe is presented, select the required probe and then click ‘OK’ to start
the debug session. At this point, the projects launch configuration files will be created. Note:
SEGGER Launch configuration files will contain the string ‘JLink’.

To simplify debug operations, MCUXpresso IDE will automatically start SEGGER’s GDB Server
and select and dynamically assign the various ports needed as required. This means that multiple
SEGGER debug connections can be started, terminated, restarted etc. all without the need for
any user connection configuration. These options can be controlled if required by editing the
SEGGER launch configuration file.

In MCUXpresso IDE, SEGGER Debug operations default to using the SWD Target Interface.
When debugging certain multicore parts such as the LPC43xx Series, the JTAG Target Interface
must be used to access the internal Slave MCUs. To select JTAG as the Target Interface, simply
edit the SEGGER launch configuration file and select JTAG.

For more information see

Note: If the project already had a SEGGER launch configuration, this will be selected and used.
If an existing launch configuration file is no longer appropriate for the intended connection, simply
delete the files and allow new launch configuration files to be created.

Important Note: Low level debug operations via SEGGER debug probes are supported by
SEGGER software. This includes, Part Support handling, Flash Programming, and many other
features. If problems are encountered, SEGGER'’s provide a range of support forums at http://
forum.segger.com/

SEGGER Differences from LinkServer Debug

MCUXpresso IDE core technology is intended to provide a seamless environment for code
development and debug. When used with SEGGER debug probes, the debug environment is
provided by the SEGGER debug server. This debug server does not 100% match the features
provided by native LinkServer connections. However basic debug operations will be very similar
to LinkServer debug.

For a description of some common debugging operations using supported debug probes see

Note: LinkServer features such as SWO Trace, Power Measurement, Live Global Variables etc.
will not be available via a SEGGER debug connection. However, additional functionality maybe
available using external SEGGER supplied applications.
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4.12 SEGGER Troubleshooting

When a debug operation to a SEGGER debug probe is performed, the SEGGER GDB server
is called with a set of arguments provided by the launch configuration file. The command and
resulting output is logged within the IDE SEGGER Debug Console. The console can be viewed
as below:

B blE AN ™3
# 1 FreeRTOS Task Aware Debugger Console version 1.0.3 (201804111610)
El 2 CDT Global Build Console
& 3 CDT Build Console [frdmk&4f_bubble]

4 RedlinkServer
5 frdmk64f bubble JLink Debug [GDB SEGGER Interface Debugging] gdb traces

Figure 4.16. Segger Server

The command can be copied and called independently of the IDE to start a debug session and
explore connection issues.

Below is the shortened output of a successful debug session to a Kinetis K64 Board.

[18-4-2018 02:22:11] Executing Server: /Applications/ SEGGER/ JLi nk_V630k/ JLi nkGDBSer ver CLExe /
-nosilent -swoport 2332 -sel ect USB=600102843 -telnetport 2333 -singlerun -endian little /
-noir -speed auto -port 2331 -vd -device MK64FNLMDxxx12 -if SWD -halt -reportuseraction

SEGCER J-Link GDB Server V6.30k Command Line Version
JLi nkARM dI | V6. 30k (DLL conpiled Apr 9 2018 18: 32:22)
Command |ine: -nosilent -swoport 2332 -sel ect USB=600102843 -tel netport 2333 -singlerun /

-endian little -noir -speed auto -port 2331 -vd -device MK64FNIMDxxx12 -if SWD -halt /
-reportuseraction

GDBInit file: none
GDB Server Listening port: 2331
SWO raw out put |istening port: 2332
Terminal 1/0 port: 2333
Accept renpte connection: yes
Generate logfile: of f
Verify downl oad: on
Init regs on start: of
Si | ent node: of
Singl e run node: on
Target connection timeout: 0 ns
------ J-Link related settings------
J-Link Host interface: UsB
J-Link script: none
J-Link settings file: none
------ Target related settings------
Tar get devi ce: MK64FNLIMDxxx12
Target interface: SWD
MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. Al rights reserved.

User Guide Rev. 10.2.0 — 14 May, 2018 33



NXP Semiconductors

MCUXpresso IDE User Guide

MCUXpresso IDE User Guide -

Target interface speed: aut o
Tar get endi an: little

Connecting to J-Link...

J-Link is connected.

Devi ce " MK64FNLMDXXX12" sel ect ed.

Fi rmware: J-Link V10 conpiled Mar 29 2018 17:45: 34

Har dwar e: V10. 10

S/'N: 600102843

Feature(s): RD, FlashBP, FlashDL, JFl ash, GDB

Checki ng target voltage...

Target voltage: 3.29 V

Li stening on TCP/IP port 2331

Connecting to target...lnitTarget()

Found SWDP with | D 0x2BA01477

Scanning AP map to find all avail abl e APs

AP[ 2]: Stopped AP scan as end of AP nmap has been reached
AP[ 0] : AHB-AP (I DR 0x24770011)

AP[1]: JTAG AP (I DR 0x001C0000)

Iterating through AP map to find AHB-AP to use

AP[0]: Core found

AP[ 0] : AHB- AP ROM base: OxEOOFF000

CPUI D regi ster: 0x410FC241. |nplenenter code: 0x41 (ARM
Found Cortex-M4 rOpl, Little endian.

FPUnit: 6 code (BP) slots and 2 literal slots

Cor eSi ght conponent s:

ROMTbI [ 0] @ EOOFF000

ROMTbI [0] [ 0] : EOOOE000, CI D: B10O5E00D, PID: 000BBOOC SCS- M7
ROMTbI [0] [ 1] : E0001000, CI D: B105E00D, PID: 003BB002 DWI
ROMTbI [0] [ 2] : E0002000, CI D: B10O5E00D, PID: 002BB003 FPB
ROMTbI [0] [ 3] : E0000000, CID: B1O5E00D, PID: 003BB001 | TM
ROMTbI [ 0] [ 4] : E0040000, CI D: B105900D, PID: 000BB9A1 TPI U
ROMTbI [0] [ 5] : E0041000, CI D: B105900D, PID: 000BB925 ETM
ROMTbI [0] [ 6] : E0042000, CI D: B105900D, PID: 003BB907 ETB
ROMTbI [0] [ 7] : E0043000, CI D: B105900D, PID: 001BB908 CSTF
I ni t Tar get ()

Found SWDP with | D 0x2BA01477

AP map detection skipped. Manually configured AP map found.
AP[ 0] : AHB-AP (IDR Not set)

Connected to target

Waiting for GDB connection...Connected to 127.0.0.1

Readi ng all registers

Read 4 bytes @ address 0x0000582C (Data = 0xB004BEAB)

Read 2 bytes @ address 0x0000582C (Data = OxBEAB)

Readi ng 64 bytes @ address 0x00005800

Recei ved nonitor conmmand: reset

Reset: Halt core after reset via DEMCR VC_CORERESET.

Reset: Reset device via Al RCR SYSRESETREQ

Af t er Reset Tar get ()

Resetting target

Downl oadi ng 16032 bytes @ address 0x00000000 - Verified OK
Downl oadi ng 10280 bytes @ address Ox00003EA0 - Verified OK
Downl oadi ng 12 bytes @ address 0x000066C8 - Verified OK
J-Link: Flash downl oad: Bank O @ 0x00000000: Ski pped. Contents already match
Witing register (PC = 0x00000204)

Readi ng all registers
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Read 4 bytes @ address 0x00000204 (Data = 0xB672B510)
Readi ng 64 bytes @ address 0x00000C40

Read 2 bytes @ address 0x00000C62 (Data = 0xF107)
Recei ved nonitor command: sem hosting enabl e

Sem - hosting enabl ed (Handl e on BKPT)

Recei ved nonitor command: exec SetRestartOnd ose=1
Execut ed Set Restart OnCl ose=1

Setting breakpoint @address 0x00000C62, Size = 2, BPHandl e = 0x0001
Starting target CPU...

... Breakpoi nt reached @ address 0x00000C62

Readi ng all registers

Renovi ng breakpoi nt @ address 0x00000C62, Size = 2
Read 4 bytes @ address 0x00000C62 (Data = 0x0320F107)

Note: If a SEGGER debug operation is not successful, the IDE will generate an error dialogue,
the 'Details' button can be clicked to display a copy of the SEGGER server log. One possible
reason for a SEGGER debug operation to fail is due to a Device name mismatch. MCUXpresso
IDE will try to supply the expected Device name to SEGGER server, however on rare occasions
this may not be the name expected. The SEGGER launch configuration Device entry can be
populated via a drop down list or via a user supplied device name.

If required, additional server options can be set within the SEGGER launch configuration. For
example to capture logging information to a file, you can set the additional server option:

-log $(CWD)/ ny. | og

where $(CWD) represents the current working directory of the debug connection, i.e. the
dynamically created project build configuration folder.
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5. SDKs and Preinstalled Part Support Overview

To support a particular MCU (or family of MCUs) and any associated development boards, a
number of elements are required. These break down into:
e Startup code

« This code will handle specific features required by the MCU
¢ Memory Map knowledge

e The addresses and sizes and types of all memory regions
« Peripheral knowledge

» Detailed information allowing the MCUs peripherals registers to be viewed and edited
¢ Flash Drivers

« Routines to program the MCU'’s on and off chip Flash devices as efficiently as possible
« Debug capabilities

« Knowledge of the MCU debug interfaces and features (e.g. SWO, ETB)

« Example Code (this is not strictly required or a part support element)

» Code to demonstrate the features of the particular MCU and supporting drivers
Collectively, this data is known as Part Support, MCUXpresso IDE uses these data elements for
populating its wizards, and for built in intelligence features, such as the automatic generation of
linker scripts etc.

MCUXpresso IDE delivers its part support through an extensible scheme.

5.1 Preinstalled Part Support
Firstly the IDE installs with an enhanced version of the part support as provided with LPCXpresso
IDE v8.2.2. This provides support for the majority of LPC Cortex-M based parts ‘out of the box'.
This is known as preinstalled part support.
Example code for these preinstalled parts is provided by sophisticated LPCOpen packages (and
Code Bundles). Each of these contains code libraries to support the MCU features, LPCXpresso
boards (and some other popular ones), plus a large number of code examples and drivers.
Version of these are installed by default at:
<install dir>/idel/ Exanpl es/ LPCOpen
<install dir>/idel/ Exanpl es/ CodeBundl es
Further information can be found at:
http://www.nxp.com/Ipcopen
https://www.nxp.com/LPC800-Code-Bundles
5.2 SDK Part Support
Secondly, MCUXpresso IDE’s part support can be extended using freely available MCUXpresso
SDK v2.x packages. These can be installed via a simple ‘drag and drop’ mechanism which will
then automatically enhance the IDE with new part and board knowledge (and usually a large
range of examples).
SDKs for MCUXpresso IDE can be generated and downloaded as required using the SDK Builder
on the MCUXpresso Tools website at:
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http://mcuxpresso.nxp.com/

Support for Kinetis devices is delivered by SDK 2.x packages, In addition, this mechanism is also
used to offer support for newer LPC MCUs from NXP such as the LPC54xxx series.

Once an SDK has been installed, the included part support becomes available through the
New Project Wizard and also the SDK example import Wizard, and for use by

Important Note: Only SDKs built specifically for MCUXpresso IDE are compatible with
MCUXpresso IDE. SDKs created for any other toolchain will not work! Therefore, when
generating an SDK be sure that MCUXpresso IDE is specified as the Toolchain.

Differences in Preinstalled and SDK Part Handling

Since SDKs combine part (MCU) and board support into a single package, MCUXpresso IDE
is able to provide linkage between SDK installed MCUs and their related boards when creating
or importing projects.

For preinstalled parts, the board support libraries are provided within LPCOpen packages and
Code Bundles. It is the responsibility of the user to match an MCU with its related LPCOpen
board and chip library when creating or importing projects.

Creating and importing project using Preinstalled and SDK part support is described in the
following chapters.

Note: When exporting or sharing projects with Preinstalled part support, no special actions are

required, since other installations of MCUXpresso IDE will provide the required part support. For
sharing projects created from SDKs, please see

Viewing Preinstalled Part Support

When MCUXpresso IDE is installed, it will contain preinstalled part support for most LPC based
MCUs.

To explore the range of preinstalled MCUs simply click ‘New project’ in the QuickStart panel.
This will open a page similar to the image below:
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e SDK Wizard

\ Y= P
| €3 Please select a target device or a board ‘ k &'

|
‘ . Board and/or Device selection page

~ EDKMCUs Available boards 818 | 4

MCUs from installed SDKs Please select an available board for your project.

Target

PNEV7462B LPCXpresso812-MAX LPCXpressoB12 LPC8NO4 Development Board

~ Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support
Target
»LPC1102
»LPC112x
FLPCT1AXX
»LPC11E6x
PLPC11Exx
FLPC11U6x LPCXpresso845-MAX LPCXpresso824-MAX LPCXpresso802
»LPC11Uxx
LPC11xx

\'“’C”“L" j P TN

Selected Device: SDKs for selected MCU

Name SDK Version  Manifest Versior Location

Target Core:
Description:

Cancel

Figure 5.1. New Project Wizard

The list of preinstalled parts is presented on the bottom left of this window.

You will also see a range of related development boards indicating whether a matching LPCOpen
Library or Code Bundle is available.

For creating project with preinstalled part support please see:
If you intend to work on an MCU that is not available from the range of preinstalled parts, for

example a Kinetis MCU, then you must first extend the part support of MCUXpresso IDE by
installing the appropriate MCU SDK.

5.4 Installing an SDK

The process to follow is simple, first download the SDK package, then install this into
MCUXpresso IDE.

The easiest way to do this is to switch to the “Installed SDKs” view within the MCUXpresso IDE
console view (highlighted below).
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LK ] workspace - hitp:/fmcuxpresso.nxp.com - MCUXpresso IDE
3 - &y @B w e FRUFH O Q&S 5 » Gl Pr D B Af®E ¢
LP 8 t ™ = 0 @ welcome | MCUXpresso SDK Builder &
= -
wr
A
| MCUX SDK Build
1 -
L SD ource drivers, midd
| d BC pment. Ci 78 and dow
|
| B8 Select Development Board ‘ ‘ # Access My SDK Dashboard
[0)-] v " = [=]

- MCUXpresso IDE - Gt
= No project selected OVERVIEW SOFTWARE AND TOOLS DEVELOPER RESOURCES

~ Create or import a project

B new project...

"7 Bl SDK example(s).
) -m—t ::::cclls: :)-‘oﬂ- Getting started with MCUXpresso SDK is simple.

- Build your project

Ea Do you have a development board?

Start by clicking on Select Development Board to download a customized SDK for that specific platform.
~ Debug your project

Are you returning and seeking previously downloaded SDKs?

~ Miscellaneous

Terms of Use | Contact © 2018 NXP Semicc

ors. All ights reserved.

) Quick Settings>> )l Installed SOKs &2

@ -
s Bulld all projects [1 W Instalied 50Ks

To install an SDK, simply drag and drop an SDK (2ip fileffolder) inta the ‘Installed SDKs' view.

Figure 5.2. SDK Import

SDKs are free to download (login is required); MCUXpresso IDE offers a link to the SDK portal
from the Installed SDK Console view (as indicated above). If required, the necessary SDK can
be downloaded onto the host machine.

To install an SDK, simply open a Windows Explorer / filer onto the directory containing the SDK
package(s), then select the ZIP file(s) and drag them into the “Installed SDKs” view.

You will then be prompted with a dialog asking you to confirm the import — click OK. The SDK or
SDKs will then be automatically installed into MCUXpresso IDE part support repository.

Once complete the “Installed SDKs” view will update to show you the package(s) that you have
just installed.
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O Installed SDKs

(7 Installed SDKs 82 [T Properties [2/ Problems (] Memory () Debugger Console € Instruction Trace D Power Measurement Teol . SWO Trace Config ¥ Terminal B Console

To install an SDK, simply drag and drop an SDK (zip file/folder) into the ‘Installed SDKs' view.

Name SOK Versien Manifest Version Location SOK Details
=¥ SDK_2.x_EVKB-IMXRT1050 [® <Default Location>/SDK_2.x-EVKB-IMXRT1050_max.zip
1 SDK_2.x_FROM-KBAF 2.4.0 3.3.0 ) /SDK_2.x FROM-KBAFmax,zip Selected SDK content.
# SDK_2.x_LPCXpresso54018 240 3.3.0 G, {SDK_2.x_LPCXpresso54018_max.zip
# SDK_2.x_LPCXpresso54608 2.40 3.3.0 i) /SDK_2.x_LPCXpresso54808_max.zip » i Boards
» {3 Devices

Figure 5.3. SDK Import View

» 51y Compilers

» i Toolchains

» (# Toolchain Settings
» i Components

5.4.1
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Notes:

e Released in parallel with MCUXpresso IDE version 10.2.0 are updated SDKs
(MCUXpressoSDK v2.4.0). These are indicated by their version 2.4.0 and a manifest version
3.3.0 in the Installed SDK view. While older SDKs are still compatible with MCUXpresso IDE
version 10.2.0, it is recommended that users check they are using the latest available SDK
package.

* MCUXpresso IDE can import an SDK as a zipped package or unzipped folder. Typically
importing as a zipped package is expected.

+ The main consequence of leaving SDKs zipped is that you will not be able to create (or
import projects) into a workspace with linked references back to the SDK source files.

* When an SDK is imported via drag and drop, required files are copied and the original file/folder
is unaffected. The copied files are installed into a default location allowing imported SDKs to be
shared among different IDE instances/installations and workspaces. Data from imported SDKs
is populate wizards with available MCU and board information. In addition they are parsed to
generate part support and make example projects and drivers available etc.

« By default, SDKs (like workspaces) are located in user local storage, this means they will
only be available to the user who performed the installation. The next section shows how a
public location could be used if needed.

Installed SDKs Operations
Many operations are available from the Installed SDK view some from a right click menu options:
> Import archive...

<~ Import folder...
(= Open Default Location

| Gl spk Documentation > |
| i SDKInfo >
> Open Location
J{E Unzip archive
X Delete SDK

2, Recreate

From here you can perform many actions such as view associated embedded SDK
documentation that would otherwise require the unzipping and exploration of the SDK structure.

The Installed SDKs display will show whether the SDKs are stored as zipped archives or regular

folders. MCUXpresso IDE offers the option to unzip an archive in place via a right click option
onto the selected SDK (as below).
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> Import archive...
¢ Import folder...
= Open Default Location

{0 SDK Documentation 2
i SDK Info [
c> Open Location

ll € Unzip archive |

XK Delete SDK

24 Recreate

Note: Unzipping an SDK may take some time and is generally not needed unless you wish to
make use of referenced files or perform many example imports (where some speed improvement
will be seen).

Once an SDK has been unzipped, its icon will be updated to reflect that it is now stored internally
as a folder.

9 Installed SDKs 52 [Z] Properties [£) Problems () Memory &} Debugger Console @ Instruction Trace 3 Power Measurement Taol [5] SWO Trace Config 9 Terminal & ¢
@ Installed SDKs

Toinstall an SDK, simply drag and drop an SDK (zip fileffolder) into the 'Installed SDKs' view.
Name SDK Version Manifest Version Location

v 1 SDK_2.x_EVKB-IMXRT1050 240 3.3.0 - /SDK_2.x-EVKB-IMXRT1050_max.zip

v 1 SDK_2.x_FRDM-KB4F 240 3.3.0 /SDK_2.x_FRDM-K84F_max

v i SDK_2.x LPCXpresso54018 240 330 - ISDK_2.x_LPCXpresso54018_max.zip
11 SDK_2.x_LPCXpresso54608 240 330 ) /SDK_2.x_LPCXpresso54608_max.zip

Figure 5.4. SDK Unzipped
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Many other options are available such as examining SDK XML description files, and managing
the library of installed SDKs.

Deleting an Installed SDK

If an SDK has been installed by the ‘Drag and Drop’ method, then a copy of the SDK will have
been installed into the Default Location. SDKs installed into this location can be deleted via a right
click option. Once an SDK has been deleted, then part support will automatically be recreated
for the remaining SDKs. Please see for more information.

Along side each installed SDK is a check box, if this is unchecked the SDK will be hidden
from MCUXpresso IDE until re-checked. If multiple SDKs are installed that contain shared part
support, then this feature may be useful to force the selection of part support from a particular
SDK. Please see for more information.

SDKs installed into non default locations, must be manually deleted or hidden if they are no

longer required. Note: you may have to quit MCUXpresso IDE to delete these SDKs. Please see
for more information.

Installed SDKs Features

You can explore each of the SDKs within the “Installed SDKs” view to examine its contents as
below:
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01 Installed SDKs

Name

@ Installed SDKs 2 [7] Properties [ Problems () Memory B3 Debugger Console & Instruction Trace B0 Power Measurement Tool [ SWO Trace Config

To install an SDK, simply drag and drop an SDK (zip fileffolder) into the 'Installed SDKs' view.

SDK Version Manifest Version Location SDK Details

[ 12 SDK_2.x_EVKB-IMXRT1050 [6 <Default Location>/SDK_2.x-EVKB-IMXRT 1050_max.zip

5 SDK_2.x_FROM-KB4F 240 330 @ /SDK_2.x_FRDM-K64F_max

# SDK_2.x_LPCXpresso54018 240 330 & /SDK_2.x_LPCXpresso54018_max.zip -+ WiBoords

£ S0K_2.x_LPCXpresso54608 240 330 [} /SDK_2.x_LPCXpresso54608_max.zip A T Qe
» 35 Debug Configurations
¥ =5 Examples

Figure 5.5. SDK Explore

G

4 Terminal & Console

» S aws_examples
» E cmsis_driver_examples

» 5 fatfs_examples
» £ littlefs_examples

5.4.3 Advanced Use: SDK Importing and Configuration

Although using the “Installed SDKs” view offers the easiest way of importing SDKs, MCUXpresso
IDE also provides additional capabilities for importing and configuring its SDK usage.

If you go to Preferences->MCUXpresso IDE->SDK Options then the following window will appear:
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»General

»CjC++

»Help

»Install/Update

»Java

MCUXpresso Config Too

vMCUXpresso IDE
Debug Options (Advar
Debug Options (Misce
Debug Probe Discove
Default Tool settings
General
J-Link Options
LinkServer Options
LPC-Link Options
LPC-Link2 SWO Trace
MCU settings
Paths and Directories
PEMicro Options
Quickstart Panel
SDK Options
User Interface Enablel
Utilities

| »Mylyn

»Run/Debug

»Team

» Terminal

Validation
» XML

Preferences

SDK Options Prorw

Manage SDK usage within MCUXpresso IDE
SDK refresh pelicy on startup

Refresh and recreate part info

SDK search roots:

/Users/NXP/mcuxpresso/SDKPackages New...
I Users/NXP/mcuxpresso/01/SDKPackages I

SDK Component Management
Hide middleware components in the SDK New Project Wizard for older SDKs
Skip addjremove components confirmation in future
Do not ask for component source code import policy
Component source code import policy Compare H

Do not ask for component source code delete policy

Component source code delete policy Compare

Other options
Always unzip SDK zipped files when installing
Do not ask for unzipping SDK on import
Do not ask for confirmation on SDK Drag and Drop install
Make missing SDK reference persistent
Do mot ask user action for missing SDK reference in project
Skip SDK flash driver and use internal flash driver
Default SDK debbug console to semihost on project creationfimport
Include semihost hardfault handler by default on project creationfimport
Enable SDK options check
Selected files from SDK View open in read-only mode

Enable SDK/manifest versions switch (needs an IDE restart)

Restore Defaults Apply

Cancel Apply and Close

Figure 5.6. SDK Preferences

Note: from here you can see there are actually two default locations specified but the highlighted
location will be used for new installations, see
for more information.

From here you can add paths to other folders where you have stored or plan to store SDK
folders/zips. Those SDKs will appear in the Installed SDKs View along with those from the default

location.

The main differences between having SDKs in the default location or leaving them in other folders

are:

« “Delete SDK” function is disabled when using non-default locations

» since these SDKs are not imported, they may be original files
* The knowledge of the SDKs and their part support is per-workspace
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The order of the SDKs in the SDK location list may be important on occasion: if you have multiple
SDKs for the same part in various locations, you can choose which to load by reordering. If
multiple SDK are found, a warning is displayed into the Installed SDK view.

Note: Only the default SDK location(s) is persistent between workspaces. Any other locations
must be created for each Workspace as required.

Other SDK Options

Also from the previous dialogue, are two distinct sets of options; the first to control the handling
of adding (and removing) SDK components. Please see the section

for more information. The second set of ‘other options’ are a self describing
set of features.

Important notes for SDK Users
Only SDKs created for MCUXpresso IDE can be used

If an error of the form MCUXpresso IDE was unable to load one or more SDKs is seen, the most
likely reason is that the SDK was not built for MCUXpresso IDE. Within the SDK Builder, verify
that the Toolchain is set to MCUXpresso IDE. If necessary, reset the toolchain to MCUXpresso
IDE and rebuild the SDK.

SDK compatibility with earlier versions of MCUXpresso IDE

As mentioned earlier, a new SDK version 2.4.0 has been released in parallel with MCUXpresso
IDE version 10.2.0 however, this SDK format includes features that are not compatible with earlier
versions of MCUXpresso IDE. As a result, these new SDKs will fail to install or offer reduced
featured when used in older versions of MCUXpresso IDE.

To support users who might have both this and also older versions of MCUXpresso IDE installed
on their system, we have adopted a new default SDK installation location but also maintained
support for the default used by older versions (now effectively Read Only from version 10.1.0
onwards).

The result of this is that MCUXpresso IDE version 10.1.0 and later will automatically inherit any
SDKs installed into the (old) default location by previous versions of the IDE. While older versions
of the IDE will not ‘see’ any SDKs installed with MCUXpresso IDE version 10.1.0 or later.

Note: If there is no need to maintain compatibility with older versions of the IDE, it is
recommended that users migrate to using the latest SDKs where available.

Shared Part Support Handling

Each SDK package will contain part support for one or more MCUSs, therefore it is possible
to have two (or more) SDK packages containing the same part support. For example, a user
might request a Tower K64 SDK and later a Freedom K64 SDK that both target the same
MK64FN1MOxxx12 MCU. If both SDKs are installed into the IDE, both sets of examples and
board drivers will be available, but the IDE will select the most up to date version of part support
specified within these SDKs. This means the various wizards and dialogues will only ever present
a single instance of an MCU, but may offer a variety of compatible boards and examples. Note: If
a board is selected (from one SDK) and part support is provided by another SDK, a message will
be displayed within the project wizard to show this has occurred but no user action is required.

If two SDKs with matching part support are installed, and the SDK providing part support later
deleted, then part support will automatically be used from the remaining SDK.

Finally, if a project created with one SDKs part support — for example Freedom K64, and then:
- that SDK is changed to another SDK with compatible part support — for example TWR K64 -
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the project is shared with another user who has a different SDK that includes compatible part
support (perhaps an SDK that has only device support)

a dialogue similar to the one below will be generated for each project where this occurs:

[ ] Project SDK management

| The project 'MK64FN1MOxxx12_My Shared_Project' SDK 'SDK_2.x_FRDM-KG4F' cannot be
found.
Please select a compatible SDK for chip ‘MKB84FN1MOxxx12' to use:

SDK_2.x_TWR-KB4F120M [2.4.0] | T ] Make SDK persistent

Cancel | LSS

Where the option to Make persistent will permanently change the project to be associated with
the selected SDK. If unticked, the IDE will accept the change as temporary and no data will be
written back to the project.

Note: When this new association is made, the project will contain files from one SDK but be
associated with another. If the project is refreshed or the component management feature is
used, then incompatible code may be copied into the project.

Building a Fat SDK

An SDK can be generated for a selected part (processor type/MCU) or a board. If just a part is
selected, then the generated SDK will contain both part support and also board support data for
the closest matching development board.

Therefore, to obtain an SDK with both Freedom and Tower board support for say the Kinetis
MK®64... part, simply select the part and the board support will be added automatically.

If a partis chosen that has no directly matching board, say the Kinetis MK63... then the generated
SDK will contain:
e part support for the requested part i.e. MK63...

« part support for the recommended closest matching part that has an associated development
board i.e. MK64...

« board support packages for the above part i.e. Freedom and/or Tower MK64...
Uninstallation Considerations

MCUXpresso IDE allows SDKs to be installed and uninstalled as required (although for most
users there is little benefit in uninstalling an SDK). However, since the SDK provides part support
to the IDE, if an SDK is uninstalled, part support will also be removed. Any existing project built
using part support from an uninstalled SDK will no longer build or debug. Such a situation can
be remedied by re-installing the missing SDK. Note: if there is another SDK installed capable of
providing the ‘missing’ part support, then this will automatically be used.

Sharing Projects

Note: Also see below:

If a project built using part support from an SDK and is then exported — for example to share the
project with a colleague who also uses MCUXpresso IDE, then the colleague must also install
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an SDK providing part support for the projects MCU. Note: it is recommended that any required
SDKs are installed before a project requiring SDK part support is imported. However, if this is
not done, simply select the imported project in the project explorer and right click and select: C/
C++ Build -> MCU settings ensure the correct MCU is selected and click Refresh MCU Cache.
Please see the section

Enhanced Project Sharing Features

New in MCUXpresso IDE version 10.2.0 are a range of features designed to improve the ease
of project sharing. These features combine to streamline the sharing and collaboration process.

Project Drag and Drop

In addition to the existing project import and export capabilities available from the Quickstart
panel, a new set of features has been introduced to ease the transfer of projects.

Previously, the import of a project required the browsing to a project location followed by an
import ...

¢ Projects can now be imported into a Workspace by simply dragging and dropping a folder (or
Zip) containing one or more projects into the Project Explorer view

» Projects can be copied from one IDE instance to another by simply dragging and dropping
from one Project Explorer view to another

« Projects can also be exported by dragging from the Project Explorer view onto a host filer

» Warning: Care must be used here since the default Eclipse (Oxygen) behaviour is to
move files from the workspace rather than perform a copy. This behaviour can be
modified to copy on Mac via holding the Option Key, and on Windows via holding Ctrl.

Project Local SDK Part Support

One weakness of the SDK model of extending the capabilities of the IDE comes when sharing
projects with colleagues — since they must also have the same SDK installed to use this shared
project.

To avoid this problem, SDK projects (and examples) can be modified to contain a local copy of
the required SDK part support.

SDK project may be enhanced to contain local SDK part support

« SDK based projects can now import a cache of part knowledge from an installed SDK
< Simply right click on a project and select add SDK Part Support
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» € Project Settings
» # Binaries
> [l Includes
» (2 CMSIS
» 2 board

» D drivers
» (2 source
» (2 startup
» 3 utilities
» = Debug
> = doc

v = MK64FN 1MOxxx12_My Shared_Project

New
Go Into

¥ =5 MKBAFN TMOxxx12_My Shared_Project
¥ = Project Part Support
¥ o SDK version 2.4.0 package for FRDM-K84F board
» il Boards

Sl:ow in Local Terminal
Copy

* Delete
Source
Move...
Rename...

i Import...
2y Export...

Build Project

Clean Project

7| Refresh

Close Project

Close Unrelated Projects

Build Configurations
Build Targets
Index

Validate

Run As

Debug As

Profile As

Restore from Local History...
Launch Configurations

Smart update

Utilities

Tools

£ Manage SDK Components
%4 Refresh SDK Components
[® MCUXpresso Config Tools
37 Run C/C++ Code Analysis
Team

v

v

YyYvyy

yyYyYvyy

» lus Compilers
» 4% Components
» I Devices
» (= Toolchain Settings
» i Toolchains
» ¢ Project Settings

» ¥ Binaries
» il Includes
> (2 CMSIS
» (2 board

> (S drivers
» (S source
» (S startup
> (S utilities
» = Debug
> = doc

Figure 5.7. Add SDK Local Part Support

Configure and Detect Nested Projects...
(50K) Enable SDK Creator Project Nature
. Add SDK Part Support

¢ Such projects can then be used (in other users MCUXpresso IDEs version 10.2.0 installs)
without first downloading and installing the appropriate SDK

 In such cases, the project local part support will be visible as an installed SDK

[ Installed SDKs 38 [ Properties & Console [*] Problems [J Memory G Debugger Console € Instruction Trace D Power Measurement Tool [5] SWO Trac

@ Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKs' view.

Name
& SDK_2.x_EVK-MIMXRT1020

JSDK_2.0_EVK-MIMXRT1020.zip

(@ SDK_2.x_FRDM-KB4F

[## <Workspace> MKB4FN 1MOxxx12_My Shared_Project
;:;: : x_::::presso:::: :_max.zwp

-4 L X presso54078
i SDK_2.x_LPCXpresso546808

SDK Version Manifest Version Location
2.4.0 3.20 (1)
240 230 i
240 3.3.0

730 T30 T
240 33.0 (1)

Figure 5.8. View SDK Local Part Support

JSDK_2.x_LPCXpresso54608_max.zip

Note: this feature is not designed to replace the need for ultimately installing an SDK, since there
are implications in project size etc. rather it is intended as short term solution to decouple projects

from the requirement for an SDK.

Finally, local part support can be removed in the same way as it was added. Simply right click
on a project and select Configure -> Remove SDK Part Support. Once this has been done, an
appropriate SDK must be installed for the project to be used.
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Project Local Support files

Supporting files required for debug such as flash drivers, LinkServer Connect and Reset scripts
will usually be found (automatically) either within an SDK or installed by default within the IDE.

However, on occasion, bespoke flashdrivers and/or scripts may be required. While these files
could be stored and referenced from various locations within the file system, to enhance project
sharing such files can now be included directly within a project and locally referenced.

To use script and flash driver files in this way, first they can simply be dragged into the local
Project structure:

v =5 MKBAFN1MOxxx12_My Shared_Project

» =, Project Part Support

» € Project Settings

» 4 Binaries

» 1! Includes

» 2 CMSIS

» (2 board

» (2 drivers

» 2 source

» (2 startup

» (2 utilities

> (= Debug

» (=doc

.MK64FN1 MOxxx12_My Shared_Project LinkServer Debug.launch

2_My Shared_Project LinkServer Release.launch

=| my_connect.scp
=| my_flash.cfx

=| my_reset.scp

LinkServer launch configurations can now be used to directly browse to local scripts (connect
or reset) as shown below:
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e e Edit Configuration

Modify configuration and continue. ﬁ\‘

Name: |MK64FN1MOxix12 My Shared_Project LinkServer Debug
() Main [ Common (3% Debuggers, - Source| € GUI Flash Tool
B MCuxpresso IDE LinkServer Debugger

Stop on startup at: | main Request hardware breakpoint
Debugger Options
LU Target configuration
Debug options for NXP MKG4FN1MOxxx12 (cortex-m4)

Debug Connection WD 7

Configuration Option « Valve
4 Additional cptions
[-m Cannect Script E]
i Debugger memory cache Disable I -
- Disconnect behavior [ ] MCUXpresso IDE

i Flash Driver Reset Handling

. Load image Connect script l
i Maximum wire speed

Miscellaneous | 90 e Connect script
Emulator selection  LinkServer a
B Seript | Select the elements from the tree:
Edit scripts... . |

Debug options templat | serit — " (>.settings
ebug options template

| > (=CMSIS
= | [ s

» (=board
(= doc ‘

j » = doye
|

=

@ Cancel == > rg; part-support
¥ (= source
» (= startup
> (= utilities

Figure 5.9. Local Script file

Similarly a project local flash driver can be referenced by editing a projects memory configuration
and again browsing for the required flash driver within the project as below:
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[ ] MCUXpresso IDE
Memory configuration editor

Edit configuration for MK64FN1MOxxx12

IDE

Memory configuration

Default flash driver Browse...

Type Name Alias Location Size - .

|Flash [PROGRAM_FLASH [Flash [0 0x100000  |FTFE_4K.cfx afil

RAM  SRAM_UPPER RAM 0x20000000 ‘NxANOOA E———— .

RAM  SRAM_LOWER RAM2  Ox1ftt0000 @ MCUXpreseo |OF,

RAM  FLEX_RAM RAM3  0x14000QQ Lnkserver flash driver .
\ o8
| Fiash Driver

| Flashdriver | S{workspace loc:}/S{ProiName}/my_flash.cfx ﬂ Browse workspace...
Add Flash Add RAM El
® @ LinkServer flash driver
Import... Merge... Export... Geil

Select the elements from the tree: ‘

Cancel

Figure 5.10. Local flash driver

(= .settings
F (= CMSIS
» (= Debug
> (= board

part-suppors
¥ (= source
» = startup
> (= utilities

(?) Cancel

See additionally

The features described above will rarely be required, but on the occasions where shared projects
have bespoke debug files, the above scheme should simplify the sharing and use of MCUXpresso

IDE projects.
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6. Creating New Projects using installed SDK Part
Support

For creating project using Preinstalled part support please see:

From the QuickStart Panel in the bottom left of the MCUXpresso IDE window there are two
options:

) Quicks Globa Variabl Breakp Outline = O

MCUXpresso IDE - Quickstart Panel

(Lo | No project selected

~ Create or import a project

B New project...
. Import SDK example(s)...

¥ Import project(s) from file system...

* Build your project

~ Debug your project E-EHE

* Miscellaneous

2 Quick Settings>>

oy Build all projects []

Figure 6.1. SDK Projects

The first will invoke the New Project Wizard, that guides the user in creating new projects from
the installed SDKs (and also from preinstalled part support — which will be discussed in a later
chapter).

The second option invokes the Import SDK Example Wizard that guides the user to import SDK
example projects from installed SDKs.

This option will be explored in the next chapter.

Click New project to launch the New Project Wizard.

6.1 New Project Wizard

The New Project Wizard will begin by opening the “Board and/or device selection” page, this
page is populated with a range of features described below:
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[(D Creating project for device: MK64FN 1MOxxx12 with no board. ]4_ i f i ‘ k C 7

]
. Board and/or Device selection page

@JK MCUs Available boards *ﬁi
s from installed SDKs Please select an available board for your project.
r_xi\ G;\ /_7\
(_SPK {_SDK )

frdmk64f agm04 frdmk64f agmO1 evkbimxrt1050 om13588 evkbimxrt1050

NXP MKBAFNTMOxix 12
vKéx
MKB4FN1MOxxx12
> LPC540xx
»LPC546xx
»MIMXRT1050 PN STBC AN e g
—

aeins!aﬂed MCUs
s from preinstalled LPC and generic

Cortex-M part support

Target

r ~
»LPC1102 (CLLY)
»LPC112x evkbimxrt1050 agmO1 LPCXpresso812-MAX
FLPCT1AXX
»LPC11E6x
‘ »LPC11Exx
FLPC11UBx
»LPCT1Uxx
»LPC11xx
‘ FLPCT 1xxLV
Selected Device: MK64FN1MOxxx12 with no board. SDKs for selected MCU
Target Core: cortex=md Name: SDK Version  Manifest Versjr Location
Description:  SDK_2.x_FRDM-K64F  2.4.0 3.3.0 (% <Default Location>/SDK_2.x_FRD
‘ K64_120: Kinetis® K64-120 MHz, 256KB SRA pdhtrollers
(MCUs) based on ARM® Cortex®-M4 Core

Figure 6.2. New Project Wizard first page

1. Adisplay of all parts (MCUSs) installed via SDKs. Click to select the MCU and filter the available
matching boards. SDK part support can be hidden by clicking on the triangle (highlighted in
the blue oval)

2. A display of all preinstalled parts (these are all LPC or Generic M parts). Click to select the
MCU and filter the available matching boards (if any). Preinstalled part support can be hidden
by clicking on the triangle (highlighted in blue)

3. A display of all boards from both SDKs or matching LPCOpen packages. Click to select the
board and its associated MCU.

* Boards from SDK packages will have SDK superimposed onto their image.

4. Some description relating to the users selection

5. A display to show the matching SDK for a chosen MCU or Board. If more than one matching
SDK is installed, the user can select the SDK to use from this list

6. Any Warning, Error or Information related to the current selection

7. An input field to filter the available boards e.g. enter ‘64’ to see matching MK64... Freedom
or Tower boards available

8. 3 options: to Sort boards from A-Z, Z-A or clear any filter made through the input field or a
select click.

Note: Once a project has been created the selected board and/or MCU will be remembered and
selected the next time the wizard is entered. To remove this selection, click the clear filter button
(or any background white space).
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This page provides a number of ways of quickly selecting the target for the project that you want
to create.

In this description, we are going to create a project for a Freedom MK64xxx board (The required
SDK has already been imported).

First, to reduce the number of boards displayed, we can simply type ‘64’ into the filter (7). Now
only boards with MCUs matching ‘64’ will be displayed.

[ ] ® SDK Wizard

| y
‘ (D Creating project for device: MKE4FN1MOxxx12 using board: FROM-K64F } k @

|
. Board and/or Device selection page

~ SDK MCUs Available boards 1% 1%
MCUs from installed SDKs

Please select an available board for your project.
NXP MKGAFN1MOxxx12
YKBx
[ MKBaFNTMOXx12 )
> LPCHha0xx
»LPC546xx
»MIMXRT1050

PROMFXS LT

FROMSTECAGIE FROMAGBAR

SDK

SDK
frdmkEaf frdmk641 mu\l?b frdmk64f om13588 frdmk64f agm04

~ Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support
Target
»LPC1102
FLPC112x
FLPC11AXx
»LPC11E6x
‘ »LPC11Exx
FLPC11UBX frdmk64f agm01
FLPCT1Uxx
FLPC11xx
‘ FLPCT1xxLV

Selected Device: MK64FN1MOxxx12 using board: FRDM-K64F SDKs for selected MCU

Target Core: cortex-md4 Name SDK Version Manifest Versior Location

Description: 1 SDK_2.x_FRDM-KE64F  2.4.0 3.3.0 (* <Default Location>/SDK_2.x_FRD
‘ K64_120: Kinetis® K64-120 MHz, 256KB SRAM Microcontrollers

(MCUs) based on ARM® Cortex®-M4 Core

| @ Cance

Figure 6.3. New Project Wizard selection

When the (SDK) board is selected, you can see highlighted in the above figure that the matching
MCU (part) and SDK are also selected automatically.

With a chosen board selected, now click ‘Next'...

6.1.1 SDK New Project Wizard: Basic Project Creation and Settings

The SDK New Project Wizard consists of two pages offering basic and advanced configuration
options. Each of these pages is preconfigured with default options (the default options offered
on the advanced page may be set based on chosen settings from the basic page).

Therefore, to create a simple ‘Hello World’ C project for the Freedom MK64... board we selected,
all that is required is simply click ‘Finish’.
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Note: The project will be given a default name based on the MCU name. If this name matches a
project within the workspace e.g. the wizard has previously been used to generate a project with
the default name, then the error field will show a name clash and the ‘next’ and ‘finish’ buttons
will be ‘greyed out’. To change the new project’s name; the blank ‘Project Name Suffix’ field can
be used to quickly create a unique name but retain the original prefix.

This will create a project in the chosen workspace taking all the default Wizard options for our
board.

However, the wizard offers the flexibility to select/change many build, library and source code
options. These options and the components of this first Wizard page are described below.

SDK Wizard

[

Location:

0s

Name

L

. Configure the project

Project name: [ MKE4FN1MOxxx12_Project

Use default location

Device Packages

MKB4FN1MOVDC12
© MK64FNTMOVLL12
_ MKB4FN1MOVLQ12

‘ﬁ,— baremetal
1 freertos

Figure 6.4. New Project Wizard basic SDK settings

@ .| profct name sut: @

Project Type roject Options 7
© Default board files © C Project C++ Project SDK Debug Console @) Semihost () UART
" Empty board files ") C Static Library () C++ Static Library CMSIS-Core
Copy sources
Import other files
T [ driver 7 M % =] | _cMmsis_driver ¥ % @B utilities M% @B middleware iM% BB
Version Name - Version Name Version Name _ Version Name Version
1.0.0 +adc 2.0.0 » = Device it assert 1.0.0 » = Graphics
10.0.1 < clock 2.1.0 «-arm_cortexMd4lf 5.0.1 44 debug_console  1.0.0 » = File System
3 cmp 2.0.0 4+ CAN_CMSISIncli 5.0.1 <+ debug_console  1.0.0 [-] = Security
a gicmt 2.0.1 C 4+ Common_CMSI$5.0.1 ] 4 notifier 1.0.0 ~1 » = Memories
-g_}common 2.0.0 v&l_}EtherneLCMSIS 5.0.1 -ﬁ;shel\ 1.0.0 » = Network
tcre 2.01 4 Ethernet MAC_(5.0.1 At virtual_com 1.0.0 > = WiFi
gidac 2.0.1 {kEthernet_PHY_C 5.0.1 ik lvhb 1.0.0
<+ dmamux 2.0.2 I+ Flash_CMSISInc 5.0.1 gk emaf 1.0.0
<4 dspi 2.2.0 4}12C_CMSISinclu 5.0.1 » 4 sigfox 1.0.0
43! dspi_edma 2.2.0 -‘:ﬂ}MCLCMSIS\HClL 5.0.1
g 2.2.0 M
2.1.2
e 223 C
2.01
3.00 0.
2.0.1 1+ USB_Device_CN 5.0.1
i flexcan 2.2.0 4+ USB_Host_CMS| 5.0.1
< Back Next > Cancel [ Finish |

MCUXpresso IDE User Guide -

1. Project Name: The default project name prefix is automatically selected based on the part
selected on the previous screen

« Note: Due to restrictions in the length of filenames accepted by the Windows version of the
underlying GCC toolchain, it is recommended that the length of project names is kept to 56
characters or less. Otherwise you may see project build error messages regarding files not
being found, particularly during the link step.

2. Project Suffix: An optional suffix to append to a project name can be entered here

3. Errors and Warnings: Any error or warning will be displayed here. The ‘Next’ option will not

be available until any error is handled — for example, a project name has been selected that
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matches an existing project name in your workspace. The suffix field (2) allows a convenient
way of updating a project name

4. MCU Package: The device package can be selected from the range contained with the SDK.
The package relates to the actual device packaging and typically has no meaning for project
creation

5. Board files: This field allows the automatic selection of a default set of board support files, else
empty files will be created. If a part rather than a board had been selected on the previous
screen, these options will not be displayed.
« If you intend to use board specific features such as output over UART, you should ensure

Default board files are selected

6. Project Type: C or C++ projects or libraries can be selected. Selecting ‘C’ will automatically

select RedLib libraries, selecting C++ will select NewlibNano libraries. See

7. Project Options:

* Enable Semihost: will cause the Semihosted variant of the chosen library to be selected.
For C projects this will default to be Redlib Semihost-nf. Semihosting allows IO operations
such as printf and scanf to be emulated by the debug environment.

¢ CMSIS-Core: will cause a CMSIS folder containing a variety of support code such as Clock
Setup, header files to be created. It is recommended to leave this options ticked

e Copy Sources: For zipped SDKs, this option will be ticked and greyed out. For unzipped
SDKs, projects can be created that use linked references back to the original SDK folder.
This feature is recommended for ‘Power Users’ only

8. Each set of components support a filter and check boxes for selection. These icons allow
filters to be cleared, all check boxes to be set, all check boxes to be cleared

9. OS: This provides the option to pull in and link against Operating System resources such as
FreeRTOS.

10driver: enables the selection of supporting driver software components to support the MCU
peripheral set.

11 CMSiISdriver: code and headers for standard arm hardware

12utilities: a range of optional supporting utilities.

« For example select the debug_console to make use of the SDK Debug Console handling
of 10

¢ Selecting this option will cause the wizard to substitute the (SDK) PRINTF() macro for C
Library printf() within the generated code

* The debug console option relies on the OpenSDA debug probe communicating to the host
via VCOM over USB.

13middleware: enables the selection of various middleware components

Finally, if there is no error condition displayed, ‘Finish’ can be selected to finish the wizard,
alternatively, select ‘Next’ to proceed to the Advanced options page (described next).

Important Note: Any components (OS, driver, utilities, middleware) selected by default within
this wizard will be linked into the final image. However, any additional components selected by
the user will only bring the corresponding sources into the project, these will only be linked into
the final image if subsequently referenced. Additionally, selecting a component will automatically
select any dependencies. Finally, please also note that this is an additive process, removing
components may leave unresolved dependencies resulting in a project that will not build.

Note: Some middleware components such as USB, are not currently compatible with the
New project wizard functionality and so will be hidden. The recommended approach if such
components are required is to import an example including the component and then modify this
as required. Please see for details of how this
might be done.

Note: By default, new project files are stored within the current MCUXpresso IDE workspace,
this is recommended since the workspace then contains both the sources and project
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descriptions. However, the New Project Wizard allows a non default location to be specified if
required. To ensure that each project’s sources and local configuration are self contained when
using non standard locations, the IDE will automatically create a sub directory inside the specified
location using the Project name prefix setting. The newly created project files will then be stored
within this location.

6.1.2 SDK New Project Wizard: Advanced Project Settings

The advanced configuration page will take certain default options based on settings from the
first wizard project page, for example a C project will pre-select Redlib libraries, where as a C+
+ project will pre-select NewlibNano.

[ ] [ ] SDK Import Wizard

\

- =

. Advanced Settings

(- C/C++ Library Settings
Set library type (and hosting variant) Redlib (semihost-nf) B
Redlib: Use floating point version of printf
\.__| Redlib: Use character rather than string based printf @

[ Redirect SDK "PRINTF" to C library "printf* Redirect printf/scanf to ITM
Include semihost HardFault handler Redirect printf/scanf to UART
\
(AT SeTtgS ) @
Set Floating Point type FPv4 (HardABI) B
\
(~ MCUC Comprier 4
Language standard = GNU C99 (-std=gnu98) E
\. J
~ MCU Linker 5
Link application to RAM
(‘Memory Configuration
Memory details
Type Name Alias Location Size Driver
Flash PROGRAM_FLASH Flash 0x0 0x100000 FTFE_4K.cfx
RAM SRAM_UPPER RAM 0x20000000 0x30000 Edit
RAM SRAM_LOWER RAM2 0x1ff0000 0x10000
RAM FLEX_RAM RAM3 0x14000000 0x1000
|
@ < Back Cancel [ Finish ]
Figure 6.5. New Project Wizard advanced SDK settings
1. This panel allows the selection of library variants. See . Note: if

a C++ project was selected on the previous page, then the Redlib options will be Greyed out.
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Redlib (none)
Redlib (nohost)
Redlib (semihost)
Redlib (nohost-nf)

v Redlib (semihost-nf)
Redlib (semihost-mb)
Redlib (semihost-mb-nf)
NewlibNano (none)
NewlibNano (nohost)
NewlibNano (semihost)
Newlib (none)

Newlib (nohost)
Newlib (semihost)

« Also, based on the selection, a number of options may be chosen to modify the capability
(and size) of printf support

¢ Redlib Floating Point printf: If this option is ticked, floating point support for printf will
automatically be linked in. This will allow printf to support the printing out of floating point
variables at the expense of larger library support code. Similarly for Newlib.

* Redlib use Character printf: selecting this option will avoid heap usage and reduce code
size but make printf operations slower.

2. This panel allows options to be set related to Input/Output. See

¢ Redirect SDK “PRINTF”: many SDK examples use a PRINTF macro, selecting this optlon
causes redirection to C library 10 rather than options provided by the SDK debug console.
¢ Include Semihost Hardfault Handler: selected by default, this option when checked will add
a hardfault handler to the project sources. This handler is specifically written to deal with
the situation that will occur if a semihosted function such as printf is executed when no
debug tools are attached to support the operation. If this occurs, this handler will catch
the operation and safely return to the executing application. Uncheck this option if you do
not wish to use semihosted libraries or you intend to use your own hardfault handler. See
for more information.

¢ Redirect printf/scanf to ITM: causes a C file 'retarget_itm.c to be pulled into your project.
This then enables printf/scanf 1/0O to be sent over the SWO channel. The benefit of this is
that 1/0 operations can be performed with little performance penalty. Furthermore, these
routines do not require debugger support and for example could be used to generate logging
that would effectively go to Null unless debug tools were attached. Note: This feature is not
available on Cortex MO and MO+ parts.
* More information can be found in the MCUXpresso IDE SWO Trace Guide.

¢ Redirect printf/scanf to UART: Sets the define SDK_DEBUGCONSOLE_UART causing the
C libraries printf functions to re-direct to the SDKs debug console UART code.

3. Hardware Settings: from this drop down you can set options such as the type of floating point
support available/required. This will default to an appropriate value for your MCU.

None
FPv4 (SoftABI)
Set Floating Point type o Fpy4 (HardABI)

~ Hardware settings

4. MCU C Compiler: from this drop down you can set various compiler options that can be set
for the GNU C/C++ compiler.

GNU C99 (-std=gnu99)
GNU C11 (-std=gnui1)
Set Floating Point|  ISO C80 / ANSI C89 (-std=c90)
ISO ©99 (-std=c99)
« MCUC Compile SO C11 (-std=c11)
GNU C80 (-std=gnuS0)
Language standar¢  Compiler default

~ Hardware settin

5. Link Application to RAM checkbox reflects or sets the option to force the linker to ignore any
defined flash regions and link the application to the first RAM region defined. This option is
a copy of the flag at Properties -> C/C++ Build -> Settings -> Managed Linker Script -> Link
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application to RAM Note: This setting is only sensible for projects under development, since
debug control or a bootloader is required to load the code/data into RAM and simulate a
processor reset.

6. Memory Configuration:; This panel shows the Flash and RAM memory layout for the MCU
project being created. The pre-selected LinkServer Flash driver is also shown. Note: this Flash
driver will only be used for LinkServer (CMSIS-DAP) debug connections.

 Clicking Editinvokes the IDE’'s memory configuration editor. From this dialogue, the project’s
default memory setting and hence automatically generated linker settings can be changed.

See
L]

[ ] MCUXpresso |IDE

Memory configuration editor
Edit configuration for MK64FN1MOxxx12 m
Memory configuration
Default flash driver | | Browse...
Type  Name Aias Location Size Driver .
Flash PROGRAM_FLASH Flash  0x0 0x100000  FTFE_4K.cfx v

RAM  SRAM_UPPER RAM 0x20000000 0x30000
RAM  SRAM_LOWER RAM2  0x1fff0000  0x10000

RAM  FLEX_RAM RAM3  0x14000000 0x1000
Add Flash Add RAM Split Delete
Import... Merge...

Gancel ——

SDK Build Project

To build a project created by the SDK New Project Wizard, simply select the project in the ‘Project
Explorer’ view, then go to the ' QuickStart' Panel and click on the build button to build the
project. This will build the project for the default projects ‘Debug’ configuration.

Note: MCUXpresso IDE projects are created with two build configurations, Debug and Release
(more can be added if required). These differ in the default level of compiler optimization. Debug

projects default to None (-O0), and Release projects default to (-Os). For more information
on switching between build configurations, see

The build log will be displayed in the console view as below.
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I)) Installed SDKs [ Properties & Console 22 |[2] Problems [] Memory € Instruction Trace [7 SWO Trace Config &2 Power Measurement Tool 4 4|5 L8 RBE % ME-§-= B8
CDT Build Console [MKB4FN1MOxxx12_Project]

Building file: ../CMSIS/system_MKG4F12.c

Tnvoking: MCU € Compiler

arm-none-eabi-gecc -DCR_INTEGER_PRINTF -DSDK_DEBUGCONSOLE=® -D__MCUXPRESSO -D__USE_CMSIS -DDEBUG -DSDK_OS_BAREMETAL -DFSL_RTOS_BM -DCPU_MKE4FNIM@VDC12 -DCPU_MK&4FNIMAVDC1Z _cmd -1
Finished building: ../startup/startup_mk64f12.c

Finished building: ../source/MK64FNIMBxxx12_Project.c

Finished building: ../CMSIS/system_MK64F12.c

Building target: MKG4FNIMOxxx12 Project.axf
Invoking: MCU Linker
jorm-none-eabi-gee -nostdlib -Xlinker -Map="MKG4FNIMOxxx12 Project.map” -Xlinker --gc-sections -Xlinker -print-memory-usage -mcpu=cortex-md4 -mfpu=Ffpvé-sp-d16 -mfloat-abi=hard -m

Memary region Used Size Region Size Hage Used
PROGRAM_FLASH: 3216 8 1 MB 0.78%
SRAM_UPPER: 8392 8 132 K8 4.27%
SRAM_LOWER: D G8 64 KB 8.90%
FLEX_RAM: 0GB 4 KB 0.90%

Finished building target: MKE4FN1M@xxx12_Project.axf

make --no-print-directory post-build

Performing post-build steps

arm-none-eabi-size "MKBAFNIM@xxx12_Project.axf"; # arm-none-eabi-objcopy -v -0 binary "MKB4FNIM@xxx12 Project.oxf" "MKE4FNIMBxxx12_Project.bin” ; # checksum -p MKE4FNIM@xxx12 -
text data bss dec hex filename
8212 4 8388 16604 4@dc MK64FNIMAxxx12_Project.axf

15:15:38 Build Finished (took 66%9ms)

Figure 6.6. New Project Wizard Build

The projects memory usage as highlighted above is shown below:

Menory region Used Size Region Size %age Used

PROGRAM_FLASH: 8216 B 1 MB 0.78%
SRAM_UPPER: 8392 B 192 KB 4.27%
SRAM _LOVER: 0 G 64 KB 0. 00%
FLEX_RAM 0 G 4 KB 0. 00%

Fi ni shed buil ding target: MG64FNLM)xxx12_Proj ect . axf

By default, the application will build and link against the first Flash memory found within the
devices memory configuration. For most MCUs there will only be one Flash device available.
In this case our project requires 8216 bytes of Flash memory storage, 0.78% of the available

Flash storage.

RAM will be used for global variable, the heap and the stack. MCUXpresso IDE provides a flexible
scheme to reserve memory for Stack and Heap. The above example build has reserved 4KB

each for the stack and the heap. Please See
for detailed information.
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7. Importing Example Projects (from installed SDKS)

In addition to drivers and part support, SDKs also deliver many example projects for the target
MCU.

To import examples from an installed SDK, go to the QuickStart panel and select Import SDK
example(s).

) Quicks Globa Variabl Breakp Cutline = 0O

MCUXpresso IDE - Quickstart Panel

(_ioe | No project selected

~ Create or import a project

New project...
. Import SDK example(s)... ]

¥ Import project(s) from file system...

* Build your project

~ Debug your project E-EHE

* Miscellaneous

2 Quick Settings>>

oy Build all projects []

Figure 7.1. SDK Example

This option invokes the Import SDK Example Wizard that guides the user to import SDK
example projects from installed SDKs.

Like the New Project wizard, this will initially launch a page allowing MCU/board selection.
However now, only SDK supported parts and boards will be presented.
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Figure 7.2. SDK Example Board

[} L ] SDK Import Wizard
@ Importing project(s) for device: MK64FN1MOxxx12 using board: FROM-K64F ‘ k i /
. Board and/or Device selection page
~ SDK MCUs Available boards LY
MCUs from installed SDKs Please select an available board for your project.
NXP MK84FN1MOxx0c12
TK6x
MKBAFNTMOxxx12

»LPC540xx
»LPC546xx
»MIMXRT1020
»MIMXRT1050

&Ly Q \_SDK J \_SDK )

frdmkB4f frdmk&4f mult2b frdmk&4f om13588 frdmk84f agm04

FRONFESMULTZD

frdmk641 agm01

Selected Device: MK64FN 1MOxxx 12 using board: FRDM-K64F SDKs for selected MCU

Target Core: cortex-m4 Name SDK Version  Manifest Versio Location
B SDK_2.x_FRDM-KB4F 2.4.0 &5 <Default Location> /SDK_2.x_FH

Description:
K64_120: Kinetis® K64-120 MHz, 256KB SRAM Microcontrollers
(MCUs) based on ARM® Cortex®-M4 Core

@ [ et R

7.1 SDK Example Import Wizard

Selection and filtering work in the same way as for the but please be
aware that examples are created for particular development boards, therefore a board must be
selected to move to the ‘Next’ page of the wizard.

7.1.1 SDK Example Import Wizard: Basic Selection

The SDK Example Import Wizard consists of two pages offering basic and advanced
configuration and selection options. The second configuration page is only available when a
single example is selected for import. This is because examples may set specific options, and
therefore changing settings globally is not sensible.

The first page offers all the available examples in various categories. These can be expanded to
view the underlying hierarchical structure. The various settings and options are explained below:
Note: The project will be given a default name based on the MCU name, Board name and
Example name. If this name matches a project within the workspace e.g. the wizard has
previously been use to generate an example with the default name, then the error field will show
a name clash and the ‘next’ and ‘finish’ buttons will be greyed out. To change the new example
name, the blank ‘Project Name Suffix’ field can be used to quickly create a unique name but
retain the original prefix e.g. add ‘1'.
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MCUXpresso IDE will create a project with common default settings for your chosen MCU and
board. However, the wizard offers the flexibility to select/change many build, library and source
code options. These options and the components of this first Wizard page are described below.

[ JoN SDK Import Wizard

€ Please select one or more examples to import ‘ k i i
. Import projects
[Projecl name prefix: frdmk&4f_ 7 [Prujem name suffix: i

Use default location

Location:

SDK Debug Console
Copy sources
Import other files

Examples @ By 4 M % _-]
@

Name Version
» = aws_examples \‘ 6
» = cmsis_driver_examples

» = demo_apps

» £ driver_examples

» S emwin_examples

» £ Iwip_examples

~| » = mmcau_examples

~] » = multiprocessor_examples
» £ rtos_examples

~I » £ se_hostlib_examples

» £ usb_examples /

[Prnie ct Type Project Options

(‘?‘) < Back Cancel

Figure 7.3. SDK Example Selection

1. Project Name: A project name is automatically created with the form:
boardname_examplename

2. Project Suffix: An optional suffix to append to a project name can be entered here. This is
particularly useful if you are repeating an import of one or more projects since an entry here
can make all auto generated names unique for the current workspace...

3. Project Type: These will be set by the pre-set type of the example being imported. If more
than one example is imported, then these options will appear greyed out.

4. Project Options:

« ‘SDK Debug Console’: Once an example(s) is selected, this option can be used to control
10 between semihost console or UART.

* ‘Copy sources’: For unzipped SDKs, you can untick this option to create project containing
source links to the original SDK files. This option should only be unticked with care, since
editing linked example source will overwrite the original files!

¢ ‘Import other files’: By default, non source files such as graphics are filtered out during
import, check this box to import all files.
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5. Examples Filter: Enter text into this field to find possible matches, for example enter ‘LED’ or
‘bubble’ to find examples present in many SDKs. This filter is case insensitive.

6. Examples: The example list broken into categories. Note: for some parts there will be many
potential examples to import

7. Various options (from left to right):

¢ Opens a filer window to allow an example to be imported from an XML description. This is
intended as a developer feature and is described in more detail below.

¢ Clear any existing filter

¢ Select (tick) all Examples

¢ Clear all ticked examples

¢ Open the example structure
¢ Close the example structure

Finally, if there is no error condition displayed, ‘Finish’ can be selected to finish the wizard,
alternatively if only one example has been selected the option to select ‘Next’ to proceed to the
Advanced options page is available (described in the next section).

Note: SDKs may contain many examples, 217 is indicated for the FRDM MK64 SDK example
shown below. Importing many examples will take time ... Consider that each example may consist
of many files and associated description XML. A single example import may only take a few
seconds, but this time is repeated for each additional example. Furthermore, the operation of the
IDE maybe impacted by a large number of project in a single workspace, therefore it is suggested
that example imports be limited to sensible numbers.

Note: Due to restrictions in the length of filenames accepted by the Windows version of the
underlying GCC toolchain, it is recommended that the length of project names is kept to 56
characters or less. Otherwise you may see project build error messages regarding files not being
found, particularly during the link step.
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| €3 Please select one or more examples to import

), =

‘ . Import projects

Project name prefix: srdmkgaf.

| Use default location

Location:

Project Type

Examples [ ] MCUXpresso IDE
4 You have selected '217' projects to import.

Name | Impaort may take a considerable amount of time.

v E aws_examples
aws_remote_control_enet
aws_remote_control_wifi
aws_shadow_console_echo_eng

aws_subscribe_publish_enet
aws_subscribe_publish_wifi
v = cmsis_driver_examples

v = dspi
= cmsis_dspi_edma_b2b_transfer_master
cmsis_dspi_edma_b2b_transfer_slave
cmsis_dspi_edma_transfer
cmsis_dspi_int_b2b_transfer_master
cmsis_dspi_int_b2b_transfer slave
cmsis_dspi_interrupt_transfer
=i2c
= cmsis_i2c_edma_b2b_transfer_master
rmais i?r afdma h?h tranafer clave

L R N N N N N R IR PR NN SR LN R NN
P
0l
= [

/7 Project name suffix: I

Project Options |
SDK Debug Console (#) Semihost (| UART
/' Copy sources

¥ Import other files

4 M% BE

Version

aws_shadow_console_echo_wifi

@

Figure 7.4. SDK Example Selection Many

< Back Cancel

7.1.2 SDK Example Import Wizard: Advanced options

The advanced configuration page (shown below) will take certain default options based on the
example’s selected, for example a C project will pre-select Redlib libraries, where as a C++

project will pre-select NewlibNano.

MCUXpresso IDE User Guide -

All information provided in this document is subject to legal disclaimers

© 2018 NXP Semiconductors. All rights reserved.

User Guide

Rev. 10.2.0 — 14 May, 2018 64




NXP Semiconductors MCUXpresso IDE User Guide

. Advanced Settings

SDK Import Wizard

s

Set library type (and hosting variant) Redlib (semihost-nf) B |

(- C/C++ Library Settings
Redlib: Use floating point version of printf
\.__| Redlib: Use character rather than string based printf
[ Redirect SDK "PRINTF" to C library "printf* Redirect printf/scanf to ITM
Include semihost HardFault handler Redirect printf/scanf to UART
\
(AT SeTtgS ) @
Set Floating Point type FPv4 (HardABI) B
.
(~ MCUC Comprier 4
Language standard = GNU C99 (-std=gnu98) B
\. J
~ MCU Linker 5
Link application to RAM
(‘Memory Configuration
Memory details
Type Name Alias Location Size Driver
Flash PROGRAM_FLASH Flash 0x0 0x100000 FTFE_4K.cfx
RAM SRAM_UPPER RAM 0x20000000 0x30000 Edit
RAM SRAM_LOWER RAM2 0x1ff0000 0x10000
RAM FLEX_RAM RAM3 0x14000000 0x1000
|
©) < Back cancel | (I

Figure 7.5. New Project Wizard advanced SDK settings

7.1.3

MCUXpresso IDE User Guide -

These settings closely match those in SDK New Project Wizard description. Therefore see
for a description of these options. Note: Changing
these advanced options may prevent an example from building or executing.

SDK Example Import Wizard: Import from XML fragment

This option works in conjunction with the ‘Project Explorer’ -> Tools -> Generate Example XML
(and is also used to import project created by the MCUXpresso Config Tools Project Generator).

The functionality here is to merge existing sources within a selectable board package framework.
To create an XML “fragment” for an existing project in your workspace, right click on the project
in the ‘Project Explorer’ (or just in the ‘Project Explorer’ view with no project selected) and choose

Tools->Generate examples.xml file

The selected project or all the projects in the workspace (if no projects are selected) will be
converted into a fragment within a new folder created in the workspace itself:
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m—=
==
==
—-=

[ Project Explorer 32 | &, Peripherals+ Regi

v = boards
¥ (= frdmkB4f
¥ (=~ dummy
¥ (= Category
b = MKBAFN1MOxxx12_Project
examples.xml
b 5 frdmkB4f_demo_apps_bubble

To create a project from a fragment, click on “Import SDK examples...” in the QuickStart Panel
view:

Then select a board and then click on the button “Import from XML...” (highlighted below and
described in the previous section). You will see the examples definitions from the external
fragment in list of examples as shown and selected below.

BN | SDK Import Wizard

| @ You have selected '1' projects to import. ‘ k @ ‘
| |
I |

. Import projects

Project name prefix:  frqmkg4f | Project name suffix: ML fragment

Use default location
Location:

Project Type

© C Project

Project Options

Copy sources

Examples R B

me
» S cmsis_driver_examples
» = demo_apps
» = driver_examples

Version

» = emwin_examples

F = mmcau_examples

» = multiprocessor_examples
» = rtos_examples

¥ = dummy
¥ = Category
MKE4FN1MOxxx12_Project

eV 0000000 g

@ < Back MNext > Cancel ﬁ

Select the external examples you want to re-create and click on “Finish”. The project(s) will be
created in the workspace.
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7.1.4 Importing Examples to non default locations

By default, imported example sources will be stored within the current MCUXpresso IDE
workspace, this is recommended since the workspace then contains both the sources and
project descriptions. However, the Import SDK Example Wizard allows a non default location
to be specified if required. To ensure that each project’s sources and local configuration are self
contained when using non standard locations, the IDE will automatically create a sub directory
inside the specified location using the Project name prefix setting. Single or multiple imported
projects will then be stored within this location.
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8. SDK Project Component Management

Projects and examples created from SDKs contain a number of software components such as
peripheral drivers and/or middleware. In previous versions of MCUXpresso IDE, the option to
add components was only available when creating a new project and not possible for imported
examples. Introduced in MCUXpresso IDE version 10.1.0 is the ability to easily add (or remove)
SDK components to a previously created or imported example project via a new Manage SDK
components wizard. To launch the Manage SDK Components wizard, simply select the chosen
project in the Project explorer view and then click the package icon as indicated below:

{5 Projec 2 % Periph i} Regist £ Symbo = B

= .. -
¥ 122 MKBAFN1MOxxx12_Project
» € Project Settings [ ] [ ] Manage SDK components for project MK64FN1MOxxx12_Project
» il Includes
2 '
: jg:;f 1, Adding g could i break your project. Please use this feature carefully. *%
b (D drivers
» (2 source Available SDK components

» (S startup
> (B utilities
> =doc Import other files

Copy sources

0s y ¥ [ driver LM% BE CMSIS_driver M BE utilities LM% BE middleware Y % ® B
Name Version Name Version Name Version Name Version Name Version
= baremetal 1.0.0 @ Qiadc 2.0.0 » = Device «tassert 1.0.0 » = Graphics
i freertos 10.0.1 o iarm_cortexh 5.0.1 4} debug_console 1.0.0 » £ File System
cmp 2.0.0 2 CAN_CMSISIr 5.0.1 <+ debug_console 1.0.0 2 » E Security
giemt 2.0.1 4% Common_CM 5.0.1 4 notifier 1.0.0 » £ Memories
& 4 Ethernet_CM!6.0.1 Zishell 1.0.0 » £ Network
o 2.0.1 14 Ethernet_MA(5.0.1 ghvirtual_com  1.0.0 » E WiFi
gidac 2.0.1 {3 Ethernet_PHY5.0.1 i whb 1.0.0
g dmamux 2.0.2 13 Flash_CMSISI5.0.1 I emat 1.00
[ 2.2.0 H12C CMSISIn5.0.1 i sigfox 1.0.0
4idspiedma  2.2.0 {3 MCI_CMSISIn 5.0.1
143 dspi_freertos 2.2.0 A NAND_CMSIS5.0.1
Click to add 4redma 2.1.2 4 SAICMSISINGS.0.1
frenet 2.2.3 143 SPLCMSISINg5.0.1
&hewm 2.0.1 {5 USART_CMSI 5.0.1
o 1 USB_CMSISIr 5.0.1
&) fiexbus 2.0.1 [ USR Deviee 15.0.1
@ Canca [P —

Figure 8.1. Manage SDK Components

Note: This powerful feature can add (or remove) SDK components and their dependencies at
a source file level, relying on meta data contained within the SDK. However the following points
should also be noted:

e The IDE can only maintain dependencies between SDK components. SDK component
functions referenced from user created files or from sources such as an SDK example’s main()
function will not be taken into account when determining the safe removal of components.
Therefore, the IDE cannot always prevent users removing components that may actually be
required for a successful project build.

« Defined symbols will not be removed when components are removed, therefore users should
ensure only required symbols are present if components are removed. Failing to do this may
lead to project build failures.

8.1 SDK Project Component Management example

To demonstrate the use of this feature, the dac driver will be added to a project. To do this, launch
the Manage SDK components wizard, and click on the dac driver component then click ‘OK’.

Next, a dialogue will be presented listing all of the source files required by this component — as
below.
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[¢] ® SDK Component Management

1 The following files will be added or updated if required:
Component source Project Path(s) Info
v i

A JCH

1) [ [t ) i

v -.;_ﬁndac drivers 2.0.1
¥ =} devices/MKE4F12/drivers drivers SRC
=l fsl_dac.c
v =i devices/MKB4F12/drivers drivers C_INCLUDE
= fsl_dac.h
v
| \ &
v <

A\ H

LCH

Skip addfremaove components confirmation in future

o | (EEEEE

Figure 8.2. SDK Component Management

Note: Many of these files may already be included within your project.

Click ‘Yes’ to add these source files to your project.

Important Note: Since your project may contain edited or entirely new versions of the required
source files, MCUXpresso IDE will perform a comparison between the new files to be included

and any existing files already within the selected project.

Should a source file difference be found, then a dialogue as below will be launched:

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide Rev. 10.2.0 — 14 May, 2018 69




NXP Semiconductors

MCUXpresso IDE User Guide

-

component file.

dependent components.

Remember my decision.

The file 'system_MKG4F12.¢' already exists in your project but is different from the SDK
MOTE: 'system_MKGE4F12.c' could belong to the selected component(s) or one of its

Please select from the following options:

Replace

Figure 8.3. SDK Component Management file difference

Keep existing Compare

From here you can choose from the following options:

* Replace click to overwrite the projects file from the SDK version.
« Keep Existing click to keep the existing project file unchanged.

¢ Compare click to compare the two files — this will launch the Eclipse file compare utility so the
new SDK file can be compared with the projects copy.

In this example, we will click ‘Compare’ ...

Below, you can see that a user project source modification has been found:

C Compare

[g Translation Unit

C Compare Viewer

Workspace: Workspace: [MKB4F...o0ject/CMSIS/system_MKE4F12.c

EN A user code change has been made here )
12
h I3 £

114 -- Core clock
| |R1s
116]
117 uint32_t SystemCoreClock = DEFAULT_SYSTEM_CLOCK;

122
123 void SystemInit (void) {

124 #if ((__FPU_PRESENT == 1) && (__FPU_USED == 1))

195 GFR-~CRAMR = FFRU1 or 10F2Y | 31 oo 178233 ,*

Left: 116 : 1, Right: 111 : 1, no diff

@

Compare

P [ £ 4R

1 SDK: devices/MKG64F12/system_MKB4F12.c

116

122

123 void SystemInit (void) {

124 #if ((__FPU_PRESENT == 1) && (__FPU_USED == 1))
195 QFR-~CBACR = FFRIL or 106N | R e 11623

Cancel

Figure 8.4. SDK Component Management file compare

The Compare utility allows any change to be examined and a decision made regarding which
code lines to choose or ignore. When the decisions have been made, click ‘Commit’ to use these
changes or ‘Cancel’ to leave the project file unchanged.

Finally please note the application build sizes before the addition;

Menory region Used Size Region Size %age Used
PROGRAM_FLASH: 13348 B 1 MB 1.27%
SRAM_UPPER: 8444 B 192 KB 4.29%

SRAM _LOVER: 0GB 64 KB 0. 00%
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8.2

FLEX_RAM 0GB 4 KB 0. 00%
Fi ni shed buil ding target: MG64FNLM)xxx12_Proj ect . axf

Followed by the application sizes after the addition.

Menory region Used Size Region Size %age Used
PROGRAM_FLASH: 13348 B 1 MB 1.27%
SRAM_UPPER: 8444 B 192 KB 4.29%
SRAM_LOVNER: 0 &8 64 KB 0. 00%
FLEX_RAM 0 &8 4 KB 0. 00%

Fi ni shed buil ding target: MG64FNLM)xxx12_Proj ect . axf

These are exactly the same!

This is because although new source files have been added to the project, they will (probably)
not be referenced by any code in the project and hence no new functions or data will be included
in the final image. To make use of any new component, some of its new functionality must of
course be referenced.

Note: Some middleware components such as USB, are not compatible with the Add/Remove
component functionality and so will be hidden from the Add/Remove dialogue. The recommended
approach if such components are required is to import an example including the component and
modify as required. This restriction will be addressed in a future release.

SDK Project Refresh

Using the above technology, new in MCUXpresso IDE version 10.2.0 projects can be refreshed
with updated SDK components.

When new SDKs are released for a particular MCU/Board, many source files will be updated,
bugs fixed, features added etc. If an existing SDK is replaced within MCUXpresso IDE by such a
new SDK, any updated (or changed) source files or source file sections can optionally be added
to existing project using an identical mechanism as described above.

To used this feature, simply select a project in the project explorer view and click to Refresh SDK
Components as indicated below.

Figure 8.5. SDK Component Management Project Refresh

oo

5 Project E 82 2, Peripher (il Register <. Symbol ]

» & frdmk64f_bubble

[N I SR TN I'F A PP T Y [Py sy |
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The SDK Component Management wizard will guide you through the update process.
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9. Creating New Projects using Preinstalled Part Support

For Creating project using SDKs please see

To explore the range of preinstalled parts/MCUs simply click ‘New project’ in the QuickStart
panel. This will open a page similar to he figure below:

e o SDK Wizard

M-
| € Please select a target device or a board ‘ L &

|
\ - Board and/or Device selection page

- EDKMCUs Available boards 1313 4

MCUs from installed SDKs Please select an available board for your project

Target

PNEV74628 LPCXpresso812-MAX LPCXpressoB12

~ Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support
Target
»LPC1102
FLPC112x
FLPCT1AXX
»LPC11E6x
»LPC11Exx
»LPC11U6x LPCXpresso845-MAX LPCXpresso824-MAX LPCXpressoB02
»LPC11Uxx
FLPC11xx

k» LPCT 1xxLV /

Selected Device: SDKs for selected MCU

Target Core: Name SDK Version Manifest Versior Location

Description:

.® Cancel

Figure 9.1. New Project Wizard Preinstalled

The list of preinstalled parts is presented on the bottom left of this window.

You will also see a range of related development boards indicating whether a matching board
support library (LPCOpen or CodeBundles) is available.

For details of this page see:

9.1 New Project Wizard

This wizard page provides a number of ways of quickly selecting the target for the project that
you want to create.

In this description, we are going to create a project for an LPC4337 MCU. For this MCU an
LPCOpen library is available, so we can locate this MCU using the board filter. Note: Boards will
be displayed where either LPCOpen or CodeBundle projects exist.
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Note: LPCOpen is described in section

To reduce the number of boards displayed, we can simply type ‘4337’ into the filter so only boards
with MCUSs containing ‘4337’ will be displayed.

e e . SDK Wizard
(@ Creating project for device: LPC4337 using board: LPCXpresso4337 ‘ k i 7
. Board and/or Device selection page

» SDK MCUs Available boards B 4

! elect an available board for your project.
4337

LPCXpressod337

= Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support
NXP LPC4337

LPC4325

LPC4325-M0

LPC4327

LPC4327-M0

LPC4330

LPC4330-M0

LPC4333

LPC4333-M0

LPC4337

Selected Device: LPC4337 using board: LPCXpresso4337 SDKs for selected MCU

Target Core: cortex-m4 Name SDK Version Manifest Versior Location

Description: Multicore Cortex-M4/Cortex-MO based micrecontroller, with up to 1MB
Flash and 136K8 RAM

| @ R | concel

Figure 9.2. New Project Wizard selection for Preinstalled MCUs

When a board is selected as highlighted in the above figure, the matching MCU (part) is also
selected automatically.

Note: if no matching board is available, the required MCU can be selected from the list of
Preinstalled MCUs.

Note: Boards added to MCUXpresso IDE from SDKs will have an ‘SDK’ graphic superimposed
on the board image. Boards without the SDK graphic indicate that a matching LPCOpen package
(or Code bundle) is available for that board and associated MCU.

With a chosen board selected, now click ‘Next’ to launch the next level of wizards. These wizards
for Preinstalled MCUs are very similar to those featured in LPCXpresso IDE and are described
in the next section.

9.2 Creating a Project

MCUXpresso IDE includes many project templates to allow the rapid creation of correctly
configured projects for specific MCUs.
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This New Project wizard supports 2 types of projects:
¢ Those targeting LPCOpen libraries

e Standalone projects

In addition, certain MCUs like the LPC4337 support multiple cores internally, for these MCUs,
Multicore options will also be presented (as below):

Figure 9.3. New project: wizard selection

0@
New project...

LPC43xx (Cortex-M4 basic) -> C Project (Semihosted)

. Wizard selection page.

Wizard
vLPC1800 / LPC4300
¥ PC43xx (Cortex-M4 basic
LPCOpen - C Project
LPCOpen - C Static Library Project
LPCOpen - C++ Project
PCOpen - atic Librarv Proje
C Project (Semihosted
C Static Library Project
C++ Project
C++ Static Library Project
YLPC43xx Multicore M4
LPCOpen - C Project
| PCOpen - C++ Project
C Project
C Project (Semihosted)
C++ Prtzject

@ [ Next>  IEERVYET]

9.21

MCUXpresso IDE User Guide -

You can now select the type of project that you wish to create (see below for details of Wizard
types).

In this case, we will show the steps in creating a simple C ‘Hello World’ example project.

Selecting the Wizard Type

For most MCU families MCUXpresso IDE provides wizards for two forms of project: LPCOpen
and non-LPCOpen. For more details on LPCOpen, see

. For both kinds, the main wizards available are:

C Project

¢ Creates a simple C project, with the min() routine consisting of an infinite wiie(1) loop that
increments a counter.

« For LPCOpen projects, code will also be included to initialize the board and enable an LED.

C++ Project
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9.2.2

9.2.3
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¢ Creates a simple C++ project, with the mai n() routine consisting of an infinite wni1e(1) loop that
increments a counter.

« For LPCOpen projects, code will also be included to initialize the board and enable an LED.
C Static Library Project

¢ Creates a simple static library project, containing a source directory and, optionally, a directory
to contain include files. The project will also contain a “liblinks.xml” file, which can be used by
the smart update wizard on the context-sensitive menu to create links from application projects
to this library project. For more details, please see the FAQ at:

https://community.nxp.com/message/630594

C++ Static Library Project

¢ Creates a simple (C++) static library project, like that produced by the C Static Library Project
wizard, but with the tools set up to build C++ rather than C code.

The non-LPCOpen wizard families also include a further wizard:

Semihosting C Project

« Creates a simple “Hello World” project, with the mai n() routine containing a printf() call, which
will cause the text to be displayed within the Console View of MCUXpresso IDE. This is
implemented using “semihosting” functionality. See the section on for
more information.

Configuring the Project

Once you have selected the appropriate project wizard, you will be able to enter the name of
your new project, this must be unique for the current workspace.

Finally you will be presented with one or more “Options” pages that provide the ability to set
a number of project-specific options. The choices presented will depend upon which MCU you
are targeting and the specific wizard you selected, and may also change between versions of
MCUXpresso IDE. Note: if you have any doubts over any of the options, then we would normally
recommend leaving them set to their default values.

The following sections detail some of the options that you may see when running through a
wizard.

Wizard Options

The wizard will present a set of pages (that will vary based on the chosen MCU), many of these
pages will typically require no user change since the common default values are already preset.
The pages may include:

LPCOpen Library Project Selection

When creating an LPCOpen-based project, the first option page that you will see is the LPCOpen
library selection page.
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o0 e
New project..

@ Select an LPCOpen Chip library project within the current workspace

. Wizard properties page.

Select the LPCOpen Chip and (optionally) Board library project(s) that you want your new project to link against.

Selected library project(s) must be present in this workspace. If they are not, then click the

Impeort...
‘Import’ button to run the Impeort Wizard p

Select LPCOpen Libraries
LPCOpen Chip Library Project Ipc_chip,_43sx ﬁ Browse...

LPCOpen Board Library Project ﬁ Browse.

If a Board Library Project is selected, then the coerresponding Chip Library Project must also be selected

"?} < Back Cancel

Figure 9.4. LPCOpen library selection
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This page allows you to run an “Import wizard” to download the LPCOpen bundle for your target
MCU/board from http://www.nxp.com/lpcopen and import it into your Workspace, if you have not
already done so.

You will then need to select the LPCOpen Chip library for your MCU using the Workspace
browser (and for some MCUs an appropriate value will also be available from the drop down next
to the Browse button). Note: the wizard will not allow you to continue until you have selected a
library project that exists within the Workspace.

Finally, you can optionally select the LPCOpen Board library for the board that your MCU is fitted
to, using the Workspace browser (and again, in some cases an appropriate value may also be
available from the drop down next to the Browse button). Although selection of a board library is
optional, it is recommended that you do this in most cases.

CMSIS-CORE Selection

For backwards compatibility reasons, the non-LPCOpen wizards for many parts provide the
ability to link a new project with a CMSIS-CORE library project. The CMSIS-CORE portion of
ARM'’s Cortex Microcontroller Software Interface Standard (or CMSIS) provides a defined
way of accessing MCU peripheral registers, as well as code for initializing an MCU and accessing
various aspects of functionality of the Cortex CPU itself. MCUXpresso IDE typically provides
support for CMSIS through the provision of CMSIS library projects. CMSIS-CORE library projects
can be found in the Examples directory of your MCUXpresso IDE installation.

Generally, if you wish to use CMSIS-CORE library projects, you should use
CMBI S_CORE_<part fani | y> (these projects use components from ARM’s CMSIS v3.20 specification).
MCUXpresso IDE does in some cases provide libraries based on early versions of the CMSIS
specification with names such as cvsi svip3o_<partfani | y>, but these are not recommended for use
in new projects.

The CMSIS library option within MCUXpresso IDE allows you to select which (if any) CMSIS-
CORE library you want to link to from the project you are creating. Note: you will need to import
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the appropriate CMSIS-CORE library project into the workspace before the wizard will allow you
to continue.

For more information on CMSIS and its support in MCUXpresso IDE, please see the FAQ at:
https://community.nxp.com/message/630589

Note: The use of LPCOpen instead of CMSIS-CORE library projects is recommended in most
cases for new projects. (In fact LPCOpen actually builds on top of many aspects of CMSIS-
CORE.) For more details see

CMSIS DSP Library Selection

ARM’s Cortex Microcontroller Software Interface Standard (or CMSIS) specification also
provides a definition and implementation of a DSP library. MCUXpresso IDE provides prebuilt
library projects for the CMSIS DSP library for Cortex-M0/MO0+, Cortex-M3 and Cortex-M4 parts,
although a source version of it is also provided within the MCUXpresso IDE Examples.

Note: The CMSIS DSP library can be used with both LPCOpen and non-LPCOpen projects.
Peripheral Driver Selection

For some parts, one or more peripheral driver library projects may be available for the target
MCU from within the Examples area of your MCUXpresso IDE installation. The non-LPCOpen
wizards allow you to create appropriate links to such library projects when creating a new project.
You will need to ensure that you have imported such libraries from the Examples before selecting
them in the wizard.

Note: The use of LPCOpen rather than these peripheral driver projects is recommended in most
cases for new projects.

Enable use of Floating Point Hardware

Certain MCUs may include a hardware floating point unit (for example NXP LPC32xx,
LPC407x_8x, and LPC43xx parts). This option will set appropriate build options so that code is
built to use the hardware floating point unit and will also cause startup code to enable the unit
to be included.

Code Read Protect

NXP’s Cortex based LPC MCUs provide a “Code Read Protect” (CRP) mechanism to prevent
certain types of access to internal Flash memory by external tools when a specific memory
location in the internal Flash contains a specific value. MCUXpresso IDE provides support
for setting this memory location. See the section on for more
information.

Enable use of Rrondivide Library

Certain NXP Cortex-MO0 based MCUs, such as LPC11Axx, LPC11Exx, LPC11Uxx, and LPC12xx,
include optimized code in ROM to carry out divide operations. This option enables the use of
these Romdivide library functions. For more details see the FAQ at

https://community.nxp.com/message/630743
Disable Watchdog

Unlike most MCUs, NXP’s LPC12xx MCUs enable the watchdog timer by default at reset. This
option disables that default behaviour. For more details, please see the FAQ at

https://community.nxp.com/message/630654
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LPC1102 ISP Pin

The provision of a pin to trigger entry to NXP’s ISP bootloader at reset is not hardwired on the
LPC1102, unlike other NXP MCUs. This option allows the generation of default code for providing
an ISP pin. For more information, please see NXP’s application note, AN11015, “Adding ISP to
LPC1102 systems”.

Memory Configuration Editor

For certain MCUs such as the LPC18xx and LPC43xx, the wizard will present the option to edit
the target memory configuration. This is because these parts may make use of external SPIFI
Flash memory and hence this can be described here if required. For more information please
see: and also

Note: Memory configuration can of course also be edited after a project has been created.
Redlib Printf Options

The “Semihosting C Project” wizard for some parts provides two options for configuring the
implementation of printf family functions that will get pulled in from the Redlib C library:

¢ Use non-floating-point version of printf
« If your application does not pass floating point numbers to print () family functions, you can
select a non-floating-point variant of printf. This will help to reduce the code size of your
application.
« For MCUs where the wizard does not provide this option, you can cause the same effect by
adding the symbol cr | NTEGER PRI NTF tO the project properties.

¢ Use character- rather than string-based printf

e By default printf() and puts() make use of maiioc() to provide a temporary buffer on the
heap in order to generate the string to be displayed. Enable this option to switch to using
“character-by-character” versions of these functions (which do not require heap space). This
can be useful, for example, if you are retargeting printf() to write out over a UART — since
in this case it is pointless creating a temporary buffer to store the whole string, only to print
it out over the UART one character at a time.

« For MCUs where the wizard does not provide this option, you can cause the same effect by
adding the symbol cr_pri NTF_cHAR tO the project properties.

Note: if you only require the display of fixed strings, then using puts() rather than printf() will
noticeably reduce the code size of your application.

For more information see

Project Created

Having selected the appropriate options, you can then click on the Finish button, and the wizard
will create your project for you, together with appropriate startup code and a simple min. ¢ file.
Build options for the project will be configured appropriately for the MCU that you selected in
the project wizard.

You should then be able to build and debug your project, as described in Section 10.5 and
Chapter 11.
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10. Importing Example Projects (from the file system)

10.1
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MCUXpresso IDE supports two schemes for importing examples:

¢ From SDKs — using the QuickStart Panel -> Import SDK example(s). See

« From the filing system — using the QuickStart Panel -> Import project(s) from file System
« this option is discussed below:

Drag and Drop
@ New in MCUXpresso IDE version 10.2, project(s) can be imported directly into a
workspace by simply dragging a folder (or zip) containing MCUXpresso IDE projects
onto the Project Explorer view. Note: this will import all projects within a folder (or
Zip). Projects can also be exported by dragging directly from the Project Explorer
view onto a filer, or directly into another instance of the IDE. See
for more information.

Note: This option can also be used to import projects exported from MCUXpresso IDE. See

MCUXpresso IDE installs with a large number of example projects for preinstalled parts, that can
be imported directly into a workspace: These are located at:

<install_dir>\ide\ Exanpl es

and consist of:

+ CMSIS-DSPLIB
 asuite of common signal processing functions for use on Cortex-M processor based devices.
CodeBundles for LPC800 family

< which consist of software examples to teach users how to program the peripherals at a basic
level.

FlashDrivers

« example projects to create Flash driver used by LinkServer

e Legacy

» arange of historic examples and drivers including CMSIS / Peripheral Driver Library
LPCOpen

« High quality board and chip support libraries for LPC MCUs, plus example projects

Code Bundles for LPC800 Family Devices

The LPC800 Family of MCUs are ideal for customers who want to make the transition from 8
and 16-bit MCUs to the Cortex MO/MO+. For this purpose, we've created Code Bundles which
consist of software examples to teach users how to program the peripherals at a basic level. The
examples provide register level peripheral access, and direct correspondence to the memory
map in the MCU User Manual. Examples are concise and accurate explanations are provided
within the readmes and source file comments. Code Bundles for LPC800 family devices are
made available at the time of the series product launch, ready for use with a range of tools
including MCUXpresso IDE.

More information on code bundles together with latest downloads can be found at:

https://www.nxp.com/LPC800-Code-Bundles
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10.2

10.3
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LPCOpen Software Drivers and Examples

LPCOpen is an extensive collection of free software libraries (drivers and middleware) and
example programs that enable developers to create multifunctional products based on LPC
microcontrollers. Access to LPCOpen is free to all LPC developers.

Amongst the features of LPCOpen are:

¢ MCU peripheral device drivers with meaningful examples

* Common APIs across device families

« Commonly needed third party and open source software ports

¢ Support for Keil, IAR and LPCXpresso/MCUXpresso IDE toolchains

LPCOpen is thoroughly tested and maintained. The latest LPCOpen software now available
provides:

« MCU family-specific download package

¢ Support for USB ROM drivers

« Improved code organization and drivers (efficiency, features)

¢ Improved support for MCUXpresso IDE

CMSIS / Peripheral Driver Library / code bundle software packages are still available, from
within your MCUXpresso IDE install directory in \ide\Examples\Legacy . But generally, these
should only be used for existing development work. When starting a new evaluation or product
development, we would recommend the use of LPCOpen if available.

More information on LPCOpen together with package downloads can be found at:

http://www.nxp.com/Ipcopen

Importing an Example Project

To import an example project from the file system, locate the QuickStart panel and select ‘Import
projects from Filesystem’
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Figure 10.1. Importing project(s)

From here you can browse the file system.
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[ JoN ] Impaort project(s)

Import project(s) i o
Select the examples archive file to import. / /'

Projects are contained within archives (.zip) or are unpacked within a directory. Select your
project archive or root directory and press <Mext=. On the next page, select those projects you
wish to import, and press <Finishz.

Project archives for LPCOpen and 'legacy’ examples are provided.

Project archive {zip)

Archive \ Browse...

Project directory (unpacked)

Root directory Browse...

LPCOpen

LPCOpen is the recommended code base for Cortex-M based NXP LPC Micracontrollers.

MCUXpresso IDE includes the LPCOpen packages which can be imported directly by pressing the Browse
button in the Project archive (zip) section, above, and navigating to the Examples/LPCOpen directory.

Alternatively, press the button below to Browse the nxp.com website for latest resources.

Browse LPCOpen resources on nxp.com...

A
@ Cancel

Figure 10.2. Importing examples
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* Browse to locate Examples stored in zip archive files on your local system. These could
be archives that you have previously downloaded (for example LPCOpen packages from
http://www.nxp.com/Ipcopen or the supplied, but deprecated, sample code located within the
Examples/Legacy subdirectory of your MCUXpresso IDE installation).

* Browse to locate projects stored in directory form on your local system (for example, you can
use this to import projects from a different Workspace into the current Workspace).

« Browse LPCOpen resources to visit http://www.nxp.com/lpcopen and download an
appropriate LPCOpen package for your target MCU. This option will automatically open a web
browser onto a suitable links page.

To demonstrate how to use the Import Project(s) functionality, we will now import the LPCOpen
examples for the LPCXpresso4337 development board.

Importing Examples for the LPCXpresso04337 Development Board

First of all, assuming that you have not previously downloaded the appropriate LPCOpen
package, click on Browse LPCOpen Resources, which will open a web browser window. Click
on LPC4300 Series, and then locate NXP LPCXpresso04337, and then download 2.xx version
for LPCXpresso Toolchain (LPCOpen packages created for LPCXpresso IDE are compatible
with MCUXpresso IDE).

Note: LPCOpen Packages for the LPC4337 are preinstalled and located at:

<instal |l _dir>\ide\ Exanpl es\ LPCOpen\. ..

Once the package has downloaded, return to the Import Project(s) dialog and click on the Browse
button next to Project archive (zip); then locate the LPCOpen LPCXpresso4337 package
archive previously downloaded. Select the archive, click Open and then click Next. You will then
be presented with a list of projects within the archive, as shown in Figure 10.3.
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Figure 10.3. Selecting projects to import
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@ < Back cancel | (EEEINN
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Select the projects you want to import and then click Finish. The examples will be imported into
your Workspace.

Note: generally, it is a good idea to leave all projects selected when doing an import from a zip
archive file of examples. This is certainly true the first time you import an example set, when you
will not necessarily be aware of any dependencies between projects. In most cases, an archive
of projects will contain one or more library projects, which are used by the actual application
projects within the examples. If you do not import these library projects, then the application
projects will fail to build.

Exporting Projects

MCUXpresso IDE provides the following export options from the QuickStart panel:

e Export project(s) to archive (zip)
« Export project(s) and references to archive (zip)

« choose this option to export project(s) and automatically also export referenced libraries
To export one or more projects, first select the project(s) in the Project Explorer then from the
QuickStart Panel -> Export project(s) to archive (zip). This will launch a filer window. Simply
select the destination and enter a name for the archive to be exported then click ‘OK’.

Also please see for information about dragging and
dropping projects.

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide

Rev. 10.2.0 — 14 May, 2018 83



NXP Semiconductors MCUXpresso IDE User Guide

10.5 Building Projects

Building the projects in a workspace is a simple case of using the Quickstart Panel to “Build all
projects”. Alternatively, a single project can be selected in the ‘Project Explorer’ View and built.
Note: building a single project may also trigger a build of any associated or referenced project.

10.5.1 Build Configurations

By default, each project will be created with two different “build configurations”: Debug and
Release. Each build configuration will contain a distinct set of build options. Thus a Debug build
will typically compile its code with optimizations disabled ( - ) and Release will compile its code
optimizing for minimum code size ( -cs). The currently selected build configuration for a project
will be displayed after its name in the QuickStart Panel's Build/Clean/Debug options.

For more information on switching between build configurations, see
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11. Debugging a Project

11.1

11.1.1
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This chapter describes many of the common debug features supported by the debug solutions
within MCUXpresso IDE. Please also refer to the chapter for
more details of the supported debug solutions and management of debug operations.

Debugging Overview

A debug operation requires a physical connection between the host computer and the target
MCU via a debug probe. The debug probe translates the high level commands provided by
MCUXpresso IDE into the appropriate low level operations supported on the target MCU.

This connection to the debug probe is usually made via USB to the host computer (although IP
probes from P&E and SEGGER are also supported). Some debug probes such as LPC-Link2
or SEGGER J-Link Plus are separate physical devices, however many LPCXpresso, Freedom,
Tower, EVK boards also incorporate a built in debug probe accessed by one of the development
boards USB connections.

Note: If a separate debug probe is used, you must ensure that the appropriate cables are used
to connect the debug probe to the target board, and that the target is correctly powered.

Typically, an on board debug probe connection will also provide power to the development board
and target MCU. In contrast, an external debug probe will not usually power the target, and
a second connection (often USB) will be required to provide power to the board and MCU.
Some external debug probes such as the LPC-Link2 can also provide power to the target board
— this is enabled by connecting the link JP2. For other debug probes, refer to their supplied
documentation.

External debug probes will usually provide superior features and performance compared to on-
board debug probes, however please note that LPCXpresso V2 and V3 boards incorporate a full
featured LPC-Link2 debug probe.

Note: Some LPCXpresso development boards have two USB connectors fitted. Make sure that
you have connected the lower connector marked DFU-Link. Many Freedom and Tower boards
also have two USB connectors fitted. Make sure that you have connected to the one marked
‘OpenSDA’ - this is usually (but not always) marked on the board. If in doubt, the debug processor
used on these designs is usually a Kinetis K20 MCU, it is approximately 6mm square. The USB
nearest this MCU will be the OpenSDA connection.

Debug Launch

To debug a project on your target MCU, simply highlight the appropriate project in the ‘Project
Explorer’, and then in the Quickstart Panel click on the large Debug, as in Figure 11.1,

alternatively click the blue bug icon % to perform the same action.
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. New project...
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~ Debug your project .' EH' H'

ﬁ ‘#‘ Debug
ﬂ" Terminate, Build and Debug

~ Miscellaneous

¥ Edit project settings

& Quick Settings>>

B Export project(s) to archive (zip)

P Export project(s) and references to archive (zip)
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Figure 11.1. Launching a debug session

Note: The green bug icon should not be used because this invokes the standard Eclipse debug
operation and so skips certain essential MCUXpresso IDE debug steps.

For a newly created project a debug operation will perform a number of steps. By default, it will
first build the selected project and (assuming there are no build errors) launch a debug probe
discovery operation (see next section) to allow the user to select the required debug probe. A
launch configuration file will automatically be created with default options (per build configuration)
and will be associated with the project. Like a projects build configuration, launch configuration
files control what occurs each time a debug operation is performed. Please see the section

for more information.

Note: This default behaviour can be changed by editing the Workspace preference located at
Preferences -> Run/Debug -> Launching -> Build (if required) before launching. For individual
projects, the Main tab of the launch configuration allows the workspace preference to be
overridden.

By default, once a debug probe has been selected (and ‘OK’ clicked) the binary contents of
the .axf file will automatically be downloaded to the target via the debug probe connection.
Typically, projects are built to target MCU Flash memory, and in these cases, a suitable Flash
driver will automatically be selected to perform the Flash programming operation. Next a default
breakpoint will be set on the first instruction in nai n() , the application will be started (by performing
or simulating a processor reset), and code will be executed until the default breakpoint is hit. See
the section on for additional information.

11.1.2 Debug Probe Selection Dialog (Probe Discovery)

The first time you debug a project, the IDE will perform a probe discovery operation and display
the discovered Debug Probes for selection. This will show a dialogue listing all supported probes
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that are attached to the host computer. In the example shown in Figure 11.2, a LinkServer (LPC-
Link2), a P&E Micro Multilink and also a J-Link (OpenSDA) probe have been found.

[ SN Probes discovered
Connect to target: MK64FN 1IMOxxx12
3 probes found. Select the probe to use:

Available attached probes

Name Serial number/ID Type Manufactur IDE Debug Mode
B8 LPC-LINK2 CMSIS-DAP V5.18 IWFUATEW LinkServe NXP SemiNon-Stop
4 USB1 - Multilink Universal Rev PEM834663 UsBe1 P&E Micrc All-Stop
J-Link OpenSDA 621000000 use SEGGER All-Stop

Supported Probes {tick/untick to enable/disable)

MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again
Remember my selection (for this Launch configuration)

'\?/ Cancel

Figure 11.2. Attached probes: debug emulator selection
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Note: if only one probe is found, it will be selected automatically, so simply click OK or hit return
to use the probe displayed.

MCUXpresso IDE supports unique debug probe association.

Debug probes can return an ID (Serial number) that is used to associate a particular debug
probe with a particular project. Some debug probes will always return the same ID, however
debug probes such as the LPC-Link2 will return a unique ID for each probe — in our example
IWFUALEW.

For any future debug sessions, the stored probe selection will be automatically used to match the
project being debugged with the previously used debug probe. This greatly simplifies the case
where multiple debug probes are being used.

However, if a debug operation is performed and the previously remembered debug probe cannot
be found, then a debug probe discovery operation will be performed from within the same family
e.g. LinkServer, P&E or SEGGER.

See also

Sometimes a probe discovery will find no debug probes and return a dialogue as below:
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[ ) [ ) Probes discovered

Connect to target: LinkServer

€3 LinkServer not found.
This could be because it is disconnected, not powered, or already in use

Available attached probes

Name Serial number/ID Tvpe Manufactur IDE Debug Mode

Supported Probes (tick/untick to enable/disable)
MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes

Probe search options
Search for LinkServer again Search for any enabled probe
@ Cancel

s/

Figure 11.3. LPC-Link2 no longer connected

11.1.3

MCUXpresso IDE User Guide -

This might have been because you had forgotten to connect the probe, in which case simply
connect it to your computer and select Search again. If you are using a different debug probe
from the same family of debug probes, simply select the new probe and this will replace the
previously selected probe.

Notes:

« The “Remember my selection” option is enabled by default in the Debug Emulator Selection
Dialog, and will cause the selected probe to be stored in the launch configuration for the current
configuration (typically Debug or Release) of the current project. You can thus remove the
probe selection at any time by simply deleting the launch configuration.

« You will need to select a probe for each project that you debug within a Workspace (as well
as for each configuration within a project).

« If you wish to debug a project using a different family of debug probe(s), then the simplest
option is to delete the launch configuration files associated with the project and start a debug
operation. Please see the section "An Introduction to for more
information. Please also see

Controlling Execution

When you have started a debug session a default is set on the first instruction
in mai n(), the application is started (by simulating or performing a processor reset), and code is
executed until the default "breakpoint is hit.

Program execution can now be controlled using the common debug control buttons, as listed

in Table 11.1, which are displayed on the global toolbar. The call stack is shown in the Debug
View, as in Figure 11.4.
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OB ]

DR 1 TR O’o 1 - . v O

45 Debug 2

v [ frdmk64f_driver_examples_gpio_led_output LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application)
v :’S,.J‘frdmktfiﬂf_dri\;ro:-.'r_e::tampIes_gpic)_lnc_rd_cmtpu’(.;mC [MKBAFN1MOxxx12 (cortex-md)]
¥ # Thread #1 1 (Stopped) (Suspended : Signal : SIGINT:Interrupt)
= delay() at gpio_led_output.c:61 0x806
= main() at gpio_led_output.c:91 0x852
w arm-none-eabi-gdb (7.12.0.20161204)

Figure 11.4. Debug controls and Debug Call Stack

Table 11.1. Program execution controls

Button Description Keyboard Shortcut
& Restart program execution (from reset)
T Run/Resume the program F8
i Pause Execution of the running program
Terminate the debug Session Ctrl + F2
LY Clean up debug
Ui =) Run, Pause, Terminate all debug sessions
2 Step over a C/C++ line F6
= Step into a function F5
N Return from a function F7
o @ Step in, over, out all debug sessions
= Show disassembled instructions
Tip
Clean up debug will kill all debug processes associated with LinkServer, P&E and
SEGGER debug connections. This button can be used in the event of a debugging
crash to remove any failed processes that remain. Note: a warning will be issued
with the option to cancel before any action is performed since this action will kill all
connected debug sessions.
Note: The debug controls for ‘all’ debug sessions will perform identically to their single session
counterparts if only one debug session exists.
Note: Typically a user will only have a single active debug session. However if there is more
than one debug session, the active session can be chosen by clicking within the debug call stack
within the Debug view. All debug views will reflect the selected session.
Setting a breakpoint
To set a breakpoint, simply double-click on the left margin area of the line on which you wish to
set the breakpoint (before the line number).
Restarting the application
If you hit a breakpoint or pause execution and want to start execution of the application from the
beginning again, you can do this using the Restart button.
Stopping debugging
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To stop debugging just press the Terminate/Stop button. This action will disconnect
MCUXpresso IDE from the target (board). The subsequent behaviour is controllable by the

Pause debugging

Typically, debugging is paused due to the action of a or
since these will be set to observe the target when an event of interest has occurred. However,
the pause button can be used to pause the target at an instant of time.

To pause debugging

If you are debugging using the Debug Perspective, then to switch back to the C/C++
Perspective when you stop your debug session, just click on the C/C++ tab in the upper right
area of MCUXpresso IDE (as shown in Figure 3.2).

Launch Configurations

Launch Configuration files will be automatically created within the root directory of a project the
first time a debug operation is performed. They will typically be named:

{proj nanme} { debug sol uti on}Debug. | aunch
{proj nane} {debug sol uti on}Rel ease. | aunch

A file will be created for each build variant, and used to store the settings for the debug connection
for that build configuration.

Normally, there is no need to edit launch configurations, as the default settings created by the
IDE will be suitable. However, in some circumstances, you may need to manage them — typically
under direction from an FAQ. In such cases this can be done via the “Launch Configurations”
entry on the context sensitive menu available from the Project Explorer view...

[~ Project Explorer 52 7, Peripherals+ !} Registers . Symbol Viewer
| " frdmked_d -

» 4 Binaries New

»iIncludes GO Into
»ECMSIS | 5pen in New Window
> 2 accel
> _i board 2 Copy %G
> (B drivers Paste
¥ £ source
» [£ bubbl ® Delete =
» 2 startup Source »
» Butilities | Move.
» (= Debug Rename... F2
> & doo v Import..
B framke4 . P launch
W irdmked = Expart... elaunch
Build Project
Clean Project
Refresh
Close Project

Close Unrelated Projects

Build Configurations >
Build Targets >
Index »
Run As >
Debug As >
Profile As >
Restore from Local History...
Launch Configurations Ol & Edit... >
Smart update > ## Create new... >
Utilities b # Create and edit new... >
Eo\s . > # Delete... >
%’ Run C/C++ Code Analysis % Delete JTAG configurations... >
Team »
Compare With >
Configure >
Properties E
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Note: to view the contents or edit an existing launch configuration file, you can also simply double
click it.

A number of options are available here:

Edit...

< Allows various debug settings to be modified
» Typically not required since the default options will be correct for most debug operations

Create new...

¢ Create a launch configurations for a particular debug solution, if they do not already exist.

« Normally you will not need this option as it is carried out automatically the first time that you
debug your project. However, if you want the flexibility to debug a project with different debug
solutions for example, LinkServer and SEGGER, then both sets of launch configurations
can be created. On the next debug operation, the user can select the launch configuration
to use for that session.

Create and edit new...

¢ Allows new launch configurations to be created and immediately opened for editing.

Delete...

« Allows the launch configurations for the selected project (or projects) to be deleted.

¢ This can be useful as it allows you to put the debug connection settings back to the default
after making modifications for some reason, or if you are moving your project to a new version
of the tools, and want to ensure that your debug settings are correct for this version of the tools.

Delete JTAG Configuration...

¢ Allows the JTAG configuration files for the selected project (or projects) to be deleted. These
files are stored in the Debug/Release subdirectories.

11.2.1 Editing a Launch Configuration (LinkServer)
WARNING: - Modifying the default settings for a launch configuration can prevent a successful
debug connection from being made.
After selecting the “Edit...” or “Create and edit New” launch configuration menu entry, you will
then see a new dialog box pop up, which looks similar to the following...
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L EoN ) Edit Configuration

Modify configuration and continue.

Name: | MKBA4FN1MOx0x1 2_Project Ling

B MCuUXpresso IDE LinkServer Debugger

Stop on startup at: | main Request hardware breakpoint

M

Debug options for NXP MKBAFN1MOxxx12 (cortex-ma)

Debugger Options

Debug Connection SWD ¥

Canfiguration Optian ~ Value

«] Additional options

i| Attach only False

a4 Connect Seript kinetisconnect.scp
st Debug Level 2

i-| Debugger memary cache Disable

i-| Disconnect behavior cont

2| Flash Driver Reset Handling

| Load image True

Miscellaneous
Emulator selection | LinkServer v

Edit scripts...

Debug options template

Debug Configuration (*)

Revert

@ Cancel

Most settings that you may need to modify can be found in the Debugger tab, in the Target
configuration sub-tab (as shown in the above screenshot).

Some examples of modifications that you may need to make in particular circumstances are:

¢ Changing the initial

on debug startup

* When the debugger starts, it automatically sets an initial (temporary) breakpoint on the first
statement in main(). If desired, you can change where this initial breakpoint is set, or even

remove it completely.
* Modifying the Debugger connect behavior
 via a Connect Script e.g. kinetisconnect.scp
« Connecting to a target via JTAG rather than SWD

« if supported by the target, you can edit the Debug type

¢ Connecting to a running target
« set Attach only to True (see also

Common Debug Operations and Launch Configurations

Where possible MCUXpresso IDE attempts to provide a common debug experience regardless
of the debug solution being used. However some debug tasks require launch configuration
modifications and these will be different for each debug solution. In this section, some common

debug operations are discussed for each debug solution.

Debug Quickstart Shortcuts

New in MCUXpresso IDE version 10.2 are Quickstart debug shortcuts. These buttons request

actions only from their respective debug solutions.
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) Quickst Globa Variable Breakp OQutine = B

MCUXpresso IDE - Quickstart Panel
e )| Project: evkbimxrt1050_ig_pio_led_autput [Debugl |

+* Create or import a project

. . New project...
. ]
ﬂ Import SDK example(s)...
® Import project(s) from file system...

~ Build your project
@ & Build
& Clean
~ Debug your project

‘#‘ Debug N
ﬂ:‘ Terminate, Bu [ Debug using LinkServer probes (CTRL+SHIFT+L)
B8 Attach to a running target using LinkServer (CTRL+ALT+L)
~ Miscellaneous B Program flash action using LinkServer

E‘::" Edit project settings B Erase flas_h gction using LierServer .
& Quick Settings> > r
A} Export project(s) to archive (zip)

. Export project(s) and references to archive (zip)

oy Build all projects [Debug]

Each button provides the same 4 options for each debug solution:

Debug (default) : make a Debug connection to the chosen debug probe. A launch configuration
will be created if not present. The attach mode will be set to False. Note: a normal debug
operation will inherit a launch configurations attach setting, whereas this operation will force
attach mode to False. If a launch configuration already exists, its attach setting will be set to
False, no other changes will be made.

Attach : make an Attach connection to a LinkServer compatible debug probe. A launch
configuration will be created if not present. The attach mode will be set to True. The launch

configuration will be given a A decorator to show that Attach is the set configuration. # button.
If a launch configuration already exists, its attach setting will be set to True, no other changes
will be made.

Program Flash : perform the launch configuration Program action, by default this will program the
‘project’ into flash. The selected project will be built if required and a default launch configuration
will be created if one is not present.

Erase Flash : perform the launch configuration Erase action, by default this will erase the flash
memory via a mass erase. A default launch configuration will be created if one is not present.

Tip

@ If an attach operation is performed, the created launch configuration will have Attach
setto True. Therefore any subsequent debug operations will be in Attach Mode, until
either the launch configuration is edited to set Attach to false, or the Debug short cut
is used again to force the attach mode to false.
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11.3.2 Connecting to arunning Target (attach)

A typical debug session will begin by downloading code to Flash and then debugging from main()
onwards. However, to explore an already running system a debug connection (attach) can be
made to the target MCU without affecting the code execution (at least until the user chooses to
halt the MCU!).

Note: Source level debug of a running target is only possible if the sources of the project to be
attached exactly match the binary code running on the target.

Important Note: Please be sure to read and understand the section on
and also the implications in the related section on

LinkServer

Edit the project launch configuration by double clicking on the launch config file, select the
Debugger tab and Target configuration view, then set the ‘Attach only’ setting to True as below:

Edit Configuration

Modify configuration and continue. ﬁ‘v

1| Name: | MK64FN1MQuaioRiala

||| B MCuXpresso IDE LinkServer Debugger

arver Debug

||| E) Main | Comm (> GUI Flash Tool | i~ Source

Stop on startup at: | main Request hardware breakpoint

Debug options for NXP MKG64FN 1M0xxx12 (cortex-md)

| Debugger Options

Debug Connection SWD |¥

Configuration Option ~« Value
- Additional options

iz Attach only True v
i a4 Connect Script True '
at]: Debug Level False

- Debugger memory cache
i Disconnect behavior cont

When a debug connection is made, the target will continue running until it is paused. However,
if the IDE Debug Mode is set to Non-Stop (the default) then Global variables values can be
explored and displayed.

Other operations such as ITM console 10 will also function. See the LinkServer SWO Trace
Guide for further information.

P&E

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, then set the ‘Attach to a running target’ check box as below:
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Modify configuration and continue.

Edit Configuration

Name: MKB4FN1MOxxx12_Project PE Debug
[ Main '1} Debugger | € GUI Flash To@:j Source| (] Common
Semihosting Settings

Enable semihasting Console routed to: Telnet

Enable Telnet console Telnet Port:

GDB client
51794

Load Symbols and Executable
Load symbols
° Use project binary: MK6&4FN1MOxxx12_Project.axf

") Use file:

Symbols offset (hex):
Load executable
o Use project binary: MKB64FN1MOxxx12_Project.axf

Use file:

Executable offset (hex):

Runtime Options

[ Attach to Running Target ]
Set PC (absolute hex address or symbol):

Run on reset

Set breakpoint at:  main
GDB run commands:

¥

When a debug connection is made, the target will continue running until it is paused.

SEGGER JLink

Edit the project launch configuration by double clicking on the launch config file, select the
Debugger tab, then set the ‘Attach to a running target’ check box as below:

MCUXpresso IDE User Guide -

Modify configuration and continue.

Edit Configuration

i, By using attach mode any ‘monitor reset' command will be ignered.

Name: Gemeel, Project JLink Debug

> GUI Flash Tool | b= Startup | % Source| ] Common

JLink Interface Settings

JLink Interface Quss 1P

Device MKB4FNTMOx012 B
Target Interface SWD B

Speed adaptive @auto (fixed

GDB Server Settings

Server startup and port selection () auto manual

GDB Sarver Port

SWO Port

Telnet Part

Endianess little
Disconnect behaviour Run B

Power Target Enable Semihosting
GDB Client Settings
Halt target on startup
GDB Client Port

Initialize CPU registers

Additional Options

Request hardware breakpoint for stop on startup symbol/address

o

Silent Verify (@ Single fhn B3 Attach to a running target

seript Browse

Select RTOS plugin
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11.3.3 Controlling the initial Breakpoint (on main)
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When the debugger starts, it automatically sets an initial (temporary) breakpoint on the first
statement in main(). If desired, you can change where this initial breakpoint is set, or even remove
it completely. One common requirement is to debug an application from startup. The entry point
(startup) in an standard example application can be identified by a symbol called ResetISR, a
breakpoint can be set on this symbol to halt execution at the first instruction within an application.

LinkServer

To debug from the start of the image, edit the project launch configuration by double clicking on
the launch config file, select the Debugger tab, replace main with ResetISR

|5 Mal Debu GUI Flash Teol | ] Common | & Source

B mcCuXpresso IDE LinkServer Debugger

Stop on startup & ResetlSFi Request hardware breakpoint

Debugger Options

When a debug connection is made, the target should halt at this symbol.

To disable the initial breakpoint, uncheck the option ‘Stop on startup at...". To restore the original
behaviour, replace the symbol ResetISR with main, and check the option ‘Stop on startup at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

P&E

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, replace main with ResetISR

[ Main [35 Debugger | € GUI Flash T i Startup 5 Bource | T Common

Seminosting Settings

Enable semihosting  Console routed to; Telnet GDB client
Enable Telnet console Telnet Port: 51794

Loag Symbols and Executadie
Load symbols
© Use project binary: MKE4FN1MOxxx12_Project.axi

Use file:

Symbols offset (hex):
Load executable
O Use project binary: MKE4FN1MOxxx12_Project.axf

Use file:
Executable offset (hex):

Runtime Options

Attach to Running Target Run on reset

Set P (absolte hex aress orsymbo: S I
GDB run commands:

When a debug connection is made, the target should halt at this symbol.

To disable the intial breakpoint, uncheck the option ‘Set breakpoint at...". To restore the original
behaviour, replace the symbol ResetISR with main, and check the option ‘Set breakpoint at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

SEGGER JLink

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, replace main with ResetISR
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[5) Main | %5 Debugger | € GUI Flash To Source | ] Commen
Initialization Commands

Reset and Delay (seconds): 3
Halt
meonitor reset

Load Image and Symbols

Load image

O Use project binary: MKB4FN1MOxxx12_Project.axi
Use file:

Image offset (hex):

Load symbols

© Use project binary: MKE4FN1MOxxx12_Project.axi
Use file:

Symbols offset (hex):

Run Commands

Set program counter at (hex):

bt il

When a debug connection is made, the target should halt at this symbol.

To disable the initial breakpoint, uncheck the option ‘Set breakpoint at...". To restore the original
behaviour, replace the symbol ResetISR with main, and check the option ‘Set breakpoint at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

Disconnect Behaviour

Once the user has completed a debug session, the debugger connection can be terminated via
the IDE’s Terminate button! The exact behaviour of the target will depend on the particular debug
solution.

LinkServer

For LinkServer, the launch configuration contains a set of options to control what the target should
do when terminated. The default option is for the target to continue running from the current PC
value, however this can be changed by selecting a new setting within the launch configuration.

1 i 5 Sowoe ) Comnf Oubigin, € o Fash T

B McuXpresso IDE LinkServer Debugger

Stop on startup at:  main Request hardware breakpoint

Debug options for NXP MKB4FN1MOxxx12 (cortex-md)

Debugger Options

Debug Connection |SWD ¥

Contiguratian Option ~ value
abi: Additional options

i| Attach only False
at Connect Script kinetisconnect.scp

abl- Debug Level

............. Dicahl

connect behavior cont b

= Flash Driver Resetl Hanaling HQChEFQE
i Load image stop

Miscellaneous

Where:

* nochange - will leave the target in its current state

« stop - will leave the target in debug state i.e. halted

e cont - the default, will either start the image from its current PC value or leave it running
e run cont - will reset the target and let it run
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P&E

The Terminate button will force the target to halt. Alternatively, for P&E debug the IDE supports
another option — to disconnect and force the target to run. This can be achieved via the IDE’s

disconnect ' button.
SEGGER JLink

The target will Run on disconnect by default. The launch configuration option, Disconnect
behaviour can be changed to Halt causing the target to halt on disconnect.

11.3.5 Project Flash Programming

New in MCUXpresso IDE version 10.2.0 — launch configuration dialogues now contain a GUI
Flash Tool tab. This along with the and
provide access to the flash programming capabilities each of the supported debug solutions.

For each debug solution, the options will vary slightly but the presentation is broadly the same
as shown below. These options are self describing.

[ ain f}Denugge Startup 5 Source. ] Common
GUI Flash™TO0
{ D, Program e@g into flash Debug/MK64FN1MOxxx12_Project.axf

Target: MKGAF! IL
B a5 o R > o e B o
T"“E' ng 3 GUI Flash TG0
| Program file into flash: Debug/MK64FN1MO0xxx12_Project.axf
Prog Erase| R

Options @
P Target: MK64, %ﬂ 2
Select the options ta.

Format to use for pf Turget OpSEon —
Pl Select the target fiash | IE) Main (%5 Debugger (& Suur [] Common

Base Address Program E,,s,L GUI Flash Tool

Reset target on Program file into @ Debug/MK64FN1MOxxx12_Projectaxf

Actions
Select the action i

O crose, blankd| 1419 \nxeaww@e

General Options Program andi| Target Op
Flash programming tod Verify Only Selegt th flash operation to perform
Preview command| =
Options
- Seleet the options) Actions
Select the action to perform

Erase| Resurrect locked Kinetis device

Reset target ¢
] © program Program (mass erase first)

Verify only Check file areas blank

General Options Options
Flash programming tf Select the options to apply

Preview comman Format to use for programming @ axf () bin

Base address

. |

Reset target on completion

General Options.
Flash programmming tool options

Preview command Clear console

To perform the selected operation, simply click the Run button.

Important Note: By default, a launch configuration will be created with Program as the default
Program action, and Mass Erase as the default Erase action. When settings are changed by the
user they will be stored within that project’s launch configuration and will remain until manually
changed (or the launch configuration is deleted). When are used, they
will action the current settings within the selected projects launch configuration (or if none exists,
create a new default launch configuration) - therefore if the Program action is set to Verify, a
Verify will be performed as the Program action.

11.4 Breakpoints

When viewing source (or disassembly) during a debug session, you can toggle breakpoints by
simply clicking/double clicking in the left most side of the source view, typically shown as a light
blue column. This is also where the breakpoint symbol is shown when one is set. This can be
done when the target is paused or running.
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11.4.1

11.4.2
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Breakpoints (and Watchpoints) are also displayed, and can be deleted or disabled in the
Breakpoints View. If you are using the “Develop” perspective, then by default it will be in the
bottom left of the MCUXpressolDE window tabbed with the Quickstart and other views

If you have closed the Breakpoint view at some point, then you can re-open it using the “Window
-> Show view” menu or ‘Window -> Perspective -> Reset Perspective".

Breakpoint Types

At a basic level there are 2 types of breakpoints:

e Hardware: these are limited in quantity but can be set on ROM (Flash) or RAM. These
breakpoints are provided by the debug hardware built into to the CPU.

e Software: these are implemented by a software instruction BKPT and can in normal
circumstances only be placed on addresses within RAM (since the underlying code must be
changed). These breakpoints can be applied in any quantity and are invisibly placed (and
removed) by the debugger.

Usually the debugger will automatically decide the best breakpoint to use for a particular memory
type or circumstance and this is invisible to the user.

Simplistically, Software breakpoints will be placed in RAM and Hardware breakpoints are placed
in ROM (Flash).

Tip

@ On some systems, a bootloader may copy code from ROM into RAM for execution —
if a symbol within this code is breakpointed — such as main(), then the debugger may
select a software breakpoint since it knows that main() will reside in RAM. A problem
can arise if the software breakpoint is set by the debugger before the bootloader has
relocated the code. If this occurs, any software breakpoint will be overwridden by
the relocated code. New in MCUXpresso IDE version 10.2.0 is support for

- to ensure this problem does not arise in this case, MCUXpresso

IDE will force a hardware breakpoint onto main(). This will not be overridden since
this breakpoint type makes no changes to memory.

Breakpoints Resources

When debugging code running from Flash memory, the debugger is limited on how many
breakpoints it can set at any time by the number of hardware breakpoint units provided by the
ARM CPU within the MCU.

Note: Code located in RAM can use a different breakpoint mechanism offering the capability of
essentially unlimited breakpoints.

Typically, the number of hardware breakpoints/watchpoints that can be set are as follows:

Cortex- M)/ M+ (LPC) - 4 breakpoints, 2 watchpoints
Cortex- M)/ M+ (Kinetis) - 2 breakpoints, 1 watchpoints
Cor t ex- M3/ M4/ M7 - 6 breakpoints, 4 watchpoints

ARM does provide a level of implementation flexibilty, so always consult your MCU
documentation.

If you try to set too many breakpoints/watchpoints when debugging, then the precise behaviour
will depend on the debug solution you are using. For LinkServer an error of the form below will
be generated.

15: Target error from Set break/watch
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Unabl e to set an execution break - no resource avail able.

To fix the problem, simply remove the excess breakpoint(s).

Also remember that a breakpoint will be (temporarily) required for the initial breakpoint set by
default on the function main() when you initially debug your application. A breakpoint may also
be required (temporarily) when single stepping code.

Note: When the target is paused, any number breakpoints may be set within the source or
disassembly views of the IDE, however only when the target is Resumed (Run) will the low level
debug hardware attempt to set the required breakpoints. Therefore it is possible to request many
more breakpoints that are supported by the target MCU leading to the error described above.

11.4.3 Skip All Breakpoints
You can use the “Skip all breakpoints” button ® in the Breakpoints view (or on the main toolbar)
to temporarily disable all breakpoints. This can be particularly useful on parts with only a few
breakpoints available, particularly when you want to reload your image, which will typically cause
the default breakpoint on main() to be temporarily set again automatically by the tools.
11.5 Watchpoints
Watchpoints are Breakpoints for Data and are often referred to as Data Breakpoints. Watchpoints
are a powerful aid to debugging and work by allowing the monitoring of global variables,
peripheral accesses, stack depth etc. The number of watchpoints that can be set varies with the
MCU family and implementation.
Watchpoints are implemented using watchpoints units which are data comparators within the
debug architecture of an MCU/CPU and sit close to the processor core. When configured they
will monitor the processor’s address lines and other signals for the specific event of interest. This
hardware is able to monitor data accesses performed by the CPU and force it to halt when a
particular data event has occurred.
The method for setting Watchpoints is rather more hidden within the IDE than some other
debugging features. One of the easiest ways to set a Watchpoint is to use the Outline View,
which by default this will be located within the IDE Quickstart panel.
From this view you can locate global and static variables then simply select Toggle Watchpoints.
) Quickst 9= Global (=Variabl % Breakp 5= Qutline 22| = O
SRR TN T
& LPC8xx.h
2 cr_section_macros.h
H stdio.h
;. gl01 : ItI unsigned int Open Declaration =
main{void) : int Open Call Hierarchy ~%H
Open Include Browser |
Refactor >
Declarations >
References >
&3 Toggle Watchpoint
Launch Configurations >
Smart update >
| Utilities >
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Once set, they will appear within the Breakpoint pane alongside any breakpoints that have been
set.

Watchpoints can be configured to halt the CPU on a Read (or Load), Write (or Store), or
both. Since watchpoints ‘watch’ accesses to memory, they are suitable for tracking accesses to
global or static variables, and any data accesses to memory including those to memory mapped
peripherals.

Note : To easily distinguish between Breakpoints and Watchpoints within the Breakpoint view,
you can choose to group entries by Breakpoint type. From within the Breakpoints view, click the
Eclipse Down Arrow Icon Menu, then you can select to Group By Breakpoint Types as shown
below:

W) Quic ®=Glo ®=Vari 0= Outl |% Bre 22| = B 67 * Bbrief main routine for blinky example

68 * @return Function should not exit.
&£ = BE @ 69 */
¥ aw C/C++ Line Breakpoints ayout >

v systick.c [line: 62]

@ systic — @ Add Line Breakpoint (C/C++)...

@' Add Function Breakpoint (C/C++)...

ick.c [expression: 'counter1'] €0 Add Event Breakpoint (C/C++)...

. . B ' r T - ey 1 - ]

# systick.c [expression: ‘counter2'] £ Add Watchpoint (C/C++)... :olL;mErT§EK;A‘pFEr_I:I§$;C rate */
<. Show Full Paths
Group By > % 1 Breakpoints
oo Select Default Working Set... v .. 2 Breakpoint Types
Deselect Default Working Set oo 3 Breakpoint Working Sets
Working Sets... 4 Files

= 5 Projects
Installed SDKs Properties Bl Cor (> 6 Resource Working Sets

nerinh svstick LinkServer Dehua TC/C++ [N k= 7 Advanced...

As you can see from the above graphic, the option to set a Watchpoint is also available directly
from the Breakpoint view. When set from here, you will be offered an unpopulated dialogue —
simply entering an address will cause a watchpoint to be created, monitoring accesses to that
location.

Another place to set Watchpoints within the IDE is from the context sensitive menu within a
Memory view.

Note: Watchpoint resources are shared with other debug features, in particular an SWO Data
Watch item will require a dedicated watchpoint unit to monitor the value.

Note: Due to the way watchpoints are implemented, any monitored access will be performed
by the CPU before a halts occurs (unlike instruction breakpoints — which halt the CPU before
the underlying instruction executes). When a watchpoint is hit you will see some ‘skid’ beyond
the instruction that performed the watched data access. If the instruction after the data access
changes program flow (e.g. a branch or function return), then the IDE may not show the
instruction or statement that caused the CPU to halt.

Note: Application initialisation performed by the C library may write to monitored memory
locations, therefore you may see your application halting during startup if watchpoints have been
set on initialised global data.

Using Watchpoints to monitor stack depth
Watchpoints provide a very simply way of monitoring stack depth when an application is running.

Stacks on ARM based processors use a Full Descending scheme and so have the potential to
descend into areas of memory used for other purposes (typically holding global data or the heap).
Establishing the maximum depth of an applications stack can be a challenge especially since any
memory corruption due to excessive stack use may not be immediately apparent. Watchpoints
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may be used to monitor and trap the stack exceeding a particular depth during execution enabling
positive reassurance that the true stack depth is understood.

The graphic below shows the use of the breakpoint view feature Add Watchpoint (C/C++) ...
where an address has been selected to watch for the Stack reaching 0x10007D00.

® [ ] Properties for C/C++ Watchpoint
Comman Common - -
Class: C/C++ Watchpoint

Expression to watch: | Ox10007D00
Range:

Read

Write
Enabled
Condition:
Ignore count: 0
@ cancel | (NNCISNN

Registers

The Register view, by default located next to the Project Explorer view, will display the internal
ARM CPU registers when the core is halted i.e. when there is an active debug connection but
the target is paused. The contents of the registers view will vary depending on the nature of the
ARM CPU inside the MCU being debugged, however the base register set will be available for
all MCUs.

The Register list as displayed is made up from, the Basic Register set (Core Registers), Fault
Registers, Pseudo Registers (provided by LinkServer), and finally Floating point Registers (for
Cortex M4/M7 etc.).

Note: For many debug tasks, the values of the low level registers will be of little concern, however
when debugging at the disassembly level and single stepping, these values can be a powerful
debugging aid. For an in depth understanding of the ARM register set for the CPU within your
NXP MCU, please consult the documentation available from ARM.

Tip

@ Even when operating in LinkServer None Stop mode, registers can not be read or
written when the target is executing. The main register display may appear blank
when the target is executing.

Basic Register set (Core Registers)

The basic register set comprises the CPU’s 16 32 bit core registers (rO — r15), where certain
registers have a special function:

¢ rl3 — SP Stack Pointer, this holds the address of the last entry on the stack

e rl4 — LR Link Register, this holds the return address for a low level BL (branch with link)
instruction

e r15— PC Program Counter, this holds the address of the instruction (to be) executed

e psr — program status register, this combines the application, interrupt and execution status
registers, reflecting the state of the CPU

« flags — set by certain instructions performing arithmetic operations
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The core register set is displayed below:

i Project Explorer 2, Peripherals+ i Registers 82 £ Symbol Viewer = O

=
Mame Value Description
v A MKBAFNTMOx00c1 2 (cortex-mé) MKBAFN1MOxxx12_f

o 0x00000000

it 0x20000104

miir2 0x00000400

wir3 0x000001D4

Hird 0x000001D4

Hirs 0x00000000

ity 0x00000000

it 0x2002FFFO

ity 0x00000000

iHirg 0x00000000

iitals] 0x00000000

i 0x00000000

iz 0x00000000

iisp 0x2002FFFO

e 0x00000213

i pe 0x000004CC

1ii psr 0x61000000

i flags nZCvg

Note: some core registers relating to interrupts are not shown on the above graphic.

When paused, all of these registers can be read (or written). The ability to write values to the
registers set is a powerful debug feature but should be used with care.

11.6.2 LinkServer Pseudo Registers

In addition to real hardware registers, MCUXpresso IDE generates (for certain CPUs) pseudo
registers (highlighted below).
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[¥5 Project Explorer = Peripherals+ !} Registers 3 % Symbol Viewer = O

EB et ©
Mame Value Description
v HAMKBAFN1MOxxx12 (cortex-m4) MKG4FN1MOxxx12_f
i 0x0000000C
il 0x2002FFB8
iiir2 0x12345678
biair3 0x20000018
bt rd 0x00000104
i ] 0x00000000
e 0x00000000
Wi r? Ox2002FFFO
8 0x00000000
bith 0x00000000
Wir10 0x00000000
i1 0x00000000
12 0x0000000E
Wil sp 0x2002FFDO
Wit Ir OxFFFFFFF9
Wil pe 0x00002A00
it psr 0x21000003
iihi flags nzCvg
Wil epsr none
Wi ipsr 3 (HardFault)
it 0x00000000
0x00000000
0x00006C09
0x0000004D
0x000004EC
0x00000400
11 faults ImpreciseErr
bibi mmar ignore
1t bfar ignare
i1t basepri 0x00000000
Wit primask Ox00000000
i1t faultmask 0x00000000
o1t fpscr 0x00000000
i fpeer 0xCO000000
11 fpear 0x00000000
o1ii fpdscr 0x00000000
iiel mvfrO 0x10110021
18 mvfr 0x11000011
i s0 0.0

Cycledelta

Cycledelta holds the number of core clock ticks that have occurred since the last time the
CPU was paused. For example, if you run from the default breakpoint on main to a breakpoint,
cycledelta will contain the number of clock ticks that occured while executing this section of code.
If a step is performed, the cycledelta will be the number of clock ticks for code being stepped. If
stepping at the instruction level, this value will often be 1 because many instructions will execute
within a single clock cycle.

Vectpc

VectPC will only display a value when the CPU has experienced a Hard Fault. If this occurs when
executing your code, the vectpc displays the program counter of your application when the Hard
Fault occurred. By clicking on the vectpc register in the Register View, additional information
is displayed, including the PC that caused the fault, and its matching source file/location (if
available) and various Fault registers indicating the exact cause of the Fault, as shown below.
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Faults = ImpreciseErr
Fault PC = @xQ00@@4EC

= main + 36 in section .text

= File: ../source/MKE4FNIMIxxx12_Project.c Line: &7

Fault status registers:

IPSR = Bx21000003: 3 (HardFault)

CFSR = PRAGA438 (Configurable Fault Status Register)
HFSR = 40000002 (Hard Fault Status Register)

DFSR = 900002082 (Debug Foult Status Register)
MMAR = eBd@edf8 (MemManage Fault Address Register)
BFAR = eB@Bedf8 (Bus Foult Address Register)

AFSR = PBPGAGBY (Auxiliary Fault Stotus Register)
Stocked registers:

R@ = BORGddc

R1 = 2002ffb8

R2 = 12345678

R3 = 20000018

R12 = PBRGAABe

LR = 000004c3

PC = BB2@ddec

PSR = 21000000

Sp = 2002ffd0

In some circumstances, a hard fault might be caused early on during the initialisation of the
system before the breakpoint on main() is hit. This may mean that the fault is triggered before
the debugger can take action to display vectpc. If this happens, try setting a breakpoint in the
startup code — this might then allow your code to load without the hard fault being triggered. You
should then be able to single step / run until the cause of the hard fault is hit. You will then see
vectpc displayed.

Peripherals

Peripherals is a generic term referring to both core peripherals, for example the System Timer
(SysTick) and SOC/MCU peripherals such as an ADC or UART. In both instances these hardware
blocks are exposed within the MCUs address space (known as memory mapped peripherals)
and so can be interrogated by accesses to their specific memory locations.

MCUXpresso IDE’s debug support (whether built in or provided by an SDK) includes knowledge
of an MCU'’s peripheral set, this is available via the Peripherals tab within the Project Explorer
pane (once a debug connection is made).

Highlighted in the view below are two peripherals that have been selected for detailed display.
Also highlighted are the device memory regions, if these memory regions are selected a standard
hex memory display will be created. Memory regions are not peripherals in the normal sense but
are included here so their memory space can be easily displayed.
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Project Explorer 2, Peripherals+ 22 Registers Symbaol Viewer B it = 8
ﬁﬁﬂﬂhﬂ' il Address Jescriotion
v 2, ADCO 0x1c034000 12-bit ADC controller 0 '
L ADvSTSCOUN V) C2w vrgoiviviv) raveny
- 2, ASYNCSYSCON 0x40080000 Asynchronous system configuration
1| E CRC 0x1c010000 CRC engine
- 2, CT32B0 0x400b4000 Standard counter/timer O
- & CT32B1 0x400b8000 Standard counter/timer 1
- &, CT32B2 0x40004000 Standard counterftimer 2
- 2 CT3283 0x40008000 Standard counter/timer 3
- 2, CT32B4 0x4000c000 Standard counter/timer 4
. 2 DCR 0xe000edf0 Debug Core Registers (v7M)
1 F.DMA 0x1c004000 DMA controller
- 2 GINTO 0x40010000 Group GPIO input interrupt O
- 2 GINT1 0x40014000 Group GPIO input interrupt 1
- 2 GPIO 0x1c000000 General Purpose /O
. 2 12c0 0x40094000 12C-bus interface O
. 2 12¢1 0x40098000 12C-bus interface 1
. 2 12c2 0x4009c000 12C-bus interface 2
- 2 INPUTMUX 0x40050000 Input multiplexing
- 2, 10CON 0x4001c000 1/O pin configuration
. Y 0xe0000000 Instrumentation Trace Macrocell
T MAILBOX 0x1c02c000 Mailbox
1 B MPU 0xe000ed90 MPU (v7M)
I EMRT 0x40074000 Multi-Rate Timer
- 2 NVIC Oxe000e000 NVIC Control/Status Regsiters (v7M)
- L PINT 0x40018000 Pin interrupt and pattern match en...
- ZRIT 0x40070000 Repetitive Interrupt Timer
. 2 RTC 0x4003c000 Real-Time Clock
. 2, SCTO 0x1c018000 State Configurable Timer/PWM O
1 EsPI0 0x400a4000 SPIO
25PN 0x40038000 SPl1
(v = syscon 0x40000000 System configuration )
T USARTO Ox20084000 USARTO
~I E USART1 0x40088000 USART1
~| E USART2 0x4008c000 USART2
~I ' USART3 0x40090000 USART3
. 2 UTICK 0x40020000 Micro-tick timer
- 2, VFIFO 0x1c038000 System FIFO for Serial Peripherals
0x40038000 Windowed Watchdog Timer
0x0 Flash: size=0x40000 (256k)
0x2000000 RAM: size=0x10000 (64k)
0x2010000 RAM: size=0xB8000 (32k)
= Ram2_8 0x3400000 RAM: size=0x2000 (8k)

From this view each peripheral is listed along with its base address and brief description. If
selected from the associated check box, a detailed memory view will be launched. This view
exposes the inner peripheral registers and offers bit field enumerations to greatly simplify both
reading existing configurations and setting new values.
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0 Memory 53 oo g o ) (SR By T = O
Monitors = 3 % [SYSCON: 0x40000000 [LPC54102J256] 3 . == New Renderings...

@ ADCO [LPC54102J258] Register Address Value

@ SYSCON [LPC54102J256] > i ASYNCAPBCTRL 0x40000020 Ox0
b 3 SYSRSTSTAT 0x40000040 0x0
> i PRESETCTRLO 0x40000044 Ox0
> 5 PRESETCTRL 0x40000048 0x0
> i PRESETCTRLSETO 0x4000004¢ <writeonly>
» S PRESETCTRLSET1 0x40000050 <writeonly>
» 18! PRESETCTRLCLRO 0x40000054 <writeonly>
» i PRESETCTRLCLR1 0x40000058 <writeonly>
» i1 PIOPORCAPO 0x4000005¢ Oxf9e33fff
> i3 PIOPORCAP1 0x40000080 Ox3ffff
il PIORESCAPO 0x40000068 0x79e33fff
> i1 PIORESCAP1 0x40000086¢ Ox3ffff
v 51 MAINCLKSELA 0x40000080 0x0

i SEL [1:01 IRC OSCILLATOR i

» 31§ MAINCLKSELB 0x40000084 IRC_OSCILLATOR
> i ADCCLKSEL 0x4000008¢ CLKIN
» i CLKOUTSELA 0x40000084 WATCHDOG_OSCILLATOR
> 3 CLKOUTSELB 0x40000088 RESERVED
> i SYSPLLCLKSEL 0x400000a0 Ox0
» i1 AHBCLKCTRLO 0x400000c0 0x211b
> i AHBCLKCTRL 0x400000c4 Ox0
» i8I AHBCLKCTRLSETO 0x400000c8 <writeonly>
> S AHBCLKCTRLSET1 0x400000cc <writeonly>
b B AHBCLKCTRLCLRO 0x400000d40 <writeonly>
> S AHBCLKCTRLCLR1 0x400000d4 <writeonly>
b 3i SYSTICKCLKDIV 0x400000e0 0x0

Important Note: When an MCU powers up, many peripherals will be unavailable because they
are unpowered/not clocked. Attempting to access a peripheral in this state will result in failure, and
the detailed peripheral view will simply display their base address in red. Certain peripherals may
be partially available, unavailable sections will again display in red. Entries that have changed,
will display in yellow.

Tip

Even when operating in LinkServer None Stop mode, peripherals can not be read or
written when the target is executing. The main peripheral display may appear blank
when the target is executing regardless of LinkServer mode

Warning: It is strongly advised that only peripherals that are well understood are accessed
in this manner since attempting to view certain peripherals can break a debug connection or
perform other unexpected actions. MCUXpresso IDE’s debug features cannot offer protection
from such occurrences.

11.7.1 Peripheral Filters

New in MCUXpresso IDE version 10.2.0 is the ability to filter the displayed peripheral view.
Peripherals may contain a large number of internal registers, and these registers may contain
many fields, to reduce screen clutter and to help locate peripheral registers (and fields) of interest,
one or more filters can be applied.

To create a filter, right click inside the peripheral rendering and select Edit Filters. This will launch
a dialogue as below.
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MCUXpresso IDE
Filter

Hide registers/fields not containing the filter string

Filters configurations

| Regular Expression ) Contains

Case sensitive

Filters
| [Text Field
PERIF iléi Register v
"
Field
Add Filter Remove Selected Filters

Cancel oK

For each piece of text to match, you can select whether the filter applies to Register Names or
Field names.

To restore the view, right click inside the peripheral rendering and select Remove all filters.
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12. MCUXpresso Config Tools

This chapter provides an introduction to the features of the MCUXpresso Config Tools installed
by default with MCUXpresso IDE. The Config Tools present new perspectives in addition to the
IDE’s Develop and Debug perspectives.

™4 = [ [ | b [ Update Project Code :Functional Group | BOARD InitPins -@oaB Qi ~ B vth - QuickAccess §| % | K 45 [@)
E Pins 57 | [ Peripheral Signals = O  f Package 5T QQQ#EE = O [Registers 2 =8
BB ¥ @ veefiterten 2 DShnwmnmﬁed registers only
Pin | Pinname Label - g type filter text
i 1 5{P8]/SBHCD, 3 Reg. Name Set Value
2 J15[P7)/SDHCO g L DMAMUY 0
3 115[PS]/SDHCO i
4 115[P3)/SDHCO .
5 J15[P2]/SDHCO, ADCO ADCH CaND
6 J15[P1]/SDHCO| ﬁg}g:::g:; = M. oMt COMPE Ws”“;;
7 J1S[GLYSD_CAl “aDC0_DF2/ our DAC) o CUPT_INPTCS:
8  VvDDI6 P3V3_KE4F e ENET Bt ExPort 5
& FTESLLAT_P. ADCO_SEIBRTCY
9 vssi7 GND PTESISRIN_PCS2. B Fmo FIht ADCO_SE14RTCOS,
T U 23K PTEB/SPI1_POSD/ ::I/ZE ::gc z:zs PTBIISPIZ_SIN L
/ ssiT PTBEIISPII_SCKS
1 UsBoOM 12212)/K64_MIC ol orio eco o1 FTaz0/sPi RCs0)
12 vouT33 VOUT33_K64 USE DM I2c2 1250 JTAG FTBI0/CAND_RA..
13 VREGIN VREGIN_K6+4 il Loy LPTMRO 0sc e S
14 ADCO_DP1 i ADCO_DP1 POBO RCM RTC UARTO_RX s DA
15 ADCODML e gt some n sPu o011 oA
16 ADCLDPL 5] ADCT DM SPit 3Pz SUPPLY ADCT_SEI8PTON 7 g E: H 1‘*“
Ao D01 T TP AT ADE{_SE14PTO10 > DMAMUX
LA GRS nm ADED OM s PTBRRPI_PCSr . BORTA P
18 ADCO_DPO/ADC.. J2[5] ADCT_DPDJ. LT e WS ADCO_SE13/PTBI).
19 ADCODMO/AD.. 12(7] FEELE \U/:';? i Peripheral UART3 et
20 ADCLDPO/ADC.. J2[i1] VREFH Serial Communication Interface }/ - s
d e » PORTA_PCR3
2 ADCLDMO/AD. J2(13] ussa Non pin routed 107 » PORTA_PCRA
22 VDDA P3V3_K64F MKBAFMNAMOVLL 12 - LGFP 1 0o pacreage J i
3 VREFH VREFH
4 VREFL GND
3 vssa GND o
2 VREF.OUT/CMP.. J2(17]
27 DACOOUT/CM.. M[11] R o
B XTALR VILLIXTALZZ_F type filter text
2 EXTALR2 VI2VEXTAL32.
30 VBAT VBAT Routed Pins for BOARD InitPins 3 @)~ [v]
3 J21201/U8[41/12¢ = Peripheral  Signal Route to Label Identifier Direction Slew rate Open drain
ii E[imnﬁ[slﬁ( B varTo RX UARTORX ~ UTMI/UARTORX  DEBUG_UARTRX Input Fast Disabled
" 19[4]”SWD[ guc 63 UARTO T UARTOTX  UIO[LVUARTOTX  DEBUG_UART_TX Not Specified Fast Disabted
= JIH - 68 GPIOB GPI0,22  PTB22 DI2[1/LEDRGB_RED  LED_RED Not Specified  Fast Disabted
ES IL21/9I61TR
7 nremn ma T (= [ ] » —
< [ ' « I v
£ Problems 52 (BI¥Y)= &
type filter text
Level Issue Origin Target Resource Type
% Warning Peripheral UARTO is not initialized Pins: BOARD InitPins Peripherals: BOARD InitPeripherals  UARTO Validation

Please refer to the MCUXpresso IDE Config Tools User Manual for detailed information.

12.1 Using the Config Tools

MCUXpresso IDE includes the following Config Tools:

¢ Pins Tool
« allows you to configure pin routing and generates ‘pin_mux.c & .h’ source files
¢ Clocks Tool
« allows you to configure system clocks and generates ‘clock_config.c & .h’ source files
« Peripherals Tool
« allows you to configure other peripherals and generates ‘peripherals.c & .h’ source files
MCUXpresso Config Tools can be used to review or modify the configuration of SDK example

projects or new projects based on SDK 2.x. To open the tool, simply right click on the project in
Project Explorer and select the appropriate Open command:
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Figure 12.2. Config Tools Launch

MCUXpresso Config Tools > B Open Pins

#7 Run C/C++ Code Analysis N Open Clocks
Team > ¥ Open Peripherals
Compare With > Import Configuration (*mex)

12.1.1

12.1.2

12.1.3

12.1.4

12.1.5

MCUXpresso IDE User Guide -

If the project does not contains any configuration file (.mex) yet, it is automatically created by
importing the existing source files (from YAML comments from pin_mux.c, clock_config.c and/or
peripherals.c). If there are no source files in the project, a default configuration is created. The
configuration is stored in the root of project folder with “.mex” file extension.

Tool Perspectives

Each tool is displayed in separate perspective. Once the configuration is opened, you can switch
between perspectives to review/modify configuration of each tool — using the toolbar on the upper
right part of the IDE window:

B E<®W®

If your workspace contains multiple projects, please be aware that the MCUXpresso Config Tools
only support one configuration to be opened at a time and that configuration must be opened
explicitly for each project using the Open command from the popup menu. Switching perspectives
does not switch the selected configuration.

Pins Tool

The Pins Tool allows you to display and configure the pins of the MCU. Basic configuration can
be done in either of these views Pins, Peripheral Signals or Package. More advanced settings
(pin electrical features) can be adjusted in Routed Pins view.

Clocks Tool @

The Clocks Tool allows you to display and modify clock sources and outputs settings in Table
view. More advanced settings can be adjusted via Diagram view and Details view. Global settings
of the clocking environment such as run modes, MCG modes and SCG modes can be modified
via main application toolbar.

Peripherals Tool ®

You can use the Peripherals tool to configure initialization of selected peripherals and generate
code for them. In the Peripherals view, select the peripheral to configure and confirm addition
of the configuration component. Then you can select the mode of the peripheral and configure
the settings within the settings editor.

Generate Code

To update sources in the project, simply hit “Update Project Code” button on the toolbar. The
command opens dialog with list of files that will be re-generated and allows to select which tools
will generate the code.

Alternatively, it is also possible to export select source file by hitting export button in the Sources
view.
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12.1.6 SDK Components

Generated code uses the API of the SDK components to configure peripherals. SDK components
missing in the IDE project are reported in problems view. It is possible to add component into
IDE project by right click on the reported problem and selecting the proposed quick fix.
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13. The GUI Flash Tool

New in MCUXpresso IDE version 10.2.0, the rearchitected GUI Flash tool provides flash
programming capabilities for all supported debug solutions.

As well as implementing seamless programming of Flash when starting a debug session,
MCUXpresso IDE enables the Flash programming capabilities of the supported debug solutions
to be accessed directly, both via the GUI and from the command line (which might be useful for
performing small production runs).

These flash programming capabilities can be accessed from three distinct places with the IDE.

Firstly, the most feature capable (advanced) variant is launched via the IDE button (and will be
described in this section) :

;97: O;JJE” ##vﬁv@vt

GUI Flash Tool

Clicking this will launch a dialogue similar to:

Figure 13.1. GUI Flash Tool

[ ] ) GUI Flash Tool
GUI Flash Tool for:
MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
Program file into flash: MK64FN1MOxxx12_Project.axf

Target: MKE4FN1MOxxx12

Probe Options
Probe specific options

Connect script kinetisconnect.scp B4 Workspace... File System..
Reset Handling Default <]
Flash Reset Handling Default B
Use JTAG Interface || Reset the target on connection
Target Operations
Select the target flash operation to perform
lmvasé Resurrect locked Kinetis device I
Actions
Select the action to perform
© Program Program (mass erase first)
Verify only Check file areas blank
Options
Select the options to apply
File to program I / FN1MOxxx12_Project/D M 1MOxxx12_Project.axf l Workspace. File System.

Format to use for programming () axf bin
Base address

Reset target on completion

General Options
Flash programming tool options

Additional options

Repeat on completion (| Preview command [ Clear console

cancel | (TN
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Note: This dialogue will vary subtly for each debug solution.

Secondly, project launch configurations now contain a GUI Flash Tool Tab providing project
specific flash operations. Please see for more information.

Finally, the QuickStart panel Debug Shortcuts provide easy access for simple project flash
programming. Please see for more information.
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13.1 The Advanced GUI Flash Tool

The operations below are supported for each debug solution.

1. Programming an .axf or .bin file into flash
2. Flash Mass Erase
3. Various debug solution specific features

When launched, each debug solution will present a dialogue similar to the LinkServer variant —
described below:

[ o) ) GUI Flash Tool

GUI Flash Tool for:
MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes

Program file into flash: MK64FN1MOxxx12_Project.axf
Target: MK64FN1MOxxx12
Probe Options
Probe specific options
Connect script kinetisconnect.scp @ H Workspace... File System...

Reset Handling Default O
Flash Reset Handling Default O

Use JTAG Interface Reset the target on connection

Target Operations
elect the target flash operation to perform
MYESE Resurrect locked Kinetis device

o o)

Actions

Select the action to perform

© Program Program (mass erase first)
Werify only Check file areas blank

Options

Select the options to apply

File to program I ${workspace_loc}/MKB4FN1MOxxx12_Project/Debug/MKB4FN1MOxxx12_Project.axf ﬁﬂrksmcem File System...

Format to use for programming| .

Base address

Reset target on completion

General Options
ash programming tool options
Additional options .
Repaat on completion Clear console

cancel | (TN

Figure 13.2. GUI Flash Tool Annotated

Note: Probe options (highlighted above) will be different for each debug solution, where as Target
and General Options (also highlighted) will be broadly similar.

Tip

@ A project must first be selected before the Advanced GUI Flash Tool can be
launched. The device and other project configurations (such as flash driver) will be
inherited from this selected project. The advanced GUI Flash tool will not create or
use information within project associated launch configurations.

1. Connect Script: The device default connect script will be automatically selected. A different
connect script can be selected if required using the Workspace or File System shortcut
buttons.

2. Reset Handling: The device default reset handling can be overridden from the selection:
Default, SYSRESETREQ, VECTRESET, SOFT
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3. Flash Reset Handling: The flash drivers default reset handling can be overridden from the
selection: Default, SYSRESETREQ, VECTRESET, SOFT

4. Program/Erase/Resurrect locked Kinetis Device

* Program view (displayed) should be selected to program an application of binary into flash.
Only the Program options will be described below.

e Erase view should be selected for options to erase a flash device to its blank state
« offers options to Mass erase, Erase by sector, Check blank (to verify a blank flash).

< generally flashes do not need to be erased, since program operations automatically erase
sections of the flash as required. However on occasion it can be useful to erase a flash
most often because the image in flash is causing problems.

» Erase by sector is not recommended for Kinetis parts since this will leave the device fully
erased and therefore in a locked state — should this occur, use the option below ...

* Resurrect locked Kinetis device view should be selected to recover a locked device.
5. Programming actions:

* Program: the default action will program the selected application or binary erasing only the
required sections of the flash device.

e Program (mass erase first): will erase the whole device before program the selected
application or binary. This will ensure that any previous flash contents are erased.

« Verify only: this option will compare the contents of flash with the selected application or
binary. Note: most flash programming operations are verified at the programming stage.
Flash contents are not changed.

¢ Check file area blank: this can be used to verify that a program operation will not overwrite
any data already programmed into flash. Flash contents are not changed.

6. File selection: if the selected project contains a built .axf file, then this will automatically be
selected. Alternatively a different file can be selected using the Workspace and File System
shortcut buttons.

7. Format: these radio buttons will be preset by the File to Program type. However, if an .axf file
is selected, clicking bin will automatically generate a .bin from the selected .axf.

« for file types containing no base address information, such as .bin, a base address must
be specified.

8. Preview command: select this option to be presented with a preview programming command
to be issued and a script that can perform this action independently of the IDE (see below)

« the previewed command can be edited if required, changes will be reflected within the script

« various shell script flavours can be selected, and finally the script can be copied to the
clipboard with a single click

Finally, click Run to execute the flash programming operation, a dialogue displaying the success
of the operation will be displayed once the program operation has completed.

13.1.1 Advanced GUI Flash Tool command Preview
As discussed in point 8 above, the GUI Flash Tool can optionally display the command to be
issued — allowing the opportunity of editing the command before execution.
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[ BON ] Program file into flash: MKE4FN1MOxxx12_Project.axf

1 Command to be executed...

.

crt_emu_cm_redlink --flash-load-exec "/Users/nxp/Documents/MCUXpressolDE_10.2.0/workspace/
MKGBAFN1MOxxx12_Project/Debug/MKE4AFN1MOxxx12_Project.axf" -g --debug 2 --vendor NXP -p
MKB4FN1MOxxx12 --ConnectScript kinetisconnect.scp -ProbeHandle=1 -Corelndex=0 -x /Users/nxp/
mcuxpresso/01/.mcuxpressoide_packages_support/MKE4FN1MOxxx12_support --flash-dir /Users/nxp/
mecuxpresso/01/.mcuxpressoide_packages_support/MKE4FN1MOxxx12_support/Flash

Command to use in a script

MCUX_WORKSPACE_LOC=/Users/nxp/Documents/MCUXpressolDE_10.2.0/workspace
MCUX_FLASH_DIR=/Users/nxp/mcuxpresso/01/.mcuxpressoide_packages_support/MKB4FN1MOxxx12_supp

ort/Flash

MCUX_IDE_DIR=/Applications/MCUXpressolDE_10.2.0_740/ide

MCUX_IDE_BIN=$MCUX_IDE_DIR/bin El
SMCUX_IDE_BIN/crt_emu_cm_redlink --flash-load-exec (=)

"{Users/nxp/Documents/MCUXpressolDE_10.2.0/workspace/MKB64FN1MOxxx12_Project/Debug ™ **7= *™ "<+~
xxx12_Project.axf" -p MK64FN1M0xxx 12 --ConnectScriptkinetisconnect.scp -x C Shell
/Users/nxp/mcuxpresso/01/.mcuxpressoide_packages_support/MK64FN1MOxxx12_support --fli v Bourne Shell
/Users/nxp/mcuxpresso/01/.mcuxpressoide_packages_support/MK64FN1MOxxx12_support/Fla ~ Powershell
Command Shell

cancel | IS

Figure 13.3. GUI Flash Tool Command Preview

In addition to displaying the command to be issued, the dialogue also contains a script that can
be issued independently of the IDE to perform the flash programming operation. Changes the
command to be executed will also be reflected within the script.

Notes

« The script will setup the local environment to be independent of your local shells configuration.
However components of MCUXpresso IDE are of course referenced so the script can only be
used if MCUXpresso IDE is installed and any referenced workspace files are present.

¢ Debug probes may install drivers when first seen by a host, this driver installation may take
some time to complete.

¢ MCUXpresso IDE is able to maintain connection to multiple debug probes, while the IDE can
dynamically maintain knowledge of connected probes, any generated commandline will be
a snhapshot of a given instance. Therefore it is essential that only a single debug probe is
connected if the command script is to be captured for re-use.

¢ Typically, LPC-Link2 or LPCXpresso V2 and V3 boards have debug probe firmware soft loaded
automatically by the IDE when a debug operation is first performed. Therefore to use these
debug probes from the command line they must either have their firmware softloaded or
have probe firmware programmed into the Flash. Probe firmware can be soft-loaded from the
command line by use of scripts boot_linkl for LPC-Link and boot_link2 for LPC-Link2, these
are located at mcuxpresso_install_dir/ide/bin. To program debug probe firmware into the Flash
memory of an LPC-Link2 debug probe, please see: http://www.nxp.com/LPCSCRYPT
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13.1.2 Advanced GUI Flash Tool logged Output

When a GUI Flash Tool operation is performed, the low level output will be logged into the debug

log. A snippet of a LinkServer successful program operation is shown below:

Loadi ng ' MK64FN1MDxxx12_Proj ect . axf' ELF 0x00000000 | en 0x3CF8
Opening flash driver FTFE 4K cfx (already resident)

Sendi ng VECTRESET to run flash driver

Witing 15608 bytes to address 0x00000000 in Fl ash

1of 1 ( 0) Witing pages 0-3 at 0x00000000 with 15608 bytes
( 0) at 00000000: O bytes - 0/15608

( 26) at 00000000: 4096 bytes - 4096/ 15608

( 52) at 00001000: 4096 bytes - 8192/ 15608

( 78) at 00002000: 4096 bytes - 12288/ 15608

(100) at 00003000: 4096 bytes - 16384/ 15608

Erased/ Wote page 0-3 with 15608 bytes in 693nsec

Cl osing flash driver FTFE_ 4K cfx

(100) Finished witing Flash successfully.

Fl ash Wite Done

Loaded Ox3CF8 bytes in 1081ns (about 14kB/s)

Reset target (system

Starting execution using systemreset
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14. LinkServer Flash Support

14.1

MCUXpresso IDE User Guide -

Note: Quad SPI (QSPI) and SPIFI are used interchangeably within this section. The term SPIFI
(SPI Flash Interface) is commonly used to reference LPC use of QSPI.

Please refer to the section on for details of the LinkServer debug solution.

MCUXpresso IDE’s LinkServer based debug connections makes use of a RAM loadable Flash
driver mechanism. Such a Flash driver contains the knowledge required to program the internal
Flash on a particular MCU (or potentially, family of MCUs). This knowledge may be either
hardwired into the driver, or some of it may be determined by the driver as it starts up (typically
known as a ‘generic’ Flash driver).

At the time a debug connection is started by MCUXpresso IDE, the LinkServer debug session
running on the host will typically download a Flash driver into RAM on the target MCU. It will
then communicate with the downloaded Flash driver via the debug probe in order to program the
required code and data into the Flash memory.

In addition, the loadable Flash driver mechanism also provides the ability to support Flash drivers
which can be used to program external Flash memory (for instance via the SPIFI Flash memory
interface on LPC18x, LPC40xx, LPC43xx and LPC5460x families). The sources for some of
these drivers is provided in the Examples/Flashdrivers subdirectory within the MCUXpresso IDE
installation directory.

LinkServer Flash drivers have a .cfx file extension. For Preinstalled MCUs, the Flash driver
used for each part/family will be located in the /bin/Flash subdirectory of the MCUXpresso IDE
installation. For SDK installed MCUs, the Flash driver will generally be supplied within the SDK,
although copies may also provided in the /bin/Flash subdirectory.

Default vs Per-Region Flash Drivers

By default, for legacy reasons, Preinstalled MCUs are configured to use what is called a ‘Default’
Flash driver. This means that this Flash driver will be used for all Flash memory blocks that are
defined for that MCU (i.e. as displayed in the Memory Configuration Editor).

For most users, there is never any need to change the automatically selected Flash driver for
the MCU being programmed.

However, MCUXpresso IDE also supports the creation and programming of projects that span
multiple Flash devices. In order to allow this to work, Flash drivers can also be specified per
memory region.

For example, this allows a project based on an LPC43xx device with internal Flash to also make
use of an external SPIFI Flash device. This is achieved by removing the default Flash driver from
the memory configuration and instead explicitly specifying the Flash driver to use for each Flash
memory block (per-region Flash drivers). A typical use case could be to create an application
to run from the MCU'’s internal Flash that makes use of static constant data (e.g. for graphics)
stored in external SPIFI device. An example memory configuration is shown below:
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Figure 14.1. Per Region Drivers

‘e MCUXpresso IDE

Memory configuration editor
Edit configuration for LPC4337 m

Memory configuration

Default flash driver Browse...

Type MName Alias Location Size Driver —
Flash MFlashA512 Flash Ox1a000000 OxB80000| LPC18x7_43x7_2x512_BootA.c u
Flash MFlashB512 Flash2 Ox1bQ00000 Ox80000] LPC18x7_43x7_2x512_BootA.c

Flash Flash_SPIFI Flash3 O0x14000000 Ox10000Q LPC18_43_SPIFI_GENERIC.cfx

RAM RamLoc3Z RAM  Ox10000000 0xB000O
RAM RamLoc40 RAM2 Ox10080000 0xaO00
RAM RamAHB32 RAM3 Ox20000000 Ox8000
RAM RamAHB16 RAM4 Ox20008000 Ox4000

Add Flash Add RAM Split Delete

Import... Merge... Export... Generate...

cance | (TN

14.2
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Note: SDK installed MCUs always use Per-Region Flash drivers.

Special case Flash Drivers

For most projects, the selection of a Flash driver is automatically performed by the Project wizard,
however for some MCUs user intervention may be required.

LPC18xx / LPC43xx Internal Flash Drivers

A number of LPC18/43 parts provide dual banks of internal Flash, with bank A starting at address
0x1A000000, and bank B starting at address 0x1B000000.

* LPC18x3/ LPC43x3 : Flash 2x 256KB (512 KB total)
* LPC18x5/ LPC43x5 : Flash = 2x 384KB (768 KB total)
* LPC18x7/LPCA3x7 : Flash = 2x 512KB ( 1 MB total)

When you create a new project using the New Project Wizard for one of these
parts, an appropriate default Flash driver (from LPC18x3 43x3 2x256_ BootA.cfx /
LPC18x5_43x5 2x384 BootA.cfx /LPC18x7_43x7_2x512_ BootA.cfx) will be selected which
after programming the part will also configure it to boot from Bank A Flash.

If you wish to boot from Bank B Flash instead, then you will need to manually configure the
project to use the corresponding “BootB” Flash driver ( LPC18x3 43x3 2x256_BootB.cfx /
LPC18x5_43x5 2x384 BootB.cfx / LPC18x7_43x7_2x512_ BootB.cfx). This can be done by
selecting the appropriate driver file in the “Flash driver” field of the Memory Configuration Editor.
Note: you will also need to delete Flash Bank A from the list of available memories (or at least
reorder so that Flash Bank B is first).
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14.2.2

LPC SPIFI QSPI Flash Drivers

A number of parts provide support for external SPIFI Flash, sometimes in addition to internal
Flash. Programming these Flash memories provides a number of challenges because the size
of memory (if present) is unknown, and the actual memory device is also unknown. These issues
are handled using Generic Drivers which can interrogate the memory device to find its size and
programming requirements.

At the time of writing, these LPC devices comprise:

Table 14.1. SPIFI details

LPC Part SPIFI Address Bootable Flash Driver
LPC18xx/LPC43xx  0x14000000 Yes LPC18_43_ SPIFI_GENERIC.cfx
LPC40xx 0x28000000 No LPC40xx_SPIFI_GENERIC.cfx
LPC5460x 0x10000000 No LPC546x_SPIFI_GENERIC.cfx
LPC540xx 0x10000000 Yes LPC54xx_SPIFI_GENERIC.cfx
During a programming operation, the Flash driver will interrogate the SPIFI Flash device to
identify its configuration. If the device is recognised, its size and name will be reported in the
MCUXpresso IDE Debug log - as below:
I nspected v.2 External Flash Device on SPl using SPIFl |ib LPC18_43_SPI FI _GENERI C. cf x
| mage ' LPC18/ 43 Generic SPIFI Mar 7 2017 13:14:25'
Opening flash driver LPC18_43_SPI FI _GENERI C. cf x
flash variant ' MX25L8035E' detected (1MB = 16*64K at 0x14000000)
Note: Although the Flash driver reports the size and location of the SPIFI device, the IDE’s view
of the world is determined by the project memory configuration settings. It remains the users
responsibility to ensure these setting match the actual device in use.
Flash devices supported by our LPC SPIFI Flash Drivers
Below is a list of SPIFI Flash devices supported by our supplied Generic SPIFI Flash drivers.
Note: additional devices which identify as one of the devices below are also expected to work.
However if a device is not supported by our supplied Flash Drivers, sources to generate these
drivers are supplied in the Examples/Flashdrivers subdirectory within the MCUXpresso IDE
installation directory. Users may thus add support for new SPIFI devices if needed.
@D25@2C
MIr25Q.128AB
MI25Q612A
MI25QR56A
N25QR56
N25Q128
N25Q64
N25@B2
PMR25LQD32C
MX25L1606E
MX25L1635E
MX25L3235E
MX25R6435F
MX25L6435E
MX25L12835E
MX25V8035F
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14.2.3

MX25L8035E
S25FL016K
S25FL032P
S25FL064P
S25FL129P 64kSec
S25FL129P 256kSec
S25FL164K
S25FL256S 64kSec
S25FL256S 256kSec
S25FL512S
V25Q40CV
VR5Q@B2FV
VR5Q64FV
V25Q128FV
VW5QR56FV_Unt est ed
V25QB0BV

I.MX RT QSPI and Hyper Flash Drivers

At the time of writing the following LinkServer flash drivers are included for use with the EVK
range of development boards supporting i.MX RT MCUSs. These parts support external flash via
a QSPI/Hyperbus interface. Currently flash drivers are targeted at specific QSPI and hyper flash
devices and comprise of the following:

Table 14.2. SPIFI details

iMX RT Part

i.MX RT 1050
i.MX RT 1050
i.MX RT 1050
i.MX RT 1020

Flash Driver
MIMXRT1050-EVK_S26KS512S.cfx
MIMXRT1050-EVK_IS25WP064A.cfx
MIMXRT1050-EcoXiP_ATXP032.cfx
MIMXRT1020-EVK_1S25LP064.cfx

Bootable
Yes
Yes
Yes
Yes

QSPI Address
0x6000000
0x6000000
0x6000000
0x6000000

14.2.4
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Note: itis planned to complement these drivers with self configuring variants post release, please
see for more information on this methodology.

When used with the approriate SDK for your development board, the correct driver will be
automatically selected.

Important Note: For an application to Boot and execute in place (XIP) from these flash devices
(post reset), a correct header for the specific device MUST be programmed into the flash. SDK
examples will build to include an approriate header automatically however, MCUXpresso IDE
will not prevent users programming projects without headers into these devices. If this occurs
the application will not boot and susequent flash programming operations may fail.

The recommended recovery procedure is to change the boards boot strategy (via DIP switches)
to prevent booting from QSPI or hyperflash. Power cycle the board and then perform a Mass
Erase of the flash. Next, reprogram with an image that has appropriate header, restore the boot
strategy and power cycle again.

SPIFI QSPI Flash Drivers using SFDP

As discussed above, the programming these Flash memories provides a number of challenges
because the size of memory (if present) is unknown, and the actual memory device is also
unknown

Our Generic flash drivers attempt to solve this problem by recognising specific devices (via
their JEDEC ID) and then setting their sizes and programming parameters accordingly. This
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mechanism will only work if the device is recognised by the flash driver, and in consequence any
device not recognised will fail.

This issue, combined with the sheer volume of devices available has forced a different approach
to be taken. Fortunately, modern flash devices typically contain a data block describing their
properties including device size, low level structure and programming details etc. These data
blocks and their use are collectively known as Serial Flash Discovery Protocol or SFDP. The
standard for these blocks are described by JEDEC JESD216 standard(s).

New in MCUXpresso IDE version 10.2.0 are a range of Generic flash drivers built to self configure
via SFDP data. Drivers are currently available for the following MCUs.

LPC18_43_SPIFI_SFDP.cfx
LPC540xx_SPIFI_SFDP.cfx
LPC546xx_SPIFI_SFDP.cfx
« Drivers for other MCUs supporting external QSPI may be made available post release

SPIFI QSPI SFDP issues and Limitations

Some (usually older) QSPI parts do not support the SFDP mechanism and therefore will not be
programmable via these drivers. However, some QSPI devices fitted to NXP (LPC) manufactured
development boards do not support this protocol — therefore if SFDP data is not found, some
basic assumptions are made by the driver to program the device and its size will be assumed
to be 1MB. This mechanism should ensure that NXP LPC development boards with QSPI can
be used with this driver type.

Note: this information is correct at the time of writing — future development of these drivers may
change their capabilities.

Flash programming log

When programming code or data into flash, a portion of the debug log will display the flash
programming operations (as below):

I nspected v.2 External Flash Device on SPlI using SFDP JEDEC | D LPC18_43_SPI FI _SFDP.cfx —(1)
I mage ' LPC1843_JEDEC SFDP May 1 2018 15:32:05'

Opening flash driver LPC18_43_SPIFI _SFDP. cfX  --------mmmmmmm i (2)
Sendi ng VECTRESET to run flash driver
flash variant 'JEDEC SFDP_EF4014' detected (1MB = 16*64K at 0x14000000) ---------------- (3)

Cl osing flash driver LPC18_43_SPI Fl _SFDP. cf x
NXP: LPC43S37

Connect ed: was_reset=true. was_stopped=fal se
Awai ting telnet connection to port 3330 ...
GDB nonst op node enabl ed

Opening flash driver LPC18 _43_SPIFI _SFDP.cfx (already resident) --------------mmmmnoon (4)
Sendi ng VECTRESET to run flash driver

Witing 1046900 bytes to address 0x14000000 in Flash ---------ccmmmmmmmm oo (5)
Erased/ Wote page 0-15 with 1046900 bytes in 7548MBEC -------------mmmmmmmmmm o (6)

Cl osing flash driver LPC18_43_SPI Fl _SFDP. cf x

Fl ash Wite Done

Fl ash Program Sunmary: 1046900 bytes in 7.55 seconds (135.45 KB/seC) ------------------- (7)
St opped: Breakpoint #1

Note: when accessing unknown flash devices, the driver will be called twice. First to identify the
device and secondly to perform the required programming. In a situation where multiple devices
are being programmed, the flash driver(s) may be (re)loaded for each use.

Where:
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1. SFDP JEDEC ID is the method used to access the flash and LPC18 43 SPIFI_SFDP.cfx is
the flash driver used
2. the driver named above is loaded and initialised (this step will setup clocks, pin muxing, and
perform some investigation of the connected device)
3. the driver returns a string JEDEC_SFDP indicating that SFDP data was found and successfully
read
e the devices JEDEC ID was read as EF4014, in this case corresponding to a Winbond
25Q80DVSIG (as fitted to the LPC-Link2 board used in Target mode)
 the devices size was read as 1MB divided up into 16 64KB Sectors/Blocks — these blocks
are the erase size that will be used for programming and so any operation to program this
flash must start on an address aligned to this 64KB size
4. the driver is opened a second time (without reloading since it remains from the previous call)
5. the project that referenced this driver requested that 1046900 bytes of data were written to
the address starting 0x14000000, as set within the projects memory configuration
6. the write operation is performed via 16 page writes
« Note: this flash driver (like many LinkServer drivers) uses a virtual page size that is much
larger than the actual flash device page size to optimise driver operation
7. finally, a summary of the operation is printed showing the flash programming performance

Note: If the driver fails to find SFDP data, it will attempt to program the device with standard
routines. If this occurs, the size will be assumed to be 1MB and the flash variant will be reported
as ID rather than SFDP as shown below:

flash variant 'JEDEC | D EF4014' detected (1MB = 16*64K at 0x14000000)

On occasion, some devices that report the same JEDEC ID will actually be different, in this case
the device is a very similar Winbond 25Q80BVSIG i.e. ..BV rather than ..DV

SPIFI programming and booting

When dealing with external flash, it is important to understand the difference between the
flash programming operation performed by the flash driver and the subsequent use of the
flash for executing code and/or providing data. Essentially the flash drivers responsibility ends
with a successful program operation, after this point, correct operation of the MCU/SPI flash
combination lies elsewhere.

Thus, once the MCU is reset (or power cycled), the responsibility for the devices configuration and
operation lie entirely outside of MCUXpresso IDE and instead lie with one or all of the following:

» development board/MCU boot settings
« these may be DIP switches or Jumpers providing inputs to the MCU boot flow, alternatively

these could be OTP bits programmed within the MCU
« MCU’s BootROMs ability to understand and setup the device
» BootROMs on devices such as the LPC1800 and LPC4300 have inbuilt understanding of
certain QSPI devices allowing them to be configured for boot. However, this boot process
may fail with some QSPI flash despite the fact that it has been correctly programmed

* BootROMs on devices such as the LPC540xx and RT10xx rely on correct header (XIP)
information being programmed (as part of the Application) into the QSPI flash itself. If this
data is incorrect (or not present), the boot/reset will fail.

» Devices that incorporate both internal boot flash and external SPIFI/QSPI flash such as the
LPC546xx typically place the responsibilities for QSPI configuration to the users application,
where this might include
* Setup of pinmuxing
* QSPI/SPIFI clock setup
¢ Flash interface initialisation
* QSPI initialisation (this may be QSPI device specific)
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« including setup of appropriate waitstates for QSPI operation at the selected QSPI clock
frequency

Configuring projects to span multiple Flash Devices

https://community.nxp.com/thread/388979

Kinetis Flash Drivers

Kinetis MCUs make use of a range of generic drivers, which are supplied as part of the SDK
part support package. When a project is created or imported, the appropriate Flash driver is
automatically selected and associated with the project.

Kinetis Flash drivers generally follow a simple naming convention i.e. FTFx_nK_xx where:

e FTFx is the Flash module name of the MCU, where x can take the value E, A or L

¢ nK represents the Flash sector size the Flash device supports, where n can take the value
1,2,4,8
* a sector size is the smallest amount of Flash that can be erased on that device

¢ xxis an optional suffix for special case drivers e.g. __Tiny for use on parts with a small quantity
of RAM

So for example a K64F MCU'’s Flash driver will be called FTFE_4K, because the K64F MCU
uses the FTFE Flash module type and support a 4KB Flash sector size.

When a debug session is started that programs data into Flash memory, the IDE’s debug log
file will report the Flash driver used and parameters it has read from the MCU. Below we can
see the driver identified a K64 part and the size of the internal Flash available. It also reports the
programming speed achieved when programming this device. These logs can be useful when
problems are encountered.

Note: when the Flash driver starts up, it will interrogate the MCU and report a number of data
items. However, due to the nature of internal registers with the MCU, these many not exactly
match the MCU being debugged.

Probe Firnware: LPC-LINK2 CVSI S-DAP V5. 181 (NXP Semi conduct or s)
Serial Nunber: |WUALEW

VID: PID: 1FC9: 0090

USB Pat h: USB_1f c9_0090_14131100_f f 00

Probe(0): Connected&Reset. Dpl D: 2BA01477. Cpul D. 410FC240. |nfo: <None>
Debug protocol: SWD. RTCK: Disabl ed. Vector catch: Disabled.
Inspected v.2 On chip Kinetis Flash nmenory nodul e FTFE_4K. cf x

I mage ' Kinetis Sem Generic Feb 17 2017 17:24:02'

Openi ng flash driver FTFE_4K. cf x

flash variant 'K64 FTFE Ceneric 4K detected (1MB = 256*4K at 0x0)
Cl osing flash driver FTFE_4K. cfx

NXP: MK64FN1MDxxx12

Connect ed: was_reset=true. was_stopped=true

MCUXpr essoPro Full License - Unlimted

Awai ting tel net connection on port 3331 ...

GDB nonst op node enabl ed

Opening flash driver FTFE 4K cfx (already resident)

Witing 26732 bytes to address 0x00000000 in Fl ash

Erased/ Wote page 0-6 with 26732 bytes in 285nsec

Cl osing flash driver FTFE_4K. cfx

Fl ash Wite Done
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Fl ash Program Sunmary: 26732 bytes in 0.28 seconds (91.60 KB/ sec)

Flash drivers for a number of Kinetis MCUs are listed below:

K64F FTFE_4K (1MB)

K22F FTFA 2K (512KB)
KL43 FTFA_1K (256KB)
KL27 FTFA_1K (64KB)
K40  FTFL_2K (256KB)

The LinkServer GUI Flash Programmer

The LinkServer GUI Flash Programmer has been replaced by the debug solution independent

The Command Line Flash programmer

Note: While the information below is still current, for most users this functionality has been
replaced by features within the

Flash programming is usually invoked automatically when you launch a debug session from
within MCUXpresso IDE, but can also be accessed directly using a command line utility (also
known as the LinkServer debug stub). This can be useful for things like programming the Flash
for devices with limited production runs.

The MCUXpresso IDE Flash programming utility is located at:

<install _dir>/ide/bin/

To run a Flash programming operation from the command line, the correct Flash utility stub for
your part should be called with appropriate options. For boards containing Cortex-M MCUs the
utility is called crt_emu_cm_redlink.

For example:

crt_emu_cmredlink -p LPC11U68 --flash-1oad "LPC11U68_App. axf"

will load the AXF file LPC11U68_App.axf into Flash on an LPC11U68.

Note: typically, LPC-Link2 or LPCXpresso V2 and V3 boards have debug probe firmware soft
loaded automatically by the IDE when a debug operation is first performed. Therefore to use
these debug probes from the command line they must either have their firmware softloaded or
have probe firmware programmed into the Flash. Probe firmware can be soft-loaded from the
command line by use of scripts boot_linkl for LPC-Link and boot_link2 for LPC-Link2, these
are located at mcuxpresso_install_dir/ide/bin. To program debug probe firmware into the Flash
memory of an LPC-Link2 debug probe, please see: http://www.nxp.com/LPCSCRYPT

Programming an image into Flash

In the simplest case the Flash programming utility takes the following options if the file to be
flashed is an AXF (or ELF) file:

crt_emu_cmredlink -p target --flash-load "filename" [--flash-driver "flashdriver"]

it is also possible to flash binary files using:
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crt_emu_cmredlink -p target --flash-load "fil ename" --1oad-base base_address [--flash-driver /
"flashdriver"]

Where:

e crt_emu_cm_redlink is the name of the Flash utility

 target is the target chip name. For example LPC1343, LPC1114/301, LPC1768 etc. (see
‘Finding Correct Parameters...” below)

« --flash-load can actually be one of a few different options. Use:

« --flash-load to write the file to Flash,

» --flash-load-exec to write it to Flash and then cause it to start running,

« --flash-mass-load to erase the Flash and then write the file to the Flash, and

» --flash-mass-load-exec to erase the Flash, write the file to Flash and then cause it to start
running.

« filename is the file to Flash program. It may be an executable (axf) or a binary (bin) file. If using
a binary file, the base_address also must be specified. Using enclosing quotes is optional
unless the name includes unusual characters or spaces.

« base_address is the address where the binary file will be written. It can be specified as a hex
value with a leading Ox.

If you are using Flash memory that is external to the main chip you will need to specify an
appropriate Flash driver that supports the device. This usually takes the name of a .cfx file held
in a default location. In unusual circumstances it is possible to specify an absolute file system
name of a file. Using enclosing quotes is optional unless the name includes unusual characters
or spaces (see ‘Finding Correct Parameters...” below).

WARNING: When crt_emu_cm_redlink Flash drivers program data that they believe will form
the start of an execute-in-place image they determine where the image’s vector table is and
automatically inserts a checksum of the initial few vectors, as required in many LPC parts. This
may not be the value held in that location by the file from which the Flash was programmed. This
means that if the content of the Flash were to be compared against the file a difference at that
specific location may be found.

WARNING: Flash is programmed in sectors. The sizes and distributions of Flash sectors is
determined by the Flash device used. Data is programmed in separate contiguous blocks — there
may be many contiguous blocks of data specified in an EFL (.AXF) file but there is only one in
a binary file. When a contiguous data block is programmed into Flash data preceding the block
start in its Flash sector is preserved. Data following data in the block in the final sector, however
is erased.

Programming Flash with SDK Part Support

The above method works for parts supported with preinstalled part support. If SDK part support
is required, then additional options must be passed to the utility.

e sdk_parts_directory - the place where the utility can find SDK part information; and
¢ sdk_flash_directory - the place where the utility can find Flash drivers provided by the SDK.

These are supplied to the utility by adding the following two options

-x "sdk_parts_directory" --flash-dir "sdk_flash_directory"

on to the command line already described. For example:

crt_emu_cmredlink -p LPC54018 --flash-1oad "LPC54018_app. axf" \
-x ~/ mcuxpresso/ 01/ . ncuxpr essoi de_packages_support/LPC54018_support \
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--flash-dir ~/ ncuxpresso/ 01/ . ncuxpressoi de_packages_support/LPC54018_support/Fl ash

Since this is quite a lot to type you might wish to put the location of your SDK support directory
into an environment variable as follows:

Windows:

set DIR_SDK ...\ ntuxpresso\01\. ncuxpressoi de_packages_support\LPC54018_support
crt_emu_cmredlink -p LPC54018 --flash-1oad "LPC54018_app. axf" -x %I R_SDK% --fl ash-dir %Ol R_SDK% Fl ash

MacOS or Linux:

export DI R_SDK="~/.ncuxpresso/ 01/ . ncuxpressoi de_packages_support/LPC54018_support"
crt_emu_cmredlink -p LPC54018 --flash-load "LPC54018_app. axf" -x $DIR_SDK --flash-dir \
$DI R_SDK/ Fl ash

Use “Finding Correct Parameters from MCUXpresso IDE”, below, to determine what values you
require for these options.

Programming Flash taking MCUXpresso IDE project Memory edits into Account

MCUXpresso IDE allows the user to modify the default definition of the memory areas (including
the specification of different named Flash regions) used in a hardware using the Edit... button
found in the project’s properties at C/C++Build -> MCU Settings under the heading “Memory
details”. The editor can create multiple named Flash regions.

In order to use these updates to the project’s part information the utility must use the directory
where MCUXpresso IDE stores the project’'s products for whatever configuration has been
modified (typically the configuration will be called ‘Debug’) as the source of its part information.

To find the location of this directory in MCUXpresso expand the project in the Project Editor view,
select the directory with the required configuration name (e.g. ‘Debug’), right click on it to bring
up its properties and see the ‘Resource’ heading.

Supply this directory name as the sdk_parts_directory to the utility by adding the options:

-x "sdk_parts_directory"

Even if the part is supported by an SDK this will be the correct option to use for -x.
Programming Flash for complex debug connections

Some boards or chips occasionally need additional steps to occur before a stable debug
connection can be established. Such debug connections are set up by small BASIC like programs
called Connect Scripts. A good indication as to whether your chip or board normally requires a
connect script can be discovered when “Finding Correct Parameters from MCUXpresso IDE” (see
below).

Connect scripts are distributed within the product and do not normally need to be written from
scratch.

If a connect script is required it can be supplied by adding the following option to the command
line already described:

--connectscript "connectscript"
If you are using --flash-load-exec rather than --flash-load you may also find that the part that you

are using requires its own “reset script” to replace the standard means of starting the execution of
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the flashed image. Again you may discover whether one is necessary as below. When required
it can be supplied by adding the following option to the command line:

--resetscript "resetscript"

(As usual the quotes are required only if the script file name contains a space or other unprintable
character.)

Finding the correct parameters from MCUXpresso IDE

Note: A simple way of finding the correct command and options is to use the GUI Flash
Programmer described above, the completion dialog shows the exact command line invoked by
the GUI. On this line the IDE will have chosen the correct

 target name

« a default Flash driver, flashdriver

e a connect script to be run, if needed

e aresetscript to be run, if needed with --flash-load-exec

e an sdk_parts_directory where XML information about the part being used (if it is provided via
an SDK) can be found

« an sdk_flash_directory where flash drivers supporting the part being used (if it is provided via
an SDK) can be found

Note: that the details will only appear and be relevant only if a project supporting the relevant
chip or board is selected in the project explorer view.

For example the command line produced might be:

crt_emu_cmredlink "/Wrkspace/frdnk64f_driver_exanpl es_blinky.axf" -g --debug 2 --vendor NXP \
-p MK64FN1MDxxx12 - ProbeHandl e=1 - Corel ndex=0 --Connect Script kinetisconnect.scp -x \
/ User s/ nxp/ ncuxpr esso/ 01/ . ncuxpr essoi de_packages_support / MK64FNLMOxxx12_support --flash-dir \
/ User s/ nxp/ ncuxpr esso/ 01/ . ncuxpr essoi de_packages_support / MK64FNLMOxxx12_suppor t/ Fl ash

Looking at this the target name follows -p; the flashdriver follows --flash-driver; a connectscript
follows --connectscript; a resetscript follows --resetscript; any sdk_flash_directory is provided
following --flash-dir and any sdk_parts_directory is provided following -x.

If the target does not require a connect script or reset script the relevant options will not appear.
If the project is not based on an SDK -x and --flash-dir do not appear.

Dealing with Errors during Flash operations

If your board requires a connect script to be run in order to provide a stable environment for Flash
drivers you may see errors when you undertake a Flash operation without using it. You can use
‘Finding Correct Parameters from MCUXpresso IDE’, above, to check whether a connect script
is required.

On some boards it is possible to run an image which is incompatible with the Flash driver (which
crt_emu_cm_redlink runs on the target to help it manipulate a Flash device). This incompatibility
is likely to show in the form of programming errors signalled as the operation progresses. Often
they are due to unmaskable exceptions (such as watchdog timers) being used by the previous
image that interfere with a Flash driver’s operation.

There are a number of ways to address this situation:

¢ Does your board support In System Processing (ISP) Reset? Using it will usually reset the
hardware and stop in the Boot ROM, thus ensuring a stable environment for Flash drivers. If
present it can usually be activated with one or more on-board switches. You may have to refer
to the board’s documentation.
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¢ Use the --vc option with crt_emu_cm_redlink. This option causes a reset when the utility’s
connection to the board’s debug port is established. Most chips will be left having executed
part of the Boot ROM and usually the resulting state is suitable for running a Flash driver.
(There are exceptions however.)

¢ Erase the contents of Flash (see below) or program a (e.g. small) image that ensures no non-
maskable exceptions are involved. Naturally these solutions have the problem that they are as
likely to fail (and for the same reason) as the programming operation. It is sometimes the case
that an incompatible image will allow the Flash drivers to operate for a short period in which
there is a chance that one of these ‘solutions’ can be used.

Validating the Content of Flash

The Flash programming utility can validate the content of Flash programmed as an AXF (or ELF)
file:

crt_emu_cmredlink -p target --flash-verify "filenane" [--flash-driver "flashdriver"]

it is also possible to verify binary files using:

crt_emu_cmredlink -p target --flash-verify "filenane" --I|oad-base base_address \
[--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.

For example:

crt_emu_cmredlink -p LPC11U68 --flash-verify "LPCL1U68_App. axf"

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.

Erasing the Flash

The Flash programming utility can also delete the content of Flash. To do so it takes the following
options:

crt_emu_cmredlink -p target --flash-mass-erase [--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.

For example:

crt_emu_cmredlink -p LPC11U68 --fl ash-nmass-erase

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.)

Validating that Flash has been Erased

The Flash programming utility can validate that the content of Flash has been erased:

crt_emu_cmredlink -p target --flash-check --area flash " [--flash-driver "flashdriver"]

For example:
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crt_emu_cmredlink -p LPC11U68 --fl ash-check --area flash

It is also possible to check that just the specific areas that would have been programmed by a
given AXF or binary file are blank.

crt_emu_cmredlink -p target --flash-check-file "filename" [--flash-driver "flashdriver"]

t is also possible to verify binary files using:

crt_emu_cmredlink -p target --flash-check-file "filename" --1oad-base base_address \
[--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.

For example:

crt_emu_cmredlink -p LPC11U68 --flash-check-file "LPCL11U68_App. axf"

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.)

Examples

To load the binary executable file app.bin at location 0 on an LPC54113J128 target using LPC-
Link2, use the following command line:

crt_emu_cmredlink -p LPC54113J128 --1|o0ad-base 0 --flash-Ioad-exec app.bin

To load the executable file app.axf and start it executing on an LPC1768 target using LPC-Link2,
use:

crt_emu_cmredlink -p LPC1768 --flash-|oad-exec "app.axf"

To erase Flash, program the executable app.axf into an LPC18S37 board, which has no internal
Flash but supports external Flash on the board, and then run it:

crt_emu_cmredlink -p LPC18S37 --flash-mass-| oad-exec "app.axf" --flash-driver \
LPC18x7_43x7_2x512_Boot A. cf x

To erase then program app.axf into a Kinetis MK64FN1MOxxx12, which is supported through an
SDK, and requirings a connect script (on MacOS/Linux):

crt_emu_cmredlink -p MK64FNLMDxxx12 --flash-mass-1oad "app. axf" \
--connectscript kinetisconnect.scp \
-x ~/ mcuxpresso/ 01/ . ncuxpr essoi de_packages_support/ MK64FNLMOxxx12_support \
--flash-dir ~/ncuxpresso/ 01/ . ncuxpressoi de_packages_support/ MK64FN1MIxxx12_support/ Fl ash

To delete the Flash on an LPC1343:

crt_emu_cmredlink -p LPC1343 --flash-mass-erase

To delete the Flash on an LPC54113J128 using vector catch to ensure that the currently booted
code does not interfere with the Flash driver:
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crt_emu_cmredlink -p LPC54113J128 --fl ash-erase --vc

To check that the Flash is blank on an LPC54018 which is supported by an SDK and which
has modified its memory layout stored in the MCUXpresso SDK example project held at ~/ws/
Ipcxpresso54018 driver_examples_gpio_gpio_led_output:

crt_emu_cmredlink -p LPC54018 --flash-check -x \
~/ ws/ | pcxpresso54018_dri ver _exanpl es_gpi o_gpi o_| ed_out put/ Debug \
--flash-dir ~/ ncuxpresso/ 01/ . ncuxpressoi de_packages_support/LPC54018_support/Fl ash
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MCUXpresso IDE ships with three different C/C++ library families. This provides the maximum
possible flexibility in balancing code size and library functionality.

Overview of Redlib, Newlib and NewlibNano

¢ Redlib Our own (non-GNU) ISO C90 standard C library, with some C99 extensions.
¢ Newlib GNU C/C++ library
« NewlibNano a version of the GNU C/C++ library optimized for embedded.

By default, MCUXpresso IDE will use Redlib for C projects, NewlibNano for SDK C++ projects,
and Newlib for C++ projects for preinstalled MCUs.

Newlib provides complete C99 and C++ library support at the expense of a larger (in some cases,
much larger) code size in your application.

NewlibNano was produced as part of ARM’s “GNU Tools for ARM Embedded Processors”
initiative in order to provide a version of Newlib focused on code size. Using NewlibNano can
help dramatically reduce the size of your application compared to using the standard version of
Newlib — for both C and C++ projects.

If you need a smaller application size and don't need the additional functionality of the C99 or C+
+ libraries, we recommend the use of Redlib, which can often produce much smaller applications.

Redlib extensions to C90

Although Redlib is basically a C90 standard C library, it does implement a number of extensions,
including some from the C99 specification. These include:

 Single precision math functions
 Single precision implementations of some of the math.h functions such as sinf() and cosf()
are provided.
 stdbool.h
* An implementation of the C99 stdbool.h header is provided.
* itoa
« itoa() is non-standard library function which is provided in many other toolchains to convert
an integer to a string. To ease porting, an implementation of this function is provided,
accessible via stdlib.h. More details can be found later in this chapter.

Newlib vs NewlibNano

Differences between Newlib and NewlibNano include:

« NewlibNano is optimized for size.

¢ The printf and scanf family of routines have been re-implemented in NewlibNano to remove
a direct dependency on the floating-point input/output handling code. Projects that need to
handle floating-point values using these functions must now explicitly request the feature
during linking.

e The printf and scanf family of routines in NewlibNano support only conversion specifiers
defined in C89 standard. This provides a good balance between small memory footprint and
full feature formatted input/output.

* NewlibNano removes the now redundant integer-only implementations of the printf/scanf
family of routines (iprintf/iscanf, etc). These functions now alias the standard routines.

¢ In NewlibNano, only unwritten buffered data is flushed on exit. Open streams are not closed.

« In NewlibNano, the dynamic memory allocator has been re-implemented
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15.2

Library Variants

Each C library family is provided in a number of different variants : None, Nohost and Nohost-nf,
Semihost and Semihost-nf (Redlib only). These variants each provide a different set of ‘stubs’
that form the very bottom of the C library and include certain low-level functions used by other
functions in the library.

Each variant has a differing set of these stubs, and hence provides differing levels of functionality:

¢ Semihost(-mb)
 This library variant provides implementation of all functions, including file I1/0. The file 1/O will
be directed through the debugger and will be performed on the host system (semihosting).
For example, printf/scanf will use the debugger console window and fread/fwrite will operate
on files on the host system. Note: emulated I/O is relatively slow and can only be used when
debugging.
¢ Semihost(-mb)-nf (no files)
« Redlib only. Similar to Semihost, but only provides support for the 3 standard built-in streams
— stdin, stdout, stderr. This reduces the memory overhead required for the data structures
used by streams, but means that the user application cannot open and use files, though
generally this is not a problem for embedded applications.
¢ Nohost and Nohost-nf
 This library variant provides the string and memory handling functions and some file-based
I/O functions. However, it assumes that you have no debugging host system, thus any file
I/0 will do nothing. However, it is possible for the user to provide their own implementations
of some of these 1/O functions, for example to redirect output to the UART.
* None
e This has literally no stub and has the smallest memory footprint. It excludes low-level
functions for all file-based 1/0 and some string and memory handling functions.

Note: -mb library variants are not selected by default durung any wizard project creation however
they may optionally be selected for enhanced semihost performance with the penalty of slightly
larger RAM usage. Please see for additional information.

In many embedded microcontroller applications it is possible to use the None variant by careful
use of the C library, for instance avoiding calls to printf().

If you are using the wrong library variant, then you will see build errors of the form:

* Linker error "Undefined reference to ‘xxx

For example for a project linking against Redlib(None) but using printf() :

...libcr_c.a(fpprintf.o):

In function “printf':

fpprintf.c:(.text.printf+0x38):
fpprintf.c:(.text.printf+0x4c):

undefined reference to
undefined reference to

__sys_ wite'
*__Ciob'

...libecr_c.
_deferredl
...libecr_c.
_writebuf.
_writebuf.
_writebuf.
...libecr_c.
alloc.c: (.
alloc.c: (.
...libecr_c.
fseek.c: (.
fseek.c: (.

a(_deferredl azyseek.0): In function ~_ flsbuf':

azyseek. c: (.text.__fl sbuf +0x88):
a(_witebuf.o): In function ~_Cwitebuf':
c:(.text._Owitebuf+0x16):
c:(.text._Owitebuf+0x26):
c:(.text._Owitebuf+0x3c):
a(alloc.o0):

In function ~_Csys_alloc':

text._Csys_al |l oc+Oxe): undefined reference to °

text._Csys_all oc+0x12): undefined reference to

a(fseek.0): In function “fseek':

text.fseek+0x16): undefined reference to

text.fseek+0x3a): undefined reference to

undefined reference to

undefined reference to
undefined reference to
undefined reference to

©__sys_appexit'

T__sys_|
T__sys_|

T __sys_istty'

*__sys_ flen'

' __sys_seek’

__sys_wite'

sys_wite'

istty'
flen'
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Or if linking against NewlibNano(None):

...libc_nano.a(lib_a-witer.o0): In function ~_wite_r":
witer.c:(.text._wite_r+0x10): undefined reference to ~_wite'
...libc_nano.a(lib_a-closer.o0): In function ~_close_r":
closer.c:(.text._close_r+0xc): undefined reference to " _close'
...libc_nano.a(lib_a-1seekr.o0): In function "~_lseek_r":

| seekr.c: (.text._| seek_r+0x10): undefined reference to " _I|seek’
...libc_nano.a(lib_a-readr.o): In function ~_read_r':

readr.c: (.text._read_r+0x10): undefined reference to ~_read
...libc_nano.a(lib_a-fstatr.o): In function ~_fstat_r":
fstatr.c:(.text._fstat_r+0xe): undefined reference to ~_fstat'
...libc_nano.a(lib_a-isattyr.o): In function "~ _isatty_r':

isattyr.c:(.text._isatty_r+0xc): undefined reference to "_isatty'

In such cases, simply change the library hosting being used (as described below), or remove the
call to the triggering C library function.

Switching the selected C library

Normally the library variant used by a project is set up when the project is first created by the
New Project Wizard. However it is quite simple to switch the selected C library between Redlib,
Newlib and NewlibNano, as well as switching the library variant in use.

To switch, highlight the project in the Project Explorer view and go to:
Quickstart -> Quick Settings -> Set library/header type

and select the required library and variant.

Manually Switching
Alternatively, you can make the required changes to your project properties manually as follows...

When switching between Newlib(Nano) and Redlib libraries you must also switch the headers
(since the 2 libraries use different header files). To do this:

1. Select the project in Project Explorer

2. Right-click and select Properties

3. Expand C/C++ Build and select Settings

4. In the Tools settings tab, select Miscellaneous under MCU C Compiler. Note: Redlib is not
available for C++ projects

5. In Library headers, select Newlib or Redlib

. In the Tools setting tab, select Architecture & Headers under MCU Assembler

7. In Library headers, select Newlib or Redlib

»

Repeat the above sequence for all Build Configurations (typically Debug and Release).

To then change the libraries actually being linked with (assuming you are using Managed linker
scripts):

. Select the project in Project Explorer

. Right-click and select Properties

. Expand C/C++ Build and select Settings

. In the Tools settings tab, select Managed Linker Script under MCU Linker

. In the Library drop-down, select the Newlib, NewlibNano or Redlib library variant that you
require (None, Nohost, Semihost, Semihost-nf).

a b wnNBE

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide

Rev. 10.2.0 — 14 May, 2018 133



NXP Semiconductors MCUXpresso IDE User Guide

15.4

154.1

15.4.2

15.4.3

15.4.4

MCUXpresso IDE User Guide -

Again repeat the above sequence for all Build Configurations (typically Debug and Release).
Note: Redlib is not available for C++ projects.

What is Semihosting?

Semihosting is a term to describe application 10 via the debug probe. For this to operate, library
code and debug support are required.

Background to Semihosting

When creating a new embedded application, it can sometimes be useful during the early stages
of development to be able to output debug status messages to indicate what is happening as
your application executes.

Traditionally, this might be done by piping the messages over a serial cable connected to a

MCUXpresso IDE offers an alternative to this
scheme, called semihosting. Semihosting provides a mechanism for code running on the target
board to use the facilities of the PC running the IDE. The most common example of this is for the
strings passed to a printf being displayed in the IDE’s console view.

The term “semihosting” was originally termed by ARM in the early 1990s, and basically indicates
that part of the functionality is carried out by the host (the PC with the debug tools running on
it), and partly by the target (your board). The original intention was to provide 1/O in a target
environment where no real peripheral-based 1/0 was available at all.

Semihosting Implementation

The way it is actually implemented by the tools depends upon which target CPU you are running
on. With Cortex-M based MCUs, the bottom level of the C library contains a special BKPT
instruction. The execution of this is trapped by the debug tools which determine what operation
is being requested — in the case of a printf, for example, this will effectively be a “write character
to stdout”. The debug tools will then read the character from the memory of the target board —
and display it in the console window within the IDE.

Semihosting also provides support for a number of other 1/0O operations (though this relies upon
your debug probe also supporting them)... For example it provides the ability for scanf to read its
input from the IDE console. It also allows file operations, such that fopen can open a file on your
PC's hard drive, and fscanf can then be used to read from that file.

Semihosting Performance

It is fair to say that the semihosting mechanism does not provide a high performance 1/0O system.
Each time a semihosting operation takes place, the processor is basically stopped whilst the data
transfer takes place. The time this takes depends somewhat on the target CPU, the debug probe
being used, the PC hardware and the PC operating system. But it takes a definite period of time,
which may make your code appear to run more slowly.

In MCUXpresso IDE version 10.2.0 semihosting performance has been enhanced to deliver
roughly double the speed when compared with the previous IDE release. Furthermore, a new
MB library variant is been supplied that delivers a significant further improvement in performance
when combined with LinkServer debug connections. This library along new LinkServer debug
support provides the added benefit of no impact on code execution performance.

Important notes about using Semihosting

When you have linked with the semihosting library, your application will no longer work
standalone — it will only work when connected to the debugger.
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Semihosting operations cause the CPU to drop into “debug state”, which means that for the
duration of the data transfer between the target and the host PC no code (including interrupts) will
get executed on the target. Thus if your application uses interrupts, then it is normally advisable to
avoid the use of semihosting whilst interrupts are active — and certainly within interrupt handlers
themselves. If you still need to use printf, then you can retarget the bottom level of the C library to
use an alternative communication channel, such as a UART or the Cortex-M CPU’s ITM channel.

Semihosted printf and Debugging

Semihosting is common to all supported debug solutions so the implications of this mechanism
should be understood:

Projects linked against semihosting libraries that perform semihosted operations e.g. printf, can
not execute without a debugger connected. This is because semihosted operations make use of
a BreakPoint instruction that is intercepted by the debug tools to trigger the desired behaviour
(typically the printf string appearing within the IDE console). Without a debug connection, these
BreakPoint instructions will not be trapped and a Hard Fault exception will occur. By default, the
supplied Hard Fault handler implementation will be an infinite loop. Therefore if an ‘attach’ is
performed to such a target, the user will observe the code running within the hard fault handler. To
avoid this occurring, ensure that the project makes no use of semihosted operations via sending
output to a UART, using the ITM feature, commenting out semihosted operations etc.

In consequence, if for example a user had created an LED blinky application that also performed
semihosted printf operations, then without a debug connection the blinky would stop when the
first printf was executed.

Introduced in MCUXpresso IDE version 10.1.0: New projects and newly imported SDK example
projects will automatically include a semihost hardfault handler (as can be seen in the image
below). The purpose of this handler is to prevent the problem described above. Now, if a
semihosted operation is performed without debug tools attached, the new semihost hardfault
handler will be entered. The handler will check to see if a semihosted operation cause it to be
entered and if so, simply return.

v =5 MKL2BZ512xxx7_Project

» 4 Binaries

F kil Includes

> 2 CMSIS

» 2 board

¥ 2 source
b Lo MKL2BZ51 2xxx7_Project.c
b g mth.c
b || semihost_hardfault.c

b 2 startup

In consequence, if the user creates an LED blinky application that also performs semihosted
printf operations, then without a debug connection the blinky will continue regardless of any printf
operation that may occur.

This functionality can be disabled if required by either simply deleting the handler file, or by
defining a symbol:

__ SEM HOST_HARDFAULT DI SABLE

Note: Previously created projects imported into MCUXpresso IDE (such as LPCOpen projects),
will not inherit this feature.
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New in MCUXpresso IDE version 10.2.0: The inclusion of the hardfault handler can be
controlled via a preference preferences -> MCUXpresso IDE -> SDK Options -> Include semihost
hardfault handler ..., where the default is to include.

New in MCUXpresso IDE version 10.2.0: is the optional Redlib Semihost MB library
variant. This library provides enhanced semihosting performance from LinkServer
debug connections (other debug solutions will perform as before) with the added
benefit of no impact on code execution performance. There is a small penalty of
slightly larger code and data sizes compared to other Redlib Semihost libraries. This
optional library is recommended for users needing high semihosting performance
and/or have slow debug probe performance

@ Redlib Semihost MB

Semihosting Specification

The semihosting mechanism used within MCUXpresso IDE is based on the specification
contained in the following document available from ARM'’s website... => ARM Developer Suite
(ADS) v1.2 Debug Target Guide, Chapter 5. Semihosting

Use of printf

By default, the output from printf() (and puts()) will be displayed in the debugger console via the
semihosting mechanism. This provides a very easy way of getting basic status information out
from your application running on your target.

For printf() to work like this, you must ensure that you are linking with a “semihost” or “semihost-
nf’ library variant.

Note: If you only require the display of fixed strings, then using puts() rather than printf() will
noticeably reduce the code size of your application.

Redlib printf Variants

Redlib provides the following two variants of printf. Many of the MCUXpresso New project wizards
provide options to select which of these to use when you create a new project.

Character vs String output

By default printf() and puts() functions will output the generated string at once, so that a single
semihosted operation can output the string to the console of the debugger. Note: these versions
of printf() /puts() make use of malloc() to provide a temporary buffer on the heap in order to
generate the string to be displayed.

It is possible to switch to using “character-by-character” versions of these functions (which do
not require heap space) by specifying the build define “CR_PRINTF_CHAR” (which should be
set at the project level). This can be useful, for example, if you are retargeting printf() to write
out over a UART (as detailed below)- as in this case it is pointless creating a temporary buffer to
store the whole string, only to then print it out over the UART one character at a time

Integer only vs full printf (including floating point)

The printf() routine incorporated into Redlib is much smaller than that in Newlib. Thus if code
size is an issue, then always try to use Redlib if possible. In addition, if your application does
not pass floating point numbers to printf, you can also select a “integer only” (non-floating point
compatible) variant of printf. This will reduce code size further.

To enable the “integer only” printf from Redlib, define the symbol “CR_INTEGER_PRINTF”" (at
the project level). This is done by default for projects created from the SDK new project wizard.
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NewlibNano printf Variants

By default, NewlibNano uses non-floating point variants of the printf and scanf family of functions,
which can help to dramatically reduce the size of your image if only integer values are used by
such functions.

If your codebase does require floating point variants of printf/scanf, then these can be enabled
by going to:

Project -> Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Script and
selecting the " Enable printf/scanf float" tick box.

Newlib printf variants

Newlib provides an “iprintf” function which implements integer only printf.

Printf when using LPCOpen

If you are building your application against LPCOpen, you may find that printf output does not
get displayed in MCUXpresso IDE’s debug console by default. This is due to many LPCOpen
board library projects by default redirecting printf to a UART output.

If you want to direct printf output to the debug console instead, then you will need to modify your
projects so that:

1. Your main application project is linked against the “semihost” variant of the C library, and
2. You disable the LPCOpen board library’s redirection of printf output by either:
« locating the source file board.c within the LPCOpen board library and comment out the line:
#include retarget.h, or
« locating the file board.h and enable the line: #define DEBUG_SEMIHOSTING

Printf when using SDK

The MCUXpresso SDK codebase provides its own printf style functionality through the macro
PRINTF. This is set up in the header file fsl_debug_console.h such that it can either point to the
printf function provided by the C library itself, or can be directly to the SDK function pseudo-printf
function : DbgConsole_Printf() . This will typically cause the output to be sent out via a UART
(which may be connected to an on-board debug probe which will sent it back to the host over a
USB VCOM channel). This is controlled by the macro SDK_DEBUGCONSOLE thus:

e |f SDK_DEBUGCONSOLE ==
e PRINTF is directed to C library printf()
» |f SDK_DEBUGCONSOLE ==
e PRINTF is directed to SDK DbgConsole_Printf()

The Advanced page of the SDK new project wizard and Import SDK examples wizard offer
the option to configure a project so that PRINTF is directed to C library printf() by setting
SDK_DEBUGCONSOLE appropriately.

In addition, if PRINTF is being directed to the C library printf(), then if
SDK_DEBUGCONSOLE_UART is also defined, then printf output will still be directed to the
UART. Again the Advanced page of the SDK new project wizard and Import SDK examples
wizard offer an option to control this.

Retargeting printf/scanf

By default, the printf function outputs text to the debug console using the “semihosting”
mechanism.
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In some circumstances, this output mechanism may not be suitable for your application. Instead,
you may want printf to output via an alternative communication channel such as a UART or — on
Cortex-M3/M4 — the ITM channel of SWO Trace. In such cases you can retarget the appropriate
portion of the bottom level of the library.

The section “How to use ITM Printf” below provides an example of how this can be done.

Note: when retargeting these functions, you can typically link against the “nohost” variant of the
C Library, rather than the “semihost” one.

Redlib

To retarget Redlib’s printf(), you need to provide your own implementations of the function
__sys_write():

int __sys_ wite(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of unwritten bytes if error, otherwise 0 for success

Similarly if you want to retarget scanf(), you need to provide your own implementations of the
function __sys_readc():

int __sys_readc(void)

Function returns character read
Note: these two functions effectively map directly onto the underlying “semihosting” operations.
Newlib / NewlibNano

To retarget printf(), you will need to provide your own implementation of the Newlib system
function _write():

int _wite(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of unwritten bytes if error, otherwise 0 for success

To retarget scanf, you will need to provide your own implementation of the Newlib system function
_read():

int _read(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of characters read, stored in pcBuffer

More information on the Newlib system calls can be found at: https://sourceware.org/newlib/
libc.html#Syscalls

How to use ITM Printf

ITM Printf is a scheme to achieve application 10 via a debug probe without the usual semihosting
penalties.

ITM Overview

As part of the Cortex-M3/M4 SWO Trace functionality available when using an LPC-Link2 (with
NXP’s CMSIS-DAP firmware), MCUXpresso IDE provides the ability to make use of the ITM :
The Instrumentation Trace Macrocell (ITM) block provides a mechanism for sending data from
your target to the debugger via the SWO trade stream. This communication is achieved through
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a memory-mapped register interface. Data written to any of 32 stimulus registers is forwarded to
the SWO stream. Unlike other SWO functionality, using the ITM stimulus ports requires changes
to your code and so should not be considered non-intrusive.

Printf operations can be carried out directly by writing to the ITM stimulus port. However the
stimulus port is output only. And therefore scanf functionality is achieved via a special global
variable, which allows the debugger to send characters from the console to the target (using
the trace interface). The debugger writes data to the global variable named ITM_RxBuffer to be
picked up by scanf.

Note: MCUXpresso IDE currently only supports ITM via stimulus port 0.

Note: For more information on SWO Trace, please see the MCUXpresso IDE LinkServer SWO
Trace Guide.

ITM printf with SDK

The Advanced page of the SDK new project wizard and Import SDK examples wizard offer the
option to configure a project so as to redirect printf/scanf to ITM. Selecting this option will cause
the file retarget_itm.c to be generated in your project to carry out the redirection.

ITM printf with LPCOpen

To use this functionality with an LPCOpen project you need to: Include the file retarget_itm.c in
your project — available from the Examples subdirectory of your IDE installation Ensure you are
using a semihost, semihost-nf, or nohost C library variant. Then simply add calls to printf and
scanf to your code.

If you just linking against the LPCOpen Chip library, then this is all you need to do. However if you
are also linking against an LPCOpen board library then you will likely see build errors of the form:

../src/retarget.h:224: nultiple definition of ~__sys wite'

../src/retarget.h:240: nultiple definition of ~_ sys_readc’

locating the file board.h and enable the line: #define DEBUG_SEMIHOSTING, or locating
the source file board.c within the LPCOpen board library and comment out the line: #include
"retarget.h"

15.6 itoa() and uitoa()
itoa() is non-standard library function which is provided in many other toolchain to convert an
integer to a string.
15.6.1 Redlib
To ease porting, MCUXpresso IDE provides two variants of this function in the Redlib C library....
char * itoa(int value, char *vstring, unsigned int base);
char * uitoa(unsigned int value, char *vstring, unsigned int base);
which can be accessed via the system header....
#i ncl ude <stdlib. h>
itoa() converts an integer value to a null-terminated string using the specified base and stores
the result in the array pointed to by the vstring parameter. Base can take any value between 2
and 16; where 2 = binary, 8 = octal, 10 = decimal and 16 = hexadecimal.
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If base is 10 and the value is negative, then the resulting string is preceded with a minus sign (-).
With any other base, value is always considered unsigned. The return value to the function is a
pointer to the resulting null-terminated string, the same as parameter vstring.

uitoa() is similar but treats the input value as unsigned in all cases.

Note: the caller is responsible for reserving space for the output character array — the
recommended length is 33, which is long enough to contain any possible value regardless of
the base used.

Example invocations

char vstring [33];
itoa (value,vstring,10); // convert to decinal
itoa (value,vstring, 16); // convert to hexadeci mal

itoa (value,vstring,8);; // convert to octal

Standards compliance

As noted above, itoa() / uitoa() are not standard C library functions. A standard-compliant
alternative for some cases may be to use sprintf() - though this is likely to cause an increase in
the size of your application image:

sprintf(vstring,"%l",value); // convert to decimal
sprintf(vstring,"%",value); // convert to hexadeci mal
sprintf(vstring,"%",value); // convert to octal

Newlib/NewlibNano

Newlib and NewlibNano now also provide similar functionality though with slightly different
naming - itoa() and utoa().

Libraries and linker scripts

When using the managed linker script mechanism, as described in the chapter “Memory
configuration and Linker Script Generation”, then the appropriate settings to link against the
required library family and variant will be handled automatically.

However if you are not using the managed linker script mechanism, then you will need to define
which library files to use in your linker script. To do this, add one of the following entries before
the SECTION line in your linker script:

¢ Redlib (None), add
* [C project only]: GROUP (libcr_c.a libcr_eabihelpers.a)
* Redlib (Nohost), add
 [C projects only]: GROUP (libcr_nohost.a libcr_c.a libcr_eabihelpers.a)
¢ Redlib (Semihost-nf), add
* [C projects only]: GROUP (libcr_semihost_nf.a libcr_c.a libcr_eabihelpers.a)
* Redlib (Semihost), add
e [C projects only]: GROUP (libcr_semihost.a libcr_c.a libcr_eabihelpers.a)

« NewlibNano (None), add

¢ [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_none.a)

* [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a libcr_newlib_none.a)
* NewlibNano (Nohost), add

¢ [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_nohost.a)
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o [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a
libcr_newlib_nohost.a)

NewlibNano (Semihost), add

¢ [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_semihost.a)

o [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++ _nano.a libm.a
libcr_newlib_semihost.a)

Newlib (None), add

* [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_none.a)

e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_none.a)
Newlib (Nohost), add

e [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_nohost.a)

e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_nohost.a)
Newlib (Semihost), add

* [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_semihost.a)

e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_semihost.a)

In addition, if using NewlibNano, then tick box method of enabling printf/scanf floating point
support in the Linker pages of Project Properties will also not be available. In such cases, you
can enabling floating point support manually by going to:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Miscellaneous
and entering -u _printf_float and/or -u _scanf_float into the “Linker flags” box.

A further alternative is to put an explicit reference to the required support function into your project
codebase itself. One way to do this is to add a statement such as:

asm (“.global _printf_float”);

to one (or more) of the C source files in your project.
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16. Memory Configuration and Linker Scripts

16.1

Introduction

A key part of the core technology within MCUXpresso IDE is the principle of a default defined
memory map for each MCU. For devices with internal Flash, this will also specify a Flash driver
to be used to program that Flash memory (for use with LinkServer “native” debug probes).

For preinstalled MCUs, the definition of the memory map is contained within the MCU part
knowledge that is built into the product. For MCUs installed into MCUXpresso IDE from an SDK,
the definition of the memory map is loaded from the manifest file within the SDK structure.

But in both cases, the defined memory map is used by MCUXpresso IDE to drive the “managed
linker script” mechanism. This auto-generates a linker script to place the code and data from
your project appropriately in memory, as well as being made available to the debugger.

A project’'s memory map can be viewed and modified by the user to add, remove (split/join)
or reorder blocks using the Memory Configuration Editor. For example, if a project targets an
MCU that supports external Flash (e.g. SPIFI), then it's memory map can be easily extended to
define the SPIFI memory region (base and size). In addition, an appropriate Flash driver can be
associated with the newly defined region.

[ ] MCUXpresso IDE

| Memory configuration editor
| Edit configuration for MKB4FN1MOxxx12 m

Memory configuration

Default flash driver | Browse...
Type Name Alias Location Size Driver —
Flash PROGRAM_FLASH Flash 0x0 0x100000 FTFE_4K.efx i
RAM  SRAM_UPPER RAM 0x20000000 0x30000
RAM  SRAM_LOWER RAMZ2  Ox1fff0000 0x10000 &
RAM  FLEX_RAM RAM3  0x14000000 Ox1000
|
Add Flash Add RAM Split Delete
Import... Merge... Export... Generate...

Cancel | OK |

Figure 16.1. Memory Configuration
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Managed Linker Script Overview

By default, the use of “managed linker scripts” is enabled for projects. This mechanism allows
MCUXpresso IDE to automatically create a script for each build configuration that is suitable
for the MCU selected for the project, and the C libraries being used. It will create (and at times
modify) three linker script files for each build configuration of your project:

<proj nane>_<bui l dconfig>_lib.ld
<proj nane>_<bui | dconfi g> nmem | d
<proj nane>_<bui | dconfig>.1d
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This set of hierarchical files are used to define the C libraries being used, the memory map of
the system and the way your code and data is placed into the memory map. These files will be
located in the build configuration subdirectories of your project (typically — Debug and Release).

Figure 16.2. Project Explorer Debug folder Linker Scripts

[~ Project Ex 2 2, Peripheral !} Registers 1. SymbolVi =
==

» 4 Binaries
F i Includes
» ECMSIS
» 2 accel
F 2 board
» Edrivers
» 2 source
» Estartup
b (2 utilities
¥ = Debug
» (=accel
F (= board
k= CMSIS
b (=drivers
F [=-sOurce
= startup
F (= utilities
b 3k frdmk64f demo apps bubble.axf - [arm
=| frdmk64f_demo_apps_bubble_Debug_library.ld
frdmk64f_demo_apps_bubble_Debug_memory.ld
= frdmk64f demo_apps_bubble Debug.ld
= frdmk64f_demo_apps_bubble.map
| @ makefile
| & objects.mk
| & sources.mk
F =doc
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The managed linker script mechanism also automatically takes into account memory map
changes made in the Memory Configuration Editor as well as other configuration changes, such
as C/C++ library settings.

How are Managed Linker Scripts Generated?

MCUXpresso IDE passes a set of parameters into the linker script generator (based on the
“FreeMarker” scripting engine) to create an appropriate linker script for your project. This
generator uses a set of conditionally parsed template files, each of which control different aspects
of the generated linker script.

It is possible to modify certain aspects of the generated linker script by providing one or more
modified template files locally within linkscripts folder of project directory structure. Any such
templates that you provide locally will then override the default ones built into MCUXpresso IDE.
A full set of the default linker templates (.Idt) files are provided inside \Wizards\linker subdirectory
of your IDE install.

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide

Rev. 10.2.0 — 14 May, 2018 143



NXP Semiconductors

MCUXpresso IDE User Guide

16.4 Default Image Layout

Code and initial values of initialised data items are placed into first bank of Flash (as show in
memory configuration editor). During startup, MCUXpresso IDE startup code copies the data into
the first bank of RAM (as show in memory configuration editor), and zero initializes the BSS data
directly after this in memory. This process uses a global section table generated into the image
from the linker script.

Other RAM blocks can also have data items placed into them under user control, and the startup
code will also initialize these automatically. See later in this chapter for more details.

Figure 16.3. Default Memory Layout

0X2000 4000

RAMZ -] (o P BSSZ
0x2000 0000 " DATA2
0x1000 8000 |

Co|
RAM :py Heap {}

Zerg. oo BSS
Ox 1000 0000 . ----------- > | DAT,A
0x0001 0000 E
. Copy
DATA2 | -
Flash DATA .
CODE { c'::E CODE
0x0000 0000 .,
Load view Runtime view
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Note: The above memory layout is simply the default used by the IDE’s managed linker script
mechanism. There are a number of mechanisms that can be used to modify the layout according
to the requirements of your actual project — such as simply editing the order of the RAM banks
in the Memory Configuration Editor. These various methods are described later in this chapter.

The default memory layout will also locate the heap and stack in the first RAM bank, such that:

« the heap is located directly after the BSS data, growing upwards through memory
« the stack located at the end of the first RAM bank, growing down towards the heap

Again this heap and stack placement is a default and it is very easy to modify the locations for
a particular project, as will be described later in this chapter.

Note: When you import a project, you may find that the defaults have already been modified.
Check the Project Properties to confirm the exact details.
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16.5 Examining the layout of the generated image
Looking at the size of the AXF file generated by building your project on disk does not provide any
information as to how much Flash/RAM space your application will occupy when downloaded
to your MCU. The AXF file contains a lot more information than just the binary code of
your application, for example the debug data used to provide source level information when
debugging, that is never downloaded to your MCU.
16.5.1 Linker --print-memory-usage

MCUXpresso IDE projects use the --print-memory-usage option on the link step of a build to
display memory usage information in the build console of the following form:

Menory regi on Used Size Regi on Si ze %ge Used

PROGRAM_FLASH: 26764 B 1 MB 2.55%

SRAM_UPPER: 8532 B 192 KB 4. 34%

SRAM_LOVNER: 0 & 64 KB 0. 00%

FLEX_RAM 0 & 4 KB 0. 00%

Fi ni shed building target: frdnk64f_deno_apps_bubbl e. axf
The memory regions displayed here will match up to the memory banks displayed in the memory
configuration editor when the managed linker script mechanism is being used.
By default, the application will build and link against the first Flash memory found within the MCU'’s
memory configuration. For most MCUSs there will only be one Flash device available. In this case
our project requires 26764 bytes of Flash memory storage, 2.55% of the available Flash storage.
RAM will be used for global variable, the heap and the stack. MCUXpresso IDE provides a flexible
scheme to reserve memory for Stack and Heap. This build has reserved 4KB each for the stack
and the heap contributing 8KB to the overall 8532 bytes reported.
If using the 'LPCXpresso style' of heap and stack placement (described later in this chapter), the
RAM consumption provided by this is only that of your global data. It will not include any memory
consumed by your stack and heap when your application is actually executing.
Note: project imported into MCUXpresso IDE may not have been created with this option. To add
this, right click on the project and select C/C++ Build ->Settings -> MCU Linker -> Miscellaneous
then click ‘+’ and add --print-memory-usage

16.5.2 arm-none-eabi-size
In addition, a post-build step will normally invoke the arm-none-eabi-size utility to provide this
information in a slightly different form....
text dat a bss dec hex filenane
2624 524 32 3180 c6e LPCXpressol768_systi ck_tw nkl e. axf
¢ text - shows the code and read-only data in your application (in decimal)
« data - shows the read-write data in your application (in decimal)
* bss - show the zero initialized (‘bss’ and ‘common’) data in your application (in decimal)
e dec - total of ‘text’ + ‘data’ + ‘bss’ (in decimal)
¢ hex - hexadecimal equivalent of 'dec’
Typically:
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 the Flash consumption of your application will then be text + data
« the RAM consumption of your application will then be data + bss

Again if using the 'LPCXpresso style' of heap and stack placement (described later in this
chapter), the RAM consumption will not include any memory allocated for your stack and heap
when your application is actually executing.

You can also manually run the arm-none-eabi-size utility on both your final application image, or
on individual object files within your build directory by right clicking on the file in Project Explorer
and selecting the Binary Utilities -> Size option.

Linker Map Files

The linker option “-map” option, which is enabled by default by the project wizard when a new
project is created, allows you to analyse in more detail the contents of your application image.
When you do a build, this will cause a file called projectname.map to be created in the Debug (or
Release) subdirectory, which can be loaded into the editor view. This contains a large amount
of information, including:

¢ Alist of archive members (library objects) included with details

¢ Alist of discarded input sections (because they are unused and the linker option --gc-sections
is enabled).

« The location, size and type of all code, data and bss items that have been placed in the image

Symbol Viewer

The Symbol Viewer provides a simple way of displaying the symbols in an object, library archive
or executable. By default, this is located in the top left of the MCUXpresso IDE window, in parallel
with the Project Explorer view.

Viewing Symbols in the Viewer

To open an image in the Symbol Viewer, either highlight it in the Project Explorer Views and
use the context sensitive menu ‘Tools->View Symbols’ menu, or use the Browse button on the
Toolbar within the Symbol Viewer windows itself

The Symbol Viewer can display object files (.0), libraries (.lib .a) and executables (.axf or .elf)
The image will be processed and displayed in the Symbol Viewer as shown in the next section.

It is possible to open multiple Symbol Viewers by pressing the ‘Green +' icon in the toolbar. The
symbols for different images can then be displayed simultaneously.

Using the Symbol Viewer

When first opening a file, the viewer will display the sections found in the file (e.g. .text, .bss etc).
Expanding a section will show the symbols within that section. Clicking on the symbol name will
open the source file in an editor window at the symbol definition (if source is available).

The columns of the symbol viewer show information about the symbols:

¢ Symbol Name:
¢ Address: The address (or value) of the Symbol

¢ Size: The size of the symbol, in bytes. For functions this would be the size of the function. For
variables, this would be the size occupied by the variable

* Flags: The type of the Symbol. Typically this would be Local or Global and Function or Object
(data variable)
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[(5 Project Explorer =, Peripherals+ 1} Registers | £ Symbol Viewer 2 = 8
B FE o+ 7
Symbol Address (Range) Size Flags
TMKB4FN1MOxxx12_Project.axf
F text (00000000-000... 8212 Local Debug
¥.data (20000000-200... 4 Local Debug
SystemCoreClock 20000000 4 Global Object
_data 20000000 0 Global
_edata 20000004 0 Global
.data_RAM2 (00000000-000... 0 Local Debug
E_I
v b ss (20000004- 200 19 Local Debug
i.5865 20000004 4 Local Object
ermao 20000010 4 Global Object
_ehss 2000008 0 Global
_bss 20000004 0 Global
__heaps 20000008 4 Global Object
__end_of_heap 2000000¢ 4 Global Object
__Ciob 20000014 180 Global Object
¥.uninit_RESERVED (00000000-000... 0 Local Debug
_end_uninit RESERVED 20000000 {) Global
.noinit_RAM2 (00000000-000... 0 Local Debug
.noinit_RAM3 (00000000-000... O Local Debug
» .noinit (00000000-000... O Local Debug
¥ . heap (00000000-000... O Local Debug
_pvHeapLimit 2000108 ] Global
_pvHeapStart 2000008 0 Global
heap2stackfill (00000000-000... O Local Debug
b .stack (00000000-000... O Local Debug
»*ABS* (00000000-000... 0 Local Debug

Figure 16.4. Symbol Viewer

16.6

16.6.1

MCUXpresso IDE User Guide -

Note: The symbols displayed are a snapshot of the symbols for a particular build, therefore these
should be refreshed when a new build is performed. This can easily be done using the Reload
icon in the Symbol Viewer window.

Other Utilities

The arm-none-eabi-nm utility is effectively a command line version of the Symbol Browser. But
it can sometime be useful when looking at the size of your application, as it can produce some
of the information provided in the linker map file but in a more concise form. For example:

arm none-eabi -nm -S --size-sort -s project.axf

produces a list of all the symbols in an image, their sizes and their addresses, listed in size order.
For more information on this utility, please see the GNU binutils documentation.

Note: you can run arm-none-eabi-nm as a post-build step, or else open a command shell using
the status bar shortcuts (at the bottom of the IDE window).

Other Options affecting the Generated Image

LPC MCUs — Code Read Protection

Most of NXP’s LPC Cortex-M based MCUs which have internal Flash memory contain “Code
Read Protection” (CRP) support. This mechanism uses one of a number of known values being
placed in a specific location in Flash memory to provide a number of levels of protection. When
the MCU boots, this specific location in Flash memory is read and depending upon its value, the
MCU may prevent access to the Flash memory by external devices. This location is typically at
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0x2FC though for LPC18xx/43xx parts with internal Flash, the CRP location is at an offset of
0x2FC from the start of the Flash bank being used.

CRP : Preinstalled MCUs

Support for setting up the CRP memory location is provided via a combination of the Project
Wizard, a header file and a number of macros. This support allows specific values to be easily
placed into the CRP memory location, based on the user’s requirements.

The New Project wizard contains an option to allow linker support for placing a CRP word to be
enabled when you create a new project. This is typically enabled by default. This wizard option
actually then controls the “Enable CRP” checkbox of the Project Properties linker Target tab.

In addition, the wizard will create a file, ‘crp.c’ which defines the ‘CRP_WORD’ variable which will
contain the required CRP value. A set of possible values are provided by the NXP/crp.h header
file that this then includes. Thus for example ‘crp.c’ will typically contain:

#i ncl ude <NXP/crp. h>
__CRP const unsigned int CRP_WORD = CRP_NO CRP ;

which is then placed at the correct location in Flash by the linker script generated by the managed
linker script mechanism:

. = 0x000002FC ;
KEEP(*(.crp))

Note: the value CRP_NO_CRP ensures that the Flash memory is fully accessible. When you
reach the stage of your project where you want to protect your image, you will need to modify
the CRP word to contain an appropriate value.

Important Note: You should take particular care when modifying the value placed in the CRP
word, as some CRP settings can disable some or all means of access to your MCU (including
debug). Before making use of CRP, you are strongly advised to refer to the User Manual for the
LPC MCU that you are using.

CRP : MCUs installed by Importing an SDK

The support for CRP in LPC parts imported into MCUXpresso IDE from an SDK, is generally
similar to the Preinstalled MCUs. However rather than having a separate crp.c file, the
CRP_WORD variable definition is generally found within the startup code.

Kinetis MCUs — Flash Config Blocks

Kinetis MCUs provides an alternative means of protecting the user’s image in Flash using the
Flash Configuration Block. The Flash Configuration Field is generally located at addresses
0x400-0x40F and unlike the LPC CRP mechanism only specific values give access, whereas
any other values are likely to lock the part.

The value of the Flash Configuration block for a project is provided by the following structure
which will be found in the startup code:

_attribute__ ((used,section(".FlashConfig"))) const struct {
unsi gned int wordil;
unsi gned int word2;
unsi gned int word3;
unsi gned i nt word4;

} Flash_Config = {OxFFFFFFFF, OxFFFFFFFF, OxFFFFFFFF, OxFFFFFFFE};
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which is then placed appropriately by the linker script generated by the managed linker script

mechanism.

= 0x400 ;

/* Kinetis Flash Configuration data */

PROVI DE(__FLASH CONFI G START__ = .) ;

KEEP(* (. Fl ashConfi g))

PROVI DE(__FLASH CONFIG END__ = .) ;

ASSERT( ! (__FLASH CONFI G_START__ == __FLASH CONFI G_END__),
"Li nker Flash Config Support Enabled, but no .FlashConfig
section provided within application");

/* End of Kinetis Flash Configuration data */

Important Note: The support for placing the Flash Configuration Block can be disabled by
unticking a checkbox of the Project Properties linker Target tab. However this is generally not
advisable as it is very likely to result in a locked MCU.

[ N ) Properties for frdmk64f_demo_apps_bubble
Settings fe=1) - -
*Resource
Tg:‘giir;uild Configuration: | Debug [ Active ] E Manage Configurations...
Build Variables
Environment
Logging #Build steps Build Artifact Binary Parsers @ Error Parsers
MCU settings
fEﬂIirC‘:ghs n Edit ¥ & MCU C Compiler Manage linker script
ool Chain Editor N
» C/C++ General %:Dlalecl Enable automatic placement of Flash Configuration field in image )
2 Preprocessor = —
Project References glnclzdes Link application to RAM
Run/Debug Settings (B Optimization Stack offset 0
»Task Repository = . -
= 22 Debugging . . . .
WikiText Warnings Library Redlib (semihost-nf) <]
EMiscellanecus
# Architecture
¥ & MCU Assembler i .
(B General Linker script
(& Architecture & Headers Script path
¥ 52 MCU Linker —
EGeneral Heap and Stack placement = MCUXpresso Style <]
@ Libraries Region Location Size
%Mmcellanleous ) Heap Default Post Data Default
(¥ Shared Library Settings  stack Default End Default
(2 Architecture
£ Managed Linker Script
EMulticore
Restore Defaults Apply
@ cace (CCENNN
Figure 16.5. Linker Settings

16.6.3 Placement of USB Data

For MCUs where part support is imported from an SDK, the managed linker script mechanism
supports the automatic placement of USB global data (as used by the SDK USB Drivers),
including for parts with dedicated USB_RAM (small or large variants).
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16.6.4

Plain Load Image

The LPC540xx family provides no built-in flash, but rather offers a quad SPI Flash Interface
(SPIFI) so that external flash can be used. The most straight forward way of using external flash
is that the image is built to be programmed into the external flash and executed directly from the
same location (XIP — eXecute In Place).

However the LPC540xx boot rom also offers an alternative way of using the external flash — such
that the application is programmed into the flash, but the boot rom will relocate it into a bank of
the onboard SRAM for execution. Generally it is expected that the SRAMX bank (at address 0x0)
will be used for this. An application that runs in this manner is known as a “plain load image”.

MCUXpresso IDE’s managed linker script mechanism offers a simple way of configuring an
application project so that it will build as a plain load image. This can be controlled for a particular
build configuration via:

Project -> Properties -> C/C++ Build -> Settings -> Tools Settings -> MCU Linker -> Managed
Linker Script

v @E;CU Assembler Link application to RAM
e —
@ General Plain load image SRAMX o

(2 Architecture & Headers .

viH MCU Linker | Generate an image suitable for relocating by @ Style d
& General bootloader from its load address in Flashtoan |
LJ-.‘.Libl.al.ies ] IOKE:PIE auures:r:r‘ f;\eds;;uchdaslthe "plain
B h gt mage” on
(2 Miscellaneous O8C.ARAGH.CAL LI aobd

= % . Region Location Size
(% Shared Library Settings

16.6.5
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4 5 Heap Default Post Data Default
i:nr::;:a:;u[;ker Script Stack Default End Default
=
(2 Multicore
Figure 16.6. Plain Load Image
Please see also the shortcuts.

Enabling the “Plain load image” option will:

1. Modify the generated linker script so that the main code section is located so that it will be
programmed into flash, but expect to be copied into specified RAM bank by the boot rom
before being executed

2. Modify the startup code, using symbols provided from the generated linker script, so that the
appropriate data is placed into the image so that the boot rom know that it needs to relocate
the image from flash into RAM.

Note 1: This functionality requires the application project to be based on the LPC540xx part
support from SDK v2.4.0 (or later).

Note 2: The size of the application image (including the initialised global data) must be less than
the size of the RAM bank that the code will execute from.

Note 3: LPC540xx supports plain load images being executed from either address 0x0 or address
0x20000000. However if the RAM at 0x20000000 is used then the debugger will not be able to
stop on the default breakpoint on main(). This is because a hardware breakpoint needs to be
used (as the copying of the code from flash into RAM by the boot rom would overwrite a software
breakpoint), but the Cortex-M4 cannot set a hardware breakpoint this high in the memory map.

Link Application to RAM
The MCUXpresso IDE managed linker mechanism defaults to placing the code and initialised

data values to first Flash region listed within a projects memory configuration as discussed in the
section.

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide

Rev. 10.2.0 — 14 May, 2018 150



NXP Semiconductors MCUXpresso IDE User Guide

On occasion, it can be useful to debug a project directly from RAM since this offers some benefits
such as avoiding the flash programming element of the debug session etc. Linking to RAM could
be achieved by deleting the Flash memory regions from the projects memory configuration and
rebuilding the application — however this is not the most convenient approach!

Therefore MCUXpresso IDE offers the option to tell the managed linker script mechanism to
simply ignore any flash regions listed in the projects memory configuration via a simple checkbox
at:

Project -> Properties -> C/C++ Build -> Settings -> Tools Settings -> MCU Linker -> Managed
Linker Script

¥ ) MCU Assembler

(% General Link application to RAM
(# Architecture & Headers |
¥ 5 MCU Linker Link all sections to RAM {i.e. ignore Flash)

eneral
braries Heap and Stack placement = MCUXpressc Style ]

iscellaneous
hared Library Settings
(# Architecture

Stack offset 0

Region Location Size

@Managed Linker Script Heap Default Post Data Default
@Multicore Stack Default End 0x4
Figure 16.7. Link to RAM
Please see also the shortcuts.
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With this option is set, the application will instead link to the first RAM region listed within the
projects memory configuration.

There are two important considerations when developing with RAM based projects:

1. They require support from the debug environment to be run and so may not execute in the
exactly the same manner as a true application running from an MCU reset. Please see the
section for more information. Please note: if you are
using debug solutions other than LinkServer, additional user setup may be required.

2. Unlike project running from Flash, global variable load and execute addresses will by default
be the same. The consequence of this is that global variables values will persist at their
current value if an application is restarted. Therefore this is not recommended, and instead a
restart should be achieved by terminating and restarting the whole debug session. See also:

Note: Some MCU/development boards make use of SDRAM. These memories are typically
initialised by the MCU BootROM during reset and this initialisation may require user supplied
configuration data to be programmed into flash. Therefore you must ensure that any SDRAM
regions are correctly initialised before they are used for RAM based debug operations.

Modifying the Generated Linker Script / Memory Layout

The linker script generated by the managed linker script mechanism will be suitable for use,
as is, for many applications. However in some circumstances you may need to make changes.
MCUXpresso IDE provides a number of mechanisms to allow you to do this whilst still being able
to use the managed linker script mechanism. These include:

¢ Changing the layout and order of memory using the Memory Configuration Editor
¢ Changing the size and location of the stack and heap using the Heap and Stack Editor

¢ Decorating the definitions of variables and functions in your source code with macros from the
cr_section_macros.h to cause them to be placed into different memory blocks
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« Providing project specific versions of FreeMarker linker script templates to change particular
aspects of how the managed linker script mechanism creates the final linker script

The following sections describe these in more detail.

16.8 Using the Memory Configuration Editor
The Memory Configuration Editor is accessed via the MCU settings dialog, which can be found at
Project Properties -> C/C++ Build -> MCU settings

This lists the memory details for the selected MCU, and will, by default, display the memory
regions that have been defined by MCUXpresso IDE itself (from installed or SDK part support).

o0 e Properties for LPC4337
type filter text [x] MCU settings Dy w
»Resource

Builders Available parts
¥C/C++ Build IDE
Build Variables
Environment } SDK MCUs
Logging
MCU settings ~ Preinstalled MCUs
Settings MCUs from preinstalled LPC and generic Cortex-M part support
Tocl Chain Editor NXP LPG4337
» C/C++ General LPC4325
Project References LPC4325-M0
Run/Debug Settings LPC4327
* Task Repasitory LPCA4327-M0
WikiText LPC4330
LPC4330-M0
LPC4333
LPC4333-M0
LPC4337
LPC4337-M0

Target architecture: cortex-md
Memory details (LPC4337)
Default flash driver: LPC18x7_43x7_2x512 BootA.cfx

Type Name Alias Location Size Diriver
Flash  MFlashA512 Flash  0x1a000000 0x80000
| Flash MFlashB512 Flash2 0x1b000000  0x80000 |
| RAM  RamLoec32 RAM  0x10000000 0x8000 |
RAM  Ramloc40 RAMZ2 0x10080000  0xa000 |
RAM  RamAHB32 RAM3  0x20000000 0x8000
RAM  RamAHB16 RAM4  0x20008000  0x4000

RAM  RamAHB_ETB16 RAMS 0x2000c000 0x4000

Refresh MCU Cache

Restore Defaults Apply
@ Cancel (TSN

Figure 16.8. LPC4337... default memory regions

16.8.1 Editing a Memory Configuration

In the example below, we will show how the default memory configuration for an LPC4337... can
be changed. Selecting the Edit... button will launch the Memory configuration editor dialog —
see Figure 16.9.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide Rev. 10.2.0 — 14 May, 2018 152




NXP Semiconductors

MCUXpresso IDE User Guide

Memory configuration editor
Edit configuration for LPC4337 m
Memeory configuration
Default flash driver LPC18x7_43x7_2x512_BootA.cfx Browse...
Type Mame Alias Lecation Size Diriver —
Flash MFlashA512 Flash 0x1aDD0000  0xB80000 i
Flash MFlashB512 Flash2  0x1b000000 0x80000
AAM  RamlLoc32 RAM 0x10000000 0xB8000 2
RAM  RamLoc40 RAMZ2  0x10080000 Oxal00
AAM  RamAHB32 RAM3  0x20000000 0x8000
RAM  RamAHB16 RAM4  0x20008000 0x4000
AAM  RamAHB_ETB16 RAMS5  0x2000c000 0x4000
Add Flash Add RAM Split Delete
Import... Merge... Export... Generate...
Cancel OK
Figure 16.9. Memory configuration editor

Known blocks of memory, with their type, base location, and size are displayed. Entries can be
created, deleted, etc by using the provided buttons.

For simplicity, the additional memory regions are given sequential aliases, starting from 2, so
RAM2, RAMS etc (as well as using their “formal” region name — for example RamAHB32).

Table 16.1. Memory editor controls

Button
Add Flash
Add RAM
Split

Join
Delete
Import

Merge

Export
Up / Down

Generate
Driver

Browse(Flash driver)

Details

Add a new memory block of the appropriate type.

Add a new memory block of the appropriate type.

Split the selected memory block into two equal halves.

Join the selected memory block with the following block (if the two are contiguous).
Delete the selected memory block.

Import a memory configuration that has been exported from another project,
overwriting the existing configuration.

Import a partial memory configuration from a file, merging it with the existing memaoryj
configuration. This allows you, for example, to add an external Flash bank definition
to an existing project.

Export a memory configuration for use in another project.

Reorder memory blocks. This is important: if there is no Flash block, then code will
be placed in the first RAM block, and data will be placed in the block following the,
one used for the code (regardless of whether the code block was RAM or Flash).
Generates local part support for the selected MCU.

Highlighted in blue, shows the selection of a per-Flash region Flash driver. Click
this field to see a drop down of all available drivers. Please see:

Select the appropriate driver for programming the Flash memory specified in
the memory configuration. For more information please see the section on
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The name, location, and size of this new region can be edited in place. Note: When entering
the size of the region, you can enter full values in decimal or in hex (by prefixing with ox), or by
specifying the size in kilobytes or megabytes. For example:

¢ To enter a region size of 32KB, enter 32768, 0x8000 OF 32k.

« To enter a region size of 1MB, enter 0x100000 OF 1m

Note: Memory regions must be located on four-byte boundaries, and be a multiple of four bytes
in size.

The screenshot below shows the dialog after the “Add Flash” button has been clicked. Use the
highlighted up/down buttons to move this region to be top in the list.

[ ] MCUXpresso IDE
Memory configuration editor
Edit configuration for LPC4337

Memory configuration

Default flash driver LPC18x7_43x7_2x512_BootA.cfx Browse...
Type Mame Alias Leocation Size Driver

Flash MFlashA512 Flash 0x1a000000 0x80000

[Flash_|Flash_00 Flash3

FATY - FUAY X

RAM  RamlLoc40 AAMZ  |0x10080000 OxalO0
RAM  RamAHB32 RAM3  0x20000000 0x8000
RAM  RamAHB16 RAM4 | 0x20008000 O0x4000

RAM RamAHB_ETB16 RAMS  0x2000c000 0x4000

Add Flash Add RAM Split Delete

Impaort... Merge... Export... Generate...

Cancel | (TSN

Figure 16.10. Effect of Add Flash

After updating the new memory configuration, click OK to return to the MCU settings dialog,
which will be updated to reflect the new configuration.

Tip
@ once a change has been made, ensure a mouse click is made outside any
changed cell, this action will force the change to be recognised by Eclipse
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Figure 16.11. Updated MCU settings
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Here you can see that the region has been named SPIFI_1MB, and the default Flash driver has
been deleted and the Generic SPIFI driver selected for the newly created SPIFI_1MB region.

MCUXpresso IDE provides extended support for the creation and programming of projects that
span multiple Flash devices. In addition to a single default Flash driver, per region Flash drivers
can also be specified (as above). Using this scheme projects can be created that span Flash
regions and can be programmed in a single ‘debug’ operation.

Note: Once the memory details have been modified, the selected MCU as displayed on the
“Status Bar” (at the bottom of the IDE window) will be displayed with an asterisk (*) next to it.
This provides an indication that the MCU memory configuration settings for the selected project
have been modified.

Device specific vs Default Flash Drivers

When a project is configured to use additional Flash devices via the Memory Configuration Editor,
the Flash driver to be used for programming that Flash device has to be specified in the Driver
column. Typically for a SPIFI device, this should be:

« LPC18_43 SPIFI_GENERIC.cfx (for LPC18/LPC43 series MCUS)

e LPC40xx_SPIFI_GENERIC.cfx (for LPC407x/8x MCUs)

e LPC5460x_SPIFI_GENERIC.cfx (for LPC5460x MCUs).

e LPC540xx_SPIFI_GENERIC.cfx (for LPC540xx MCUSs).
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16.8.3

16.8.4

16.9

For further information please also see the section on

Restoring a Memory Configuration

To restore the memory configuration of a project back to the default settings, simply reselect the
MCU type, or use the “Restore Defaults” button, on the MCU Settings properties page.

Copying Memory Configurations

Memory configurations can be exported for import into another project. Use the Export and Import
buttons for this purpose.

Global Data Placement

By default, global data items are located at run time in the ‘default’ memory region (i.e. the first
RAM block displayed in the memory configuration area).

However, MCUXpresso IDE v10.2 introduced a mechanism to the Managed Linker Script
mechanism to allow the user to specify a specific memory region to be used for the global data,
without the need to change the order of the RAM blocks in the memory configuration editor.

This can be done via the Managed Linker Script page of Project Properties:

v 2 MCU Linker Plain load image SHAM_UPFER
 General
ELibraries Heap and Stack placement | MCUXpresso Style B
122 Mi
e Mlsce\lar‘!enus ) S OR OF et 0
(% Shared Library Settings
= i Region Location Size
(2 Architecture
(% Managed Linker Script Heap Default Post Data Default

(% Multicore Stack Default End Default

33

Global data placement Default

Extra linker script input sections & X

Input section description Region Section Type

Figure 16.12. MCUXpresso IDE Global Data Placement

16.10
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To change the memory region to be used, simply use the drop down box to select the memory
region you wish to locate the global data.

Note: the above placement of global data applies to global data items that are not explicitly placed
elsewhere in the memory map see:

Modifying heap/stack placement

MCUXpresso IDE provides two models of heap/stack placement. The first of these is the
“LPCXpresso Style”, which is the mechanism provided by the previous generation LPCXpresso
IDE. This is the default model used for projects created for Preinstalled MCUs. The second model
is the “MCUXpresso style”. This is the default model used for projects created for MCUs imported
from SDKs.

The heap/stack placement model being used for a particular project/build configuration can be
modified by right clicking on the project and selecting:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Scripts
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Figure 16.13. MCUXpresso IDE Linker Settings

In the dialogue above, highlights show the managed linker script option along with the selection
of the MCUXpresso Style scheme.

16.10.1 MCUXpresso style Heap and Stack

By default the heap and stack are placed in the “default” memory region (i.e. the first RAM block
displayed in the memory configuration area), with the heap placed after the application’s data
and the stack rooted at the top of this block.

However, using the Heap and Stack editor in Project Properties, it is very simple to individually
change the stack and heap locations (both the memory block used, and the location within that
block), and also the size of the memory to be used by each of them.

Region

« Default : Place into first RAM bank as shown in Memory Configuration Editor
« List of memory regions, and aliases, as show in Memory Configuration Editor

Location

Start : Place at start of specified RAM bank.
Post Data : Place after any data in specified RAM bank. Default for heap.
End : Place at end of specified RAM bank. Default for stack.
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Size

e Default: 1/16th of the memory region size, up to a maximum of 4KB (and a minimum of
128bytes). Hovering the cursor over the field will show the current value that will be used.

« Value : Specify exact required size. Must be a multiple of 4. Note: When entering the size of
the region, you can enter full values in decimal or in hex (by prefixing with 0x), or by specifying
the size in Kilobytes (or Megabytes). For example:

* To enter a size of 32KB, enter 32768, 0x8000 or 32k.
« Avalue of 0 can be entered to prevent any heap use by an application.

» Note: For semihosted printf to operate without any heap space, you must enable the
“character only” version. For Redlib, define the symbol “CR_PRINTF_CHAR” (at the
project level) and remove other semhosting defines such as CR_INTEGER_PRINTF.
Character only semihosted printf is significantly slower than the default version and may
display differently depending on your debug solution.

Note: The MCUXpresso style of setting heap and stack has the advantage over the LPCXpresso
style described below in that the memory allocated for heap/stack usage is also taken into
account in the image size information displayed in the Build console when your project is built.

16.10.2 LPCXpresso style Heap and Stack
By default the heap and stack are still placed in the “default” memory region (i.e. the first RAM
block displayed in the memory configuration area), with the heap placed after the application’s
data and the stack rooted at the top of this block.
To relocate the stack or heap, or provide a maximum extent of the heap, then the linker “--defsym”
option can be used to define one or more of the following symbols:
__user_stack_top
__user_heap_base
_pvHeapLim t
To do this, use the MCU Linker -> Miscellaneous -> Other Options box in Project Properties.
For example:
--defsym=__user_stack_top=__top_RAM?2
¢ Locate the stack at the top of the second RAM bank (as listed in the memory configuration
editor)
* Note: The symbol _ top_RAM?2 is defined in the project by the managed linker script
mechanism at:
<pr oj nanme>_<bui | dconfi g>_nem | d
--defsym=__user_heap_base=__end_bss RAM2
« Locate the start of the heap in the second RAM bank, after any data that has been placed there
--defsym=_pvHeapLimit=__end_bss_RAM2+0x8000
* Locate the end of the heap in the second RAM bank, offset by 32KB from the end of any data
that has been placed there
--defsym=_pvHeapLimit=0x10004000
¢ Locate the end of the heap at the absolute address 0x10004000
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16.10.3 Reserving RAM for IAP Flash Programming

The IAP Flash programming routines available in NXP’s LPC MCUs generally make use of some
of the onchip RAM when executed. For example on the LPC1343 the top 32 bytes of onchip RAM
are used. Thus if you are calling the IAP routines from your own application, you need to ensure
that this memory is not used by your main application — which typically means by the stack.

However, with the managed linker script mechanism, it is easy to modify the start position of the
stack (remember that stacks grow down) to avoid this clash with the IAP routines. To do this go to:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Manager Linker Script

and modify the value in the “Stack Offset” field from 0 to 32. This will work whether you are using
LPCXpresso style or MCUXpresso style of heap/stack placement.

»Resource
Builders ) - _ : :
vC/C++ Build Configuration: = Debug [ Active | d Manage Configurations...
Build Variables
Environment

Logging m #Build steps Build Artifact Binary Parsers @ Error Parsers
MCU settings
Settings
Tool Chain Editer
»C/C++ General
Project References
Run/Debug Settings
»Task Repository
WikiText

Properties for LPC11UG8
Settings Sy

¥ # MCU C Compiler Manage linker script

%:Dia|9d Enable automatic placement of Code Read Protection field in image
(2 Preprocessor

@Includes Link application to RAM

= Optimization Stack offset (32 )
# Debugging
#=Warnings
(& Miscellaneous
= Architecture

¥ & MCU Assembler
B General Linker script

Library Redlib (semihost) u

# Architecture & Headers Script path

¥ & MCU Linker
#General Heap and Stack placement | LPCXpresso Style d
ELibraries
#FMiscellaneous
(#28hared Library Settings
= Architecture
#2Managed Linker Script
EMulticore

Region Size
Heap Default Default

Stack Default End Default

Restore Defaults Apply

Cancel | ok |

Figure 16.14. MCUXpresso IDE Linker Reserve Stack Space
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The value you enter in this field must be a multiple of 4.

You are also advised to check the documentation for the actual MCU that you are using to confirm
the amount of memory required by the IAP routines.

Stack Checking

Although, as described above, it is possible to define a size of memory to be used for the stack,

Cortex-M CPUs have no support for hardware stack checking. Thus if you want to automatically
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detect if the stack exceeds the memory set aside for it — other mechanisms must be used. For
example:

* Locate stack to fall off start of memory block and trigger fault

Include code that sets the stack to a known value, and periodically checks whether the lowest
address has been overwritten.

« When debugging, set a watchpoint on the lowest address the stack is allowed to reach

Use the Memory Protection Unit (MPU) to detect overflow, on parts which implement one

16.10.5 Heap Checking

By default, the heap used by the malloc() family of routines grows upwards from the end of the
user data in RAM up towards the stack — a “one region memory model”.
When a new block of memory is requested, the memory allocation function _sbrk() will make a
call to the following function to check for heap overflow:

unsi gned __check_heap_overfl ow (void * new_end_of _heap)
This should return:
e 1 - If the heap will overflow
¢ 0 - If the heap is still OK
If 1 is returned, Redlib’s malloc() will set errno to ENOMEM and return a null pointer to the caller
The default version of __check _heap_overflow() builtinto MCUXpresso IDE supplied C libraries
carry out no checking unless the symbol “_pvHeapLimit” has been created in your image, to mark
the end location of the heap.
This symbol will have been created automatically if you are using the MCUXpresso style of heap
and stack placement described earlier in this chapter. Or alternatively if using the LPCXpresso
style of heap and stack placements, you can use the --defsym option to set this.
If you wish to use a different means of heap overflow checking, then you can find a reference
implementation of __check_heap_overflow() in the file _cr_check _heap.c that can be found
in the Examples subdirectory of your IDE installation.
This file also provides functionality to allow simple heap overflow checking to be done by
looking to see if the heap has reached the current location of the stack point, which of course
assumes that the heap and stack are in the same region. This check is not enabled by default
implementation within the C library as it can break in some circumstances — for example when
the heap is being managed by an RTOS.

16.10.6 Checking the Heap from your Application

The symbol __end_of_heap indicates the current end of the heap and can be used by user code
to track heap usage. For instance:

extern unsigned int __end_of _heap;

end_of _heap = __end_of _heap;

nmyBuf f ptr=(ui nt 32_t*) mal | oc(20*si zeof (uint32_t));

new_end_of _heap = __end_of _heap;
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16.11

16.11.1

However it should be noted that the location this points to includes any last block that has been
free’'d. In other words it effectively provides the maximal extent of the the heap so far, not the
end of the currently “active” last block.

Thus in some cases, if you check __end_of _heap before calling malloc(), then again afterwards,
it is possible that the value will not change if the heap request can be fulfilled using the free’d
last block. So there is no need to extend the heap further.

Placement of specific code/data Iltems

It is possible to make changes to the placement of specific code/data items within the final image
without modifying the FreeMarker linker script templates. Such placement can be controlled via
macros provided in an MCUXpresso IDE supplied header file which can be pulled into your
project using:

#i ncl ude <cr_section_nacros. h>

Alternatively Introduced in MCUXpresso IDE v10.2, the managed linker script mechanism now
also provides a means of placing arbitrarily named code or data sections into a specified memory
region of the generated image and is described in the next section. (See also

Placing data into different Memory Regions

Unlike the macros provided by cr_section_macros.h (described later), this method does not
require any change to the source code declaring the affected code/data (which basically rename
the generated code/data sections to match the memory region name). And in many cases it can
avoid the need to provide project local FreeMarker linker script templates (described later in this
chapter).

To place the code or data, you simply need to add the details of the section name, the memory
region to place it in, and the type of the code/data, as per the below screenshot:

¥ i) MCU Linker

L3

Meap and Stack placement MCUXpresso Style

(% General

(ELibraries Stack offset 0

(= Miscellaneous . . .

S Shared Library Settings i e e

‘—;A hitect ¥ g Heap Default Post Data Default

T; L=t - Stack Default End Default

(* Managed Linker Script

¢ Multicore
Global data placement Default 4
Extra linker script input sections 4 K
Input section description Region Section Type
*(NonCacheable.init) SRAM_DTC .data
*(NonCacheable) SRAM_DTC .bss

Figure 16.15. Adding an Extra Linker Section
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which will modify the generated linker script to contain the sections specified in the appropriate
region:
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/* Main DATA section (SRAM_DTC) */
.data : ALIGN(4)
{

FILL(@xfF)

_data = . ;

*(vtable)

*(NonCacheable.init)

. = ALIGN(4) ;
_edata = . ;
} > SRAM_DTC AT>BOARD_FLASH

Y GV W S P R R R e

/% MAIN BSS SECTION */
.bss : ALIGN(4)
{

*(NonCacheable)

*(COMMON)

. = ALIGN(4) ;

_ebss = .;

PROVIDE(end = .);
} = SRAM_DTC

Figure 16.16. Extra Linker Section Script

Note: that the format of the “input section description” is as detailed in the GNU Linker
documentation, which can be found within the IDE’s built-in help system :

Help -> Help Contents -> Tools (Compilers, Debugger, Utilities) -> GNU Linker -> Linker Scripts

-> SECTIONS Command -> Input Section Description

or directly in the online GNU documentation at:

https://sourceware.org/binutils/docs/ld/Input-Section-Basics.html

Also, this functionality only allows you to add sections to the linker script, not to remove something
that the managed linker script already puts in. Thus if you need to remove part of the generated
linker script’s contents — then you will still need to modify the underlying FreeMarker linker script

templates.

Finally, remember that the GNU linker script mechanism functions such that the first match
encountered for a section will win (not the best match found). Thus this mechanism is just a
request, not a guarantee. Always check the generated linker script and the map file output by
the link step to confirm the expected placement of sections. In some problem cases, you may
be able to force the required placement by use of an EXCLUDE in one memory region, as well

as the section in the required region.

16.11.2 Placing data into different RAM blocks using Macros

Many MCUs provide more than one bank of RAM. By default the managed linker script
mechanism will place all of the application data and bss (as well as the heap and stack) into

the first bank of RAM.

However it is also possible to place specific data or bss items into any of the defined banks for the
target MCU, as displayed in the Memory Configuration Editor, by decorating their definitions in
your source code with macros from the cr_section_macros.h MCUXpresso IDE supplied header

file

For simplicity, the additional memory regions are named sequentially, starting from 2, so RAM2,
RAM3 etc (as well as using their “formal” region name — for example RamAHB32).

For example, the LPC1768 has a second bank of RAM at address 0x2007c000. The managed
linker script mechanism creates a data (and equivalent bss) load section for this region thus:

MCUXpresso IDE User Guide -
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.data_RAM2 : ALIGN(4)
{
FI LL( Oxff)
*(. dat a. $RAMR*)
*(. dat a. $RamAHB32*)
} > RamAHB32 AT>MFl ash512

To place data into this section, you can use the _ DATA macro, thus:

/] create an unitialised 1k buffer in RAM2
__ DATA(RAMR) char data_buffer[1024];

Or the _ BSS macro:

/l create a zero-init buffer in RAM2
__BSS(RAMR) char bss_buffer[128];

In some cases you might need afiner level of granularity than just placing a variable into a specific
memory bank, and rather need to place it at a specific address. In such a case you could then
edit the predefined memory layout for your particular project using the “Memory Configuration
Editor” to divide up (and rename) the existing banks of RAM. This then allows you to provide a
specific named block of RAM into which to place the variable that you need at a specific address,
again by using the attribute macros provided by the “cr_section_macros.h” header file.

Noinit Memory Sections

Normally global variables in an application will end up in either a “.data” (initialized) or
“.bss” (zero-initialized) data section within your linked application. Then when your application
starts executing, the startup code will automatically copy the initial values of “.data” sections from
Flash to RAM, and zero-initialize “.bss” data sections directly in RAM.

MCUXpresso IDE’'s managed linker script mechanism also supports the use of “.noinit” data
within your application. Such data is similar to “.bss” except that it will not get zero-initialized
during startup.

Note: Great care must be taken when using “.noinit” data such that your application code makes
no assumptions about the initial value of such data. This normally means that your application
code will need to explicitly set up such data before using it — otherwise the initial value of such
a global variable will basically be random (i.e. it will depend upon the value that happens to be
in RAM when your system powers up).

One common example of using such .noinit data items is in defining the frame buffer stored in
SDRAM in applications which use an onchip LCD controller (for example NXP LPC178x and
LPC408x parts).

Making global variables Noinit

The linker script generated by the MCUXpresso IDE managed linker script mechanism will
contain a section for each RAM memory block to contain “.noinit” items, as well as the “.data”
and “.bss” items. Note: For a particular RAM memory block, all “.data” items will be placed first,
followed by “.bss” items, and then “.noinit” items.

However, normally for a particular RAM memory block where you are going to be put “.noinit”
items, you would actually be making all of the data placed into that RAM “.noinit”.

The “cr_section_macros.h” header file then defines macros which can be used to place global
variables into the appropriate “.noinit” section. First of all include this header file:
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#i ncl ude <cr_section_nacros. h>

The __NOINIT macro can then be used thus:

/] create a 128 byte noinit buffer in RAM2
__NO NI T(RAM2) char noinit_buffer[128];

And if you want “.noinit” items placed into the default RAM bank, then you can use the
__NOINIT_DEF macro thus:

/] create a noinit integer variable in the main bl ock of RAM
__NO NIT_DEF int noinit_var ;

16.11.4 Placing code/rodata into different FLASH Blocks
Most MCUSs only have one bank of Flash memory. But with some parts more than one bank may
be available — and in such cases, by default, the managed linker script mechanism will still place
all of the application code and rodata (consts) into the first bank of Flash (as displayed in the
Memory Configuration Editor).
For example:
¢ most of the LPC18 and LPC43xx parts containing internal Flash (such as LPC1857 and
LPC4357) actually provide dual banks of Flash.
« some MCUs have the ability to access external Flash (typically SPIFI) as well as their built-in
internal Flash (e.g. LPC18xx, LPC40xx, LPC43xx, LPC546xx).
However it is also possible to place specific functions or rodata items into the second
(or even third) bank of Flash. This placement is controlled via macros provided in the
"cr_section_macros.h" header file.
For simplicity, the additional Flash region can be referenced as Flash2 (as well as using its
“formal” region name — for example MFlashB512 — which will vary depending upon part).
First of all include this header file:
#i ncl ude <cr_section_nacros. h>
Then, for example, to place a rodata item into this section, you can use the _ RODATA macro,
thus:
__RODATA(Fl ash2) const int roarray[] = {10, 20, 30, 40, 50};
Or to place a function into it you can use __ TEXT macro:
__TEXT(Fl ash2) void systick_delay(uint32_t del ayTicks) {
}
In addition, the _ RODATA_EXT and __ TEXT_EXT macros can be used to place functions/
rodata into a more specifically named section, for example:
__ TEXT_EXT(Fl ash2, systi ck_del ay) void systick_del ay(uint32_t del ayTi cks) {
}
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will be placed into the section “.text.$Flash2.systick_delay” rather than “.text.$Flash2”.

Placing specific functions into RAM Blocks

In most modern MCUSs with built-in Flash memory, code is normally executed directly from Flash
memory. Various techniques, such as prefetch buffering are used to ensure that code will execute
with minimal or zero wait states, even a higher clock frequencies. Please see the documentation
for the MCU that you are using for more details.

However it is also possible to place specific functions into any of the defined banks of RAM for
the target MCU, as displayed in:

Project -> Properties -> C/C++ Build -> MCU settings

and sometimes there can be advantages in relocating small, time critical functions so that they
run out of RAM instead of Flash.

For simplicity, the additional memory regions are named sequentially, starting from 2, (as well
as using their “formal” region name — for example RamAHB32). So for a device with 3 RAM
regions, alias names RAM, RAM2 and RAM3 will be available.

This placement is controlled via macros provided in a header file which can be pulled into your
project using:

#i ncl ude <cr_section_nacros. h>

The macro __RAMFUNC can be used to locate a function into a specific RAM region.

For example, to place a function into the main RAM region, use:

__RAVFUNC(RAM) void fooRAM void) {...

To place a function into the RAM2 region, use:

__RAVFUNC(RAM2) voi d fooRAMR(voOi d) {...

Alternatively, RAM can be selected by formal name (as listed in the memory configuration editor),
for example:

__RAMFUNG( RamAHB32) voi d Handl er RAM voi d) {. ..

In order to initialize RAM based code (and data) into specified RAM banks, the managed linker
script mechanism will create a “Global Section Table” in your image, directly after the vector
table. This contains the addresses and lengths of each of the data (and bss) sections, so that the
startup code can then perform the necessary initialization (copy code/data from Flash to RAM) .

Long branch veneers and Debugging

Due to the distance in the memory map between Flash memory and RAM, you will typically
require a “long branch veneer” between the function in RAM and the calling function in Flash. The
linker can automatically generate such a veneer for direct function calls, or you can effectively
generate your own by using a call via a function pointer.

One point to note is that debugging code with a linker generated veneer can sometimes cause
problems. This veneer will not have any source level debug information associated with it, so that
if you try to step in to a call to your code in RAM, typically the debugger will step over it instead.

You can work around this by single stepping at the instruction level, setting a breakpoint in your
RAM code, or by changing the function call from a direct one to a call via a function pointer.
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Reducing Code Size when support for LPC CRP or Kinetis Flash
Config Block is Enabled

One of the consequences of the way that LPC CRP and Kinetis Flash Configuration Blocks work
is that the memory between the CPU’s vector table and the CRP word/ Flash Config Block is
often left largely unused. This can typically increases the size of the application image by several
hundred bytes (depending upon the MCU being used).

However this unused space can easily be reclaimed by choosing one or more functions to be
placed into this unused memory. To do this, you simply need to decorate their definitions with
the macro __ AFTER_VECTORS which is supplied in the “cr_section_macros.h” header file

Obviously in order to do this effectively, you need to identify functions which will occupy as much
of this unused memory as possible. The best way to do this is to look at the linker map file.

MCUXpresso IDE startup code already uses this macro to place the various initialization functions
and default exception handlers that it contains into this space, thus reducing the ‘default’ unused
space. But you can also place additional functions there by decorating their definitions with the
macro, for example

__AFTER VECTORS voi d nyStartupFunction(void);

Note: you will get a link error if the _ AFTER_VECTORS space grows beyond the CRP/Flash
Configuration Block (when this support is enabled):

nyproj _Debug. | d: 98 cannot nove |ocation counter backwards (from 00000334
to 000002f c)

collect2: |Id returned 1 exit status

make: *** [nyproj.axf] Error 1

In this case, you will need to remove the _ AFTER_VECTORS macro from the definition of one
or more of your functions.

FreeMarker Linker Script Templates

By default, MCUXpresso IDE projects use a managed linker script mechanism which
automatically generates a linker script file without user intervention — allowing the project code
and data to be laid out in memory based on the IDE’s knowledge of the memory layout of the
target MCU.

However sometimes the linker script generated in this way may not provide exactly the memory
layout required. MCUXpresso IDE therefore provides a highly flexible and powerful linker script
template mechanism to allow the user to change the content of the linker script generated by
the managed linker script mechanism

Basics

FreeMarker is a template engine: a generic tool to generate text output (HTML web pages, e-
mails, configuration files, source code, etc.) based on templates and changing data. Built into
MCUXpresso IDE are a set of templates that are processed by the FreeMarker template engine
to create the linker script. Templates are written in the FreeMarker Template Language (FTL),
which is a simple, specialized language, not a full-blown programming language like PHP. Full
documentation for FreeMarker can be found at http://freemarker.org/docs/index.html .

MCUXpresso IDE automatically invokes FreeMarker, passing it a data model that describes
the memory layout of the target together with a ‘root’ template that is processed to create the
linker script. This root template, #includes further ‘component’ templates. This structure allows
a linker script to be broken down into various components, and allows a user to provide their
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own templates for a component, instead of having to (re-)write the whole template. For example,
component templates are provided for text, data and bss sections, allowing the user to provide a
different implementations as necessary, but leaving the other parts of the linker script untouched.

MCUXpresso IDE Project

User
Templates

System
Templates

Target
Definition

Freemarker
Template engine

Linker script

16.12.2 Reference

FreeMarker reads input files, copying text and processing FreeMarker directives and ‘variables’,
and writes an output file. As used by the MCUXpresso IDE managed linker script mechanism,
the input files describe the various components of a linker script which, together with variables
defined by the IDE, are used to generate a complete linker script. Any of the component template
input files may be overridden by providing a local version in the project.

The component template input files are provided as a hierarchy, shown below, where each file
#includes those files nested below. This allows for individual components of the linker script to be
overridden without having to supply the entire linker script, increasing flexibility, while maintaining
the benefits of Managed Linker Scripts.

Linker script template hierarchy
linkscript.ldt (top level)

« user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory
and library templates)
e user_linkscript.ldt (an empty file designed to be overridden by users that is included in linkscript
only)
« linkscript_common.Idt (root for main content)
* header.Idt (the header for scripts)
* listvars.Idt (a script to output a list of all predefined variables available to the template)
* includes.Idt (includes the memory and library scripts)
 section_top.ldt (top of the linker script SECTION directive)
 text_section.ldt (text sections for each secondary Flash)
* text_section_multicore.ldt (text sections for multicore targets)
* extrasections_text.ldt (additional sections specified in Properties — Managed Linker Script
pane)
* text.ldt (for inserting *text)
» extrasections_rodata.ldt (additional sections specified in Properties — Managed Linker
Script pane)
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 rodata.ldt (for inserting rodata)

boot_hdr.Idt (allows placement of optional header before main code section)
* boot_hdr_partfamily.Idt

main_text section.ldt (the primary text section)

 global_section_table.Idt (the global section table)

« crp.ldt (the CRP information)

» extrasections_text.ldt (additional sections specified in Properties — Managed Linker Script
pane)

e main_text.Idt (for inserting *text)

» extrasections_rodata.ldt (additional sections specified in Properties — Managed Linker
Script pane)

e main_rodata.ldt (read-only data)

» cpp_info.ldt (additional C++ requirements)

exdata.ldt (the exdata sections)

end_text.Idt (end of text marker)

usb_ram_section.Idt (placement of SDK USB data structures)

stack_heap_sdk_start.ldt (placement of MCUXpresso style heap/stack)

data_section.ldt (data sections for secondary ram)

» data_section_multicore.ldt (data sections for multicore targets)

» extrasections_data.ldt (additional sections specified in Properties — Managed Linker Script
pane)

 data.ldt (for inserting *data)

mtb_default_section.ldt (special section for MTB (cortex-mO0+ targets)

uninit_reserved_section.ldt (uninitialised data)

main_data_section.ldt primary data section)

» extrasections_data.ldt (additional sections specified in Properties — Managed Linker Script
pane)

* main_data.ldt (for inserting *data)

bss_section.Idt (secondary bss sections)

» extrasections_bss.Idt (additional sections specified in Properties — Managed Linker Script
pane)

* bss.ldt (for inserting *bss)

main_bss_section.ldt primary bss section)

» extrasections_bss.Idt (additional sections specified in Properties — Managed Linker Script
pane)

e main_bss.ldt (for inserting *bss)

noinit_section.ldt (no-init data)

» extrasections_noninit.ldt (additional sections specified in Properties — Managed Linker
Script pane)

noinit_noload_section.Idt (no-load data)

stack_heap_sdk_postdata.ldt (placement of MCUXpresso style heap/stack)

stack_heap_sdk_end.Idt (placement of MCUXpresso style heap/stack)

stack _heap.ldt (define the stack and heap)

checksum.Idt (create the LPC checksum)

image_size.ldt (provide basic symbols giving location and size of image)

symbols.ldt (provide additional symbols needed to built image)

* symbols_partfamily.ldt

section_tail.ldt (immediately before the send of linker SECTION directive)

library.ldt (the standard libraries used in the application)

« user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory
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memory.ldt (the memory map)

< user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory
and library templates)
« user_memory.ldt (an empty file designed to be overridden by users that is included in memory

only)

Linker script search paths

Whenever a linker script template is used, MCUXpresso IDE will search in the following locations,
in the order shown:

e project/linkscripts
 the searchPath global variable
« The searchPath can be set in a script by using the syntax <#global searchPath="c:/windows/
path;d:/another/windows/path”>

each directory to search is separated by a semicolon ;'

e mcuxpresso_install_dir/ide/Data/Linkscripts
* linker templates can be placed in this directory to override the default templates for an entire
installation
¢ MCUXpresso IDE internally provided templates (not directly visible to users)

Thus, a project can simply override any template by simply creating a linkscript directory within
the project and placing the appropriate template in there. Using the special syntax “super@” an
overridden template can reference a file from the next level of the search path

e.g. <#include “super@user.ldt">
Linker script templates

Copies of the default linker script templates used within MCUXpresso IDE can be found in the
Wizards/linker directory within the MCUXpresso IDE install. These can be used as the basis of
any project local scripts you wish to write.

Predefined variables (macros)

List (sequence) variables (used in #list)

« libraries][]
« list of the libraries to be included in the “lib” script
» for example (Redlib nohost)

libraries[0]=libcr_c.a
libraries[1] =libcr_eabihel pers. a

< configMemory][]
« list of each memory region defined in the memory map for the project. Each entry has the

following fields defined
e name — the name of the memory region
+ alias — the alias of the memory region
* location — the base address of the memory
* size — the size of the memory region
» sizek — the printable size of the memory region in k or M
* mcuPattern
» defaultRAM — boolean indicating if this is the default RAM region
 defaultFlash — boolean indication if this is the default Flash region
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* RAM - boolean indicating if this is RAM
» Flash — boolean indicating if this is Flash
» for example

confi gMenory[ 0] = nane=MFl ashA512 al i as=Fl ash | ocati on=0x1a000000
si ze=0x80000 si zek=512K bytes ntuPattern=Fl ash flash=true RAMf al se
def aul t Fl ash=true def aul t RAM=f al se

confi gMenory[ 2] = nanme=RaniLoc32 al i as=RAM | ocat i on=0x10000000
si ze=0x8000 si zek=32K byt es ntuPattern=RAM f| ash=f al se RAM:true
def aul t Fl ash=f al se def aul t RAM=t r ue

e Slaves|]
« list of the Slaves in a Multicore project. This variable is only defined in Multicore projects.
Each entry has the following fields defined
* name — name of the Slave
» enabled — boolean indicating if this Slave is enabled
» objPath — path to the object file for the Slave image
« linkSection — name of the section this Slave is to be linked in
* runtimeSection
* textSection — name of the text section
* textSectionNormalized — normalized name of the text section
» dataStartSymbol — name of the Symbol defining the start of the data
» dataEndSymbol — name of the Symbol defining the end of the data
« for example

sl aves[ 0] = nane=MDAPP obj ect Pat h=${ wor kspace_| oc: / MCB4357_Bl i nky_Dual M)/ Debug
/ MCB4357_Bl i nky_Dual M. axf. o}l i nkSecti on=Fl ash2 runti nmeSecti on= text Secti on=
.core_nDapp text SectionNornal i zed=_core_nDappdata Start Synbol =__start_data

dat aEndSynbol =__end_dat a enabl ed=true; </ notextil e>

Simple variables include:

« CODE - name of the memory region to place the default code (text) section
« CRP_ADDRESS - location of the Code Read Protect value

« DATA — name of the memory region to place the default data section

¢ LINK_TO_RAM — value of the “Link to RAM” linker option

e STACK_OFFSET - value of the Stack Offset linker option

¢ FLASHnN — defined for each FLASH memory

¢« RAMnN — defined for each RAM memory

* basename — internal name of the process

¢ bss_align — alignment for .bss sections

 buildConfig — the name of the configuration being built

e chipFamily — the chip family

» chipName — name of the target chip

« data_align — alignment for .data section

e date — date string

* heap_symbol — name of the symbol used to define the heap
 isCppProject — boolean indicating if this is a C++ project

« isSlave — boolean indicating if this target is a slave — true iff is a slave core in a multicore system
* library_include — name of the library include file

« libtype — C library type
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« memory_include — name of the memory include file

* mtb_supported — boolean indicating if mtb is supported for this target

« numCores — number of cores in this target

¢ procName — the name of the target processor

* project — the name of the project

* script — name of the script file

¢ slaveName — is the name of the slave (only present for slaves)

e stack_section — the name of the section where the stack is to be placed
 start_symbol — the name of the start symbol (entry point)

e scriptType — the type of script being generated (one of “script”, “memory”, or “library”)
e text_align — alignment for .text section

¢ version — product version string

e workspace_loc — workspace directory

e year — the year (extracted from the date)

Extended variables
Two ‘extended’ variables are available:

environment

¢ The environment variable makes the host Operating System environment variables available.
For example, the Path variable is available as ${environment[“Path”]}. Note Environment
variables are case sensitive.

systemProperties

* The Java system properties are available through the systemProperties variable. For example
the “os.name” system property is available as ${systemProperties[“0os.name”]}. Note: System
properties are case sensitive.

Outputting variables

A list of all predefined variables and their values can be output to the generated linker script
by setting the Preference: MCUXpresso IDE -> Default Tool settings -> ... and list predefined
variables in the script

A list of extended variables and their values can be output to the generated linker script by
creating a linkscripts/user.ldt file in the project with the content

<#assign |istvarsext=true>

(This is likely to be used less often, hence the slightly longer winded method of specifying the
option)

FreeMarker Linker Script Template Examples
The use of FreeMarker linker script templates allows more wide ranging changes to be made to

the generated link script than is possible using the cr_section_macros.h macros. The following
examples provide some examples of this.

Relocating code from FLASH to RAM

If you have specific functions in your code base that you wish to place into a particular block
of RAM, then the simplest way to do this is to decorate the function definition using the macro
__RAMFUNC described earlier in this chapter.
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However once you want to relocate more than a few functions, or when you don’t have direct
access to the source code, this becomes impractical. In such case the use of FreeMarker linker
script templates will be a better approach. The following sections provide a number of such
examples.

Relocating particular objects into RAM

In some cases, it may be required to relocate all of the functions (and rodata) from a given object
file in your project into RAM. This can be achieved by providing three linker script template files
into a linkscripts folder within your project. For example if it was required that all code/rodata
from the files foo.c and bar.c were relocated into RAM, then this could be achieved using the
following linker script templates:

mai n_t ext.|dt
*( EXCLUDE_FI LE(*f00. 0 *bar.o) .text*)

mai n_r odat a. | dt
* (EXCLUDE_FI LE(*f 00. 0
*( EXCLUDE_FI LE(*f00. 0 *bar.o) .rodata.*)
* (EXCLUDE_FI LE(*f 00. 0
*( EXCLUDE_FI LE(*fo00.0 *bar.o) .constdata.*)
. = ALIGN(${text_align});

*bar. o) .rodata)

*bar. o) .constdata)

mai n_dat a. | dt

*foo.0(.text*)

*foo.o(.rodata .rodata.* .constdata .constdata.*)
*bar.o(.text*)

*bar.o(.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

*(.data*)

What each of these EXCLUDE_FILE lines (in main_text.Idt and main_rodata.ldt) is doing in
pulling in all of the sections of a particular type (for example .text), except for the ones from the
named object files. Then in main_data.ldt, we specify explicitly that the text and rodata sections
should be pulled in from the named object files. Note: that with the GNU linker, LD, the first
match found in the final generated linker script is always used, which is why the EXCLUDE_FILE
keyword is used in the first two template files.

Note: EXCLUDE_FILE only acts on the closest input section specified, which is why we have
4 separate EXCLUDE_FILE lines in the main_rodata.ldt file rather than just a single combined
EXCLUDE_LINE.

Once you have built your project using the above linker script template files, then you can check
the generated .Id file to see the actual linker script produced, together with the linker map file to
confirm where the code and rodata have been placed.

Relocating particular libraries into RAM

In some cases, it may be required to relocate all of the functions (and rodata) from a given library
in your project into RAM. One example of this might be if you are using a flashless LPC43xx
MCU with an external SPIFI Flash device being used to store and execute your main code from,
but you need to actually update some data that you are also storing in the SPIFI Flash. In this
case, the code used to update the SPIFI Flash cannot run from SPIFI Flash.

This can be achieved by providing three linker script template files into a linkscripts folder
within your project. For example if it was required that all code/rodata from the library
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MYLIBRARYPROJ were relocated into RAM, then this could be achieved using the following
linker script templates:

mai n_t ext.|dt
* (EXCLUDE_FI LE(*1i bMYLI BRARYPRQJ. a:) .text*)

mai n_r odat a. | dt
* (EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a:) . rodat a)
* (EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a:) . rodata. *)
* (EXCLUDE_FI LE(*| i bMYLI BRARYPRQJ. a:) . const dat a)
* (EXCLUDE_FI LE(*| i bMYLI BRARYPRQJ. a:) . constdat a. *)
. = ALIGN(${text_align});

mai n_dat a. | dt
*| i bMYLI BRARYPROJ. a: (. t ext *)
*| i bMYLI BRARYPRQJ. a: (. rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});
*(.data*)

Relocating majority of application into RAM

In some situations, you may wish to run the bulk of your application code from RAM — typically
just leaving startup code and the vector table in Flash. This can be achieved by providing three
linker script template files into a linkscripts folder within your project:

mai n_text.|dt
*startup_*.o (.text.*)
*(.text. main)
*(.text.__main)

mai n_r odat a. | dt
*startup_*.o (.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

mai n_dat a. | dt

*(Ltext*)

*(.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

*(. data*)

The above linker template scripts will cause the main body of the code to be relocated into the
main (first) RAM bank of the target MCU, which by default will also contain data/bss, as well as
the stack and heap.

If the MCU being targeted has more than one RAM bank, then the main body of the code could
be relocated into another RAM bank instead. For example, if you wanted to relocate the code
into the second RAM bank, then this could be done by providing the following data.ldt file instead
of the main_data.ldt above:

dat a. | dt
<#if menory.al i as=="RAM2" >
*(.text*)
*(.rodata .rodata.* .constdata .constdata.*)
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. = ALIGN(${text_align});
</ #if>

*(.data. $${nenory. al i as}*)
*(.data. $${ nenory. nane} *)

Note: memory.alias value is taken from the Alias column of the Memory Configuration Editor.

16.13.2 Configuring projects to span multiple Flash Devices
Most MCUs only have one bank of Flash memory. But with some parts more than one bank may
be available — and in such cases, by default, the managed linker script mechanism will still place
all of the application code and rodata (consts) into the first bank of Flash (as displayed in the
Memory Configuration Editor)..
For example
e most of the LPC18 and LPC43xx parts containing internal Flash (such as LPC1857 and
LPC4357) actually provide dual banks of Flash.
* some MCUs have the ability to access external Flash (typically SPIFI) as well as their built-in
internal Flash (e.g. LPC18xx, LPC40xx, LPC43xx, LPC546xx).
The macros provided in the “cr_section_macros.h” header file provide some ability to control the
placement of specific functions or rodata items into the second (or even third) bank of Flash.
However the use of FreeMarker linkers script templates allow this to be done in a much more
powerful and flexible way.
One typical use case for this is a project which stores its main code and data in internal Flash,
but additional rodata (for example graphics data for displaying on an LCD) in the external SPIFI
Flash.
For instance, consider an example project where such rodata is all contained in a set of specific
files, which we therefore want to place into the external Flash device. One very simple way to do
this is to place such source files into a separate source folder within your project. You can then
supply linker script templates to place the code and rodata from these files into the appropriate
Flash.
For example, for a project using the LPC4337 with two internal Flash banks, plus external SPIFI
Flash, if the source folder used for this purpose were called ‘spifidata’, then placing the following
files into a linkscripts directory within your project would have the desired effect:
text.ldt
<#i f menory. al i as=="Fl ash3">
*spifidatal/ *(.text*)
</ #if>
*(.text_${nenory.alias}*) /* for conpatibility with previous rel eases */
*(.text_${menory.nanme}*) /* for conpatibility with previous releases */
*(.text.$${nenory. alias}*)
*(.text.$${menory. nane}*)
rodat a. | dt
<#if menory.alias=="Fl ash3">
*spi fidatal/*(.rodata*)
</ #if>
*(rodata. $${menory. al i as}*)
*(rodat a. $${ menory. nane}*)
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Note: the check of the memory.alias being Flash3 is to prevent the code/rodata items from ending
up in the BankB Flash bank (which is Flash2 by default).

Disabling Managed Linker Scripts

It is possible to disable the managed linker script mechanism if required and provide your own
linker scripts, but this is not recommended for most users. In most circumstance, the facilities
provided by the managed linker script mechanism, and its underlying FreeMarker template
mechanism should allow you to avoid the need for writing your own linker scripts. But if you do
wish to do this, then untick the appropriate option at:

Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Script

And then in the field Script Path provide the name and path (relative to the current build directory)
of your own, manually maintained linker script.

In such cases you can either create your own linker script from scratch, or you can use the
managed linker scripts as a starting point. One very important point though is that you are advised
not to simply modify the managed linker scripts in place, but instead to copy them to another
location and modify them there. This will prevent any chance of the tools accidentally overwriting
them if at some point in the future you turn the managed make script mechanism back on.

Note: if your linker script includes additional files (as the managed linker scripts do), then you
will also need to include the relative path information in the include inside the top level script file.

For more details of writing your own linker scripts, please see the GNU Linker (Id) documentation:
Help -> Help Contents -> Tools (Compilers, Debugger, Utilities) -> GNU Linker

There is also a good introduction to linker scripts available in Building Bare-Metal ARM Systems
with GNU: Part 3 at:

http://www.embedded.com/design/mcus-processors-and-socs/4026080/Building-Bare-Metal-
ARM-Systems-with-GNU-Part-3
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Introduction

Multicore MCUs can be designed in many ways, however within MCUXpresso IDE there is an
underlying expectation that one core (the Master) will control the execution (or at least the startup)
of code running on other (Slave) core(s).

Multicore application projects as described below consists of two (or more) linked projects —
one project containing the Master code and the other project(s) containing the Slave code. The
‘Master’ project contains a link to the ‘Slave’ project which will cause the output image from the
‘Slave’ to be included into the ‘Master’ image when the Master project is built. Building the Master
project will trigger the Slave project to be built first.

After a power-on or Reset, the Master core boots and is then responsible for booting the Slave
core. However, this relationship only applies to the booting process; after boot, your application
may treat either of the cores as the Master or the Slave.

For this concept to work, the memory configurations of these related projects must
be carefully managed to avoid unintended overlap or contention. One way this can be
achieved is by linking the Slave application to execute entirely from a RAM bank unused
by the Master. Our automatic linkerscript generation will then locate the Slave code within
the Master’s generated image, this will then be relocated to the correct RAM location by
the Master projects initialisation code at run time.

In practice, the master projects memory configuration will be the same as for asingle core
project, where as the Slave projects memory configuration will be set to use a ‘spare’ or
dedicated Slave RAM region. In addition, a shared region may be used for communication
between the CPUs

Note: MCUs supporting dedicated Flash regions for each core can also be supported by this
scheme, in such a case the Slave project would be linked to the Slave’s Flash location.

To complete the story ... the Master project is debugged first, this will lead to the combined image
being programmed into Flash and the Master code executed. The Master’s initialisation code will
(in addition to other things) copy the Slave code into RAM (if appropriate) and then stop on Main.
When the Slave project is debugged, the launch configuration will automatically be set to ‘Attach’
by the IDE since there is no need for this code to be programmed/downloaded. When the Master
application is resumed it will release the Slave and both projects can be debugged as required.

Important Note: Multicore MCUs may offer significant flexibility in how they can be used. The
mechanism described above and also used in example projects is not necessarily the only way
(or even the best way) for a user application(s)/projects to be configured. However, it has been
chosen as the simplest and safest way to demonstrate the concepts and issues involved.

MCUXpresso IDE allows for the easy creation of “linked” projects that support the targeting of
LPC541xx Multicore MCUs

The rest of this chapter will describe the use of the LPC5411x multicore MCU, however the

concepts discussed will be the same (or similar) for other multicore MCUs such as the LPC43xx
and LPC5410x.

Creating a Master / Slave project Pair (using an SDK)

The example described below is base around the LPC5411x multicore MCU using the
LPCXpresso54114 SDK.
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Note: Be sure to have installed the LPCXpresso54114 SDK into MCUXpresso IDE to follow this
example.

17.2.1 Creating the MO Slave project

As discussed above, the Master projects configuration will need to reference the Slave project,
therefore the Slave project should be created first.

Launch the New Project Wizard and select the LPCXpresso54114 SDK board. Entering 54114
into the boards filter will reduce the number of boards to help selection, then click Next.

[ DK Wizard o [ |

(1) Creating project for device: LPC54114)256 using board: LPCXpresso54114 ‘ k \E

. Board and/or Device selection page

> SDK MCUs Awailable boards 13, 1, | a
T alled SDKs

Please select an available board for your project.

NXP LPC541141256 Supported boards for device: LPC54114J256

4 LPCoAl1x
LPC54114)256

» Preinstalled MCUs

If \I
5DK

Ipcxpresso5411d lpoxpresso54114 oml3588

Selected Device: LPC541141256 using board: LPCXpresso54114 SDKs for selected MCU
Target Core: multicore device with cores: cortex-méd cortex-miplus Name SDK Version  Manifest Ve.. Location
Description: The LPC5411x are ARM Cortex-M4 based microcontrollers for embedded 1 SDK_2.x_LPCXpresso54114 230 3.20 [E, <Default Location>A\SDK_2.0_LPC}
applications.
@ < Back Next » Finish

Figure 17.1. New Project Wizard SDK MultiCore MO

From the next wizard page, select the cmOplus Core, and see that the MOSLAVE is selected
in the core options. Also note that the Project will automatically be given the suffix MOSLAVE.
Drivers, utilities etc. can be selected at this stage for the Slave project if required.
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[ sDK Wizard

. Configure the project

Copy sources
Import other files

[} -B flexcomm_iZc_dma  2.0.0
[T dg} flexcomm_i2e_freertos 2.0.0

7] dg# flexcomm_i2s 200
F -B flexcomm_i2s_dma  2.0.0
[T 4} flexcomm_spi 201

7] dg# flexcomm spi dma 201
[7] &g flexcomm_spi_freertos 2,01

Project iame: | psy1141256_Project 2| Project name suffi ot av

-8
Use default location
C\Users\peter\Documents\MCUXpressolDE_10.1.0_547_prcl\workspace\LPC54114J256_Project Browse...
Device Packages Board Project Type Project Options Cores
@ LPC54114)256BD64 @ Default board files @ C Project (©) C++ Project SDK Debug Console @ Semihost (©) UART cier 0
() LPC54114)256UK49 () Empty board files () C Static Library (©) C++ Static Library CMSIS-Core @ cmOplus (cmOplus) | MOSLAVE =

s 7 | g driver Z % ‘ o utilities 7 % ‘ £ middleware 7 % | =REE
type to filter type to filter type to filter type to filter
Name WVersion Narne Version  * Marne Version Namne Version
[#] i baremetal 1.00 ] &gt elock 210 [ gt assert 1.0.0 > [F] £ Graphics
[ 4} freertos 9.00 1k commen 202 gt debug_console 1.00 [C] £ File System
7] &g ctimer 200 (7] dg notifier 1.00 » ] £ Multicore
[7] ig dmic 200 = [ dgt shell 1.00 > [[] £ Memories
O] 4t dmic_dma 200 > [0 £ usB
[7] &g flashiap 200
g flexcomm 200
[T dgh flexcomm_iZe 201 —

<Back || Net> || Finish

Cancel

Figure 17.2. New Project Wizard SDK MO Slave

Next, the MO Slave memory configuration needs to be set.

Note: the MCUXpresso IDEs managed linker script mechanism will default to link code to the first
Flash region in this view (if one exists) and use the first RAM region for data, heap and stack..

To force our project to link to a private area of RAM, we must ensure that the Flash region is
removed and the chosen RAM bank is at the top of the list of memory regions. Note here that
the SDK we are using has presented the RAM regions in a non sequential order. In this example
we will configure the memory so that the MO Slave project links to the RAM region starting at

address 0x20010000 (the first region).

Click Edit... to launch the Memory configuration editor.
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(%) SDK Wizard = [[-E ]

. Advanced project settings

= C/C++ Library Settings

Set library type (and hosting variant) [Redl\b (semihost-nf) -

|| Redlib: Use floating point version of printf NewlibMano: Use floating point version of printf
[] Redlib: Use character rather than string based printf NewlibMano: Use floating point version of scanf
Redirect SDK "PRINTF" to C library "printf" Redirect printf/scanf to ITM

Include semihest HardFault handler [T Redirect printf/scanf to UART

* MCU C Compiler

Language standard | ¢ smpiler default

* Memory Configuration

Memory details
Type Mame Alias Location Size Driver

(Flash PROGRAM_FLASH Flash 0x0 0x40000 LPC5411x_256K.cfx )
RAM

SRAML RAM ( Oé!!!g!! ' 010000

RAM SRAMO RAMZ 020000000 010000 (

RAM SRAMX RAM3 0x4000000 0x8000
RAM SRAMZ RAM4 0x20020000 0x5000

@ Next > Finish I [ Cancel

Figure 17.3. New Project Wizard SDK MO Slave Memory

In the Memory Config Editor, select the PROGRAM_FLASH and click Delete to remove the

region. Ensure that the top RAM region has the base address (location) 0x20010000, then click
OK.
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[ MCUpresso IDE

Memory configuration editor
Edit configuration for LPC541141256

Memory configuration

os | g

Default flash driver | | Browse...
Type Name Alias Location Size Drriver
Flash PROGRAM_FLASH Flash 0x0 (0x40000 LPC5411x 25...
RAM SRAML RAM 0x20010000 010000
RAM SRAMD RAMZ 020000000 010000
RAM SRAMX RAM3 04000000 0x8000
RAM SRAMZ RAM4 0:20020000 0x8000

Jc:in Impeort...| | Merge...| | Export... | | Generate...

I OK l [ Cancel

Figure 17.4. New Project Wizard SDK MO Slave Memory Edit

Finally, click Finish to complete the creation of the Slave project.

17.2.2 Creating the M4 Master project

To create the Master project, launch the New Project Wizard and again select the
LPCXpresso54114 SDK board and click Next. This time, select the cm4 Core, and click the
MASTER check box, this configures the wizard to create a Multicore project. Note that the Project
will automatically be given the suffix MASTER. Drivers, utilities etc. can be selected at this stage
for the Master project if required.
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[X) 5DK Wizard = =[]
. Configure the project
Project name: || p541141256_Project 7 | Project name suffif pyacrep &
Use default location
CAUsers\peter\Documents\MCUXpressolDE_10.1.0_547_prel\workspace\l PC54114)256_Project Browse...
Device Packages Board Project Type Project Options Cores
@ LPC54114)256BD64 (@ Default board files @ C Project (7) C++ Project SDK Debug Console @ Semihost () UART (0 cmd (cmd) Master \3‘)
) LPC54114)256UK49 () Empty board files () C Static Library () C++ Static Library [Z] CMSIS-Core () em0Oplus (em0plus) | MOSLAVE -
Copy sources
[¥]Import other files
0s Z | o driver & Sﬁl £ utilities & 3% ‘ ]  middleware & Sﬁ ‘ =]
type to filter type to filter type to filter type to filter
Name Version MName Version Name Version Name Wersion
[¥] 4+ baremetal 1.00 [ 4t clock 210 [ 4+ assert 1.00 » [[] £ Graphics
[7] dg freertos 9.0.0 L common 202 it debug_console 1.00 [F] £ File System
[7] dgk ctimer 200 [ dgt notifier 100 . [7] £ Multicare
[ 4 dmic 200 = [C] & shell 1.00 » [[] £ Memories
[ 4t dmic_dma 200 . 7] £ use
[ dggk flashiap 200
A flexcomm 200
[7] dgt flexcomm_i2e 204 —
[ dgk flexcomm_i2c_dma  2.0.0
[ 4 flexcomm_i2¢ freertos 2.0.0
[7] dgt flexcomm_i2s 200
[ dgk flexcomm_i2s_dma 200
[ 4 flexcomm_spi 201
[7] dgt flexcomm_spi_dma 201
[ dgk flexcomm_spi_freertos 2.0.1
Jpt flexcomm_usart 200
= @ flexcomm_usart_dma  2.0.0
[7] dgt flexcomm_usart_freertt 2.0.0 -
@ <Back | Net> || Finisn

Figure 17.5. New Project Wizard SDK M4 Master

Next, the M4 Master memory configuration needs to be set. Typically we might leave the memory
setting unaltered, however the SDK we are using presents the RAM regions in a non sequential
way. In this example we wish to select the RAM region at 0x20000000 for the Master projects data
and the Flash at 0x0 for the Master projects code (and also a copy of the Slave projects code)

Note: MCUXpresso IDEs managed linker script mechanism will default to link code to the first
Flash region in this view (if one exists) and use the first RAM region for data, heap and stack.

To adjust the memory layout, click Edit ... then select the second RAM region (at location
0x20000000) and click the ‘Up’ arrow to move this to the top of the RAM regions.

Once this has been done, click ‘OK’.
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[ sDK Wizard
€3 Please select a slave project to link for multicore projects!

. Advanced project settings

= C/C++ Library Settings

3

Set library type (and hosting variant) | Redlib (semihost-nf)

|| Redlib: Use floating point version of printf
[] Redlib: Use character rather than string based printf
[] Redirect printf/scanf to ITM

Redirect SDK "PRINTF" to C library "printf"
] Redirect printf/scanf to UART

[¥]Include semihost HardFault handler

~ Hardware settings

NewlibNane: Use floating point version of printf

NewlibNano: Use floating point version of scanf

Set Floating Peint type [FPvd (HardABI)

~ MCU C Compiler

Language standard | Compiler default

~ Memory Configuration

/

Memery details
Type MName Alias Location Size Driver
Flach PROGRAM FLASH Flash 0 0:40000 LPC5411x_256K.cfx
M SRAML RAM 020010000 0:10000 )
1] SRAMD RAM2 020000000 0:10000
RAM SRAMX RAM3 04000000 08000
RAM SRAM2 RAM4 020020000 08000
~ Multicore slave projects settings
Opticnally allow an existing slave project to be associated with this project. -
Bro nk Secticf RAM2

e’

Slave project for MOSLAVE| ‘ D
£ By default, the slave images will be placed in the RAM2 block of the master project's memory map. The slave memory setting inwm

Cancel

Next > Finish

Figure 17.6. New Project Wizard SDK M4 Master Memory

Then click Browse to select the Slave project within the Workspace. Select the previously created

Slave project and click ‘OK’.
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B Slave project selection for MOSLAVE = @

Select a slave project to link with the master project being created.

L= LPC54114)256_Project_ MOSLAVE

@' [ OK ] [ Cancel

Figure 17.7. New Project Wizard SDK M4 Master Slave Selection

Also ensure the Link Section name (default of RAM2) selects a Master memory region that
matches the linked address of the Slave project. In this case RAM2 should correspond to the
address 0x2001000. If required, other memory regions can be selected here but please note: the
first Flash Region, and the first RAM Region are not included in the drop down list because it is
assumed that these will be used for the Master Project. If required, this setting can be changed
later from:

Project Properties -> C/C++ Build -> Settings -> Multicore
Where all of the memory regions are available for selection.

Below we can see the edited project settings for the Master project.
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) SDK Wizard =g =m ==

. Advanced project settings

+ C/C++ Library Settings

Set library type (and hosting variant) [Redib (semihost-nf) .I

[ Redlib: Use floating point version of printf NewlibNano: Use floating point version of printf
[T] Redlib: Use character rather than string based printf NewlibMano: Use floating point version of scanf
Redirect SDK "PRINTF" to C library "printf" [T Redirect printf/scanf to ITM

[#]Include semihost HardFault handler [ Redirect printf/scanf to UART

~ Hardware settings

Set Floating Point type l;pw (HardABT) .l

¥ MCU C Compiler

Language standard | Compiler default -

~ Memory Configuration

Memory details

Name Alias Location Size Driver
PROGRAM FLASH Flash 00 0:40000 LPC5411x_256K.cfx

SRAMD RAM 0x20000000 0:10000

SRAML RAM2 0:20010000 0:10000 )
SRAMX RAM3 0:4000000 0:8000

SRAMZ RANMA 0x20020000 0:8000

~ Multicore slave projects settings

Optionally allow an existin is project.
Slave project for MOSLAVE LPC54114)256_Project_MOSLAVE e IBrow;e.‘.lek Section| RAM2. -

%, By defaut, the slave images will be placed in the RAMZ block of the master project's memory map. The slave memory setting in the master project should match how the slave project was built.

Figure 17.8. New Project Wizard SDK M4 Master Project

Finally click Finish to generate the Master project.

17.3 Creating a Master / Slave project Pair (using Preinstalled Part
Support)
The example described below is base around the LPC5411x multicore MCU.
Note: It is recommended to create and build LPC541xx multicore projects which are linked to
LPCOpen. Thus before you follow the below sequence, please ensure that you have imported

the chip and (optionally) the board library projects (for both the M4 and M0O+) from an LPCOpen
package for the LPC5410x family or LPC5411x family (depending upon your target part).

17.3.1 Creating the MO Slave project

As discussed above, the Master projects configuration will need to reference the Slave project,
therefore the Slave project should be created first.

Launch the New Project Wizard and select the LPC54114-M0 from the Preinstalled MCUs.
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b
b
b

b

b
b
b

@

LPC54114)256-M0

34 SDK Wizard
(1) Cresting project for device: LPC54114)256-M0
. Board and/or Device selection page

b SDK MCUs Available boards

- Preinstalled MCUs Please select an available board for your project.
WICUs from preinstalied LPC and generic

Cortex-M part support

Supported boards for device: LPC5411x

MXP LPC54114)256- MO i

PCE0x
LPC82x
LPC84x
LPCENDx
LPCaux
PN73000¢
PN74x000¢

leatn |

LPCXpresso54114

1

Selected Device: LPC54114J256-M0 with no board.

Target Core: cortex-m0
Description: Dual Cortex-M4/Cortex-M0+ based microcentroller, with up to 256KB

Flash and 192KB RAM

SDKs for selected MCU

MName

15 1% | LS

SDK Version Manifest Ve.. Location

< Back Next > Finish

Figure 17.9. New Project Wizard Preinstalled MO

MCUXpresso IDE User Guide -

Next, select a MultiCore MO Slave project type, below we have selected an LPCOpen — C Project.
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® = o] ]
New project...
LPC5411x Multicore (M0+ slave) -> LPCOpen - C Project

- Wizard selection page.

Wizard
4 LPC54110
4 LPC5411x (MO+)
LPCOpen - C Project
LPCOpen - C Static Library Project
LPCOpen - C++ Project
LPCOpen - C++ Static Library Project
C Project
C Project (Semihosted)
C Static Library Project
C++ Project
C++ Static Library Project
4 LPC5411x Multicore (M0+ slave)
LPCOpen - C Project
LPCOpen - C++ Project
C Project
C Project (Semihosted)
C++ Project

@ < Back Next > Eran

Figure 17.10. New Project Wizard Preinstalled MO C Project

MCUXpresso IDE User Guide -

Next, name the project, for example LPC54114 MO_Slave, then click next until the Memory
Configuration page is reached. From here we can see the MCU memory regions.

Note: MCUXpresso IDE’s managed linker script mechanism will default to link code to the first
Flash region in this view (if one exists) and use the first RAM region for data.

To force our project to link to a private area of RAM, simply delete the Flash and first RAM region
(RAMO_64) from this view (since these will be use for the M4 Master project). To do this, just
select the regions and click Delete. Since there will no longer be any Flash region, the default
Flash driver can also be removed.
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New project...
Memory Configuration Editor

. Wizard properties page.

Allows external flash to be defined and appropriate flash driver allocated, or for layout of internal RAM to be recenfigured.

Default flash driver {| pC5411x_256K.cfx
Type Name Alias Location Size Driver
7~
Flash  MFlash256 Flash 00 0x40000
ami i
tUQAM Ram0 64 RAM 0x20000000 010000 )
RAM Raml_&4 RAM2 020010000 0x10000
RAM  Ram2_32 RAM3 020020000 0x8000
RAM  RamX_32 RANM4 04000000 08000
() (e () () [
@ Next > i Finish i [ Cancel

Figure 17.11. New Project Wizard Preinstalled MO Memory

The memory setting should then look as below. In this case our Slave projects code and data
will be linked to address 0x20010000 with the stack set to the top of this region.

= = e =
New project...
Memery Configuration Editor
. Wizard properties page.
Allows external flash to be defined and appropriate flash driver allocated, or for layout of internal RAM to be reconfigured.
Default flash driver || Ee——
Type Name Driver
RAM Raml_64
RAM  Ram2_32 =
RAM  RamX_32 RAM3 04000000 0xE000
Add Flash | | Add RAM [Import..‘] [Merge...] [Etport...] [Ganerate...]
@ Mext > ([ Finish D[ Cancel

Figure 17.12. New Project Wizard Preinstalled MO Memory edited

Now click Next -> Finish to complete the MO Slave projects creation.

17.3.2 Creating the M4 Master project

To create the Master, Launch the New Project Wizard again and this time select the LPC54114
(M4) part and click Next. Select the matching ‘MultiCore M4 Master -> LPCOpen -C Project’ and
click Next again. Now, name the new project, for example LPC54114 M4 Master and click next
until the Multicore Project Setup page is reached.

Note: The wizard will present an identical memory configuration page, but on this occasion, no
editing is required since the default Flash and RAM setting are

MCUXpresso IDE User Guide -
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From here, click browse to select the previously created Slave project from the existing
Workspace

Figure 17.13. New Project Wizard Preinstalled M4 Select Slave

® = =]
New project...
Multicore Project Setup

. Wizard properties page.

Multicore Slave Project selection

Select an existing slave project to be associated with this master project

Slave Project - ‘

[ Slave Project o e

Browse to the slave project associated with this master project

5 LPC54114_MO_Slave '
P Do TPeApTEse
(% Ipe_hoard_lpcxpresso_54114_m0

(5 Ipe_chip_5411x
(5 Ipe_chip_5411x m0D

®

17.4

MCUXpresso IDE User Guide -

Now click Next -> Finish to complete the M4 Master projects creation.

Debugging MultiCore Projects

The debug story for MultiCore MCUs can vary with their implementation and also the chosen
debug solution.

Our MultiCore model as described above, assumes that the Master project will both copy
the Slave MCUs code and data (into RAM) but also release the Slave from reset. Therefore
the Master project should be run (debugged) first and typically run to main(). Once here, the
instantiation of the Slave’s code will be complete but the Slave will not have been released. On
some MCUs, a debug connection can be made to the Slave before it has been released, but on
others this will only be possible after they are released.

Note: Slave projects debug launch configurations may require user modification before a debug
connection can be made. Please see the section

In our example LPC54114, the Slave’s debug connection can be made as soon as the Master
reaches main(). The debug window will then look similar to that below.
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Figure 17.14. MultiCore Debug

|o> 00 @ 3D i i il @22 RS LI FEHE -0

%5 Debug 22
a . LPC54114)256_Project_MASTER LinkServer Debug [C/C++ (MXP Semiconductors) MCU Application]
4 [T LPC54114)256_Project_MASTER.axf [LPC54114)256 (cortex-md)]
. ] . ;i

= main() at LPC54114)256_Project_MASTER.c:52 0:x50c
| arm-none-eabil-gan 1121201708117
4 . LPC54114)256_Project MOSLAVE LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application]
a {2 LPC54114)256 Project MOSLAVE.axf [LPC54114)256 (cortex-m0plus)]
»& Thread #1 1 (Stopped) (Running)
s arm-none-eabi-gdb (/. LLLUL70ALT]

17.4.1

Note above: that the MultiCore debug controls have been highlighted, these controls differ from
the standard controls in that they operate on all cores being debugged. Via these, the system
to be stepped, run, paused, terminated etc.

In addition, the M4 Master debug stack (blue) is shown stopped at main, while the Slave stack
(green) is waiting to be released by the Master; clicking between these stacks will change the
IDE’s debug scope from one core to the other. The currently selected core will be the one used
for displaying many of the debug related views, such as Registers and Locals.

Controlling Debug Views

It is also possible to create copies of many of the debug related views, and then lock each copy
to a particular core (as described below).

For example, to create two register views, one for the M4 and one for the MO+ ...First of all, use
the ‘Open New view’ button in the Registers view to create a second Registers view:

Project Ex Peripheral 17 Registers 23 SymbolVi = B %
| @ gt - vl
Name Value Description =
| ¥ AALPC54114J256 (cortex-m4) LPC54112 0P8N New View
i r0 0x00000000
e 0x200000F8
. W2 0x00000400 M
| i3 0x00000001
iiira 0x00000160
s 0x00000001
e 0x40000000
7 0x2000FFFO
ity 0x00000000
| itie] 0x00000000

Figure 17.15. MultiCore Debug New View

MCUXpresso IDE User Guide -

Now pin the original view to the core currently selected in the Debug, using the ‘Pin to Debug
context’ button :
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[75 Project Ex 2, Peripheral

i1 Registers 52 | £ Symbol Vi

= B | 4+ Debug =

t B rieg v vEecs:

LPC54114J266_Project_MASTER.axf: Thread [1] - v :BLPC

" Pin to Debug Context

Name Value Description —

v HALPC54114J256 (cortex-m4) LPC54114J256_F H]

iro 0x00000000 bl arm

W1 0x200000F8 v@@Lpcs:

Hitr2 0x00000400 vELPC

3 0x00000001 el

ira 0x00000160 pil arm
s 0x00000001
16 0x40000000
7 Ox2000FFFO
18 0x00000000
e 0x00000000

HHr10 0x00000000 LPC541"

Figure 17.16. MultiCore Debug Pin View

Now select the other core in the Debug view, and go to the second Register view. Use this view’s
‘Pin to Debug Context’ button to lock this second Registers view to the selected core:

oroject Exp Peripherals iili Registers 23

LPC54114J256_Project_MASTER.axf: Thread [1]

Mame Value
v 44 LPC54114J256 (cortex-md)
1iei rQ 0x00000018
1 Ox2000FFB8
2 0x20000010
i3 0x0000000F
tini rd 0x00000180
15 0x00000001
e 0x40000000
1000, [al¥eTalalal == =g}

iiti Registers <2> ¢ ii]

LPC54114J256_Project_MOSLAVE.axf: Thread [1]

Mame Value

v HHLPC54114J256 (cortex-mOQ...

o 0x00000017
el 0x20011EE4
2 Ox00714F42
i3 0x00714F42
ird 0x20010110
Mg 0x00000001
16 OxFFFFFFFF
7 0x2001FFE8

Figure 17.17. MultiCore Debug Registers
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El

B it~

Description
LPC54114J256_P

= 8 %% Debug =
Y.LP054‘I 14J256_Project_MASTER LinkServer C

¥ 2 LPC54114J256_Project_ MASTER.axf [LPCE
v #% Thread #1 1 (Stopped) (Suspended : Sigr
= main() at LPC54114J256_Project_MAE

. arm-none-eabi-gdb (7.12.1.20170417)

vELPC54114J256_Project_MOSLAVE LinkServer

o] - [l

57

S8

Description
LPC54114J256_f

¥ ¥ LPC54114J256_Project_MOSLAVE.axf [LPC
v %% Thread #1 1 (Stopped) (Suspended : Sigr
= main() at LPC54114J256_Project_MO$

»| arm-none-eabi-gdb (7.12.1.20170417)

[€] LPC54114J256_Project MASTER.c &2 | [¢ LPCE

/* Start slave CPU. */
boot_multicore_slave(};

printf{"Hello World from MASTERNA"};

/¥ Force the counter to be placed in
volatile static int i = @ ;

/* Enter an infinite loop, just incr
while(1) {

i++ 3

return @ ;

17.4.2 Slave Project Debug

Typically, the Master project will be debugged first in exactly the same way as a single CPU
project. However the slave projects debug launch configuration may require special settings in
order to establish a debug connection to the slave CPU.

MCUXpresso IDE will automatically configure the correct settings for LinkServer slave launch
configurations however, for other debug solutions the slave debug settings may require

modification, please see below:

* Core Selection - within a MultiCore MCU there will be more than one CPU (sometimes referred
to as a device). The debug connection needs to be made to the appropriate internal CPU for
both the Master and Slave Projects.

e LinkServer CMSIS-DAP Debug: this process is automatic and hidden from the user. The
selection details are stored within the projects build configuration folder(s) and will take the

suffix .jtag or .swd

MCUXpresso IDE User Guide -
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* P&E Debug: the Master CPU will be selected automatically for the Master project, however
the launch configuration for the Slave project will need to be edited to select the required
CPU. In our example this will be Core: MO

 SEGGER Debug: the Master CPU will be selected automatically for the Master project,
however the launch configuration for the Slave project will need to be edited to select the
required CPU. In our example this will be LPC54114J256_MO

« Attach mode for the Slave CPU — as described above, the debug connection to the slave(s)

should be via an attach

e LinkServer CMSIS-DAP Debug: this option is set automatically when the LinkServer
debug launch configuration is created

« P&E Debug: the launch configuration for the Slave project will need to be edited to force
an attach operation

* SEGGER Debug: the launch configuration for the Slave project will need to be edited to
force an attach operation

e Managing the Debug Server - this is the low level interface between the debugger and target

e LinkServer CMSIS-DAP Debug: the LinkServer launch configuration is automatically
correctly configured when the debug connection is made

« P&E Debug: the slave core is controlled via the master cores debug server, therefore the
slave launch configuration must be edited to ensure that:

* no Server is launched
» the Port Numbers match those set in the Master Project’s launch configuration

GDEB Server Settings
[T]Launch Server Locally GDBMI Port Number: 6224 J

Hostname or IP: localhost Server Port Mumber® 7224

» The Quickstart debug option cannot be used to make the slave debug connection.
Instead, select Run > Debug Configurations... Next, select the appropriate slave launch
configuration and then click Debug

« See the P&E FAQ for more information http://www.pemicro.com/faqgs/faq_view.cfm?
ID=231

+ SEGGER Debug: the default settings can be used

17.5 MultiCore Projects additional Information
17.5.1 Defines
A number of compiler defines are automatically created for LPC5410x projects to allow
conditional compilation of certain blocks of code depending upon whether a specific project is
configured to be a Slave, a Master or neither.
e _ MULTICORE_MASTER
« Defined automatically for a project that has been configured to be a Master project
e _ MULTICORE_MASTER_SLAVE_MOSLAVE
» Defined automatically for a project that has been configured to be a Master project and has
had a Slave project associated with it (hence indicating to the Master project which cpu type
the Slave project is for).
e _ MULTICORE_MOSLAVE
« Appropriate one defined automatically for a project that has been configured to be a Slave
project
e __ MULTICORE_NONE
weveesoioe v cuse -+ Defin€d automatigally for a project which has not been configured as gither a Slave qr Master
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Note: The multicore support within MCUXpresso IDE is highly flexible and provides
functionality beyond that required for the LPC5411x family. Thus the symbols
_ MULTICORE_MASTER_SLAVE_MA4SLAVE and _ MULTICORE_MA4SLAVE are also
provided for completeness.

Slave Boot Code

boot_multicore_slave() is called by the Master project code created directly by the New project
wizard to release the Slave core from sleep.

Note: the source files containing this function will be included in all LPC541xx projects, but will
be conditionally compiled so that it is included only when required. This has been done to allow
projects originally created, for example, as a Slave project, to be reconfigured (via the project
properties — linker multicore tab) as a Master project.

Reset Handler code

When configured as a Master project, the LPC541xx startup file will be built with additional
(assembler) code at the beginning of the reset handler, ResetISR(), with the ‘standard ‘ reset
handler code moved to ResetISR2().

This additional code is required in order to allow correct booting of both the Master and Slave
cores. It is written in assembler in order to force it to be ‘Thumbl’ code, and hence runnable
by both cores.
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18. Appendix — Additional Hints and Tips

18.1 Quick Settings

18.2
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MCUXpresso IDE provides quick access to a range of project settings via the QuickStart Panel
as shown below:

) Quickstart Panel 53 (9= Global Variables (*)=Variables ®g Breakpoints o= Outline

. MCUXpresso IDE (Pro Edition)
IDE

~ Start here

. MNew project...

. Import SDK example(s)...

® Import project(s) from file system...

Q Build 'frdmkl28z_demo_apps_bubble' [Debug]

& Clean 'frdmkl28z_demo_apps_bubble' [Debug]

‘ﬁ" Debug 'frdmkl28z_demo_apps_bubble' [Debug]

5 Edit 'frdmkl28z_demo_apps_bubble' project settings

O i "
& Quick Seftings>3 4 % Defined symbols [frdmki28z_demo_apps_bubble Debug]

B Export project(s) 2 1 Undefined symbols [frdmki28z_demo_apps_bubble Debug]

& Export project(s) 3 pug Include paths [frdmki28z_demo_apps_bubble Debug]

& Build all projects 4 3 Library search paths [frdmkl28z_demo_apps_bubble Debug]
5 1% Libraries [frdmkl28z_demo_apps_bubble Debug]

6 (22 SDK Debug Console >
7 (¥ Set Floating Point type L
| 8 (2 Set library/header type g

Note: These settings apply to the selected project’s default build configuration only and simplify
access to commonly used settings hormally accessed from Properties -> C/C++ Build -> Settings

O WN B

. Defined symbols — select to edit the (-D) symbols

. Undefined symbols — select to edit the (-U) symbols

. Include paths — select to edit the (-I) the include paths

. Library search paths — select to edit the (-L) the library

. Libraries — select to edit the (-I) the linker libraries search

. SDK Debug Console — select the SDK Debug Console’s PRINTF output to be via UART or
to redirect via the C libraries printf function

« selecting printf will increase the size of the project binary compared to UART output

« for semihosted printf output to be generated, the project must be linked against a suitable
library.

« for more information see the section on

. Set Floating Point type — select to switch between the available Floating Point options
« for more information see the section on

. Set Library/Header type — select to switch the current C/C++ Library

« for more information see the section on

Part Support Handling from SDKs

MCUXpresso IDE needs specific device information provided by the SDK in order to properly:

Create/import projects

 with part specific startup code
Define memory layout

Create debugging launch configuration
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e Perform flash programming

This detailed part knowledge is known as Part Support.

SDK Version control

MCUXpresso IDE obtains new Part Support from installed SDKs. The IDE’s internal database
only uses SDKs with the highest version number. For example, a user may have installed two
SDKs for a single part:

* SDK_2.3.0_FRDM-K64F
* SDK_2.0.0_FRDM-K64F

The IDE loads only the 2.3.0 version of that SDK, and also provides a warning in the SDK View
header:

() Installed SDKs £2 ﬂ Properties E Conscle [*| Problems [] Memary ﬁ Instruction Trace ua SWO Trace Config ED Power Measure

% Installed SDKs 'SDK 2.x FRDM-KB4F' ('2.2.0') replaced by SDK version ('2.3.0')

To install an SDK, simply drag and drop an SDK (zip file/felder) into the ‘Installed SDKs' view.

Name SDK Version Manifest Version Location
+ SDK_2.x_FRDM-KE4F 2.3.0 3.2.0 @_ (SDK_2.3.0_FRDM-KB4F.zip

In this situation, it is likely that the user no longer needs the older version of the SDK. Therefore
the IDE provides an option to delete this older SDK via clicking on the warning message, and
clicking the X'.

\@ Installed SDKs E3 j Properties E Conscle l:_ Problems D Memory @ Instruction Trace ,:;' SWO Trace Config B2 Power Measureme

" Installed SDKs 'Shk 2 v EROM-KRAER' ('2 7 (' ranlarad bu SNK warsinn 2 3 0%
To install an SDK, simply dra * 'SDK_2.x_FRDM-K84F' ('2.2.0') replaced by SDK version ('2.3.

Name SDK Version Manifest Version Location
£ SDK_2.x_FRDM-K&4F 2.3.0 3.2.0 @‘ /SDK_2.3.0_FRDM-KE4F.Zip

Note: Once a new SDK for a part is installed, it will always replace any older installed SDK for
that part, even if the new SDK is deactivated (by unchecking the associated tick box). The effect
of deactivating an SDK is that part support and wizard will be removed from internal views. These
will be restored if the SDK is activated again.

SDK Manifest versioning

Along with SDK versioning, also the internal manifest in an SDK can have multiple versions.
MCUXpresso IDE loads the manifest associated to its internal version head info. Thus, assuming
an IDE with internal head version set to 3.3, we could have an SDK with the following manifests:

¢ Manifest version 3.3
¢ Manifest version 3.2
¢ Manifest version 3.1
¢ Manifest version 3.0

In such case, the IDE will load the manifest version 3.3.

After loading, the IDE validates the manifest against the schema version head, and if for any
reason this is not valid, it will try with the other schema versions. If the manifest 3.3 cannot be
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validated, then it tries with manifest 3.2, validating it, and so on. The manifest version is shown
in the SDK View and any validation errors are shown in the Error Log.

In the case that the IDE loads an older manifest, or in the case the SDK contains a manifest 3.4
and the IDE manifest head is 3.3, the SDK image in the SDK view is decorated with a warning
and, by clicking on the SDK, a message appeatrs in the SDK view header:

() Installed SDKs 32 [] Properties [£) Conscle [*/ Problems [] Memon

Iy Installed SDKs A newer version of MCUXpresso IDE is recommende:

To install an SDK, simply drag and drop an SDK (zip file/folder) into the ‘Installe

Mame SDK Version Manifest
‘h SDK_2.x_FRDM-KGA4F 2.3.0 3.2.0

The full error will look like: "A newer version of the MCUXpresso IDE is recommended for use
with the selected SDK. Please update your MCUXpresso IDE in order to get full SDK features"

At the time of the MCUXpresso IDE v10.2.0 release, such an error should never occur. However,
in the future, newer SDKs may be released supporting features not understood by this version
of the IDE. This will be used to warn users that there is a miss match between the SDK and
IDE capabilities.

Device versions

If the user installs more than one SDK containing the same device (i.e. a device with the same
identifier), the IDE loads the part support from the device with the highest version number,
regardless of which SDK it is located within. If two or more SDKs have the same device with
the same version number, then the order these are presented to the IDE by the host OS will
determine which SDK is used.

If an SDK in the Installed SDK view contains a device that is not installed (because it is supplied
by another SDK), its image (and the device in the SDK tree) will be decorated with an icon:

) Installed SDKs £3 Properties Console |*| Problems Memaory Instruction Trace EJ SWO Trace Config @D Power Measurement X Symbol Viewe
Lot s

@i
‘Q) Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/folder) inte the ‘Installed SDKs' view.

Name SDK Version Manifest Version Location

1+ SDK_2.x_FRDM-K&4F-AGMO1 220 3.0.0 {;‘ (SDK_2.0_FRDM-KG4F-agm({ » . Boards

4 SDK_2.x_FRDM-KE4F [® <Default Location>/SDK_2.0.0_FRDM-KG4F.zip [ B Devices

€]

¥ |aig Compilers
» 13 Toolchains
P (¥ Toolchain Se
» {1k Components

How do | switch between Debug and Release builds?

By default, MCUXpresso IDE projects will automatically have two build configurations, Debug
and Release. Typically a project will be developed using the Debug build variant, but switched
to Release late in the development cycle to benefit from more compilation optimisations.
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18.3.1 Changing the build configuration of a single project
You can switch between Debug and Release build configurations by selecting the project you
want to change the build configuration for in the Project Explorer view, then using one of the
below methods:
« Select the menu item Project->Build Configuration->Set Active and select Release or
Debug as necessary
* Use the drop down arrow next to the ‘sundial’ (Manage configurations for the current project)
icon on the main toolbar (next to the ‘hammer’ icon) and select Release or Debug as
necessary. Alternatively, you can use the drop down next to the ‘hammer’ icon to change the
current configuration and then immediately trigger a build.
A-B~- Qu-|@ >~ o~
1010 v’l’\\Sl Debug (Debug build) b
2 Releaze (Releasze build)
« Right click in the Project Explorer view to display the context sensitive menu and select Build
Configurations->Set Active entry.
18.3.2 Changing the build configuration of multiple projects
Itis also possible to set the build configuration of multiple projects at once. This may be necessary
if you have a main application project linked with a library project, or you have linked projects for
a multicore MCU such as an LPC43xx or LPC541xx (one project for the master Cortex-M4 CPU
and another for a slave Cortex-M0/M0+ CPU).
To do this, you first of all you need to select the projects that you wish to change the build
configuration for in the Project Explorer view — by clicking to select the first project, then use
shift-click or control-click to select additional projects as appropriate. If you want to change all
projects, then you can simply use Ctrl-A to select all of them.
Note: it is important that when you select multiple projects, you should ensure that none of the
selected projects are opened out — in other words, when you selected the projects, you must not
have been able to see any of the files or the directory structure within them. If you do not do this,
then some methods for changing the build configuration will not be available.
Once the required projects are selected, you then need to simply change the build configuration
as you would do for a single project.
18.4 Editing Hints and Tips
The editor view within Eclipse, which sits under the MCUXpresso IDE, provides a large number
of powerful features for editing your source files.
18.4.1 Multiple views onto the same file
The Window -> Editor menu provides several ways of looking at the same file in parallel.
» Clone : two editor views onto the same file
e Toggle Split Editor : splits the view onto the current file into two (either horizontally or
vertically)
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Viewing two edited files at once

To see more than one file at the same time, simply click the file tabs that you have open in the
editor view, and then keep the mouse button held down and drag that file tab across to the right.
After you've moved to the side, or below, an outline should appear showing you where that tab
will be placed once you release the mouse button.

Source folding

Within the editor view, functions, structures etc. may be folded to show the structure and hide
the detail.

Folding is controlled via, right click in the margin of the editor view to bring up the context sensitive
menu, then select Folding -> <option required>

When folding is enabled, you can then click on the + or - icon that now appear in the margin next
to each function, structure, etc, to expand or collapse it, or use the Folding -> Expand all and
Folding -> Collapse all options from the context sensitive menu

Various settings for Folding can also be controlled through:

Preferences -> C/C++ -> Editor -> Folding

Editor templates and Code completion

Within the editor, a number of related pieces of functionality allow you to enter code quickly and
easily.

First of all, templates are fragments of code that can be inserted in a semi-automatic manner to
ease the entering of repetitive code — such as blocks of code for C code structures such as for
loops, if-then-else statements and so on.

Secondly, the indexing of your source code that is done by default by the tools, allows for auto
completion of function and variable names. This is known as “content assist”.

¢ Ctrl-Space at any point will list available editor template, function names etc.
« Ctrl-Shift-Space will display function parameters
« Alt-/ for word completion (press multiple times to cycle through multiple options).

In addition, the predefined templates are user extensible via:

Preferences -> C/C++ -> Editor -> Templates

Brace matching
The editor can highlight corresponding open and closing braces in a couple of ways.

First of all, if you place the cursor immediately to the right of a brace (either an opening or closing
brace), then the editor will display a rectangle around the corresponding brace.

Secondly, if you double click immediately to the right of a brace, then the editor will automatically
highlight all of the text between this brace and the corresponding one.

Syntax coloring

Syntax Coloring specifies how your source code is rendered in the editor view, with different
colors used for different elements of your source code. The settings used can be modified in:

Preferences -> C/C++ -> Editor -> Syntax Coloring
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Note that general text editor settings such as the background color can be configured in:
Preferences -> General -> Text Editors
Fonts may be configured in:

Preferences -> General -> Appearance -> Colors and Fonts

Comment/uncomment block

The editor offers a number of ways of comment in or out one or more lines of text. These can
be accessed using the Source entry of the editor context-sensitive menu, or using the following
keyboard shortcuts...

¢ Select the line(s) to comment, then hit Ctrl-/ to comment out using // at the start of the line, or
uncomment if the line is currently commented out.

« Select the line(s) to comment, then hit Ctrl-Shift-/ to block comment out (placing /* at the start
and */ at the end).

e To remove a block comment, hit Ctrl-Shift-\.

Format code

The editor can format your code to match the coding standards in use ( Preferences -> C/C
++ -> Code Style). This can automatically deal with layout elements such as indentation and
where braces are placed. This can be carried out on the currently selected text using the Source-
>Format entry of the editor context-sensitive menu, or using the keyboard shortcuts Ctrl-Shift-F.
If no text is selected, then the format will take place on the whole of the current file.

Correct Indentation

As you enter code in the editor, it will attempt to automatically indent your code appropriately,
based on the code standards in use, and also the layout of the preceding text. However, in
some circumstances, for example after manually laying text out, you may end up with incorrect
indentation.

This can usually be corrected using the Source->Correct Indentation entry of the editor context-
sensitive menu, or using the keyboard shortcuts Ctrl-I.

Alternatively, use the “Format code” option which will fix other layout issues in addition to
indentation.

Insert spaces for tabs in editor

You can configure the IDE so that when editing a file, pressing the TAB key inserts spaces instead
of tab characters. To do this go to

Preferences -> General -> Editors -> Text Editors

and tick the “Insert spaces for tabs” box. If you tick “Show white-space characters” you can see
whether a tab character or space characters are being inserted when you press the TAB key

Replacing tabs with spaces
To replace existing tabs with spaces throughout the file, open the Code Style preferences:

Preferences -> C/C++ -> Code Style

« Select a Code Style profile and then select Edit...
¢ Choose the Indentation tab
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« For the Tab policy, select Spaces only
* Apply the changes.
< Note: If the Code Style has not been edited before, the Profile must be renamed before the
change can be applied.
¢ The new style will be applied when the source is next formatted using Source -> Format

Hardware Floating Point Support

Most ARM-based systems — including those based on Cortex-M0, MO+ and M3, have historically
not implemented any form of floating point in hardware. This means that any floating point
operations contained in your code will be converted into calls to library functions that then
implement the required operations in software.

However, many Cortex-M4 based MCUs do incorporate a single precision floating point hardware
unit. Note: that the optional Cortex-M4 floating point unit implements single precision operations
(C/C++float) only. Thus if your code makes use of double precision floating point (C/C++ double),
then any such floating point operations contained in your code will still be converted into calls to
library functions that then implement the required operations in software.

Similarly, Cortex-M7 based MCUs may incorporate a single precision or double precision floating
point hardware unit.

Floating Point Variants

When a hardware floating point unit is implemented, ARM define that it may be used in one of
two modes.

SoftABI

¢ Single precision floating point operations are implemented in hardware and hence provide a
large performance increase over code that uses traditional floating point library calls, but when
calls are made between functions any floating point parameters are passed in ARM (integer)
registers or on the stack.

* SoftABI is the ‘most compatible’ as it allows code that is not built with hardware floating point
usage enabled to be linked with code that is built using software floating point library calls.

HardABI

¢ Single precision floating point operations are implemented in hardware, and floating point
registers are used when passing floating point parameters to functions.

HardABI will provide the highest absolute floating point performance, but is the ‘least compatible’
as it means that all of the code base for a project (including all library code) must be built for
HardABI.

Floating point use — Preinstalled MCUs

When targeting preinstalled MCUs, MCUXpresso IDE generally assumes that when Cortex-M4
hardware floating point is being used, then the SoftABI will be used. Thus generally this is the
mode that example code (including for example LPCOpen chip and board libraries) are compiled
for. This is done as it ensures that components will tend to work out of the box with each other.

When you use a project wizard for a Cortex-M4 where a hardware floating point unit may be
implemented, there will be an option to enable the use of the hardware within the wizard’s options.
This will default to SoftABI — for compatibility reasons.

Selecting this option will make the appropriate changes to the compiler, assembler and linker
settings to cause SoftABI code to be generated. It will also typically enable code within the startup
code generated by the wizard that will turn the floating point unit on.
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You can also select the use of HardABI in the wizards. Again this will cause appropriate tool
settings to be used. But if you use this, you must ensure that any library projects used by your
application project are also configured to use HardABI. If such projects already exist, then you can
manually modify the compiler/assembler/linker settings in Project Properties to select HardABI.

Warning : Creating a project that uses HardABI when linked library projects have not been
configured and built with this option will result in link time errors.

18.5.3 Floating point use — SDK installed MCUs
When targeting SDK installed MCUs, MCUXpresso IDE generally assumes that when hardware
floating point is available, then the HardABI will be used. This will generally work without problem
as generally projects for such MCUs contain all required code (with no use of library projects).
However, it is still possible to switch to using SoftABI using the “Advanced Properties settings”
page of the |New project" and “Import SDK examples” wizards.

18.5.4 Modifying floating point configuration for an existing project
If you wish to change the floating point ABI for an existing project (for example to change it from
using SoftABI to HardABI), then go to:
Quickstart -> Quick Settings -> Set Floating Point type
and choose the required option.
Alternatively, you can configure the settings manually by going to:
Project -> Properties -> C/C++ Build -> Settings -> Tool Settings
and changing the setting in ALL of the following entries:
e MCU C Compiler -> Architecture -> Floating point
¢ MCU Assembler -> Architecture & Headers -> Floating point
¢ MCU Linker -> Architecture -> Floating point
Note: For C++ projects, you will also need to modify the setting for the MCU C++ Compiler.
Warning: Remember to change the setting for all associated projects, otherwise linker errors
may result.

18.5.5 Do all Cortex-M4 MCUs provide floating point in hardware?
Not all Cortex-M4 based MCUs implement floating point in hardware, so please check the
documentation provided for your specific MCU to confirm.
In particular with some MCU families, some specific MCUs may not provide hardware floating
point, even though most of the members of the family do (for example the LPC407x_8x). Thus it
is a good idea to double check the documentation, even if the project wizard in the MCUXpresso
IDE for the family that you are targeting suggests that hardware floating point is available.

18.5.6 Why do | get a hard fault when my code executes a floating point
operation?
If you are getting a hard fault when your application tries to execute a floating point operation,
then you are almost certainly not enabling the floating point unit. This is normally done in the
LPCOpen or SDK initialisation code, or else in the startup file that MCUXpresso IDE generates.
But if there are configuration issues with your project, then you can run into problems.
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For more information, please see the Cortex-M4 Technical Reference Manual, available on the
ARM website.

18.6 LinkServer Scripts
The LinkServer debug server supports a Basic like programming language that can be used to
script low level target operations. Within a LinkServer debug connection, we provide two call
outs where scripts can be referenced (if required). The first call out is intended to assist with the
initial debug connection, via a Connect Script, and the second is to assist with the targets reset
via a Reset Script.
These scripts are specified within a LinkServer launch configuration file and will be preselected
if needed for projects performing standard connections to known debug targets.
18.6.1 Supplied Scripts
A set of scripts are supplied within the MCUXpresso IDE installation at:
<install dir>/ide/bin/Scripts
These scripts will be used to prepopulate LinkServer launch configuration files when needed.
The purpose of certain scripts will be described below:
¢ kinetismasserase.scp - invoked by the GUI Flash Programmer to Ressurect locked Kinetis
device
e kinetisunlock.scp - if for any reason the GUI Flash Programmer fails to resurrect a locked part
(as above), this script can be specified in place of the above and the recovery attempt repeated
« delayexample.scp - an example script showing how a delay can be performed
18.6.2 User Scripts
Additional user generated scripts can be added directly to the product installation but more
typically they should be located within a project. The LinkServer launch configuration allows the
location of scripts to be either project relative, absolute or product local.
18.6.3 Debugging code from RAM
[This section is deprecated — please see
for details of the improved scheme]
MCUs have well defined boot strategies from reset, typically they will first run some internal
manufacturer boot ROM code that performs some hardware setup and then control passes to
code in flash (i.e. the users Application).
On occasion it can be useful to run and debug code directly from RAM. Since an MCU will not
boot from RAM a scheme is needed to take control of the debuggers reset mechanism. This can
be achieved the use of a LinkServer reset script.
Within MCUXpresso IDE, certain pre-created scripts are located at:
{install dir}/bin/Scripts
Contained in this directory is a script called kinetisRamReset.scp (see below).
10 REM Kinetis K64F Internal RAM (@ 0x20000000) reset script
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20 REM Connect script is passed PC/SP fromthe vector table in the image by the debugger
30 REM For the sinple use case we pass them back to the debugger with the |ocation of the
45 REMreset context.

40 REM

50 REM Syntax here is that '~ commands a hex output, all integer variables are a%to z%
70 REM Find the probe index

80 p% = probefirstfound

90 REM Set the 'this' probe and core

100 sel ect probecore p% 0

110 REM NOTE!'! Vector table presunmed RAM | ocation is address 0x20000000

120 REM The script passes the SP (%) and PC (%) back to the debugger as the reset context
130 b% = peek32 this 0x20000000

140 a% = peek32 this 0x20000004

150 print "Vector table SP/PC is the reset context."

160 print "PC = "; ~a%
170 print "SP = "; ~b%
180 print "XPSR = "; ~c%
190 end

This reset script makes an assumption that the user intends to run code from RAM at 0x20000000
— this is the value of the SRAM_Upper RAM block on Kinetis parts.

Note: To build a project to link against RAM, you can simply delete any flash entries within the
projects memory configuration. If the MCUXpresso IDEs default linker settings are used then
project will link to the first RAM block in the list. For many Kinetis parts, this address will match the
expected address within the script. For some parts (for example KLxx) however, the first RAM
block may take a different value. This problem can be resolved by editing the script or modifying
the projects RAM addresses.

For users if LPC parts, the RAM addresses will be different but the principal remains the same.
Within the Scripts directory, you will find an RAM reset script for the LPC18LPC43 parts, this
script is identical to the one above apart from the assumed RAM address.

Finally, to use the script, simply edit the projects launch configuration for the ‘Reset Script’ entry,
browse to the appropriate ‘RAMReset.scp’ script. For information about launch configurations
please see the section

Note: When executing code from RAM, the projects Vector table will also be located at the
start of the RAM block. Cortex M MCUs can locate their vector table using an internal register
called VTOR (the vector table offset register). Typically this register will be set automatically by
a projects startup or init code. However, if execution fails when an interrupt occurs, check that
this register is set the correct value.

LinkServer Scripting Features

LinkServer scripts are written in a simple version of the BASIC programming language. In this
variant of BASIC, 26 variables are available (%a thru %z). On entry to the script some variable
have assigned values:

% is the PC
% is the SP
% is the XPSR

On exit from the script %a is loaded into the PC and %b is loaded into the SP, thus providing a
way for the script to change the startup behavior of the application.

They offer functionality as shown below:
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Generic BASIC like functions that only work inside scripts

GOTO ' Li neNunber"'

IF 'relation' THEN 'statenent’

REPEAT : Start of a repeat block

UNTIL 'relation' : End with condition of repeat block
BREAKREPEATTO ' Li neNunber' : Premature end of a repeat |oop
GOSUB ' Li neNunber '

RETURN

TIME : Returns a 10ms increnenting count fromthe host

Generic BASIC like functions

PEEK8{[ THI S] | [' Probel ndex' 'Corelndex']} 'Address'
PEEK16{[ THI S] | [' Probel ndex' 'Corelndex']} 'Address'
PEEK32{[ THI S] | [' Probel ndex' 'Corelndex']} 'Address'
POKES{[ THI S] | ['Probelndex' 'Corelndex']} 'Address' 'Data’
POKEL16{[ THI S] | [' Probel ndex' 'Corelndex']} 'Address' 'Data'

POKE32{[THI S] | [' Probel ndex' 'Corelndex']} 'Address' 'Data'

QPOKE8  {[THI S| |

QPOKEL6 {[THI S| |

QPOKE32{[THI S] | ['Probelndex' 'Corelndex']} 'Address' 'Data'

QSTARTTRANSFERS{[ THI S] | [' Probel ndex' ' Corelndex']}

MEMSAVE{[ THI S] | ['Probelndex' 'Corelndex']} 'FileNane' 'Byte StartAddress' 'Length in Bytes'
MEMLOAD{[ THI S] | ['Probelndex' 'Corelndex']} 'Byte StartAddress' 'LengthLimt in Bytes'
MEMDUMP{[ THI S] | [' Probel ndex' 'Corelndex']} 'Byte StartAddress' 'Length in Bytes'

EXIT: Exit the server

LI ST: Lists the script

NEW Erases script from nenory

RENUMBER: Renunbers in increments of 10

LOAD ' FI LENAVE' : Loads a script fromcurrent directory

SAVE ' FI LENAMVE : Saves a script to current directory

[ <Probel ndex> <Cor el ndex>]} <Address> <Dat a>
[

<Pr obel ndex> <Cor el ndex>]} <Address> <Dat a>

Probe related functions

PROBELI ST : Creates and then returns an indexed |ist of the probes attached
PROBENUM : Returns the nunber of probes attached

PROBECPENBY!I NDEX ' Probel ndex' : Returns a uni que probe handl e

PROBECLCSE ' Pr obeHandl e’

PROBECLOSEBYI NDEX ' Probel ndex' : Returns an error code

PROBETI ME ' Probel ndex' : Returns tinme fromfirnware in the probe
PROBESTATUS : Returns an indexed summary of the status of the probes connected to the system
PROBEVERS| ON ' Probel ndex' : Returns version information about probe firmare
PROBEI SOPEN ' Pr obel ndex’

PROBEHASJTAG ' Pr obel ndex'

PROBEHASSWD ' Pr obel ndex’

PROBEHASSW ' Pr obel ndex’

PROBEHASETM ' Pr obel ndex’

Core/TAP related functions

CORELI ST ' Probel ndex': Returns |ist of TAPs/ Cores found connected to specified probe
CORECONFI G[[THI'S] | [' Probelndex']}: Configures the scanchain

CORESCONFI GURED ' Pr obel ndex'

COREREADI D ' Probel ndex' ' Cor el ndex'
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Wire related functions

W RESWDCONNECT{[ THI S] | [' Probelndex']}: Returns the DPID

W REJTAGCONNECT{[ THI' S] | [' Probel ndex']}:

W RETI MEDRESET ' Probel ndex' 'Tinmeln_nms': pulls reset and returns the end state of the wire

W REHOLDRESET ' Probel ndex' 'State' : pulls reset and returns the end state of the wire

W RESTATUS ' Probel ndex' : Returns the status of the wire connection on the probe specified

W RESETSPEED ' Probel ndex' ' Speedl nHz': Requests a particular wre speed

W REGETSPEED ' Probel ndex' : Returns the current wre speed

W RESETI DLECYCLES ' Probel ndex' ' Cycles': Requests a specific nunber of idle cycles between debug
transactions

W REGETI DLECYCLES ' Probel ndex' : Returns the current nunber of debug idle cycles W REI SCONNECTED
' Probel ndex'

W REGETPROTOCOL ' Pr obel ndex'

SELECTPROBECORE ' Probel ndex' ' Corelndex' : sets up for use with follow ng commands

TH'S : displays the current Probe, Core pair

Cortex-M related functions

CM NI TAPDP{[ THI'S] | ['Probelndex' 'Corelndex']}: Initialize a CW core ready for debug
connections

CMARI TEDP{[ THI' S] | ['Probelndex' 'Corelndex']} 'REG 'DATA : returns zero on success
CMARI TEAP{[ THI' S] | [' Probelndex' 'Corelndex']} 'REG 'DATA : returns zero on success
CVREADDP{[ THI S] | [' Probelndex' 'Corelndex']} 'REG: returns data

CVREADAP{[ THI S] | [' Probelndex' 'Corelndex']} 'REG: returns data (note this deals w th RDBUF
on AP reads)

CMCLEARERRORS{[ THI' S] | [' Probel ndex' ' Corel ndex']}

CVHALT{[THI S] | [' Probel ndex' ' Corelndex']}

CMRUN{[THI S] | [' Probel ndex' ' Corelndex']}

CVREGS{[THI S] | [' Probel ndex' ' Corelndex']}

CMARI TEREG[[ THI'S] | [' Probel ndex' ' Corelndex']} 'RegNumber' ' Val ue'

CVREADREG[[ THI S] | [' Probel ndex' 'Corelndex']} 'RegNumber'

CMMTCHLI ST{[THI S] | [' Probel ndex' ' Corelndex']}

CMMTCHSET{[ THI'S] | [' Probel ndex' 'Corelndex']} 'DWIl ndex' 'Address' ['[RW|R W]
CMMTCHCLEAR{[ THI S] | [' Probel ndex' ' Corelndex']} ' DWII ndex'

CMBREAKLI ST{[THI S] | [' Probel ndex' 'Corelndex']} : List the hardware breakpoints
CMBREAKSET{[ THI'S] | [' Probel ndex' 'Corelndex']} 'Address' : Set an FPB
CVBREAKCLEAR{[ THI S] | [' Probelndex' 'Corelndex']} ['Address'] : Cear an FPB
CMBYSRESETREQ([ THI' S] | [' Probel ndex' 'Corelndex']} : Systemreset request
CWECTRESETREQ([ THI S] | [' Probel ndex' 'Corelndex']} : Core reset request
CVRESETVECTORCATCHSET{[ THI' S] | [' Probelndex' 'Corelndex']} : Enable reset vector catch
CVRESETVECTORCATCHCLEAR{[ THI S] | [' Probel ndex' 'Corelndex']} : Disable reset vector catch

Scripts can be specified within a LinkServer launch configuration to be run before a connection
and/or before a reset.

RAM projects with LinkServer

MCUs have well defined boot strategies from reset, typically they will first run internal
manufacturer boot ROM code to perform some hardware setup and then pass control to code
in flash (i.e. the users Application).

Most examples and wizards create projects to run from MCU flash memory but on occasion it
can be useful to debug code directly from RAM. There are two stages to such a task:

1. Modify a project to that it links to run from RAM
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2. Modify the default reset mechanism to ensure that the RAM image is executed

To build a project to link against RAM, simply delete any flash entries within the projects memory
configuration. If the MCUXpresso IDEs default linker settings are used then the project will then
link against the first RAM block in the list (provided no Flash entry is present). Alternatively, from:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Manager Linker Script, you can
check the entry Link application to RAM.

Note: if the project has already been built to link to flash, then it should be cleaned before being
rebuilt.

Since an MCU will not automatically boot from RAM, a scheme is needed to take control of the
debuggers reset mechanism. This can be achieved via the use of a SOFT reset type. LinkServer
launch configurations can take an additional option, add the line --reset soft to override the default
reset type. Or preferably, set the reset type to 'SOFT' as shown below.

| Maximum wire speed

- Memory Access Checking off

abf: Pre launch command

i Reset Handling SOFT v
atf: Reset Script SYSRESETREQ

i Run/Continue image VECTRESET

PR T

Default

Miscellaneous

A soft reset is performed by setting the PC to the images resetISR() address, the stack pointer
to the top of the first RAM region and VTOR (Vector Table Offset Register) to the base address
of the first RAM region.

Note: Typically, MCU RAM sizes will be smaller that Flash sizes, therefore such a scheme may
not be suitable for larger images.

18.7.1 Advantages of developing with RAM projects
There are a number of advantages when debugging from RAM:
¢ Breakpoints in RAM do not require dedicated HW resources, essentially there is no limit of the
number of breakpoints that can be set.
¢ Flash programming step is not required, so the build and debug cycle will be faster.
« Development of secondary bootloaders is free from BootROM considerations
* No risk of accidently triggering Flash security features.
« No requirement to understand or have flash programming capability allowing code (including
flash drivers) can be developed.
« Any flash contents are preserved while debugging
¢ Unit development of large applications
Note: It should be remembered that since the MCU will not undergo a true hardware reset,
peripheral configurations will be inherited from one debug session to the next.
18.8 The Console View

The Console View contains a number of different consoles providing textual information about the
operation of various parts of MCUXpresso IDE. It is located by default in the bottom right of the
Debug Perspective, in parallel with a number of other views — including the ‘Installed SDKs’ view.
The actual consoles available within the Console view will depend upon what operations are
currently taking place — in particular a number of consoles will only become available once a
debug session is started.
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The currently displayed console will provide a local toolbar, with icons to do things like copying
the contents of the console or clearing its contents.

To see the list of currently available consoles, and, if required, change to a different one..

1. Switch to the Console View

2. Using the toolbar within the Console View click on the drop-down arrow next to the Display
Selected Console icon (which looks like a small monitor)

3. Select the require console from the drop down list

[ Installed SDKs  [] Properties B Console 52 |* Problems [] Memory 3 Instruction Trace G SWO Trace Config B2 Power Measurement Tg = O
s x% AEEEe {=-0)-
frdmk64f_demo_apps bubble =1y cpt global Build Console 55

[MCUXpressc Semihostin .
=] 2 CDT Build Console [frdmk64f_demo_apps_bubble]

‘ # 3 FreeRTOS Task Aware Debugger Console version 1.0.2 (201702241004)
4 frdmki4f_demo_apps_bubble Debug [C/C++ (NXP Semiconducters) MCU Application] gdb traces
. 5 frdmko4f_demo_apps_bubble Debug [C/C++ (NXP Semiconductors) MCU Application] arm-none-eabi-gdb (7.12.0.20161204)
6 RedlinkServer
@ 7 frdmkb4f_demo_apps_bubble Debug messages
. 8 frdmkidf_demo_apps_bubble Debug [C/C++ (NXP Semiconducters) MCU Application] frdmki4f_demo_apps_bubble.axf

Console types
Consoles you will typically see include the following...
Build Console and Global Build Console

The Build Console (sometimes referred to as the Build Log) is used by the MCUXpresso IDE
build tools (compiler,linker, etc.) to display output generated when building your project. In fact
MCUXpresso IDE has two build consoles — one of which records the output from building the
current project, and the second a global build console which will record the output from building
all projects.

By default, the number of lines stored in the Build Console is limited to 500 lines. You can increase
this to any reasonable number as follows:

1. Select the Windows->Preferences menu option
2. Now choose C/C++ -> Build -> Console
3. Increase the "Limit Console out (humber of lines)" to a larger number, for instance 5000.

Note: This setting, like most within the MCUXpresso IDE is saved as part of your workspace.
Thus you will need to make this change each time you create a new workspace.

Other options that can be set in Preferences include whether the console is cleared before a
build, whether it should be opened when a build starts, and whether to bring the console to the
top when building.

Once your build has completed, then if you have any build errors displayed in the console, clicking
on them will, by default, cause the appropriate source file to be opened at the appropriate place
for you to fix the error.

FreeRTOS Task Aware Debugger Console

This console displays status about the FreeRTOS TAD views. For more details, please see the
MCUXpresso IDE FreeRTOS Debug Guide.

gdb traces and arm-none-eabi-gdb Consoles

These consoles give access to the GDB command line debugger, that sits underneath the
MCUXpresso IDE’s graphical debugging front end.
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RedlinkServer/LinkServer Console

This console gives access to the server application that sits at the bottom of the debug stack
when using a debug probe connected via the MCUXpresso IDEs native “LinkServer” debugging
mechanism. LinkServer commands can be entered from this console.

Debug messages Console

The Debug Messages Console (sometimes referred to as the Debug Log) is used by the debug
driver to display additional information that may be helpful in understanding connection issues
when debugging your target MCU.

Semihosting Console

This console, generally displayed with .axf, allows semihosted output from the application running
on the MCU target to be displayed, and potentially for input to be sent down to the target.

18.8.2 Copying the contents of a console
Occasionally, you may wish to copy out the contents of a console. For instance, the MCUXpresso
IDE support team may ask you to provide the details of your Build Console in a forum thread.
To do this:
1. Clean, then build your project.
2. Select the appropriate Build Console as above:
3. Select the contents (e.g. Ctrl-A)
4. Copy to the clipboard (e.g. Ctrl-C).
5. Paste from clipboard into forum thread (e.g. Ctrl-V). If there is a large amount of text in the
build console, it is advisable to paste it into a text file, which can be ZIPed if appropriate.
Note: some console will provide a button in their local toolbar to copy or save out their contents.
18.8.3 Relocating and duplicating the Console view
By default the Console View is positioned in parallel with a number of other views. This can
mean, if a console is being regularly updated with new output (for instance the view displaying
semihosted output from the application running on the target MCU), then by default this may
cause the console to keep jumping to the foreground — hence hiding other views that you are
using (for instance one of the SWO Trace views)
To avoid this you may wish to relocate the Console. To do this ...
1. Click and hold down on the Console View
2. Continue to hold down, and drag the cursor to the location you want to Console view to be
displayed
3. Then release the mouse click, and the Console view will be placed at the required position
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Another alternative is to spawn a duplicate instance of the Console view. This allows multiple
consoles to be visible at the same time. To do this use the Open Console button on the Console
view local toolbar

& B E?
mo_apps_bubple =t

Open Console

and then select "New Console View"

IX % BKEREE BN
1 C/C++ Build Console

By zcvs

3 Mew Console View

# 4 FreeRTOS Task Aware Debugger Console

This will then display a second console view, which can be drag and dropped to a new location
within in the Perspective, as shown for the single Console view case described above.
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€] bubble.c 52 », = 5 @ Console X -5
}F Angl JE\NGLEUPPERBDLA . |-x.‘_1t| d’z‘lﬁlda'i:?'
¥ (gyAngle > - - frdmlb4f_demo_apps_bubble Debug [C/C++ (NXP Semiconduc

Angle = 188; = -26 y = -38 "
} E_vAngle ; S A
/* Update angles to turn off | "i -26 y - -33
if (g_wxAngle < ANGLE_LOWER_BOL x= -29 y = -36
- - - x= -3 y=  -37
g_wAngle = @; = -28 y = T

Y _ x=  -35y= -4l B

‘ — ”r o P \.:’_ DE e — =X -

[ Install... [ Proper.. B Console &2 [%] Proble.. [J Memory € Instruc.. [5]SWOT.. =D Power.. = 0

LR E RO
frdmlkb4f_demo_apps_bubble Debug messages

=
Awaiting telnet connection on port 3330 ... v

GDB nonstop mode enabled

Opening flash driver FTFE_4K.cfx (already resident)

Writing 26688 bytes to address @x@8608088 in Flash

Erased/Wrote page @-6 with 26688 bytes in 324msec

Closing flash driver FTFE_4K.cfx

Flash Write Done

Flash Program Summary: 26688 bytes in 8.32 seconds (88.44 KB/sec)

Stopped: Breakpoint #1 -

Having opened a second console view, select which console you want displayed in it, and then
use the “Pin Console” button to ensure that it does not switch to one of the other consoles when
output is displayed.

=R

apps
SPES Pin Conscle

Using Terminal View for UART communcation with target

MCUXpresso IDE v10.2.0 (and later) provide a Terminal View, which can be used to display
UART (serial) input/output between a host PC and the target MCU. In situations where a debug
probe is built into the target board, UART comms will often be possible via a VCOM connection
over the same USB cable as the debug connection. However, where this is not the case a
serial_to_USB cable can be used, alternatively, if the target MCU has built in USB then a VCOM
port can implemented in the application code running on the target MCU.

Using a Terminal View offers an alternative way of interacting with the target when compared to
semihosting output via debug channel (which is displayed in the Console View). There are pros
and cons to both approaches, but one distinct advantage to using the Terminal View for serial
output is that you can interact with the target MCU without a debug session being active!

To use the Terminal View within MCUXpresso IDE, the first thing you will need to do is open it (as
it is not visible by default). To do this go to: Window -> Show View -> Other and select Terminal.
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® _©® Show View
|

F =Help

b (= Java

¥ (= Java Browsing

b (= Make

» (= MCUXpresso Config Tools

F (= MCUXpresso IDE

b (= MCUXpresso |IDE Power Measurement
F (= MCUXpresso IDE Trace

» (= PEmicro

¥ (= Terminal
2 Terminal

Alternatively, just type “Terminal” into the “Quick Access” button in the top right of the IDE’s
window.

Next, ensuring that the serial connection between your PC and the target MCU is active first,
click on the “Open a Terminal” button in the Terminal View's toolbar:

& Terminal 2 2 i S=0

Open a Terminal (~C4T)

Note: If using the LPC-Link2 built into many LPCXpresso boards, then you need to make sure the
probe has been booted before the serial connection will be available. You can do this manually
by using the “Boot Debug probe” button in the tool bar towards the top of the IDE window. Or
else you can pre-program the probe firmware into flash using LPCScrypt.

Now select the type of terminal required — a serial one :

® @ Launch Terminal ‘
Choose terminal + Local Terminal '
St SSH Terminal
L Serial Terminal :
Encoding: L Telnet Terminal

P AW PV

And then select the appropriate settings:
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Launch Terminal

<>

Choose terminal:  Serial Terminal
Settings
Serial port: /dev/cu.usbmodemDSATBQD2 o

Baud rate: 115200

<>

<>

Data size: 8

<>

Parity: None

<>

Stop bits: 1

Encoding: Default (ISO-8859-1)

<>

Cancel OK

S

Note: that if you are receiving serial output via USB (for instance over a VCOM port from the
debug probe), then the default settings should normally be fine. The one setting you do need to
get correct is the Serial port to use. This will vary depending upon what devices are connected
within your PC, what OS you are running, and what the source for your serial port will be.

For instance if you are running on Windows, then the simplest way to identify the required serial
port is to open “Device Manager” (typically via the “Start Menu”), then expand the “Ports” tab.
This should allow you to identify the appropriate COM port needed.

After configuring the settings as required, click on the “OK” button. You should now see serial
output from the application running on the target MCU within the Terminal View:

& Terminal 2 25 QUERENY B&-=

SHELL Cbuild: Apr 20 2018)
Copyright (c) 2017 NXP Semiconductor
SHELL>> help

"help": Lists all the registered commands
"exit": Exit program

"led argl arg2":

Usage:
argl: 1121314... Led index
arg2: onloff Led status
SHELL>>

PUPT Y WA P R

Note: the Terminal view only offers a simple terminal mechanism with a small number of
configuration options. If you require more control over the way the terminal behaves, you may
still need to use a standalone terminal application, such as PuUTTY, CoolTerm and Tera Term.
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18.10.1

18.10.2

18.10.3
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Using and troubleshooting LPC-Link2

LPC-Link2 hardware

LPC-Link2 is a powerful, low cost debug probe design from NXP Semiconductors based on the
LPC43xx MCU. It has been implemented into a number of different systems, including:

¢ The standalone LPC-Link2 debug probe
e The debug probe built into the range of LPCXpresso V2/V3 boards.

For more details, see http://www.nxp.com/lpcxpresso-boards

Softloaded vs Pre-programmed probe firmware

One thing that most LPC-Link2 implementation offer is the ability to either softload the debug
probe firmware (using USB DFU functionality) or to have the debug probe firmware pre-
programmed into flash.

Programming the firmware into flash has some advantages, including:

¢ Allows the use of the LPC-Link2 with toolchains that, unlike MCUXpresso IDE, do not support
softloading of the probe firmware.

» Better supports the use of LPC-Link2 as a small production run programmer

* Allows the LPC-Link2 to be used with SEGGER J-Link firmware as an alternative to the normal
CMSIS-DAP firmware. For more details please visit http://www.segger.com

¢ Avoids issues that the re-enumeration of the LPC-Link2 can sometimes trigger as the firmware
softloads (particularly where virtual machines are in use).

The recommended way to program the firmware into the flash of LPC-Link2 is NXP’s LPCScrypt
flash programming tool. For more details, see http://www.nxp.com/LPCSCRYPT

However, when used with MCUXpresso IDE, softloading the probe firmware is the recommended
method of using LPC-Link2 in most circumstances.

This ensures that the firmware version matching the MCUXpresso IDE version can automatically
be loaded when the first debug session is started (so normally the latest version). It also allows
different probe firmware variants to be softloaded, depending on current user requirements.

For this to work, you need to make sure that the probe hardware is configured to allow DFU
booting. To do this:

¢ For standalone LPC-Link2: remove the link from header JP1 (nearest USB)
e For LPCXpresso V2/V3: add a link to the header "DFU link"

LPC-Link2 firmware variants

As well as providing debug probe functionality, NXP’s CMSIS-DAP firmware for LPC-Link2 by
default also includes bridge channels to provide:

e Support for SWO Trace capture from the MCUXpresso IDE
¢ Support for Power Measurement from the MCUXpresso IDE (certain LPCXpresso V3 boards

only)
« Support fora UART VCOM port connected to the target processor (LPCXpresso V2/V3 boards

only)
e Support for a LPCSIO bridge that provides communication to 12C and SPI slave devices
(LPCXpresso V3 boards only)
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However, two other variants of the CMSIS-DAP firmware are provided that remove some of these
bridge channels.

« “Non Bridged”: This version of firmware provides debug features only — removing the bridged
channels such as trace, power measurement and VCOM. By removing the requirement for
these channels, USB bandwidth is reduced, therefore this firmware may be preferable if
multiple debug probes are to be used concurrently. The non-bridged build will also provide an
increase in download and general debug performance.

¢ “VYCOM Only”: This version of firmware provides only debug and VCOM features. The removal
of the other bridges allows better VCOM performance (though generally the bridged firmware
provides more than good enough VCOM performance).

A particular workspace can be switched to softload a different firmware variant via: Preferences
-> MCUXpresso IDE -> LinkServer Options -> LPC-Link2 boot type.

5] Prefercnces N o o =L e S|

type filter test LinkServer Options =T v

. 3 | i
?nera [] Ask to boot LPC-Link 2
> CfC++

. Help [¥] Boot LPC-Link 2
. Install/Update LPC-Link 2 boot type CMSIS-DAP (default) M

a MCUXpresso IDE
Debug Options (Adw

CMSIS-DAP (default)
CMSIS-DAP (Mon-bridged - Debug only

Debug Opticns (Mis Redlink wirespeed in Hz (0 = default) | CM3I5-DAP (VCOM serial bridge only)

Redlink server port (restart required)

Debug Probe Discov
Default Tool setting:
General

J-Link Options
LinkServer Opticns
LPC-Link Options

Block IDE requests to kill redlink server
Shutdown redlink server
Kill redlink server on exit

m

Note: If a mix of bridged and unbridged debug probes is required, then it is recommended that
these probes are pre-programmed with the required debug firmware. This can easily be done
via LPCScrypt.

18.10.4 Manually booting LPC-Link2
The recommended way to use LPC-Link2 with the MCUXpresso IDE is to allow the GUI to boot
and softload a debug firmware image at the start of a debug session.
Normally, LPC-Link2 is booted automatically (when configured to operate in DFU mode)
however, under certain circumstances — such as when troubleshooting issues, or using the
LinkServer command line flash utility, you may need to boot it manually.
LPC-Link2 USB Details
The standard utilities to explore USB devices on MCUXpresso IDE supported host platforms are:
* Windows — Device Manager
 MCUXpressolDE also provides a listusb utility in:
* {install_dir}\ide\bin\Scripts
¢ Linux — terminal command: Isusb
¢ Mac OS X — terminal command: system_profiler SPUSBDataType
Before boot, LPC-Link2 appears as a USB device with details:
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Devi ce Vendor| D/ Product | D: 0x1FC9/ 0x000C (NXP Sem conduct or s)

and will appear in Windows -> Devices and Printers, as below:

LPC

After boot, LPC-Link2 will by default appear as a USB device with details:

Devi ce Vendor | D/ Product | D: 0x1FC9/ 0x0090

and will appear in Windows -> Devices and Printers similar to below:

LPC-LIMEKZ
CMSIS-DAP
V5181

Note: Text details will vary depending on version number and which probe firmware variant is
booted.

Booting from the command line

MCUXpresso IDE provides a boot script for all supported platforms. To make use of this script
first of all connect the LPC-Link2 to your PC then enter the commands into a DOS command
prompt (or equivalent):

cd {install_dir}\ide\bin
boot _| i nk2

This will invoke the dfu-util utility to download the probe firmware into the RAM of the LPC-Link2’'s
LPC43xx MCU and then re-enumerate the probe.

Booting from the GUI

It is also possible to manually boot LPC-Link2 from the MCUXpresso IDE GUI, which may be a
more convenient solution than using the command line. To do this, first of all connect the LPC-
Link2 to your PC, then locate the red Boot icon on the Toolbar:

P A0~ Q
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and then click OK in the dialog displayed :

@ Debug probe selection =) =

Select the debug probes to be booted

LinkServer

[ selectal || Deselectan |

\/?::l l OK ] l Cancel ]

18.10.5 LPC-Link2 windows drivers
The drivers for LPC-Link2 are installed as part of the main MCUXpresso IDE installation process.
Note: One thing to be aware of is that the first time you debug using a particular LPC-Link2 on
a particular PC, the drivers will need to be loaded. This first time can take a variable period of
time depending upon your PC and operating system version. This may mean that the first debug
attempt fails, as the IDE may time out waiting for the booted LPC-Link2 to appear. In such as
case, a second debug attempt should complete successfully. Otherwise, try booting the LPC-
Link2 manually and checking the drivers load correctly.
If you need to reinstall the drivers, then the installer can be found at:
C\nxp\{install _dir}\Drivers\|pc_driver_installer.exe
18.10.6 LPC-Link2 failing to enumerate

On some systems, after booting LPC-Link2 with CMSIS-DAP firmware, the booted debug probe
does not enumerate correctly and the MCUXpresso IDE (or other toolchain) is unable to see the
debug probe. This problem is normally caused by on old, obsolete, version of the VCOM driver
being found by Windows instead of the the correct driver. To see if this is the cause of a problem
on your computer, find the version number of the LPC-Link2 VCOM driver. The obsolete driver
version is 1.0.0.0.
To find the version number of the LPC-Link2 VCOM driver
If you are using a soft-booted LPC-Link2 debug probe, start by booting your LPC-Link2, as
described in . If your LPC-Link2 debug probe is booting from
an image preprogrammed into the flash, you can skip this step.
Once your LPC-Link2 has booted, find the device in Device Manager and look at the driver
version number.
¢ Open the Windows Device Manager
¢ Expand the “Ports (COM and LPT)” section
¢ Right-click on “LPC-Linkll UCom Port”, and select Properties
¢ Click on the Driver tab of the Properties dialog
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M LPC-Linkll UCom Port (COM30) Properties @

File Action View Help

¢ ||| H el & ] 2 % %] | [Gons [ ot Setings] Dver [t

P 3 Batteries LPC-Linkell UCom Port ({COM30)
- 1M Computer 4
Dick drives

{

]:: Display adapters Driver Provider:  NXP
e DVD/CD-ROM drives Driver Date: /2172014
e Floppy disk drives Driver Version:  2.0.0.0
’ ‘,:H Floppy drive cuntmlle-rs Digital Signer: N¥P Semiconductors USA. Inc.
% Human Interface Devices
; IDE ATASATAPI controllers
“j Keybo;b:ds Driver Details To view details about the driver files.
W Mernory devices
§ E! Mice and other pointing devices Update Driver... To update the driver software for this device.
» B Monitors
b -EF Network adapters rio
475 Ports (COM & LPT)
. 7¥ Communications Port (COM1) Disable Disables the selected device.
"? Communications Port (COM2)
Y5 LPC-Linkll UCom Port (COM30)
. LF Printer Port (LPT1)
b D Processors

.I I I
[
[ ]

]
o

]
S
[17]

ff the device fails after updating the driver, roll
back to the previously installed driver.

To uninstall the driver (Advanced).

Uningtall

| 0K || Cancel

Note: that this image shows the current correct version of the driver (2.0.0.0).
Removing the obsolete 1.0.0.0 LPC-Linkll UCOM driver
To remove the obsolete driver, perform the following actions:

. In Device Manager, right-click on the LPC-Linkll UCOM device and select Uninstall

. If there is an option to delete the driver software, make sure it is checked, and press OK

. Select the menu item Action->Scan for hardware changes

. In Windows Control Panel, select Add/Remove program or Uninstall a program option

. Find the LPC Driver Installer, right-click on choose Uninstall

. Let the uninstaller complete

. Switch back to the Device Manager and Scan for hardware changes again

. Ifthe LPC-Linkll UCOM driver version is still present, Uninstall it again (steps 1 through 3) and
repeat until the LPC-Linkll UCOM driver no longer appears

9. Now run the Ipc_driver_installer.exe found in the MCUXpresso IDE “Drivers” directory

O~NO OIS, WN PR

Note: A reboot is recommended after running the Ipc_driver_installer.exe installer.

Now manually reboot the probe again (if softloading) and check Windows — Devices and
Printers to see if the device now appears correctly as an LPC-Link2 CMSIS-DAP VX.XXX.

If this fails to correct the problem, there is one final thing to try:

¢ Open a Command Prompt as the Administrative user and run the following commands

cd % enmp%
pnputil -e >devices.txt
not epad devi ces. t xt

¢ Search devices.txt for an entry similar to this, and note down the Published name (oemXX.inf)

Publ i shed nane : oenB8. i nf
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Driver package provider : NXP

Cl ass : Ports (COM & LPT)

Driver date and version : 09/ 12/ 2013 1.0.0.0

Si gner nane : NXP Semi conductors USA. Inc.

¢ Using the name notes above, run the following command (replacing XX with the number found
above)

pnputil -f -d oemXX inf

18.10.7 Troubleshooting LPC-Link2
If you have been able to use LPC-Link2 in a debug session but now see issues such as “No
compatible emulator available” or “Priority 0 connection to this core already taken” when trying
to perform a debug operation ...
¢ Ensure you have shut down any previous debug session
* You must close a debug session (press the Red ‘terminate’ button) before starting another
debug session
 ltis possible that the debug driver is still running in the background. Use the task manager or
equivalent to kill any tasks called:
« redlinkserv
e arm-none-eabi_gdb*
e crt_emu_*
New in MCUXpresso IDE version 10.2.0is an IDE button % to kill all low level debug executables.
If your host has never worked with LPC-Link2, then the following may help to identify the problem:
¢ Try manually booting your LPC-Link2 as per Manually booting LPC-Link2, and ensure that the
drivers have installed correctly.
e Try a different USB cable!
e Try a different USB port. If your host has USB3 and USB2, then try a USB2 port
« there are known issues with motherboard USB3 firmware, ensure your host is using the
latest driver from the manufacturer. Note: this is not referencing the host OS driver but the
motherboard firmware of the USB port
« If using a USB hub, first try a direct connection to the host computer
« If using a USB hub, try using one with a separate power supply — rather than relying on the
supply over USB from your PC.
« Try completely removing and re-installing the host device driver. See also
above.
 If using Windows 8.1 or later, then sometimes the Windows USB power settings can cause
problems. For more details use your favourite search engine to search for “windows 8 usb
power settings” or similar.
18.11 Make fails with Virtual Alloc pointer is null error
Very rarely, building a project on Windows may result in an error similar to this:
O [main] us O init_cheap: Virtual Alloc pointer is null, Wn32 error 487
Al | ocati onBase 0x0, BaseAddress 0x71110000, Regi onSize 0x350000, State 0x10000
\ nsys\ bi n\ neke. exe: *** Couldn't reserve space for cygwin's heap, Wn32 error O
This is a problem that affects a tiny minority of customers, and depends on what other applications
they are running at the same time. This is caused by a feature in the MSYS binaries that we use
to provide the the build environment for the MCUXpresso IDE on Windows.
MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
User Guide Rev. 10.2.0 — 14 May, 2018 217


Link2ManualBoot

NXP Semiconductors MCUXpresso IDE User Guide

18.12

18.12.1

If this happens, you can replace the file \ide\msys\bin\msys-1.0.dIl within your MCUXpresso
IDE install directory with the msys-1.0-alternate.dll file in the same directory (i.e. do a rename)

Note: this does not fix the problem, rather it moves DLL base address. Unfortunately, itis possible
the error may occur with this replacement DLL too, again depending on what other applications
are running. In which case you will need to revert to the original DLL again.

Creating bin, hex or S-Record files

When building a project, the MCUXpresso IDE tools create an ARM executable format (AXF) file
—which is actually standard ELF/DWARF file. This file can be programmed directly down to your
target using the MCUXpresso IDE debug functionality, but it may also be converted into a variety
of formats suitable for use in other external tools.

Simple conversion within the IDE

The simplest way to create a one-off binary or hex file is to open up the Debug (or Release)
folder in Project Explorer right click on the .axf file, and "Binary Utilities->Create binary" (or
Create hex, S-Record).

[(5 Proje 32 |2, Perip '} Regis £u5ym = 08 Welcome [£] bubble.c i3
=] Q:b - 111 PORT_SetPinConfig{I2C_RELEASE_SDA_PORT, I2(
112
¥ (= Debug 113 GPIO_PinInit({I2C_RELEASE_SCL_GPIO, I2C_RELI
F = accel 114 GPIO_PinInit({I2C_RELEASE_SDA_GPIO, I2C_RELI
> = board e /% Dri SDA 1 fi imul
> cMsIS 116 rive ow first to simulate o start
F[Bd . 117 GPIO _WritePinOutput(I2ZC_RELEASE_SDA_GPIO, !
(= drivers 118 i2c_release_bus_delay();
F [=-source 119
= startup 120 /* Send 9 pulses on SCL and keep SDA high °
b (= utilities 121 for (1 = 8; 1 < 9; i44)
- 137 £

= frdmk64f_demo_ap
. New B GPIO_WritePinOutput(I2C_RELEASE_SCL_GP!

i2c_release_bus_delay();

frdmk64f_demo_ap
frdmk64f_demo_ap  Open
) frdmk64f_demo_ap  Qpen With »  GPIO_WritePinOutput(I2C_RELEASE_SDA_GP:

i2c_release_bus_delay();

frdmk64f_demo_ap

! B—'EI EOF:L}' #®C GPIO_WritePinOutput(I2C_RELEASE_SCL_GP!
. . ) aste i2c_release_bus_delay();
O Qui M=Glo = Var 3¢ Delete ® i2c_release_bus_delay(};
5 MCUXpresso IDE (P1  Move...
128 Rename... F2 Send stop */
{ 0_WritePinOutput(I2C_RELEASE_SCL_GPIO, !

~ Start here tug Import... _release_bus_delay();

. MNew DI’OJECT... m Expon"‘ AOHL_Z LRI AL L FTAS RPEFACE FRA SRTA
B Import SDK example(s)..  Refresh F5 |

o | it iect(s) f il i Propertie B Console &3 Problem

*? Import project(s) from fili Run As >

% Build ‘frdmk4f_demo_¢ Debug As *  ble [frdmk64f_ demo_apps_bubble]

& Clean 'irdmk64f_demo_y Frofile As > . /board/board.c

, Launch Configurations » C Compiler

# Debug 'frdmk84f_demo_ Smart update p -gcc -std=gnud9 -DCR_INTEGER_PRINTF -DDE
el | Utilities > ding: ../board/board.c

5 Edit 'frdmkB4f_demo_apeal g el > Create hex

Tools > Create binary

% Quick Settings

= 9= #" Run C/C++ Code Analysis Create S-Record

£ Team » & LinkServer GUI Flash programmer
B " Compare With > Disassemble

& Build all projects [Debug  1ePlace With > Size

. Strip debug symbols
b e e e P Al %l Process symdefs file
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You can also change the underlying commands and options that are called by these menu entries
from the " Preferences->MCUXpresso IDE ->Utilities" preference page.

18.12.2 From the command line

The above “Binary Utilities” option within the IDE GUI is simply invoking the command line
objcopy tool (arm-none-eabi-objcopy). Objcopy can convert into the following formats:

» srec (Motorola S record format)
 binary

« ihex (Intel hex)

* tekhex

For example, to convert example.axf into binary format, use the following command:
arm-none-eabi-objcopy -O binary example.axf example.bin

If you ctrl-click on the project name on the right hand side of the bottom bar of the IDE, this will
launch a command prompt in the project directory with appropriate tool paths set up. You can
also use the Project Explorer right-click “Utilities->Open command prompt here” option to do this.

All you need to do before running the objcopy command is change into the directory of the
required Build configuration.

18.12.3 Automatically converting the file during a build

Objcopy may be used to automatically convert an axf file during a build. To do this, create an
appropriate Post-build step

18.12.4 Binary files and checksums

When creating a binary file for most LPC MCUSs, you also need to ensure that you apply a
checksum to it — so that the LPC bootloader sees the image as being valid. Generally the linker
script will do this if the managed linker script mechanism is used. Otherwise the “checksum” utility
found in the \ide\bin subdirectory of your MCUXpresso IDE installation can be used.

18.13 Post-build (and Pre-build) steps

It is sometimes useful to be able to automatically post-process your linked application, typically
to run one or more of the GNU ‘binutils’ on the generated AXF file.

For example, any application project that you create using the Project wizard will have least one
such “post-build step” - typically to display the size of your application.

enn Post-build steps

Enter one command per line.
After editing, commands are concatenated with a ', separator.
A comment character (#) at the start of a line disables that command AND all following commands.

arm-none-eabi-size "5S{BuildArtifactFileName}"
# arm-none-eabi-objcopy -v -O binary "S{BuildArtifactFileMame}” "${BuildArtifactFileBaseNamel.bin"
# checksum -p ${TargetChip} -d "${BuildArtifactFileBaseName}.bin®

| cancel | | oK |

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide Rev. 10.2.0 — 14 May, 2018 219




NXP Semiconductors MCUXpresso IDE User Guide

18.13.1

MCUXpresso IDE User Guide -

Note: Additional commands may also be listed (for example to create a binary and to run a
checksum command), but be commented out by use of a # character and hence not executed.
Any commands following a comment #command will be ignored.

Adding additional steps is very simple. In the below example we are going to carry out three
post-link steps:

 displaying the size of the application
e generate an interleaved C / assembler listing
« create a hex version of the application image

To do this:

¢ Open the Project properties. There are a humber of ways of doing this. For example, make
sure the Project is highlighted in the Project Explorer view then open the menu “Project ->
Properties”.

« In the left-hand list of the Properties window, open “C/C++ Build” and select “Settings”.

¢ Select the “Build steps” tab

 In the “Post-build steps - Command” field, click 'Edit...'
» Paste in the lines below and click 'OK’

ar m none- eabi -si ze ${Buil dArtifact Fil| eNane};
ar m none- eabi - obj dunp -S ${Bui |l dArtifactFil eNanme} > ${Buil dArtifactFileBaseNane}.|ss;
ar m none- eabi - obj copy -O i hex ${Buil dArtifactFileNane} ${Buil dArtifactFileBaseNane}. hex;

 Click apply

« Repeat for your other Build Configurations (Debug/Release)

Next time you do a build, this set of post-build steps will now run, displaying the application size
in the console, creating you an interleaved C/assembler listing file called .Iss and a hex file called
hex.

Note: Pre-build steps can be added to a project in exactly the same way if required.

Temporarily removing post-build steps
If you want to temporarily remove a step from your post-build process, rather than deleting it

completely — move that entry to the end of the line and pre-fix it with a “#” (hash) character. This
acts as a comment, causing the rest of the post-build steps to be ignored.
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